# Table of Contents

1. ANSYS CFX Launcher ................................................................. 1
   1.1. The ANSYS CFX Launcher Interface ............................................ 1
      1.1.1. Menu Bar ........................................................................ 1
         1.1.1.1. File Menu .................................................................. 1
            1.1.1.1.1. Save As ........................................................... 1
            1.1.1.1.2. Quit ................................................................... 1
         1.1.1.2. Edit Menu .................................................................. 2
            1.1.1.2.1. Clear .................................................................... 2
            1.1.1.2.2. Find .................................................................... 2
            1.1.1.2.3. Options ............................................................... 2
               1.1.1.2.3.1. User Interface Style .......................................... 2
               1.1.1.2.3.2. Application Font and Text Window Font .............. 2
         1.1.1.3. CFX Menu .................................................................. 2
            1.1.1.3.1. CFX-Pre ................................................................ 2
            1.1.1.3.2. CFX-Solver Manager ............................................. 2
            1.1.1.3.3. CFD-Post ............................................................. 2
            1.1.1.3.4. Other CFX Applications ......................................... 2
         1.1.1.4. Show Menu ................................................................. 3
            1.1.1.4.1. Show Installation ................................................... 3
            1.1.1.4.2. Show All ............................................................... 3
            1.1.1.4.3. Show System ......................................................... 3
            1.1.1.4.4. Show Variables ..................................................... 3
            1.1.1.4.5. Show Patches ........................................................ 3
         1.1.1.5. Tools Menu ................................................................. 3
            1.1.1.5.1. ANSYS Client Licensing Utility ................................. 3
            1.1.1.5.2. Command Line ...................................................... 3
            1.1.1.5.3. Configure User Startup Files (Linux only) ................. 4
            1.1.1.5.4. Edit File ............................................................... 4
            1.1.1.5.5. Edit Site-wide Configuration File ............................... 4
         1.1.1.6. User Menu .................................................................. 4
         1.1.1.7. Help Menu ................................................................ 4
   1.1.2. Tool Bar ........................................................................ 4
   1.1.3. Working Directory Selector .................................................. 4
   1.1.4. Output Window ................................................................ 4
   1.2. Customizing the ANSYS CFX Launcher .................................... 5
      1.2.1. CCL Structure ................................................................ 5
         1.2.1.1. GROUP ................................................................ 5
         1.2.1.2. APPLICATION ....................................................... 6
            1.2.1.2.1. Including Environment Variables .......................... 7
         1.2.1.3. DIVIDER ................................................................ 8
      1.2.2. Example: Adding the Windows Calculator ......................... 8
2. Volume Mesh Import API .............................................................. 9
   2.1. Valid Mesh Elements in CFX .................................................. 9
   2.2. Creating a Custom Mesh Import Executable for CFX-Pre .......... 10
      2.2.1. Compiling Code with the Mesh Import API ......................... 11
         2.2.1.1. Compiler Flags ....................................................... 11
      2.2.2. Linking Code with the Mesh Import API .............................. 11
         2.2.2.1. Linking a Customized C Mesh Import Executable on a UNIX Platform ....... 11
         2.2.2.2. Linking a Customized Fortran Mesh Import Executable on a UNIX Platform .......... 12
         2.2.2.3. Linking a Customized Mesh Import Executable on a 32-bit Windows Platform .... 12
2.2.2.4. Linking a Customized Mesh Import Executable on a 64-bit Windows Platform .......... 12
2.3. Details of the Mesh Import API .................................................................................. 12
  2.3.1. Defined Constants ................................................................................................. 13
    2.3.1.1. Element Types .............................................................................................. 13
    2.3.1.2. Region Types ............................................................................................... 13
  2.3.2. Initialization Routines .......................................................................................... 14
    2.3.2.1. cfImportStatus ......................................................................................... 14
    2.3.2.2. cfImportInit .............................................................................................. 14
    2.3.2.3. cfImportTest ............................................................................................. 14
  2.3.3. Termination Routines ........................................................................................... 14
    2.3.3.1. cfImportDone ............................................................................................ 15
    2.3.3.2. cfImportTotals ......................................................................................... 15
  2.3.4. Error Handling Routines ....................................................................................... 15
    2.3.4.1. cfImportError ............................................................................................ 15
    2.3.4.2. cfImportFatal ............................................................................................ 15
  2.3.5. Node Routines ..................................................................................................... 16
    2.3.5.1. cfImportNode ............................................................................................ 16
    2.3.5.2. cfImportGetNode ....................................................................................... 16
    2.3.5.3. cfImportNodeList ...................................................................................... 16
  2.3.6. Element Routines ................................................................................................ 16
    2.3.6.1. cfImportElement ....................................................................................... 16
    2.3.6.2. cfImportGetElement .................................................................................. 17
    2.3.6.3. cfImportElementList .................................................................................. 18
    2.3.6.4. cfImportGetFace ....................................................................................... 18
    2.3.6.5. cfImportFindFace ...................................................................................... 19
  2.3.7. Primitive Region Routines .................................................................................... 19
    2.3.7.1. cfImportBegReg ......................................................................................... 19
    2.3.7.2. cfImportAddReg ......................................................................................... 19
    2.3.7.3. cfImportEndReg ....................................................................................... 20
    2.3.7.4. cfImportRegion ......................................................................................... 20
    2.3.7.5. cfImportRegionList .................................................................................... 20
    2.3.7.6. cfImportGetRegion .................................................................................... 20
  2.3.8. Composite Regions Routines ............................................................................... 20
    2.3.8.1. cfImportBegCompRegion ......................................................................... 20
    2.3.8.2. cfImportAddCompRegComponents .......................................................... 21
    2.3.8.3. cfImportEndCompReg .............................................................................. 21
    2.3.8.4. cfImportCompositeRegion ................................................................. 21
  2.3.9. Explicit Node Pairing .......................................................................................... 21
    2.3.9.1. cfImportMap ............................................................................................. 21
  2.3.10. Fortran Interface ............................................................................................... 22
    2.3.10.1. cfinit ........................................................................................................ 22
    2.3.10.2. cfxtest ...................................................................................................... 22
    2.3.10.3. cfxunit ..................................................................................................... 22
    2.3.10.4. cfxwarn .................................................................................................... 22
    2.3.10.5. cfxfatl ....................................................................................................... 22
    2.3.10.6. cfxdone ..................................................................................................... 22
    2.3.10.7. cfxnode .................................................................................................... 22
    2.3.10.8. cfxnodg .................................................................................................... 22
    2.3.10.9. cfxnds ........................................................................................................ 23
    2.3.10.10. cfxelem ................................................................................................... 23
    2.3.10.11. cfxeleg ................................................................................................... 23
    2.3.10.12. cfxeles ................................................................................................... 23
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.4. Details of the Mesh Export API</td>
<td>50</td>
</tr>
<tr>
<td>3.4.1. Defined Constants and Structures</td>
<td>50</td>
</tr>
<tr>
<td>3.4.1.1. Element Types</td>
<td>51</td>
</tr>
<tr>
<td>3.4.1.2. Volume List Types</td>
<td>51</td>
</tr>
<tr>
<td>3.4.1.3. Region List Types</td>
<td>51</td>
</tr>
<tr>
<td>3.4.1.4. Count Entries</td>
<td>51</td>
</tr>
<tr>
<td>3.4.1.5. Node Data Structure</td>
<td>52</td>
</tr>
<tr>
<td>3.4.1.6. Element Data Structure</td>
<td>52</td>
</tr>
<tr>
<td>3.4.2. Initialization and Error Routines</td>
<td>52</td>
</tr>
<tr>
<td>3.4.2.1. cfxExportInit</td>
<td>52</td>
</tr>
<tr>
<td>3.4.2.2. cfxExportDone</td>
<td>52</td>
</tr>
<tr>
<td>3.4.2.3. cfxExportError</td>
<td>52</td>
</tr>
<tr>
<td>3.4.2.4. cfxExportFatal</td>
<td>53</td>
</tr>
<tr>
<td>3.4.3. Zone Routines</td>
<td>53</td>
</tr>
<tr>
<td>3.4.3.1. cfxExportZoneCount</td>
<td>53</td>
</tr>
<tr>
<td>3.4.3.2. cfxExportZoneSet</td>
<td>53</td>
</tr>
<tr>
<td>3.4.3.3. cfxExportZoneGet</td>
<td>53</td>
</tr>
<tr>
<td>3.4.3.4. cfxExportZoneFree</td>
<td>53</td>
</tr>
<tr>
<td>3.4.3.5. cfxExportZoneSchemaRotating</td>
<td>54</td>
</tr>
<tr>
<td>3.4.3.6. cfxExportZoneMotionAction</td>
<td>54</td>
</tr>
<tr>
<td>3.4.4. Node Routines</td>
<td>54</td>
</tr>
<tr>
<td>3.4.4.1. cfxExportNodeCount</td>
<td>54</td>
</tr>
<tr>
<td>3.4.4.2. cfxExportNodeList</td>
<td>54</td>
</tr>
<tr>
<td>3.4.4.3. cfxExportNodeGet</td>
<td>55</td>
</tr>
<tr>
<td>3.4.4.4. cfxExportNodeFree</td>
<td>55</td>
</tr>
<tr>
<td>3.4.5. Element Routines</td>
<td>55</td>
</tr>
<tr>
<td>3.4.5.1. cfxExportElementCount</td>
<td>55</td>
</tr>
<tr>
<td>3.4.5.2. cfxExportElementList</td>
<td>55</td>
</tr>
<tr>
<td>3.4.5.3. cfxExportElementGet</td>
<td>56</td>
</tr>
<tr>
<td>3.4.5.4. cfxExportElementFree</td>
<td>56</td>
</tr>
<tr>
<td>3.4.6. Region Routines</td>
<td>56</td>
</tr>
<tr>
<td>3.4.6.1. cfxExportRegionCount</td>
<td>57</td>
</tr>
<tr>
<td>3.4.6.2. cfxExportRegionSize</td>
<td>57</td>
</tr>
<tr>
<td>3.4.6.3. cfxExportRegionName</td>
<td>57</td>
</tr>
<tr>
<td>3.4.6.4. cfxExportRegionList</td>
<td>57</td>
</tr>
<tr>
<td>3.4.6.5. cfxExportRegionGet</td>
<td>57</td>
</tr>
<tr>
<td>3.4.6.6. cfxExportRegionFree</td>
<td>58</td>
</tr>
<tr>
<td>3.4.7. Face Routines</td>
<td>58</td>
</tr>
<tr>
<td>3.4.7.1. cfxExportFaceNodes</td>
<td>58</td>
</tr>
<tr>
<td>3.4.8. Volume Routines</td>
<td>59</td>
</tr>
<tr>
<td>3.4.8.1. cfxExportVolumeCount</td>
<td>59</td>
</tr>
<tr>
<td>3.4.8.2. cfxExportVolumeSize</td>
<td>59</td>
</tr>
<tr>
<td>3.4.8.3. cfxExportVolumeName</td>
<td>59</td>
</tr>
<tr>
<td>3.4.8.4. cfxExportVolumeList</td>
<td>60</td>
</tr>
<tr>
<td>3.4.8.5. cfxExportVolumeGet</td>
<td>60</td>
</tr>
<tr>
<td>3.4.8.6. cfxExportVolumeFree</td>
<td>60</td>
</tr>
<tr>
<td>3.4.9. Boundary Condition Routines</td>
<td>60</td>
</tr>
<tr>
<td>3.4.9.1. cfxExportBoundaryCount</td>
<td>60</td>
</tr>
<tr>
<td>3.4.9.2. cfxExportBoundaryName</td>
<td>60</td>
</tr>
<tr>
<td>3.4.9.3. cfxExportBoundaryType</td>
<td>61</td>
</tr>
<tr>
<td>3.4.9.4. cfxExportBoundarySize</td>
<td>61</td>
</tr>
<tr>
<td>3.4.9.5. cfxExportBoundaryList</td>
<td>61</td>
</tr>
</tbody>
</table>
8.1.2. Reactions ................................................................. 114
8.1.3. Convergence Tips .................................................. 114
8.1.4. Post-Processing ....................................................... 115
8.2. Combustion Modeling in HVAC Cases ........................................ 115
8.2.1. Set Up ................................................................. 115
8.2.2. Convergence Tips ................................................... 116
8.2.3. Post-processing ....................................................... 116

9.1. HVAC Simulations .......................................................... 117
9.1.1. Setting Up HVAC Simulations ........................................ 117
9.1.1.1. Buoyancy ............................................................. 117
9.1.1.2. Thermal Radiation ................................................ 118
9.1.1.2.1. Thermal Radiation Model ...................................... 118
9.1.1.2.2. Spectral Model ................................................... 118
9.1.1.2.3. Scattering Model ............................................... 118
9.1.1.3. CHT (Conjugate Heat Transfer) Domains ...................... 119
9.1.1.4. Mesh Quality ....................................................... 119
9.1.1.5. Fans ................................................................. 120
9.1.1.6. Thermostats ....................................................... 120
9.1.1.7. Collections of Objects .......................................... 120
9.2. Convergence Tips .......................................................... 120

10. CFX Best Practices Guide for Multiphase .................................... 121
10.1. Bubble Columns ........................................................... 121
10.1.1. Setup ................................................................. 121
10.1.2. Convergence Tips ................................................... 122
10.1.3. Post-Processing ....................................................... 122
10.2. Mixing Vessels ............................................................. 122
10.2.1. Setup ................................................................. 122
10.3. Free Surface Applications ................................................ 122
10.3.1. Setup ................................................................. 123
10.3.2. Convergence Tips ................................................... 123
10.4. Multiphase Flow with Turbulence Dispersion Force ................... 124

11. CFX Best Practices Guide for Turbomachinery .............................. 125
11.1. Gas Compressors and Turbines .......................................... 125
11.1.1. Setup for Simulations of Gas Compressors and Turbines .......... 125
11.1.2. Convergence Tips ................................................... 126
11.1.3. Post-Processing ....................................................... 126
11.2. Liquid Pumps and Turbines .............................................. 127
11.2.1. Setup for Simulations of Liquid Pumps and Turbines ............. 127
11.2.2. Convergence Tips ................................................... 127
11.2.3. Post-Processing ....................................................... 128
11.3. Fans and Blowers ......................................................... 128
11.3.1. Setup for Simulations of Fans and Blowers ...................... 128
11.3.2. Convergence Tips ................................................... 128
11.3.3. Post-Processing ....................................................... 128
11.4. Frame Change Models .................................................... 129
11.4.1. Frozen Rotor .......................................................... 129
11.4.2. Stage ................................................................. 129
11.4.3. Transient Rotor-Stator ............................................... 130
11.5. Domain Interface Setup ................................................ 130
11.5.1. General Considerations .......................................... 130
11.5.2. Case 1: Impeller/Volute .......................................... 130
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.5.3</td>
<td>Case 2: Step Change Between Rotor and Stator</td>
<td>131</td>
</tr>
<tr>
<td>11.5.4</td>
<td>Case 3: Blade Passage at or Close to the Edge of a Domain</td>
<td>131</td>
</tr>
<tr>
<td>11.5.5</td>
<td>Case 4: Impeller Leakage</td>
<td>132</td>
</tr>
<tr>
<td>11.5.6</td>
<td>Case 5: Domain Interface Near Zone of Reversed Flow</td>
<td>133</td>
</tr>
<tr>
<td>12.1</td>
<td>CFX Command Language (CCL) Syntax</td>
<td>135</td>
</tr>
<tr>
<td>12.1.1</td>
<td>Basic Terminology</td>
<td>135</td>
</tr>
<tr>
<td>12.1.2</td>
<td>The Data Hierarchy</td>
<td>136</td>
</tr>
<tr>
<td>12.1.3</td>
<td>Simple Syntax Details</td>
<td>136</td>
</tr>
<tr>
<td>12.1.3.1</td>
<td>Case Sensitivity</td>
<td>136</td>
</tr>
<tr>
<td>12.1.3.2</td>
<td>CCL Names Definition</td>
<td>137</td>
</tr>
<tr>
<td>12.1.3.3</td>
<td>Indentation</td>
<td>137</td>
</tr>
<tr>
<td>12.1.3.4</td>
<td>End of Line Comment Character</td>
<td>137</td>
</tr>
<tr>
<td>12.1.3.5</td>
<td>Continuation Character</td>
<td>137</td>
</tr>
<tr>
<td>12.1.3.6</td>
<td>Named Objects</td>
<td>137</td>
</tr>
<tr>
<td>12.1.3.7</td>
<td>Singleton Objects</td>
<td>137</td>
</tr>
<tr>
<td>12.1.3.8</td>
<td>Parameters</td>
<td>137</td>
</tr>
<tr>
<td>12.1.3.9</td>
<td>Lists</td>
<td>138</td>
</tr>
<tr>
<td>12.1.3.10</td>
<td>Parameter Values</td>
<td>138</td>
</tr>
<tr>
<td>12.1.3.10.1</td>
<td>String</td>
<td>138</td>
</tr>
<tr>
<td>12.1.3.10.2</td>
<td>String List</td>
<td>138</td>
</tr>
<tr>
<td>12.1.3.10.3</td>
<td>Integer</td>
<td>139</td>
</tr>
<tr>
<td>12.1.3.10.4</td>
<td>Integer List</td>
<td>139</td>
</tr>
<tr>
<td>12.1.3.10.5</td>
<td>Real</td>
<td>139</td>
</tr>
<tr>
<td>12.1.3.10.6</td>
<td>Real List</td>
<td>139</td>
</tr>
<tr>
<td>12.1.3.10.7</td>
<td>Logical</td>
<td>139</td>
</tr>
<tr>
<td>12.1.3.10.8</td>
<td>Logical List</td>
<td>139</td>
</tr>
<tr>
<td>12.1.3.11</td>
<td>Escape Character</td>
<td>139</td>
</tr>
<tr>
<td>13.1</td>
<td>CEL Fundamentals</td>
<td>141</td>
</tr>
<tr>
<td>13.1.1</td>
<td>Values and Expressions</td>
<td>141</td>
</tr>
<tr>
<td>13.1.1.1</td>
<td>Using Locators in Expressions</td>
<td>142</td>
</tr>
<tr>
<td>13.1.2</td>
<td>CFX Expression Language Statements</td>
<td>142</td>
</tr>
<tr>
<td>13.1.2.1</td>
<td>Use of Constants</td>
<td>143</td>
</tr>
<tr>
<td>13.1.2.2</td>
<td>Expression Syntax</td>
<td>143</td>
</tr>
<tr>
<td>13.1.2.3</td>
<td>Multiple-Line Expressions</td>
<td>143</td>
</tr>
<tr>
<td>13.2</td>
<td>CEL Operators, Constants, and Expressions</td>
<td>144</td>
</tr>
<tr>
<td>13.2.1</td>
<td>CEL Operators</td>
<td>144</td>
</tr>
<tr>
<td>13.2.2</td>
<td>Conditional if Statement</td>
<td>145</td>
</tr>
<tr>
<td>13.2.3</td>
<td>CEL Constants</td>
<td>146</td>
</tr>
<tr>
<td>13.2.4</td>
<td>Using Expressions</td>
<td>146</td>
</tr>
<tr>
<td>13.2.4.1</td>
<td>Use of Offset Temperature</td>
<td>146</td>
</tr>
<tr>
<td>13.3</td>
<td>CEL Examples</td>
<td>147</td>
</tr>
<tr>
<td>13.3.1</td>
<td>Example: Reynolds Number Dependent Viscosity</td>
<td>147</td>
</tr>
<tr>
<td>13.3.2</td>
<td>Example: Feedback to Control Inlet Temperature</td>
<td>148</td>
</tr>
<tr>
<td>13.3.3</td>
<td>Examples: Using Expressions in CFD-Post</td>
<td>149</td>
</tr>
<tr>
<td>13.4</td>
<td>CEL Technical Details</td>
<td>149</td>
</tr>
<tr>
<td>14.1</td>
<td>CEL Mathematical Functions</td>
<td>151</td>
</tr>
<tr>
<td>14.2</td>
<td>Quantitative CEL Functions in ANSYS CFX</td>
<td>152</td>
</tr>
<tr>
<td>14.3</td>
<td>Functions Involving Coordinates</td>
<td>155</td>
</tr>
<tr>
<td>14.4</td>
<td>CEL Functions with Multiphase Flow</td>
<td>155</td>
</tr>
</tbody>
</table>
14.5. Quantitative Function List

14.5.1. area .................................................................................. 161
  14.5.1.1. Tools > Command Editor Example ..................................... 161
  14.5.1.2. Tools > Function Calculator Example .................................. 161
14.5.2. areaAve .............................................................................. 162
  14.5.2.1. Tools > Command Editor Example ..................................... 162
  14.5.2.2. Tools > Function Calculator Examples ............................... 162
14.5.3. arealnt ............................................................................ 163
  14.5.3.1. Tools > Command Editor Example ..................................... 163
  14.5.3.2. Tools > Function Calculator Examples ............................... 163
14.5.4. ave .................................................................................. 164
  14.5.4.1. Tools > Command Editor Example ..................................... 164
  14.5.4.2. Tools > Function Calculator Example .................................. 164
14.5.5. count ............................................................................. 164
  14.5.5.1. Tools > Command Editor Example ..................................... 165
  14.5.5.2. Tools > Function Calculator Example ............................... 165
14.5.6. countTrue ...................................................................... 165
  14.5.6.1. Tools > Command Editor Examples ..................................... 165
  14.5.6.2. Tools > Function Calculator Example ............................... 165
14.5.7. force ............................................................................. 165
  14.5.7.1. Tools > Command Editor Example ..................................... 166
  14.5.7.2. Tools > Function Calculator Examples ............................... 166
14.5.8. forceNorm .................................................................... 167
  14.5.8.1. Tools > Command Editor Example ..................................... 167
  14.5.8.2. Tools > Function Calculator Example ............................... 167
14.5.9. inside ........................................................................... 167
  14.5.9.1. Tools > Command Editor Example ..................................... 168
14.5.10. length .......................................................................... 168
  14.5.10.1. Tools > Command Editor Example ..................................... 168
  14.5.10.2. Tools > Function Calculator Example ............................... 168
14.5.11. lengthAve ..................................................................... 168
  14.5.11.1. Tools > Command Editor Example ..................................... 169
  14.5.11.2. Tools > Function Calculator Example ............................... 169
14.5.12. lengthInt ...................................................................... 169
  14.5.12.1. Tools > Command Editor Example ..................................... 169
14.5.13. mass ........................................................................... 169
  14.5.13.1. Tools > Command Editor Example ..................................... 169
14.5.14. massAve ..................................................................... 169
  14.5.14.1. Tools > Command Editor Example ..................................... 169
  14.5.14.2. Tools > Function Calculator Example ............................... 169
14.5.15. massFlow .................................................................... 169
  14.5.15.1. Mass Flow Sign Convention ............................................. 170
  14.5.15.2. Tools > Command Editor Example ..................................... 170
  14.5.15.3. Tools > Function Calculator Example ............................... 170
14.5.16. massFlowAve ................................................................. 171
  14.5.16.1. Tools > Command Editor Example ..................................... 171
  14.5.16.2. Tools > Function Calculator Example ............................... 171
14.5.17. Mass Flow Technical Note ............................................... 172

14.5.8.2. Tools > Function Calculator Example ............................... 167
14.5.21. massInt ................................................................. 174
14.5.21.1. Tools > Command Editor Example ................................................................. 174
14.5.22. maxVal ................................................................. 174
14.5.22.1. Tools > Command Editor Example ................................................................. 174
14.5.22.2. Tools > Function Calculator Example ................................................................. 174
14.5.23. minVal ................................................................. 174
14.5.23.1. Tools > Command Editor Example ................................................................. 175
14.5.23.2. Tools > Function Calculator Example ................................................................. 175
14.5.24. probe ................................................................. 175
14.5.24.1. Tools > Command Editor Example ................................................................. 175
14.5.24.2. Tools > Function Calculator Example ................................................................. 175
14.5.25. rbstate ................................................................. 175
14.5.25.1. Expressions Details View Example ................................................................. 176
14.5.26. rmsAve ................................................................. 176
14.5.26.1. Tools > Command Editor Example ................................................................. 176
14.5.27. sum ................................................................. 176
14.5.27.1. Tools > Command Editor Example ................................................................. 177
14.5.27.2. Tools > Function Calculator Example ................................................................. 177
14.5.28. torque ................................................................. 177
14.5.28.1. Tools > Command Editor Example ................................................................. 177
14.5.28.2. Tools > Function Calculator Example ................................................................. 177
14.5.29. volume ................................................................. 177
14.5.29.1. Tools > Command Editor Example ................................................................. 177
14.5.29.2. Tools > Function Calculator Example ................................................................. 177
14.5.30. volumeAve ................................................................. 178
14.5.30.1. Tools > Command Editor Example ................................................................. 178
14.5.30.2. Tools > Function Calculator Example ................................................................. 178
14.5.31. volumelnt ................................................................. 178
14.5.31.1. Tools > Command Editor Example ................................................................. 178
14.5.31.2. Tools > Function Calculator Example ................................................................. 179

15. Variables in ANSYS CFX .............................................. 181
15.1. Hybrid and Conservative Variable Values ................................................................. 181
15.1.1. Solid-Fluid Interface Variable Values ................................................................. 182
15.1.1.1. Conservative Values at 1:1 Interface ................................................................. 182
15.1.1.2. Hybrid Values at 1:1 Interface ................................................................. 182
15.1.1.3. Conservative Values on a GGI Interface ................................................................. 183
15.1.1.4. Hybrid Values on a GGI Interface ................................................................. 183
15.2. List of Field Variables ................................................................. 183
15.2.1. Common Variables Relevant for Most CFD Calculations ................................................................. 184
15.2.2. Variables Relevant for Turbulent Flows ................................................................. 188
15.2.3. Variables Relevant for Buoyant Flow ................................................................. 191
15.2.4. Variables Relevant for Compressible Flow ................................................................. 191
15.2.5. Variables Relevant for Particle Tracking ................................................................. 192
15.2.6. Variables Relevant for Calculations with a Rotating Frame of Reference ................................................................. 192
15.2.7. Variables Relevant for Parallel Calculations ................................................................. 192
15.2.8. Variables Relevant for Multicomponent Calculations ................................................................. 193
15.2.9. Variables Relevant for Multiphase Calculations ................................................................. 194
15.2.10. Variables Relevant for Radiation Calculations ................................................................. 195
15.2.11. Variables for Total Enthalpies, Temperatures, and Pressures ................................................................. 196
15.2.12. Variables and Predefined Expressions Available in CEL Expressions ................................................................. 197
15.2.12.1. System Variable Prefixes ................................................................. 206
15.2.12.2. CEL Variables r and theta ................................................................. 206
15.2.12.3. CEL Variable rNoDim ................................................................. 207
15.2.12.4. CEL Variable "subdomain" and CEL Function "inside" ......................................................... 207
15.2.12.5. Timestep, Timestep Interval, and Iteration Number Variables ......................................................... 207
  15.2.12.5.1. Steady-State Runs .................................................................................................................... 207
  15.2.12.5.2. Transient Runs ....................................................................................................................... 207
  15.2.12.5.3. ANSYS Multi-field Runs ....................................................................................................... 207
15.2.12.6. Expression Names ....................................................................................................................... 208
15.2.12.7. Scalar Expressions ..................................................................................................................... 208
15.2.12.8. Expression Properties .................................................................................................................. 208
15.2.12.9. Available and Unavailable Variables ............................................................................................ 208

15.3. Particle Variables Generated by the Solver ......................................................................................... 209
  15.3.1. Particle Track Variables ................................................................................................................ 210
  15.3.2. Droplet Breakup Variable ............................................................................................................. 212
  15.3.3. Multi-component Particle Variable ............................................................................................... 212
  15.3.4. Particle Field Variables ................................................................................................................ 212
    15.3.4.1. Particle Sources into the Coupled Fluid Phase .......................................................................... 212
    15.3.4.2. Particle Radiation Variables .................................................................................................... 213
    15.3.4.3. Particle Vertex Variables ........................................................................................................ 214
    15.3.4.3.1. Variable Calculations ........................................................................................................... 216
    15.3.4.4. Particle Boundary Vertex Variables ......................................................................................... 217
    15.3.4.5. Particle RMS Variables ........................................................................................................... 218
    15.3.4.5.1. Variable Calculations ........................................................................................................... 218

15.4. Miscellaneous Variables ..................................................................................................................... 219

16. Power Syntax in ANSYS CFX .................................................................................................................... 229
  16.1. Examples of Power Syntax ................................................................................................................ 229
    16.1.1. Example 1: Print the Value of the Pressure Drop Through a Pipe .................................................. 230
    16.1.2. Example 2: Using a for Loop ....................................................................................................... 231
    16.1.3. Example 3: Creating a Simple Subroutine ...................................................................................... 231
    16.1.4. Example 4: Creating a Complex Quantitative Subroutine .................................................................. 232
  16.2. Predefined Power Syntax Subroutines ................................................................................................. 233
    16.2.1. Power Syntax Subroutine Descriptions ......................................................................................... 233
    16.2.2. Power Syntax Usage ..................................................................................................................... 234
    16.2.3. Power Syntax Subroutines ........................................................................................................... 234
      16.2.3.1. area(Location, Axis) ................................................................................................................... 234
      16.2.3.2. areaAve(Variable, Location, Axis) ............................................................................................. 234
      16.2.3.3. areaInt(Variable, Location, Axis) ............................................................................................. 234
      16.2.3.4. ave(Variable, Location) ............................................................................................................ 234
      16.2.3.5. calcTurboVariables() .............................................................................................................. 234
      16.2.3.6. calculate(function,...) ............................................................................................................ 235
      16.2.3.7. calculateUnits(function,...) .................................................................................................... 235
      16.2.3.8. collectTurboInfo() .................................................................................................................. 235
      16.2.3.9. comfortFactors() .................................................................................................................... 235
      16.2.3.10. compressorPerform(Location, Location, Location, Var, Args) .............................................. 235
      16.2.3.11. compressorPerformTurbo() .................................................................................................. 235
      16.2.3.12. copyFile(FromPath, ToPath) .................................................................................................. 235
      16.2.3.13. count(Location) .................................................................................................................... 235
      16.2.3.14. countTrue(Expression, Location) ........................................................................................... 235
      16.2.3.15. cpPolar(Location, Var, Arg, Var, Location, Arg) ..................................................................... 235
      16.2.3.16. evaluate(Expression) ............................................................................................................ 236
      16.2.3.17. evaluateInPreferred(Expression) .......................................................................................... 236
      16.2.3.18. exprExists(Expression) ......................................................................................................... 236
      16.2.3.19. fanNoiseDefault() ............................................................................................................... 236
16.2.3.20. fanNoise() ................................................................. 236
16.2.3.21. force(Location, Axis) ................................................. 236
16.2.3.22. forceNorm(Location, Axis) ......................................... 237
16.2.3.23. getBladeForceExpr() ................................................ 237
16.2.3.24. getBladeTorqueExpr() ................................................. 237
16.2.3.25. getCLState() ................................................................ 237
16.2.3.26. getChildrenByCategory(Category) ............................ 237
16.2.3.27. getChildren(Object Name, Child Type) ....................... 237
16.2.3.28. getExprOnLocators() ................................................ 237
16.2.3.29. getExprString(Expression) ......................................... 237
16.2.3.30. getExprVal(Expression) ............................................... 237
16.2.3.31. getObjectName(Object Path) ........................................ 238
16.2.3.32. getParameterInfo(Object Name, Parameter Name, Info Type) ........................................ 238
16.2.3.33. getParameters(Object Name) ....................................... 238
16.2.3.34. getTempDirectory() .................................................. 238
16.2.3.35. getType(Object Name) ............................................... 238
16.2.3.36. getValue(Object Name, Parameter Name) ..................... 238
  16.2.3.36.1. Example ............................................................. 238
16.2.3.37. getViewArea() .......................................................... 239
16.2.3.38. isCategory(Object Name, Category) ........................... 239
16.2.3.39. Length(Location) ...................................................... 239
16.2.3.40. lengthAve(Variable, Location) .................................... 239
16.2.3.41. lengthInt(Variable, Location) ..................................... 239
16.2.3.42. liquidTurbPerformTurbo() ......................................... 240
16.2.3.43. liquidTurbPerform() ................................................ 240
16.2.3.44. massFlow(Location) ................................................... 240
16.2.3.45. massFlowAve(Variable, Location) ................................. 240
16.2.3.46. massFlowAveAbs(Variable, Location) ......................... 240
16.2.3.47. massFlowInt(Variable, Location) ................................... 240
16.2.3.48. maxVal(Variable, Location) ....................................... 240
16.2.3.49. minVal(Variable, Location) ....................................... 240
16.2.3.50. objectExists(Object Name) ....................................... 240
16.2.3.51. probe(Variable, Location) .......................................... 241
16.2.3.52. pumpPerform() ....................................................... 241
16.2.3.53. pumpPerformTurbo() ............................................... 241
16.2.3.54. range(Variable, Location) ......................................... 241
16.2.3.55. reportError(String) ................................................. 241
16.2.3.56. reportWarning(String) ............................................. 241
16.2.3.57. showPkgs() ............................................................ 241
16.2.3.58. showSubs(packageName) ........................................... 241
16.2.3.59. showVars(packageName) ........................................... 241
16.2.3.60. spawnAsyncProcess(command, arguments) .................. 241
16.2.3.61. sum(Variable, Location) .......................................... 241
16.2.3.62. torque(Location, Axis) .............................................. 242
16.2.3.63. turbinePerform() .................................................... 242
16.2.3.64. turbinePerformTurbo() .......................................... 242
16.2.3.65. verboseOn() .......................................................... 242
16.2.3.66. volume(Location) .................................................... 242
16.2.3.67. volumeAve(Variable, Location) ................................ 242
16.2.3.68. volumeInt(Variable, Location) .................................. 242

17. Bibliography ..................................................................... 243
  17.1. References 1-20 ............................................................. 243
17.2. References 21-40 ........................................................................................................ 246
17.3. References 41-60 ........................................................................................................ 249
17.4. References 61-80 ........................................................................................................ 252
17.5. References 81-100 ..................................................................................................... 255
17.6. References 101-120 ................................................................................................... 258
17.7. References 121-140 .................................................................................................. 261
17.8. References 141-160 .................................................................................................. 264
17.9. References 161-180 .................................................................................................. 267
17.10. References 181-200 ................................................................................................. 270
17.11. References 201 – .................................................................................................... 273

Glossary .............................................................................................................................. 277
Index .................................................................................................................................. 297
Chapter 1: ANSYS CFX Launcher

This chapter describes the ANSYS CFX Launcher in detail:
1.1. The ANSYS CFX Launcher Interface
1.2. Customizing the ANSYS CFX Launcher

1.1. The ANSYS CFX Launcher Interface

The layout of the ANSYS CFX Launcher is shown below:

Figure 1.1 ANSYS CFX Launcher

The launcher consists of a menu bar, a tool bar for launching applications, a working directory selector, and an output window where messages are displayed. On Windows platforms, an icon to start Windows Explorer in the working directory appears next to the directory selector.

1.1.1. Menu Bar

The ANSYS CFX Launcher menus provide the following capabilities:

1.1.1.1. File Menu

Saves the contents of the text output window and to close the ANSYS CFX Launcher.

1.1.1.1. Save As

Saves the contents of the output window to a file.

1.1.1.1.2. Quit

Shuts down the ANSYS CFX Launcher. Any programs already launched will continue to run.
1.1.1.2. **Edit Menu**

Clears the text output window, finds text in the text output window and sets options for the ANSYS CFX Launcher.

1.1.1.2.1. **Clear**

Clears the output window.

1.1.1.2.2. **Find**

Displays a dialog box where you can search the text in the output window.

1.1.1.2.3. **Options**

Presents the Options dialog box, which enables you to change the appearance of the ANSYS CFX Launcher.

1.1.1.2.3.1. **User Interface Style**

You can choose any one of several user interface styles; each style is available on all platforms. For example, choosing Windows will change the look and feel of the user interface to resemble that of a Windows application. You can select from Windows, Motif, CDE (Solaris), Plastique, and Cleanlooks styles. Once you have selected a style, click Apply to test.

1.1.1.2.3.2. **Application Font and Text Window Font**

The button to the right of Application Font sets the font used anywhere outside the text output window. The button to the right of Text Window Font applies only to the text output window. Clicking either of these buttons opens the Select Font dialog box.

1.1.1.3. **CFX Menu**

Enables you to launch CFX-Pre, CFX-Solver Manager, CFD-Post, and, if they are installed, other CFX products (such as ANSYS TurboGrid).

1.1.1.3.1. **CFX-Pre**

Runs CFX-Pre, with the working directory as specified in Working Directory Selector (p. 4).

1.1.1.3.2. **CFX-Solver Manager**

Runs CFX-Solver Manager, with the working directory as specified in Working Directory Selector (p. 4).

1.1.1.3.3. **CFD-Post**

Runs CFD-Post, in the current working directory as specified in Working Directory Selector (p. 4).

1.1.1.3.4. **Other CFX Applications**

The ANSYS CFX Launcher also searches for other CFX applications (for example, ANSYS TurboGrid) and provides a menu entry to launch the application. If an application is not found, you can add it; for details, see Customizing the ANSYS CFX Launcher (p. 5).
1.1.1.4. Show Menu

Enables you to show system, installation, and other information.

1.1.1.4.1. Show Installation

Displays information about the version of CFX that you are running.

1.1.1.4.2. Show All

Displays all of the available information, including information about your system, installation and variables.

1.1.1.4.3. Show System

Displays information about the CFX installation and the system on which it is being run.

1.1.1.4.4. Show Variables

Displays the values of all the environment variables that are used in CFX.

1.1.1.4.5. Show Patches

Displays the output from the command `cfx5info -patches`. This provides information on patches that have been installed after the initial installation of CFX.

1.1.1.5. Tools Menu

Enables you to access license-management tools and a command line for running other CFX utilities.

1.1.1.5.1. ANSYS Client Licensing Utility

Enables you to configure connections to ANSYS License Managers.

1.1.1.5.2. Command Line

Starts a command window from which you can run any of the CFX commands via the command line interface. The command line will be set up to run the correct version of CFX and the commands will be run in the current working directory.

If you do not use the Tools > Command Line command to open a command window, then you will have to either type the full path of the executable in each command, or explicitly set your operating system path to include the `<CFXROOT>/bin` directory.

You may want to start components of CFX from the command line rather than by clicking the appropriate button on the ANSYS CFX Launcher for the following reasons:

- CFX contains some utilities (for example, a parameter editor) that can be run only from the command line.
- You may want to specify certain command line arguments when starting up a component so that it starts up in a particular configuration.
- If you are having problems with a component, you may be able to get a more detailed error message by starting the component from the command line than you would get if you started the component
from the launcher. If you start a component from the command line, any error messages produced are
written to the command line window.

1.1.1.5.3. **Configure User Startup Files (Linux only)**

Information about creating startup files can be found in the installation documentation.

1.1.1.5.4. **Edit File**

Opens a browser to edit the text file of your choice in a platform-native text editor. Which text editor
is called is controlled by the settings in `<CFXROOT>/etc/launcher/shared.ccl`.

1.1.1.5.5. **Edit Site-wide Configuration File**

Opens the site-wide configuration file in a text editor. Which text editor is called is controlled by the
settings in `<CFXROOT>/etc/launcher/CFX5.ccl`.

1.1.1.6. **User Menu**

The **User** menu is provided as an example. You can add your own applications to this menu, or create
new menus; for details, see *Customizing the ANSYS CFX Launcher (p. 5)*.

1.1.1.7. **Help Menu**

The **Help** menu enables you to view tutorials, user guides, and reference manuals online. For related
information, see *Accessing Help*.

1.1.2. **Tool Bar**

The toolbar contains shortcuts to the main components of CFX, for example CFX-Pre, CFX-Solver Manager
and CFD-Post. Pressing any of the buttons will start up the component in the specified working directory.
The equivalent menu entries for launching the components also show a keyboard shortcut that can be
used to launch the component.

1.1.3. **Working Directory Selector**

While running CFX, all the files that are created will be stored in the working directory. To change the
working directory, you can do any of the following:

- Type the directory name into the box and press **Enter**.
- Click the down-arrow icon (▼) next to the directory name. This displays a list of recently used directories.
- Click **Browse** to browse to the directory that you want.

1.1.4. **Output Window**

The output window is used to display information from commands in the **Show** menu. You can right-
click in the output window to show a shortcut menu with the following options:

- **Find**: Displays a dialog box where you can enter text to search for in the output.
- **Select All**: Selects all the text.
- **Copy Selection**: Copies the selected text.
Customizing the ANSYS CFX Launcher

1.2. Customizing the ANSYS CFX Launcher

Many parts of the ANSYS CFX Launcher are driven by CCL commands contained in configuration files. Some parts of the launcher are not editable (such as the File, Edit and Help menus), but others parts allow you to edit existing actions and create new ones (for example, launching your own application from the User menu). The following sections outline the steps required to configure the launcher. The configuration files are located in the `<CFXROOT>/etc/launcher/` directory (where `<CFXROOT>` is the path to your installation of CFX). You can open these files in any text editor, but you should not edit any of the configuration files provided by CFX, other than the User.ccl configuration file.

1.2.1. CCL Structure

The configuration files contain CCL objects that control the appearance and behavior of menus and buttons that appear in the ANSYS CFX Launcher. There are three types of CCL objects: GROUP, APPLICATION and DIVIDER objects. The fact that there are multiple configuration files is not important; applications in one file can refer to groups in other files.

An example of how to add a menu item for the Windows calculator to the launcher is given in Example: Adding the Windows Calculator (p. 8).

1.2.1.1. GROUP

GROUP objects represent menus and toolbar groups in the ANSYS CFX Launcher. Each new GROUP creates a new menu and toolbar. Nothing will appear in the menu or toolbar until you add APPLICATION or DIVIDER objects to the group. An example of a GROUP object is given below:

```
GROUP: CFX
  Position = 200
  Menu Name = &CFX
  Show In Toolbar = Yes
  Show In Menu = Yes
  Enabled = Yes
END
```

- The group name is set after the colon. In this case, it is "CFX". This is the name that APPLICATION and DIVIDER objects will refer to when you want to add them to this group. This name should be different to all other GROUP objects.
- Position refers to the position of the menu relative to others. The value should be an integer between 1 and 1000. Groups with a higher Position value, relative to other groups, will have their menu appear further to the right in the menu bar. Referring to Figure 1.1 (p. 1), CFX has a lower position value than the ANSYS group. The File and Edit menus are always the first two menus and the Help menu is always the last menu.
- The title of the menu is set under Menu Name (this menu has the title CFX). The optional ampersand is placed before the letter that you want to have act as a menu accelerator (for example, Alt-C displays the CFX menu). You must be careful not to use an existing menu accelerator.
- The creation of the menu or toolbar can be toggled by setting the Show in Menu and Show in Toolbar options to Yes or No respectively. For example, you may want to create a menu item but not an associated toolbar icon.
- Enabled sets whether the menu/toolbar is available for selection or is disabled. Set the option to No to disable it.
1.2.1.2. APPLICATION

APPLICATION objects create entries in the menus and toolbars that will launch an application or run a process. Two examples are given below with an explanation for each parameter. The first example creates a menu entry in the Tools menu that opens a command line window. The second example creates a menu entry and toolbar button to start CFX-Solver Manager.

APPLICATION: Command Line 1
- Position = 300
- Group = Tools
- Tool Tip = Start a window in which CFX commands can be run
- Menu Item Name = Command Line
- Command = \system32\cmd.exe
- Arguments = /c start
- Show In Toolbar = No
- Show In Menu = Yes
- Enabled = Yes
- OS List = winnt

APPLICATION: CFXSM
- Position = 300
- Group = CFX
- Tool Tip = Launches ANSYS CFX-Solver Manager
- Menu Item Name = CFX-Solver Manager
- Command = cfx5solve
- Show In Toolbar = Yes
- Show In Menu = Yes
- Enabled = Yes
- Toolbar Name = ANSYS CFX-Solver Manager
- Icon = LaunchSolveIcon.xpm
- Shortcut = CTRL+S

• The application name is set after the colon, in the first example it is "Command Line 1". This name should be different from all other APPLICATION objects.

• Position: sets the relative position of the menu entry. The value should be an integer between 1 and 1000. The higher the value, relative to other applications that have the same group, the further down the menu or the further to the right in a toolbar the entry will appear. If you do not specify a position, the object assumes a high position value (so it will appear at the bottom of a menu or at the right of a group of buttons).

• Group: sets the GROUP object to which this application belongs. The value must correspond to the name that appears after "GROUP:" in an existing GROUP object. The menu and/or toolbar entry will not be created if you do not specify a valid group name. The GROUP object does not have to be in the same configuration file.

• Tool Tip: displays a message when the mouse pointer is held over a toolbar button. In the "Command Line 1" example above, the Tool Tip entry is not used because a toolbar button is not created. This parameter is optional.

• Menu Item Name: sets the name of the entry that will appear in the menu. If you do not specify a name, the name is set to the name of the APPLICATION: object. The optional ampersand is placed before the letter that you want to have act as a menu accelerator (for example, Alt-C then S will start CFX-Solver Manager. Alt-C selects the CFX menu and S selects the entry from the menu). You must be careful not to use an existing menu accelerator.

• Command: contains the command to run the application. The path can be absolute (that is, use a forward slash to begin the path on Linux, or a drive letter on Windows). If an absolute path is not specified, a relative path from <CFXROOT>/bin/ is assumed. If no command is specified, the menu item/toolbar button will not appear in the ANSYS CFX Launcher. The path and command are checked when the launcher is started. If the path or command does not exist, the menu item/toolbar button will not appear.
in the launcher. You may find it useful to include environment variables in a command path; for details, see Including Environment Variables (p. 7).

- **Arguments**: specifies any arguments that need to be passed to the application. The arguments are appended to the value you entered for Command. You do not need to include this parameter as there are no arguments to pass. You may find it useful to include environment variables in the arguments; for details, see Including Environment Variables (p. 7).

Distinct arguments are space-separated. If you need to pass an argument that contains spaces (for example, a Windows file path) you should include that argument in double quotes, for example:

```
Arguments = "C:\Documents and Settings\User" arg2 arg3
```

- **Show In Toolbar**: determines if a toolbar button is created for the application. This optional parameter has a default value of **Yes**.
- **Show In Menu**: determines if a menu entry is created for the application. This optional parameter has a default value of **Yes**.
- **Enabled**: controls the menu entry and toolbar button. Set this parameter to **No** to disable the application. This optional parameter has a default value of **Yes**.
- **OS List** is an optional parameter that enables you to set which operating system the application is suitable for. If **OS List** is not supplied, the launcher will attempt to create the menu item and toolbar button on all platforms.

For example, the command to open a command line window varies depending on the operating system. In the ‘Command Line 1’ example above, the application only applies to Windows platforms. To complete the OS coverage, the launcher configuration files contain more ‘Command Line’ applications that apply to different operating systems.

**OS List** can contain **winnt** (Windows, including Windows XP) and **linux-ia64** (64-bit Linux).

- **Toolbar Name**: sets the name that appears on the toolbar button. This parameter is optional (because you may want to show only an icon).
- **Icon**: specifies the icon to use on the toolbar button and in the menu item. The path can be absolute (that is, use a forward slash to begin the path on Linux, or a drive letter on Windows). If an absolute path is not specified, a relative path from `<CFXROOT>/etc/icons` is assumed. The following file formats are supported for icon image files: Portable Network Graphics (**png**), Pixel Maps (**ppm**, **xpm**), and Bitmaps (**bmp**). Other icons used in the launcher are 32 pixels wide and 30 pixels high. This parameter is optional. If it is not included, an icon will not appear.
- **Shortcut**: specifies the keyboard shortcut that can be pressed to launch the application. You must be careful not to use a keyboard shortcut that is used by any other **APPLICATION** object.

### 1.2.1.2.1. Including Environment Variables

In can be useful to use environment variables in the values for some parameters. You can specify an environment variable value in any parameter by including its name between the `< >` symbols. In the ‘Command Line 1’ example above, `<windir>` is used in the Command parameter so that the command would work on different versions of Windows. `<windir>` is replaced with the value held by the windir environment variable. The **Command** and **Argument** parameters are the only parameters that are likely to benefit from using environment variables. Environment variables included in the **Arguments** parameter are expanded before they are passed to the application.
1.2.1.3. DIVIDER

DIVIDER objects create a divider in a menu and/or toolbar (see the Tools menu for an example). An example of the CCL for DIVIDER objects is shown below.

DIVIDER: Tools Divider 1
   Position = 250
   Group = Tools
   OS List = winnt, linux-ia64
END

The Position, Group and OS List parameters are the same as those used in APPLICATION objects. For details, see APPLICATION (p. 6).

1.2.2. Example: Adding the Windows Calculator

The following CCL is the minimum required to add the Windows calculator to the ANSYS CFX Launcher:

GROUP: Windows Apps
   Menu Name = Windows
END
APPLICATION: Calc
   Group = Windows Apps
   Command = <windir>\system32\calc.exe
   Toolbar Name = Calc
END

Although the parameter Toolbar Name is not strictly required, you would end up with a blank toolbar button if it were not set.
Chapter 2: Volume Mesh Import API

The Mesh Import Application Programming Interface (API) enables you to build a customized executable that reads a 3-dimensional mesh from a 3rd-party mesh file into CFX-Pre and to extend the number of file formats that CFX-Pre can understand and read beyond those supplied as part of the standard installation.

The communication between the executable and CFX-Pre is via a communications channel that is controlled by use of routines in the API provided.

For details on using the Volume Mesh Import API, see User Import.

This chapter describes:
- 2.1. Valid Mesh Elements in CFX
- 2.2. Creating a Custom Mesh Import Executable for CFX-Pre
- 2.3. Details of the Mesh Import API
- 2.4. An Example of a Customized C Program for Importing Meshes into CFX-Pre
- 2.5. Import Programs

2.1. Valid Mesh Elements in CFX

The CFX-Solver technology works with unstructured meshes. This does not prohibit the use of structured meshes. However a structured mesh will always be dealt with internally as an unstructured mesh.

The CFX-Solver can solve flows in any mesh comprising one or more of the following element types:
You must write the program using the API to translate the mesh read from the 3rd-party file into a format that can be processed by CFX-Pre.

### 2.2. Creating a Custom Mesh Import Executable for CFX-Pre

You can create your own customized program using the 'C' programming language or Fortran programming language. A number of API functions are provided in a library supplied with the ANSYS CFX installation. For details, see *Details of the Mesh Import API* (p. 12).

The installation contains a C source code example file that can be used as the basis of your custom executable. This file, `ImportTemplate.c`, is provided in `<CFXROOT>/examples/`, and is listed in: *An Example of a Customized C Program for Importing Meshes into CFX-Pre* (p. 25).

The basic structure of a program written to import a 3rd-party mesh into CFX-Pre is as follows:

1. Inclusion of the `cfxImport.h` header file (for C programs and not Fortran programs).
2. Initialization for import with the `cfxImportInit` routine.
3. Definition of node data with `cfxImportNode`.
4. Definition of element data with `cfxImportElement`.
5. Optionally, definitions of 2D and 3D regions with either `cfxImportRegion` or the following three functions: `cfxImportBegReg`, `cfxImportAddReg`, `cfxImportEndReg`
6. Data transfer with `cfxImportDone`. 
The header files associated with the API are located in `<CFXROOT>/include/`. If you do not use the header file `cfxImport.h`, the functionality of the routines contained within the API may not follow defined behavior.

After writing the program, you will need to compile the source code. For details, see *Compiling Code with the Mesh Import API* (p. 11).

You will also need to link your routine with the API routine libraries. For details, see *Linking Code with the Mesh Import API* (p. 11).

After a customized executable has been produced, it can be run in CFX-Pre. For details, see *User Import*.

### 2.2.1. Compiling Code with the Mesh Import API

Compilation of a customized executable must be performed using an appropriate compiler and compiler flags.

The customized executable must also be linked with the provided mesh import API library and the provided I/O library as detailed in *Linking Code with the Mesh Import API* (p. 11).

---

**Note**

Windows users should note that custom mesh import programs must be compiled as multi-threaded applications.

### 2.2.1.1. Compiler Flags

No compiler flags are necessary for successful compilation on linux-ia64, but use the icc compiler.

### 2.2.2. Linking Code with the Mesh Import API

In order to build a customized import utility routine, it must be linked with several libraries. With the exception of `bufferoverflowu.lib`, these libraries are located in `<CFXROOT>/lib/<os>/`:

- `libmeshimport.lib` (on Windows), or `libmeshimport.a` (on Linux)
- `libratlas_api.lib` (on Windows), or `libratlas_api.a` (on Linux)
- `libratlas.lib` (on Windows), or `libratlas.a` (on Linux)
- `libpgtapi.lib` (on Windows), or `libpgtapi.a` (on Linux)
- `libunits.lib` (on Windows), or `libunits.a` (on Linux)
- `libcclapilt.lib` (on Windows), or `libcclapilt.a` (on Linux)
- `libio.lib` (on Windows), or `libio.a` (on Linux)
- `bufferoverflowu.lib` (on Windows 64-bit)

### 2.2.2.1. Linking a Customized C Mesh Import Executable on a UNIX Platform

On most UNIX systems you should be able to build the executable with the command:

```bash
cmake myimport.c -I<CFXROOT>/include/ -o myimport -L<CFXROOT>/lib/<os> \
-ldmeshimport -ldratlas_api -ldratlas -ldpgtapi -ldunits -ldcclapilt -ldio \
-ldm -lc
```
Here, `-lmeshimport`, `-lratlas_api`, `-lratlas`, `-lpgtapi`, `-lunits`, `-lcclapilt`, and `-lio` indicate the libraries mentioned above, while `-lm` and `-lc` are system libraries.

In this example, your own import program is named `myimport.c` and the executable file will be called `myimport`. You should ensure that the libraries to which you are linking (which are in the path given after `-L`) appear on the command line after the source file (or object file if you are just linking to an existing object).

### 2.2.2.2. Linking a Customized Fortran Mesh Import Executable on a UNIX Platform

The following is an example of how to build the executable on Linux, when the source code for the executable is written in Fortran:

```
g77 myImport.F -L<install_dir>/lib/linux -lmeshimport -lratlas_api -lratlas -lpgtapi -lunits -lcclapilt -lio -o myImport.exe
```

### 2.2.2.3. Linking a Customized Mesh Import Executable on a 32-bit Windows Platform

You can build the executables on 32-bit Windows systems that have Microsoft Visual C++ 2008 Express Edition. An example command line follows:

```
cl /MD /I "C:\Program Files\Ansys Inc\v140\CFX\include" ImportTemplate.c /link /libpath:"C:\Program Files\Ansys Inc\v140\CFX\lib\winnt" libcclapilt.lib libio.lib libmeshimport.lib libunits.lib libpgtapi.lib libratlas_api.lib libratlas.lib
```

### 2.2.2.4. Linking a Customized Mesh Import Executable on a 64-bit Windows Platform

You can build the executables on 64-bit Windows systems that have the compiler from VS2008. An example command line follows:

```
cl /MD /I "C:\Program Files\Ansys Inc\v140\CFX\include" ImportTemplate.c /link /libpath:"C:\Program Files\Ansys Inc\v140\CFX\lib\winnt-amd64" libcclapilt.lib libio.lib libmeshimport.lib libunits.lib libpgtapi.lib libratlas_api.lib libratlas.lib bufferoverflowu.lib
```

### 2.3. Details of the Mesh Import API

This section contains information about the functions that are used to write a customized import executable in the Mesh Import API.

Before trying to use any of the routines listed in this section, it is highly recommended that you read *Creating a Custom Mesh Import Executable for CFX-Pre* (p. 10).

This section contains details of:

- *Defined Constants* (p. 13)
- *Initialization Routines* (p. 14)
- *Termination Routines* (p. 14)
- *Error Handling Routines* (p. 15)
- *Node Routines* (p. 16)
- *Element Routines* (p. 16)
Note

In past releases of ANSYS CFX the API has defined IDs of nodes and elements as integers (int). This release now uses a datatype ID_t to represent these quantities. This type is currently defined as an unsigned integer (unsigned int). This allows a greater number of nodes and elements to be imported than in the past.

2.3.1. Defined Constants

The following are defined in the header file cfxImport.h, which should be included in the import program.

2.3.1.1. Element Types

There are currently 4 types of elements, which are identified by the number of nodes: Tetrahedrons (4 nodes), pyramids (5 nodes), wedges or prisms (6 nodes), and hexahedrons (8 nodes). The element types may be identified by the defined constants:

```c
#define cfxELEM_TET  4
#define cfxELEM_PYR  5
#define cfxELEM_WDG  6
#define cfxELEM_HEX  8
```

The element node ordering and local face numbering follow Patran Neutral file conventions for element descriptions.

2.3.1.2. Region Types

Regions may be defined in terms of nodes, faces or elements, based on the type argument to the cfxImportBegReg or cfxImportRegion routines. The three types are defined by the defined constants:

```c
#define cfxImpREG_NODES  1
#define cfxImpREG_FACES  2
#define cfxImpREG_ELEMS  3
```

Node and Face regions define 2D regions of the imported mesh. Element regions define 3D regions of the imported mesh.

It is best to use face regions to define 2D regions of the mesh and element regions to define 3D regions of the mesh.

Node regions will be automatically transformed into a face region by the import process. This transformation requires the node IDs specified to define vertices of valid element faces. If no element faces can be constructed from the defined node region the node region will be deleted.
Note

Due to the limited topological information recoverable from a set of nodes it is not advisable to define 2D regions internal to a 3D region using nodes. In this case it is advisable to use Face regions.

Node regions are specified by a list of node IDs.

Face regions are defined by a list of face IDs. These face IDs are a combination of an element ID and a local face number in the element.

2.3.2. Initialization Routines

The following routines check and initialize the Import API. With the exception of \texttt{cfxImportStatus} the first call to the Import API must be either \texttt{cfxImportInit} for communication with CFX, or \texttt{cfxImportTest} for testing the import routine in stand-alone mode.

2.3.2.1. \texttt{cfxImportStatus}

\begin{verbatim}
int cfxImportStatus ()
\end{verbatim}

Returns 0 if descriptor is not opened and -1 if not opened for writing. In the normal case, 1 is returned if opened for writing to CFX, and 2 if opened for writing to a file.

2.3.2.2. \texttt{cfxImportInit}

\begin{verbatim}
void cfxImportInit ()
\end{verbatim}

Performs initialization to begin communicating with CFX. This routine should be called early on in the import program to let CFX know that data is to be sent. If not called within 60 seconds, CFX will terminate the import process. If called and there is no connection with CFX, then the routine \texttt{cfxImportTest} ("/dev/null") (UNIX) or \texttt{cfxImportTest} ("null") (Windows) will be called. This routine will be automatically called by most of the API routines if not already called.

There is no return value for this routine. In the case of an error, \texttt{cfxImportFatal} will be called.

2.3.2.3. \texttt{cfxImportTest}

\begin{verbatim}
int cfxImportTest (filename) char *filename;
\end{verbatim}

This routine allows testing of import program in isolation from CFX by writing data to a file \texttt{filename} instead of attempting to write it to the CFX communication channel.

The routine will return the file descriptor of the output file or will terminate with a call to \texttt{cfxImportFatal} on error.

2.3.3. Termination Routines

With the exception of \texttt{cfxImportTotals} the last call to the Import API must always be \texttt{cfxImportDone}. This function performs the final processing of the import data, and then transfers the data to CFX.
2.3.3.1. cfxImportDone

long cfxImportDone ()

Indicate to the import API that all mesh data has been given and the API should now send the data to CFX. Except for cfxImportTotals, this should be last call made to the API. Returns the total number of bytes transferred to CFX by the import program.

2.3.3.2. cfxImportTotals

long cfxImportTotals (counts)

size_t counts[cfxImpCNT_SIZE];

Get the total number of nodes, elements, regions and other useful information given to the mesh import API by the program. This information is returned in the array counts, which should be of size at least cfxImpCNT_SIZE (currently defined as 9). The values returned in counts may be indexed by the enum list in cfxImport.h, which is:

- counts[cfxImpCNT_NODE] = number of nodes
- counts[cfxImpCNT_ELEMENT] = number of elements
- counts[cfxImpCNT_REGION] = number of regions
- counts[cfxImpCNT_UNUSED] = number of unused nodes
- counts[cfxImpCNT_DUP] = number of duplicate nodes
- counts[cfxImpCNT_TET] = number of tetrahedral elements
- counts[cfxImpCNT_PYR] = number of pyramid elements
- counts[cfxImpCNT_WDG] = number of wedge elements
- counts[cfxImpCNT_HEX] = number of hexahedral elements

The return value for the function is the total number of bytes of data sent to CFX or written to the test file given when cfxImportTest was called.

2.3.4. Error Handling Routines

The first error handling routine allows the programmer to define an error callback function that is called when a fatal error is generated by the API or explicitly by the programmers code.

The second routine performs a method for clean termination of the program, shutting down the program and communication with ANSYS CFX.

2.3.4.1. cfxImportError

void cfxImportError (callback)

void (*callback)(char *errmsg);

Define a user routine to be called before terminating due to a fatal error. callback is the application-supplied function to be called in the case of an error. The callback routine takes a single argument, errmsg, which will be passed by cfxImportFatal and should be processed by the callback function as a brief message describing the error that has occurred. If this function is not called or callback is not specified, then the normal termination behavior of the mesh import API will be that the any fatal errors will write the error message to stderr as well as being sent to CFX.

2.3.4.2. cfxImportFatal

void cfxImportFatal (errmsg)

char *errmsg;

Terminate with an error message, errmsg. This routine will send the message to CFX, shut down the communication channel or test file and call the user callback function (if specified by a call to cfxImportError).
There is no return from this call. The import program will terminate immediately after clean up tasks have been performed.

### 2.3.5. Node Routines

These routines define the 3D coordinates of points in space(nodes) that will be used to define elements or 2D regions that are to be imported to CFX. Each node has a unique identifier called a node ID.

#### 2.3.5.1. `cfxImportNode`

```c
ID_t cfxImportNode (nodeid, x, y, z)
```

- `ID_t nodeid;`
- `double x, y, z;`

Define a node in the import API to be subsequently imported into CFX. The unique identifier of the node is given by `nodeid`, and the coordinates of the node by `x`, `y`, and `z`.

Returns 0 if `nodeid` is invalid (less than 1), or `nodeid` is successfully defined. If a node with the same identity has already been defined, the coordinate values will alter to the supplied values.

#### 2.3.5.2. `cfxImportGetNode`

```c
ID_t cfxImportGetNode (nodeid, x, y, z)
```

- `ID_t nodeid;`
- `double *x, *y, *z;`

Get the coordinates for the node identified by `nodeid` and return the values in `x`, `y`, and `z`. Returns 0 if the node has not been defined or the node ID for the node.

#### 2.3.5.3. `cfxImportNodeList`

```c
ID_t * cfxImportNodeList ()
```

Returns an array of all node identifiers currently defined or `NULL` if no nodes have been defined. The first entry in the array is the number of nodes currently defined.

The memory for the array returned is allocated using `malloc` by the routine, consequently it should be destroyed when no longer required by calling `free`.

### 2.3.6. Element Routines

The following routines define the topology of elements (using node IDs) that are to be imported to CFX. Also included here are routines that get the local face number and vertices of an element.

#### 2.3.6.1. `cfxImportElement`

```c
ID_t cfxImportElement (elemid, elemtype, nodelist)
```

- `ID_t elemid, *nodelist;` `int elemtype;`

Define a new element to be imported to CFX. The unique identifier of the element is given by `elemid`, the element type by `elemtype` and the list of vertices by `nodelist`. If an element with the same ID has already been defined, it will be replaced by the new element being defined.

Only volume elements are currently supported by CFX; these may be tetrahedrons (4 vertices), pyramids (5 vertices), prisms (6 vertices) or hexahedrons (8 vertices). `elemtype` is the number of vertices for the element.
The following defines are included in the header file, `cfxImport.h` for convenience:

```c
#define cfxELEM_TET 4 /* tet element (4 nodes) */
#define cfxELEM_PYR 5 /* pyramid element (5 nodes) */
#define cfxELEM_WDG 6 /* wedge element (6 nodes) */
#define cfxELEM_HEX 8 /* hex element (8 nodes) */
```

The list of vertices in `nodelist` refers to IDs of nodes that on termination of the import program by a call to `cfxImportDone` must have been defined by calls to `cfxImportNode`. If this is not the case a fatal error will be reported and the API will terminate.

The vertex ordering for the elements follows Patran Neutral File element conventions, and is shown in the following figure.

![Vertex Ordering Diagram](image)

**Note**

The vertex ordering for the export API is different. For details, see `cfxExportElementList` (p. 55).

Returns 0 in the case of an `elemid` is invalid (less than 1) or an unsupported value is given by `elemtype`, or `elemid` if the element is successfully defined. If the element already exists the vertices of the element will be redefined.

### 2.3.6.2. `cfxImportGetElement`

```c
ID_t cfxImportGetElement (elemid, nodelist)
ID_t elemid, nodelist[];
```

Get the node IDs for corresponding to the vertices of element identified by `elemid` and store in the array `nodelist`. This array needs to be at least as large the number of vertices for the element (a size of 8 will handle all possible element types).
Returns 0 if the element is not defined, or the element type (number of vertices). The node IDs will be ordered in the order expected by cfXImportElement if the program was to redefine the element.

2.3.6.3. cfXImportElementList

ID_t * cfXImportElementList ()

Returns an array of all the currently defined element IDs or NULL if no elements have been defined. The first entry in the array is the number of elements.

The memory for the array returned is allocated using malloc by the routine, consequently it should be destroyed when no longer required by calling free.

2.3.6.4. cfXImportGetFace

ID_t cfXImportGetFace (elemid, facenum, nodelist)
ID_t elemid, nodelist[]; int facenum;

Gets the node IDs for the local facenum'th face of the element identified by elemid.

The node IDs are returned in nodelist, which should be of at least of size 4. The nodes correspond to the vertices of the face and are ordered counter-clockwise such that the normal for the face points away from the element. The face numbers and associated node indices are modeled after Patran Neutral File elements, and are tabulated here:

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Face</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>tetrahedron</td>
<td>1</td>
<td>1 3 2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>1 2 4</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>2 3 4</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1 4 3</td>
</tr>
<tr>
<td>pyramid</td>
<td>1</td>
<td>1 4 3 2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>1 2 5</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>2 3 5</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>3 4 5</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>1 5 4</td>
</tr>
<tr>
<td>prism</td>
<td>1</td>
<td>1 3 2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>4 5 6</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>1 2 5 4</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>1 4 6 3</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>2 3 6 5</td>
</tr>
<tr>
<td>hexahedron</td>
<td>1</td>
<td>1 2 6 5</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>3 4 8 7</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>1 4 3 2</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>2 3 7 6</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>5 6 7 8</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>1 5 8 4</td>
</tr>
</tbody>
</table>
Note

The face numbers and associated node indices are different when exporting elements. For details, see \textit{cfxExportFaceNodes} (p. 58).

Returns -1 if the element has not been defined, 0 if the face number is out of range, or the number of nodes for the face (3 or 4):

\subsection{2.3.6.5. cfxImportFindFace}

\begin{verbatim}
ID_t cfxImportFindFace (elemid, nnodes, nodeid)
ID_t elemid, nodeid[]; int nnodes;
\end{verbatim}

Gets the local face number in element identified by \texttt{elemid} that contains all the nodes supplied by the calling routine in \texttt{nodeid}. \texttt{nnodes} is the number of nodes for the face (3 or 4).

Returns -1 if the element is not found or \texttt{nodeid} is not supplied or \texttt{nnodes} is greater than 4 or less than 3. Returns 0 if there is no match, or the local face number (1 to 6) of the element.

\subsection{2.3.7. Primitive Region Routines}

The following routines allow for the specification of 2D regions as a group of nodes or faces, or a 3D region as a group of elements. In the case of nodes and faces, only those that define faces of valid imported elements will be imported; others are ignored by CFX.

\subsubsection{2.3.7.1. cfxImportBegReg}

\begin{verbatim}
int cfxImportBegReg (regname, regtype)
char *regname;
int regtype;
\end{verbatim}

Initialize for the specification of a region. If a region is currently being defined, \texttt{cfxImportEndReg} will be called.

The name of the region is given by \texttt{regname}. If the region name is NULL, the name Unnamed Region 2D or Unnamed Region 3D, with a sequential integer appended, will be used. If a region named \texttt{regname} has already been defined, then additional objects will be added to the previous region.

The type of region is given by \texttt{regtype}, which should be one of \texttt{cfxImpREG_NODES}, \texttt{cfxImpREG_FACES} or \texttt{cfxImpREG_ELEMS} depending on whether the region is to be defined by nodes, faces or elements, respectively. It is not currently possible to mix types in a region; doing so will cause the import API to terminate with an error message.

Returns the number of objects (node, faces or elements) currently in the region.

\subsubsection{2.3.7.2. cfxImportAddReg}

\begin{verbatim}
int cfxImportAddReg (numobjs, objlist)
int numobjs, *objlist;
\end{verbatim}

Add IDs of objects being defined to the current region.

A region must be currently defined or reactivated by \texttt{cfxImportBegReg} or an error will occur, and the API will terminate.

The number of objects to add is given by \texttt{numobjs} and the IDs of the objects are supplied in \texttt{objlist}.
The objects are interpreted as node IDs, face IDs, or element IDs, depending on the type of the region indicated when `cfxImportBegReg` was called.

On calling `cfxImportDone`, any node IDs, face IDs or element IDs specified in the object list must have been defined by the appropriate routine or they will be removed from the region.

Returns the total number of objects in the current region after the object IDs have been added.

### 2.3.7.3. `cfxImportEndReg`

```c
int cfxImportEndReg ()
```

End the specification of the current region.

Returns the number of objects (nodes, faces or elements) in the region.

### 2.3.7.4. `cfxImportRegion`

```c
int cfxImportRegion (regname, regtype, numobjs, objlist)
```

Import a region named `regname` of type `regtype`. The number of objects to add to the region is given by `numobjs`, and the list of object IDs by `objlist`. This routine combines calls to `cfxImportBegReg`, `cfxImportAddReg` and `cfxImportEndReg`.

Returns the total number of objects in the region on termination of the routine.

### 2.3.7.5. `cfxImportRegionList`

```c
char ** cfxImportRegionList ()
```

Return a NULL terminated list of currently defined region names.

The memory for the array and each character string in the array returned is allocated using `malloc` by the routine, consequently each array member and the array itself should be destroyed when no longer required by calling `free`.

### 2.3.7.6. `cfxImportGetRegion`

```c
int * cfxImportGetRegion (regname)
```

Returns a list of objects in the region named `regname`, or `NULL` if the region does not exist. The first entry in the returned list is the region type and the second entry is the number of object IDs.

The memory for the array is allocated using `malloc` by the routine, consequently the array itself should be destroyed when no longer required by calling `free`.

### 2.3.8. Composite Regions Routines

The following routines allow composite regions to be defined in terms of primitive regions or other composite regions.

#### 2.3.8.1. `cfxImportBegCompRegion`

```c
cfxImportBegCompReg()
```

```c
char *endregion;
```
Begin defining a composite region with the name `regionName`,

Returns -1 if a primitive region `regionName` is already defined or memory couldn't be allocated, or 0 if successfully created.

### 2.3.8.2. `cfxImportAddCompRegComponents`

```c
int cfxImportAddCompRegComponents(componentCount, components)
int componentCount;
char **components;
```

Add a set of component region names specified in `components` to the composite region currently being defined. `componentCount` specified how many components are specified in the `components` array,

Returns -1 if a composite region isn't being defined or insufficient memory is available to add the components of the composite region, or 0 if the components were successfully added.

### 2.3.8.3. `cfxImportEndCompReg`

```c
int cfxImportEndCompReg()
```

Finish defining the current composite region.

Returns -1 if a composite region isn't currently being defined or 0 otherwise.

### 2.3.8.4. `cfxImportCompositeRegion`

```c
int cfxImportCompositeRegion(regionName, componentCount, components)
char *regionName, **components;
int componentCount;
```

Define a composite region named `regionName` with `componentCount` components supplied in character array `components`.

Returns 0 if successful or -1 if an error occurred preventing the composite region being defined.

### 2.3.9. Explicit Node Pairing

The following routine provides a method for explicitly marking two nodes as being identical (or in the same position in space).

### 2.3.9.1. `cfxImportMap`

```c
ID_t cfxImportMap (nodeid, mapid)
ID_t nodeid, mapid;
```

Explicitly map the node identified by `nodeid` to the node identified by `mapid`.

On calling `cfxImportDone` the Mesh Import API will update regions and elements referencing the mapped node to the node it is mapped to. This therefore reduces the total node count imported to CFX and eliminates the duplicate nodes.

Duplicate nodes may also be removed by CFX if the appropriate options are selected in the CFX interface and an appropriate tolerance set. For details, see Importing Meshes in the *CFX-Pre User's Guide*. 

---

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
2.3.10. Fortran Interface

The following routines are callable from Fortran, and interface with the corresponding C routine. There are currently no return values.

2.3.10.1. cfxinit

    call cfxinit

Interface to cfxImportInit. Initializes for import.

2.3.10.2. cfxtest

    CHARACTER*n filename
    call cfxtest(filename)

Interface to cfxImportTest. filename is a CHARACTER*n value that gives the name of the file to dump the output to.

2.3.10.3. cfxunit

    CHARACTER*n units
    call cfxunit(units)

Interface to cfxImportUnits. Specify the units the mesh is specified in.

2.3.10.4. cfxwarn

    CHARACTER*n mesg
    call cfxwarn(mesg)

Interface to cfxImportWarning. Emit a warning message mesg.

2.3.10.5. cfxfatl

    CHARACTER*n mesg
    call cfxfatl(mesg)

Interface to cfxImportFatal. Emit a warning message mesg and terminate the program cleanly.

2.3.10.6. cfxdone

    call cfxdone

Interface to cfxImportDone. Terminates the program and transfers the data to CFX-Pre.

2.3.10.7. cfxnode

    INTEGER idnode
    DOUBLE PRECISION x,y,z
    call cfxnode(idnode,x,y,z)

Interface to cfxImportNode. Imports a node with the specified coordinates. idnode is an INTEGER value for the node ID, and x, y, and z are the DOUBLE PRECISION coordinates of the node.

2.3.10.8. cfxnodg

    INTEGER idnode
    DOUBLE PRECISION x,y,z
    call cfxnodg(idnode,x,y,z)
Interface to cfxImportGetNode. Queries the current coordinates or a node referenced by idnode. idnode is an INTEGER value for the node ID, and x, y, and z are the DOUBLE PRECISION coordinates of the node.

### 2.3.10.9. cfxnods

```c
INTEGER ids(*)
call cfxnods(ids)
```

Interface to cfxImportNodeList. Retrieves the list of all valid node IDs having been imported into the API. ids is an INTEGER array that must be at least as large as the number of nodes currently imported.

### 2.3.10.10. cfxelem

```c
INTEGER idelem, itelem, nodes(*)
call cfxelem(idelem, itelem, nodes)
```

Interface to cfxImportElement. idelem is element ID, and itelem is the element type (number of nodes - 4, 5, 6, or 8). Both are of type INTEGER. nodes is an array of INTEGER node IDs dimensioned of size at least itelem.

### 2.3.10.11. cfxeleg

```c
INTEGER idelem, itelem, nodes(*)
call cfxeleg(idelem, itelem, nodes)
```

Interface to cfxImportGetElement. Queries the current node ids that define the vertices of the element referenced by the id idelem. idelem is element ID, and itelem is the element type (number of nodes - 4, 5, 6, or 8). Both are of type INTEGER. nodes is an array of INTEGER values that will contain the node IDs on successful return. It should be dimensioned of size at least itelem.

### 2.3.10.12. cfxeles

```c
INTEGER ids(*)
call cfxeles(ids)
```

Interface to cfxImportElemList. Retrieves the list of all valid element IDs having been imported into the API. ids is an INTEGER array that must be at least as large as the number of elements currently imported.

### 2.3.10.13. cfxfacd

```c
INTEGER eleid, elefc, id
call cfxfacd(eleid, elefc, id)
```

Interface to cfxImportFaceID. Defines a face id (id) in terms of an element ID (eleid) and local face (elefc) of that element.

### 2.3.10.14. cfxface

```c
INTEGER eleid, elefc, vtx(*)
INTEGER cfxface(eleid, elefc, vtx)
```

Interface to cfxImportGetFace. Returns the node IDs of the vertices defining a face located by the element ID (eleid) and local face (elefc) of that element.
2.3.10.15. **cfxffac**

INTEGER eleid, nvtx, vtx(*), elefc

call cfffac(eleid, nvtx, vtx, elefc)

Interface to cfxImportFindFace. Returns the local face (elefc) of an element (eleid) that is defined by the vertices (vtx).

2.3.10.16. **cfxregn**

CHARACTER*n regname

INTEGER type, nobjs, objs(*)

call cfxregn(regname, type, nobjs, objs)

Interface to cfxImportRegion. Regname is a CHARACTER*n string defining the region name, type is an INTEGER value specifying the type of region, either 1 for nodes, 2 for faces, or 3 for elements. nobjs is an INTEGER value that gives the number of objects in the region, and objs is an INTEGER array of object IDs dimensioned at least size nobjs.

2.3.10.17. **cfxregb**

CHARACTER*n regname

INTEGER type

call cfxregb(regname, type)

Interface to cfxImportBegReg. Start defining a new region or make an existing region of the same name the current one if it already exists and is of the same type. regname is a CHARACTER*n string defining the region name, type is an INTEGER value specifying the type of region, either 1 for nodes, 2 for faces, or 3 for elements.

2.3.10.18. **cfxrega**

INTEGER nobjs, objs(*)

call cfxrega(nobjs, objs)

Interface to cfxImportAddReg. Add the objects (objs) to the current region. nobjs is an INTEGER value that gives the number of objects to add to the region, and objs is an INTEGER array of object IDs dimensioned at least size nobjs.

2.3.10.19. **cfxrege**

 call cfxrege()

Interface to cfxImportEndReg. Finish defining the current region (after the call there will be no current region).

2.3.10.20. **cfxregs**

CHARACTER*n regname

INTEGER numobj

call cfxregs(regname, numobj)

Query how many objects (returned in numobj) are referenced by the region regname. regname is a CHARACTER*n string specifying the region name.

2.3.10.21. **cfxregg**

CHARACTER*n regname

INTEGER type, obj(*)

call cfxregg(regname, type, obj)
Get the type (\texttt{type}) and object IDs (\texttt{objs}) referenced by the region \texttt{regname}. \texttt{regname} is a \texttt{CHARACTER*n} string specifying the region name. \texttt{type} is \texttt{INTEGER} and \texttt{objs} is an \texttt{INTEGER} array at least of the size returned by \texttt{cfxregs}.

\subsection{2.3.10.22. cfxcmpb}

\begin{verbatim}
CHARACTER*n regname
call cfxcmpb(regname)
\end{verbatim}

Interface to \texttt{cfxImportBegCompReg}. Start defining a new composite region or make an existing composite region of the same name as the current one if it already exists. \texttt{regname} is a \texttt{CHARACTER*n} string defining the region name.

\subsection{2.3.10.23. cfxcmpa}

\begin{verbatim}
INTEGER nregs
CHARACTER*(n) regs
call cfxcmpa(nregs,regs)
\end{verbatim}

Interface to \texttt{cfxImportAddCompReg}. Add the region names (\texttt{regs}) to the current composite region being defined. \texttt{nregs} is an \texttt{INTEGER} value that gives the number of regions to add to the region, and \texttt{regs} is a \texttt{CHARACTER*(*)} array of region names dimensioned at least size \texttt{nregs}.

\subsection{2.3.10.24. cfxcmpe}

\begin{verbatim}
call cfxcmpe()
\end{verbatim}

Interface to \texttt{cfxImportEndCompReg}. Finish defining the current composite region (after the call there will be no current composite region).

\subsection{2.3.11. Unsupported Routines Previously Available in the API}

In ANSYS CFX 14.0 certain functionality available in previous releases is no longer supported. These routines have been removed because they are directly implemented in CFX.

The following is a list of routines removed from the mesh import API:

\begin{verbatim}
cfxImportFixElements
cfxImportTolerance
cfxImportGetTol
cfxImportSetCheck
cfxImportRange
cfxImportCheck
cfxtol
cfxset
cfxchk
\end{verbatim}

\subsection{2.4. An Example of a Customized C Program for Importing Meshes into CFX-Pre}

This example, \texttt{ImportTemplate.c}, can be found in \texttt{<CFXROOT>/examples}.

\begin{verbatim}
/*
 * ImportTemplate.c - Patran Neutral File Import
 * reads packets 1 (nodes), 2 (elements) and 21 (named groups)
 * and optionally packet 6 (loads), and sends data to TFC
 */
#include <stdio.h>
#include <stdlib.h>
#include <string.h>
#include <ctype.h>
\end{verbatim}
#include <math.h>
#include <sys/types.h>
#include <sys/stat.h>
#include "cfxImport.h"
#include "getargs.h"

static char options[] = "vlF:"
static char *usgmsg[] = {
    "usage : ImportTemplate.c [options] Patran_file",
    "options:",
    " -v      = verbose output",
    " -l      = process packet 6 - distributed loads",
    NULL
};

/*---------- print_error -------------------------------------------
 * print error message and line number
 *-----------------------------------------------*/

static int lineno = 0;
static void print_error (char *errmsg) {
    fprintf (stderr, "%s on line %d
", errmsg, lineno);
}

/*---------- add_face -----------------------------------------------
 * add an element face to the region list
 *-----------------------------------------------*/

static void add_face (int elemid, char *data) {
    int n, nnodes, nodes[8];
    ID_t nodeid[8];
    char errmsg[81];

    /* check for node flags set */
    for (nnodes = 0, n = 0; n < 8; n++) {
        if ('1' == data[n])
            nodes[nnodes++] = n;
    }

    /* if node flags set, use the node values */
    if (nnodes) {
        ID_t elemnodes[8];
        int elemtypes = cfxImportGetElement (elemid, elemnodes);
        if (!elemtypes) {
            sprintf (errmsg,
                "element %d not found for packet 6
", elemid);
            cfxImportFatal (errmsg);
        }
        for (n = 0; n < nnodes; n++) {
            if (nodes[n] >= elemtypes) {
                sprintf (errmsg,
                    "invalid node flags for element %d
", elemid);
                cfxImportFatal (errmsg);
            }
            nodeid[n] = elemnodes[nodes[n]];
        }
    }
    /* else get nodes from face number */
    else {
        int faceid = atoi (&data[8]);
        nnodes = cfxImportGetFace (elemid, faceid, nodeid);
        if (nnodes < 0) {
            sprintf (errmsg,
                "element %d not found for packet 6
", elemid);
        }
    }
}

Chapter 2: Volume Mesh Import API
cfxImportFatal (errmsg);
}
if (0 == nnodes) {
    sprintf (errmsg, "invalid face number for element %d\n", elemid);
    cfxImportFatal (errmsg);
}
cfxImportAddReg (nnodes, nodeid);

/*============================================================================*/
#define getline()   \
    {if (NULL == fgets (buffer, sizeof(buffer), fp)) \
        cfxImportFatal ("premature EOF"); \   
        lineno++;
}
void main (argc, argv)
int argc;
char *argv[];
{
    int n, packet, nlines;
    int nnodes;
    int elemid;
    ID_t nodeid[8];
    int lastid = -1, loadid;
    int verbose = 0, do_loads = 0;
    double xyz[3];
    char *p, buffer[256];
    char *testfile = NULL;
    FILE *fp;
    struct stat st;
    if (argc < 2)
        usage (usgmsg, NULL);
    while ((n = getargs (argc, argv, options)) > 0) {
        switch (n) {
            case 'v':
                verbose = 7;
                break;
            case 'l':
                do_loads = 1;
                break;
            case 'F':
                testfile = argarg;
                if (verbose)
                    printf ("writing output to <%s>\n", testfile);
                cfxImportTest (testfile);
                break;
        }
    }
    if (argind >= argc)
        usage (usgmsg, "filename not specified\n");
    if (stat (argv[argind], &st)) {
        fprintf (stderr, "can't stat <%s>\n", argv[argind]);
        exit (1);
    }
    if (S_IFREG != (st.st_mode & S_IFMT)) {
        fprintf (stderr, "<%s> is not a regular file\n", argv[argind]);
        exit (1);
    }
    if (NULL == testfile)
        cfxImportInit ();
    else {
        if (verbose)
            printf ("writing output to <%s>\n", testfile);
        cfxImportTest (testfile);
    }
    if (NULL == (fp = fopen (argv[argind], "r"))) {
        sprintf (stderr, "can't open <%s> for reading", argv[argind]);
        cfxImportFatal (buffer);
    }
    if (verbose) {
        printf ("reading Patran Neutral file from <%s>\n", argv[argind]);
        fflush (stdout);
    }
    cfxImportError (print_error);
    getline ();
}
/* header - packet 25 */
if ((packet = atoi (buffer)) == 25) {
    getline ();
    if (verbose)
        fputs (buffer, stdout);
    getline ();
    packet = atoi (buffer);
}
/* summary - packet 26 */
if (packet == 26) {
    getline ();
    getline ();
    packet = atoi (buffer);
}
/* get remaining packets */
while (packet != 99) {
    /* node */
    if (packet == 1) {
        if (0 != (verbose & 4)) {
            printf ("reading packet 01 (nodes)\n");
            fflush (stdout);
            verbose &= 3;
        }
        *nodeid = atoi (&buffer[2]);
        getline ();
        p = buffer + 48;
        for (n = 2; n >= 0; n--) {
            p -= 16;
            xyz[n] = atof (p);
        }
        getline ();
        cfxImportNode (*nodeid, xyz[0], xyz[1], xyz[2]);
    }
    /* element */
    else if (packet == 2) {
        if (0 != (verbose & 2)) {
            printf ("reading packet 02 (elements)\n");
            fflush (stdout);
            verbose &= 1;
        }
        elemid = atoi (&buffer[2]);
        n = atoi (&buffer[10]);
        nlines = atoi (&buffer[18]);
        if (n == 5 || n == 7 || n == 8) {
            cfxImpElemType_t typ;
            getline ();
            nnodes = n == 8 ? n - 1 : 1;
            if (nnodes == 4) {
                typ = cfxELEM_TET;
            } else if (nnodes == 5) {
                typ = cfxELEM_PYR;
            } else if (nnodes == 6) {
                typ = cfxELEM_WDG;
            } else if (nnodes == 8) {
                typ = cfxELEM_HEX;
            } else {
                cfxImportFatal("invalid number of nodes for element.");
            }
            lineno++;
            for (n = 0; n < nnodes; n++) {
                int tmp;
                if (1 != fscanf (fp, "%d", &tmp) || tmp < 1) {
                    cfxImportFatal ("missing or invalid node ID");
                } else {
                    nodeid[n] = (ID_t)tmp;
                }
            }
            while (getc (fp) != '\n')
                ;
            nlines -= 2;
            cfxImportElement ((ID_t)elemid, typ, nodeid);
    }
while (nlines-- > 0)
    getline ();
}
/* distributed loads */
else if (packet == 6 && do_loads) {
    elemid = atoi (&buffer[2]);
    loadid = atoi (&buffer[10]);
    nlines = atoi (&buffer[18]);
    if (loadid != lastid) {
        sprintf (buffer, "PatranLoad%d", loadid);
        if (verbose) {
            printf ("reading packet 06 (loads) as region <%s>...\n", 
                    buffer);
            fflush (stdout);
        }
        cfxImportBegReg (buffer, cfxImpREG_NODES);
        lastid = loadid;
    }
    getline ();
    /* add if element load flag is set */
    if ('1' == buffer[0])
        add_face (elemid, &buffer[9]);
    while (--nlines > 0)
    getline ();
}
/* named component */
else if (packet == 21) {
    int cnt, type, id;
    elemid = atoi (&buffer[2]);
    nnodes = atoi (&buffer[10]) / 2;
    getline ();
    /* strip leading and trailing spaces */
    buffer[sizeof(buffer)-1] = 0;
    p = buffer + strlen (buffer);
    while (--p >= buffer && isspace(*p))
    ++p = 0;
    for (p = buffer; *p && isspace(*p); p++)
    {
        if (verbose) {
            printf ("reading packet 21 (group) as region <%s>...\n", p);
            fflush (stdout);
        }
        cfxImportBegReg (p, cfxImpREG_NODES);
        /* currently only handle type 5 (nodes) in groups */
        for (n = 0, cnt = 0; n < nnodes; n++) {
            if (0 == (n % 5))
                lineno++;
            fscanf (fp, "%d%d", &type, &id);
            if (5 == type) {
                nodeid[cnt++] = id;
                if (8 == cnt) {
                    cfxImportAddReg (8, nodeid);
                    cnt = 0;
                }
            }
        }
    }
    while (getc (fp) != '\n')
    {
        if (cnt)
            cfxImportAddReg (cnt, nodeid);
            cfxImportEndReg ();
    }
    /* all others */
    else {
        nlines = atoi (&buffer[18]);
        while (nlines--)
        getline ();
    }
} if (NULL == fgets (buffer, sizeof(buffer), fp))

break;
lineno++;
packet = atoi (buffer);
}
fclose (fp);
cfxImportError (NULL);
/* finish up and send the data */
if (verbose) {
    printf ("transferring data...
");
    fflush (stdout);
}
cfxImportDone ();
/* print summary */
if (verbose) {
    size_t stats[cfxImpCNT_SIZE];
    long bytes;
    static char *statname[] = {
        "imported nodes ",
        "imported elements ",
        "imported regions ",
        "unreferenced nodes",
        "duplicate nodes ",
        "tet elements ",
        "pyramid elements ",
        "wedge elements ",
        "hex elements ",
        "total bytes sent 
    };
    bytes = cfxImportTotals (stats);
    putchar (\n');
    for (n = 0; n < 9; n++)
        printf ("%s = %ld
", statname[n], stats[n]);
    printf ("%s = %ld
", statname[9], bytes);
    exit (0);
}

2.5. Import Programs

The following sections detail the standard import programs currently available within CFX-Pre and their command line equivalents.

Information about importing meshes from the CFX-Pre interface is given in Importing Meshes in the CFX-Pre User's Guide.

If you want to use command line options that cannot be specified through the CFX-Pre User Interface, then you may want to run these programs as user-defined mesh import programs. User Import details how to run a mesh import program.

The executables are located in <CFXROOT>/bin/<os>.

- ANSYS (p. 31)
- CFX Def/Res (p. 31)
- CFX-4 (p. 31)
- CFX-5.1 (p. 32)
- CFX-TFC (p. 33)
- CGNS (p. 33)
- FLUENT (p. 34)
- GridPro/az3000 (p. 34)
- I-DEAS (p. 35)
2.5.1. ANSYS

Imports an ANSYS file. The external import routine is `ImportANSYS`. Available options are:

- `-v` Verbose output. Echo additional data to `stdout` during the import.
- `-E` Import Elements of the same type as regions.
- `-A` Import ANSA parts as regions.
- `-S` Display a list of all supported element types.

2.5.2. CFX Def/Res

Imports the mesh from a CFX-Solver input or results file. The external import routine is `ImportDef`. Available options are:

- `-v` Verbose output. Echo additional data to `stdout` during the import.
- `-I` Read mesh from the initial timestep in the file.
- `-L` Read mesh from the last timestep in the file.
- `-T<timestep>` Read mesh from the timestep specified (Transient files)

2.5.3. CFX-4

Imports a CFX-4 grid file. The external import routine is `ImportCFX4`.

Available options are:

- `-v` Verbose output. Echo additional data to `stdout` during the import.
- `-C` Read coordinates as being in cylindrical coordinates.
- `-i` Included interfaces in regions.
- `-3` Include USER3D and POROUS regions as 3D regions.
- `-c` Import blocked-off conducting solid regions as 3D regions.
- `-l` Include blocked-off solid regions as 3D regions.
- `-X` Import axisymmetric problem with default values in geometry file.
- `-a <nk>` Override the number of planes created in the k direction by `nk` (for example, split theta with `nk` planes) for axisymmetric import.
- `-A <theta>` Create a total sector of `theta` degrees for axisymmetric import.
Rename multiple symmetry planes with the same name to conform to CFX-Solver requirements (that is, must lie in a plane).

### 2.5.4. CFX-5.1

Imports a CFX-5.1 results file. The external import routine is `ImportCFX5`.

Available options are:

- `-v` Verbose output. Echo additional data to `stdout` during the import.
- `-f` Input file is formatted.
- `-u` Input file is unformatted (Fortran).

- `-M <machine type>` Set the machine type in the case of a binary or unformatted file so that data conversion may be done if needed. The default file format is 32-bit IEEE (Iris, Sun, HP, IBM). The currently recognized machine types are:
  - IEEE - generic 32-bit IEEE machine.
  - BSIEEE - generic 32-bit byteswapped IEEE machine.
  - IBM - IBM 32-bit IEEE.
  - IRIS - Iris 32-bit IEEE.
  - HP - HP 32-bit IEEE.
  - SUN - Sun 32-bit IEEE.
  - ALPHA - Compaq Tru64 UNIX Alpha 64-bit byte-swapped IEEE.
  - DOS - DOS 16-bit byte-swapped IEEE.
  - Compaq Tru64 UNIX - Compaq Tru64 UNIX 32-bit byte-swapped IEEE.
  - CRAY - Cray 64-bit format.
  - CONVEX - native Convex floating point format.

The argument machine type is case insensitive, and only the first 2 characters are needed (any others are ignored).

- `-M <machine type>` Set the machine type in the case of a binary or unformatted file so that data conversion may be done if needed. The default file format is 32-bit IEEE (Iris, Sun, HP, IBM). The currently recognized machine types are:
  - IEEE - generic 32-bit IEEE machine.
  - BSIEEE - generic 32-bit byteswapped IEEE machine.
  - IBM - IBM 32-bit IEEE.
  - IRIS - Iris 32-bit IEEE.
  - HP - HP 32-bit IEEE.
  - SUN - Sun 32-bit IEEE.
  - ALPHA - Compaq Tru64 UNIX Alpha 64-bit byte-swapped IEEE.
  - DOS - DOS 16-bit byte-swapped IEEE.
Compaq Tru64 UNIX - Compaq Tru64 UNIX 32-bit byte-swapped IEEE.
Cray - Cray 64-bit format.
Convex - native Convex floating point format.
Windows - 32-bit Windows.

The argument machine type is case-insensitive, and only the first two characters are needed (any others are ignored).

2.5.5. CFX-TfC

Imports a CFX-TfC 1.3 mesh file. The external import routine is ImportGEM.

Available options are:

-v Verbose output. Echo additional data to stdout during the import.
-f Input file is formatted.
-u Input file is unformatted (Fortran).
-r Read regions from a BFI file.
-b <file> Use file as a BFI file name instead of default name.
-M <machine type> Set the machine type in the case of a binary or unformatted file so that data conversion may be done if needed. The default file format is 32-bit IEEE (Iris, Sun, HP, IBM). The currently recognized machine types are:

- IEEE - generic 32-bit IEEE machine.
- BSIEEE - generic 32-bit byteswapped IEEE machine.
- IBM - IBM 32-bit IEEE.
- IRIS - Iris 32-bit IEEE.
- HP - HP 32-bit IEEE.
- SUN - Sun 32-bit IEEE.
- ALPHA - Compaq Tru64 UNIX Alpha 64-bit byte-swapped IEEE.
- DOS - DOS 16-bit byte-swapped IEEE.
- Compaq Tru64 UNIX - Compaq Tru64 UNIX 32-bit byte-swapped IEEE.
- CRAY - Cray 64-bit format.
- CONVEX - native Convex floating point format.

The argument machine type is case insensitive, and only the first 2 characters are needed (any others are ignored).

2.5.6. CGNS

Imports a CGNS file. The external import routine is ImportCGNS. Available options are:
Chapter 2: Volume Mesh Import API

-\v Verbose output. Echo additional data to stdout during the import.

-\b Read a grid from the specific CGNS base.

-\B Read all CGNS bases. (default)

-\c Read BOCO information as 2D regions.

-\f Import Family Information as regions.

-\E Import each Element Section as a separate region.

-\I Import each side of a connection as a separate region.

-\P Do not add the Zone name as a prefix to any region being defined.

2.5.6.1. SplitCGNS.exe

The SplitCGNS.exe program will take a single CGNS file and split it into multiple files on a "file per problem basis". The method for running this is:

\[\text{SplitCGNS.exe [-l] <filename> <basename>}\]

If the file contains two problems called "Pipe" and "Elbow", the import filter will only currently read "Pipe", but using SplitCGNS will produce two files called basename_Pipe.cgns and basename_Elbow.cgns each containing a single problem that can then be selected for import via the normal method.

Specifying the "-l" option "links" the part of the data in the original file to the created file using a relative pathname. The created file does not therefore need to duplicate data.

The "-l" option should only be used if the original file and resulting files are going to be kept relative to each other (that is, if when SplitCGNS was run the original file was in ../../example.cgns, it must always remain in this position relative to the created files).

2.5.7. FLUENT

Imports FLUENT msh and cas files. The external import routine is ImportFluent. The import routine will read the mesh information from the .cas or .msh file.

Available command line options are:

-\v Verbose output. Echo additional data to stdout during the import.

-\I Import interior boundary conditions.

2.5.8. GridPro/az3000

Imports a GridPro/az3000 grid and connectivity file from Program Development Corporation (PDC).

The external import routine is ImportPDC. The import routine will attempt to determine the connectivity file associated with the grid file by appending the extension conn to the grid file name. If the file is not found, then the grid file name extension will be replaced by conn and the new file checked for. If neither of these are found, the import routine will look for a file named conn.tmp, and if found will use it. A command line option (-c) is also available to explicitly name the connectivity file.
If a connectivity file is found, the interface information in the file will be used to eliminate the duplicate nodes at block interfaces, and boundaries conditions will be imported as regions into CFX. If the boundary condition is named in the connectivity file, then that name will be used for the region name, else the default name UnnamedRegionX with the X replaced by a number will be used. If a connectivity file is not found, or the command line option to ignore the connectivity file is given (-i), then only the grid file will be imported, resulting in duplicate nodes at the block interfaces. You may then want to eliminate these duplicate nodes with the command line option (-d or -D).

Available options are:

- `-v` Verbose output. Echo additional data to stdout during the import.
- `-i` Ignore the connectivity file. Duplicate nodes will result and no regions will be imported.
- `-c <connfile>` Set the name of the connectivity file associated with the grid file to connfile.
- `-p` Include periodic boundary conditions as regions. These are not normally included in the import. Setting this flag will result in these being imported as regions.
- `-q` Read from the property file
- `-P <propfile>` Set the name of the property file associated with the grid file to propfile.
- `-3` Import grid blocks as 3D regions

### 2.5.9. I-DEAS

Imports an I-DEAS Universal file from SDRC. The external import routine is ImportIDEAS. Reads datasets 781 and 2411 (nodes) as nodes, 780 and 2412 (elements) as elements, and nodes (type 7) from datasets 752 and 2417 (permanent groups) as regions. All other datasets are read, but not processed.

Available options are:

- `-v` Verbose output. Echo additional data to stdout during the import.
- `-n` Import nodes in a PERMANENT group as a 2D region.
- `-l` Import elements in a PERMANENT group as a 3D region.
- `-f` Import faces in a PERMANENT group as a 2D region.

### 2.5.10. ICEM CFX

Imports a file written for CFX by ICEM Tetra. The external import routine is ImportICEM. Available options are:

- `-v` Verbose output. Echo additional data to stdout during the import.
- `-P` Read coordinate data from a binary file as double precision.

### 2.5.11. PATRAN

Imports a PATRAN Neutral file. The external import routine is ImportPatran. Reads packet 01 (nodes) as nodes, packet 02 (elements) as elements, and nodes (type 5) from packet 21 (named groups) as regions.
A command line option is available to read packet 06 (loads) as regions also. All other packets are read, but not processed.

Available options are:

- `v` Verbose output. Echo additional data to `stdout` during the import.

- `l` Import packet 06 (distributed loads) as regions. The regions will be assigned the name `PatranLoadX` where the `X` is replaced by the load ID number.

### 2.5.12. NASTRAN

Imports a NASTRAN file. The external import routine is `ImportMSC`. Currently reads only nodes (GRID), tet (CTETRA) and hex (CHEXA) elements.

Available options are:

- `v` Verbose output. Echo additional data to `stdout` during the import.

- `l` Import PLOAD4 datasets as 2D regions.

- `s` Import PSOLID datasets as 3D regions.

### 2.5.13. CFX-TASCflow

Imports TASCflow Version 2 files. The external import routine is `ImportGRD`. The import routine will read the mesh information from the `GRD` file and automatically remove duplicate nodes where interfaces are defined and are 1:1.

Available command line options are:

- `v` Verbose output. Echo additional data to `stdout` during the import.

- `V` More verbose output.

- `i` Ignore the blockoff file (`BCF`).

- `c` Ignore GCI file.

- `o` Old style 2.4 format.

- `b <file>` Specifies a `bcf` file that contains blocked-off regions (boundary condition information is ignored). For details, see CFX-TASCflow Files in the CFX-Pre User’s Guide.

- `g <file>` Specifies the `gci` file to import. For details, see CFX-TASCflow Files in the CFX-Pre User’s Guide.

- `f` Formatted (ASCII) GRD file.

- `u` Fortran unformatted GRD file.

- `3` Import labelled 3D regions.
Chapter 3: Mesh and Results Export API

This chapter describes how to create a custom program for exporting mesh and results data. Information on using such a program is given in Using a Customized Export Program.

This chapter describes:
3.1. Creating a Customized Export Program
3.2. Compiling Code with the Mesh and Results Export API
3.3. Linking Code with the Mesh and Results Export API
3.4. Details of the Mesh Export API

3.1. Creating a Customized Export Program

The mesh and results contained within an ANSYS CFX results file can be exported in many formats, ready for input into post-processing software other than CFD-Post, MSC/PATRAN, EnSight and Fieldview. To do this, you would write a customized export program that calls routines from the Export Application Programming Interface (API). However, this is recommended only for advanced users, because it involves at least some knowledge of C or C++ programming language.

Once an export program has been created, it can be used by any number of users; so if other ANSYS CFX users at a site regularly use a different post-processor, it may be worth contacting a system administrator to find out if such a format has already been defined.

To define a new format, use the export API. The general steps to follow are:

1. Create a file that contains instructions needed to build the format in C.
   - This is most easily done by editing the template file provided (which is written in C). For details, see An Example of an Export Program (p. 38).
2. Compile your C program.
   - For details, see Compiling Code with the Mesh and Results Export API (p. 49).
3. Link the C program into the CFX code.
   - For details, see Linking Code with the Mesh and Results Export API (p. 49).
4. Use the program.
   - For details, see Using a Customized Export Program.

Numerous keywords are required for development and use of custom export files. For details, see cfx5export Arguments.

An example source routine can be used as the basis of a customized program; one is given in the next section.
3.1.1. An Example of an Export Program

The following is an annotated listing of the C source code for a reasonably simple example of a customized Export program. The full source code is available for use as a template and is located in CFX/examples/ExportTemplate.c, where CFX is the directory in which CFX is installed.

The example program is a reasonably simple example of an export program, which opens a CFX results file, writes a geometry file (ignoring pyramid elements) and several files containing results. After the program listing, a sample of the output produced is shown.

3.1.1.1. File Header

The file header uses several #include entries. The first set includes standard header files.

```c
#include <stdio.h>
#include <string.h>
#include <stdlib.h>
#include <io.h>
```

The second set includes cfxExport header files.

```c
#include "cfxExport.h"
#include "getargs.h"
```

Obtaining CFX-Mesh and Results Export API header files is described in more detail. For details, see Linking Code with the Mesh and Results Export API (p. 49).

3.1.1.2. Allowed Arguments

The definition of allowed arguments appears as:

```c
static char options[] = "u:d:t:cif";
```

The following piece of code simply defines the message that is printed if the user enters incorrect options to the program.

```c
static char *usgmsg[] = {
    "usage: ExportTemplate [options] res_file [basename]",
    " options are:",
    " -u<level> = user level of interest",
    " -d<domain> = domain of interest (default is 0 - all the domains",
    " are combined into a single domain)",
    " -t<timestep> = timestep of interest (if set to -1, all timesteps",
    " are exported)"
    " -c = use corrected boundary node data",
    " -i = include boundary node only data",
    " -f = get info on the res_file (No output is created)"
    " <basename> is the base filename for Template file output.",
    "If not specified, it defaults to 'res_file'. The Template",
    "geometry file will be written to <basename>.geom, the",
    "results file to <basename>.res, and the variables to",
    "<basename>.s## or <basename>.v## where ## is the variable",
    "number and s indicates a scalar and v a vector.",
    NULL
};
```

3.1.1.3. Main Program Initialization

As is standard, the variables argc and argv are the number of arguments and a pointer to the argument list. The variable cfxCNT_SIZE and the types cfxNode and cfxElement are defined in the header file cfxExport.h as are all variables and functions starting with the letters cfx. For details, see Mesh
and Results Export API (p. 37). The variables level, zone, alias, bndfix and bnddat are used for setting the default values for the various parameters that can be set on the command line of the program.

```c
void main (int argc, char *argv[]) {
    char *pptr;
    char baseFileName[256], fileName[256], errmsg[256];
    int i, n, counts[cfxCNT_SIZE], dim, length, namelen;
    int nnodes, nelems, nscalars, nvalues;
    int level = 1, zone = 0, alias = 1, bndfix = 0, bnddat = 0;
    int timestep = -1, infoOnly = 0;
    int t, t1, t2;
    int nTimeDig = 1;    /* number of digits in transient file suffix */
    char zoneExt[256];    /* zone extension added to the base filename */
    int isTimestep = 0;
    float timeVal = 0.0;  /* time value in the single timestep mode */
    char *wildcard = { "******" }; /* used in transient file specification */
    FILE *fp;
    cfxNode *nodes;
    cfxElement *elems;
    float *var;

    The variable cfxCNT_SIZE and the types cfxNode and cfxElement are defined in the header file cfxExport.h as are all variables and functions starting with the letters cfx. For details, see Mesh and Results Export API (p. 37). The variables level, zone, alias, bndfix and bnddat are used for setting the default values for the various parameters that can be set on the command line of the program.

    The following line prints an error message if there are not enough arguments to proceed.

    if (argc < 2) {
        cfxUsage (usgmsg, NULL);
    }

    The following piece of code reads the specified options and assigns values to certain variables accordingly. If an invalid or incomplete option is specified, then getargs prints an error message and the export program stops.

    while ((n = getargs (argc, argv, options)) > 0) {
        switch (n) {
            case 'u':
                level = atoi (argarg);
                break;
            case 'd':
                zone = atoi (argarg);
                break;
            case 't':
                timestep = atoi (argarg);
                isTimestep = 1;
                break;
            case 'c':
                bndfix = 1;
                break;
            case 'i':
                bnddat = 1;
                break;
            case 'f':
                infoOnly = 1;
                break;
        }
    }

    After this, the level variable contains the user level specified. All results are output if they are of this user level or below it. The zone variable contains the domain number that you specified. The variable alias determines whether the variables are referred to by their long names or short names. The default here is for short names to be used because some post-processors need variable names to contain no spaces, but you are encouraged to use long variable names wherever possible. The variable bndfix determines whether the variables are exported with corrected boundary node values - if bndfix is set
3.1.1.4. Checking File Names

The following code checks to make sure that a CFX results file has been specified, and that it can be read by the export program. If this is not the case, the export program exits.

```c
/* CFX-5 results file */
if (argind >= argc)
    cfxUsage (usgmsg, "CFX-5 results file not specified");
if (access (argv[argind], 0)) {
    fprintf (stderr, "result file <%s> does not exist\n", argv[argind]);
    exit (1);
}
```

The following code writes the basename specified to the character array `baseFileName`. If one was not specified, then it defaults to the name of the results file specified. A basename name may be specified in another directory (for example, `../template/output`). However, later in the code this basename without the preceding directory information is required (in this example “output”); and so the pointer `pptr` is assigned to point to the first character of this name.

```c
/* base file name */
if (argind + 1 < argc)
    strcpy (baseFileName, argv[argind+1]);
else
    strcpy (baseFileName, argv[argind]);
if (NULL != (pptr = strrchr (baseFileName, '/')))
    pptr++;
else if (NULL != (pptr = strrchr (baseFileName, '\')))
    pptr++;
else
    pptr = baseFileName;
```

The following code checks that the results file that will be produced by the export program will not overwrite an existing results file.

```c
/* don't overwrite results file */
if (0 == strcmp (argv[argind], fileName)) {
    fprintf (stderr, "Template res file would overwrite CFX results file\n");
    fprintf (stderr, "Need to select new Template output base file name\n");
    exit (1);
}
```

3.1.1.5. Opening the CFX Results File

The following code prints a message to the screen telling you that the program is reading the results file. It then calls `cfxExportInit`, which must always be called before any of the other export routines. The variable `n` is set to equal the number of zones in the results file. If the `-f` option has been selected, information about the results file will be displayed. The number of domains to be exported is also determined so that the format of the exported file includes the appropriate suffix. Finally, a check is made to make sure that the zone (if any) that you specified in the program options is a valid zone for this results file.

```c
/* open CFX-5 results file */
printf ("\nreading CFX results from <%s>\n", argv[argind]);
if (infoOnly) {
    int nt;
    printf("\n\n\ndomains:\n\n", n);
    for(i = 1; i <= n; i++)
```
Creating a Customized Export Program

```c
printf(" %d %s\n", i, cfxExportZoneName(i));
nt = cfxExportTimestepCount();
printf("%d timesteps:\n", nt);
if(nt) {
    for(i = 1; i <= nt; i++)
        printf(" %d\n", cfxExportTimestepNumGet(i));
}
cfxExportDone();
exit (0);
}

/* determine the zone suffix for the export files */
strcpy(zoneExt, "");
if(zone == 0) {
    printf("processing all domains\n");
cfxExportSetVarParams(bndfix, level);
}
else {
    printf("processing domain %d\n", zone);
    if(n != 1) {
        float f;
        int nZoneDig = 0;
        /* count number of digits needed to fit any zone number */
        f = (float) n;
        while((f /= 10) >= 1) nZoneDig++;
        sprintf(zoneExt, ".d%.*d", nZoneDig, nZoneDig, zone);
    }
}
if (cfxExportZoneSet (zone, counts) < 0)
cfxExportFatal ("invalid zone number");
```

The following code is ignoring any pyramid elements (elements with 5 nodes) and decreases `nelems` by the number of pyramid elements. It then checks to make sure that neither the number of nodes nor the number of elements is zero; if so, the program exits with return code -1.

The first two lines focus on the number of nodes in the zone and the number of elements in the zone.

```c
nnodes = cfxExportNodeCount();
zelems = cfxExportElementCount();
if (counts[cfxCNT_PYR]) {
    printf("%d pyramid elements found - they are being ignored\n",
            counts[cfxCNT_PYR]);
zelems -= counts[cfxCNT_PYR];
}
if (!nnodes || !nelems)
cfxExportFatal ("no nodes and/or elements");
```

### 3.1.1.6. Timestep Setup

The following code determines whether all of the timesteps, a specific timestep or the final timestep (steady-state) have been selected for export.

```c
if(isTimestep && timestep == -1 && !cfxExportTimestepCount()) {
    isTimestep = 0;
}
if(isTimestep) {
    int i;
    float f;
    if(timestep == -1) {
        printf("processing all timesteps\n");
        t1 = 1;
        t2 = cfxExportTimestepCount() + 1;
    } else {
        int isFound = 0;
        printf("processing timestep %d\n", timestep);
        for(i = 1; i <= cfxExportTimestepCount() + 1; i++)
            if(cfxExportTimestepNumGet(i) == timestep) {
                timeVal = cfxExportTimestepTimeGet(i);
                t1 = t2 = i;
            }
        if(isFound)
            printf("%d timesteps selected\n", cfxExportTimestepCount());
    }
}```
isFound = 1;
break;
}
if(!isFound) {
    sprintf(errmsg, "\nTimestep \d not found. "
        "Use -f to see the list of valid timesteps.\n", timestep);
cfxExportFatal (errmsg);
}
/* count number of digits needed to fit any timestep number */
f = (float) cfxExportTimestepCount();
while((f /= 10) >= 1) nTimeDig++;
}
else {
    timeVal = cfxExportTimestepTimeGet(cfxExportTimestepCount() + 1);
timestep = cfxExportTimestepNumGet(cfxExportTimestepCount() + 1);
t1 = t2 = cfxExportTimestepCount() + 1;
}

3.1.1.7. Geometry File Output

The following code opens the geometry file basename.geom, printing an error if it cannot be opened for any reason. A message is then displayed informing the user that the application is writing the geometry file.

/* Template geometry output */
sprintf (fileName, "%s.geom", baseFileName);
if (NULL == (fp = fopen (fileName, "w+"))) {
    sprintf (errmsg, "can’t open <%s> for output", fileName);
cfxExportFatal (errmsg);
}
printf ("writing Template Geometry file to <\s>\n", fileName);

The header of this file is shown after the program listing.

/* write header */
fprintf( fp, "Template Geometry file exported from CFX\n");
fprintf( fp, "\n");
fprintf( fp, "node id given\n");
fprintf( fp, "element id off\n");

The following code writes first the word "coordinates" and the number of nodes that will be written. The pointer nodes is initialized to point at the data for the first node and the node data is written into the geometry file. For each node, a node number is written, followed by the three coordinates of that node. Note that \n ranges between 0 and nnodes-1. This program adds 1 to each node number so that the nodes in the geometry file are numbered between 1 and nnodes. When it has finished, the cfxExportNodeFree routine frees the memory that was used to store the node data, and finally the word "done" is printed on the screen to alert you that it has finished writing the node data.

/* write nodes */
fprintf( fp, "coordinates\n");
fprintf( fp, "%8d\n", nnodes);
nodes = cfxExportNodeList();
printf ("writing %d nodes ...", nnodes);
fflush (stdout);
for (n = 0; n < nnodes; n++, nodes++) {
    fprintf( fp, "%8d %12.5e %12.5e %12.5e\n", n + 1, nodes->x,
        nodes->y, nodes->z );
}
cfxExportNodeFree();
printf (" done\n");

Next, the data for each element must be written.

Firstly, some general information is written. Then the data for each element type is written in turn.
/* write elements */
    fprintf( fp, "part 1\n" );
    fprintf( fp, "volume elements\\n" );
    printf(" writing %d elements...", nelems);
    fflush (stdout);

For tetrahedral elements, the word "tetra4" is written to the file, followed by the number of tetrahedral elements written.

/* tets */
    fprintf( fp, "tetra4\\n" );
    fprintf( fp, "%8d\\n", counts[cfxCNT_TET] );

The following code is executed only if the number of tetrahedral elements is non-zero. Assuming this, elems is set to point to the list of elements stored in the results file. The index n loops over all the elements. For each element, the following step is carried out: "If the element is a tetrahedron, then loop over its four vertices and write their node numbers to the geometry file, then start a new line (ready for the next set of data)." The output produced can be seen in the examples of the exported files in the next section.

if (counts[cfxCNT_TET]) {
    elems = cfxExportElementList();
    for (n = 0; n < nelems; n++, elems++) {
        if (cfxELEM_TET == elems->type) {
            for (i = 0; i < elems->type; i++)
                fprintf (fp, "%8d", elems->nodeid[i]);
            putc ("\n", fp);
        }
    }
}

For wedges (triangular prisms) and hexahedral elements, the same procedure is followed. However, there is a slight difference in the way that the fprintf line is written for hexahedral elements. This is because the order that the element nodes are written to the geometry file is different to the order in which they were read from the results file. This may need to be done if a post-processor has a different convention for node order than the one that the cfx5export node routines have. The order the nodes are written in will affect which node is connected to which. The node ordering for exported elements is illustrated in cfxExportElementList (p. 55).

/* wedges */
    fprintf( fp, "penta6\\n" );
    fprintf( fp, "%8d\\n", counts[cfxCNT_WDG] );
    if (counts[cfxCNT_WDG]) {
        elems = cfxExportElementList();
        for (n = 0; n < nelems; n++, elems++) {
            if (cfxELEM_WDG == elems->type) {
                for (i = 0; i < elems->type; i++)
                    fprintf (fp, "%8d", elems->nodeid[i]);
                putc ("\n", fp);
            }
        }
    }

/* hexes */
    fprintf( fp, "hexa8\\n" );
    fprintf( fp, "%8d\\n", counts[cfxCNT_HEX] );
    if (counts[cfxCNT_HEX]) {
        elems = cfxExportElementList();
        for (n = 0; n < nelems; n++, elems++) {
            if (cfxELEM_HEX == elems->type)
                fprintf (fp, "%8d%8d%8d%8d%8d%8d%8d\\n",
                         elems->nodeid[0], elems->nodeid[1],
                         elems->nodeid[3], elems->nodeid[2],
                         elems->nodeid[4], elems->nodeid[5],
                         elems->nodeid[7], elems->nodeid[6]);
        }
    }
Then the geometry file is closed and the memory occupied by the element data is freed.

```c
printf("done\n");
fclose(fp);
cfxExportElementFree();
```

### 3.1.1.8. Template Results File

Despite its name, the Template results file does not contain any actual values of results. It simply contains information about how many variables there are and in which file each is stored.

The first job is to make sure that there are some results for export. First, the code checks that there is a nonzero number of variables that have the specified user level. Then it counts the number of scalar and vector variables that will be exported. To be exported, a variable must:

1. Have a dimension of 1 (scalar variable) or 3 (vector variable) and,
2. Either be a variable with useful values everywhere in the zone or be a variable that has values only on the boundaries (in which case it will be exported only if you asked to "include boundary node only data" by specifying the option \(-i\) when starting the export program, which translated to setting \(bnddat = 1\) when the arguments were processed).

Review the `cfxExportVariableSize` routine if this logic is unclear. For details, see `cfxExportVariableSize` (p. 62).

Once results are identified, the code calculates the variable `namelen`, which is the length of the longest variable name to be exported (the `alias` variable was set when processing the arguments passed to the export program, and depends upon whether you wanted to use long names or short names). If there are no vector or scalar variables to be exported, the export program exits.

```c
/* output results file */
nscalars = nvectors = namelen = 0;
if ((nvalues = cfxExportVariableCount(level)) > 0) {
    for (n = 1; n <= nvalues; n++) {
        cfxExportVariableSize (n, &dim, &length, &i);
        if ((1 != dim && 3 != dim) ||
            (length != nnodes && length != bnddat))
            continue;
        if (1 == dim)
            nscalars++;
        else
            nvectors++;
        i = strlen (cfxExportVariableName (n, alias));
        if (namelen < i)
            namelen = i;
    }
} else if (0 == (nscalars + nvectors)) {
    cfxExportDone ();
    exit (0);
}
```

The following code checks that the results file can be opened for writing to, and exits if not. The number of scalar and vector variables are written to the file, followed by some numbers (which EnSight, for example, requires) that are always the same for any export of this kind.

```c
sprintf (fileName, "%s.res", baseFileName);
if (NULL == (fp = fopen (fileName, "w+"))) {
    sprintf (errmsg, "can't open <\%s> for writing", fileName);
    cfxExportFatal (errmsg);
} else {
    printf ("Writing Template results file to <\%s>\n", fileName);
    fflush (stdout);
    fprintf(fp, "%d %d 0\n", nscalars, nvectors);
    ```
Next, for each scalar variable, a line is written that contains the filename where the scalar will be written, and then the name of the variable. Note that the filename is not the basename, but the basename with all the directory structure (if any) stripped off the front. For details, see Checking File Names (p. 40). This is done because these files will be written in the same directory as this Template results file, so there is no need for directory information.

```c
if ( nscalars ) {
    for (n = 1; n <= nvalues; n++) {
        cfxExportVariableSize (n, &dim, &length, &i);
        if (1 == dim && (length == nnodes || length == bnddat))
            if(!isTimestep)
                fprintf (fp, "%s%s.s%2.2d %s
", pptr, zoneExt, n, cfxExportVariableName(n, alias));
            else if(t1 == t2)
                fprintf (fp, "%s%s_t%d.s%2.2d %s
", pptr, zoneExt, cfxExportTimestepNumGet(t1), n, cfxExportVariableName(n, alias));
            else
                fprintf (fp, "%s%s_t%*.*s.s%2.2d %s
", pptr, zoneExt, nTimeDig, nTimeDig, wildcard, n, cfxExportVariableName(n, alias));
    }
}
```

The same information is then written for each vector variable and the Template results file is closed.

```c
if ( nvectors ) {
    for (n = 1; n <= nvalues; n++) {
        cfxExportVariableSize (n, &dim, &length, &i);
        if (3 == dim && (length == nnodes || length == bnddat))
            if(!isTimestep)
                fprintf (fp, "%s%s.v%2.2d %s
", pptr, zoneExt, n, cfxExportVariableName(n, alias));
            else if(t1 == t2)
                fprintf (fp, "%s%s_t%d.v%2.2d %s
", pptr, zoneExt, cfxExportTimestepNumGet(t1), n, cfxExportVariableName(n, alias));
            else
                fprintf (fp, "%s%s_t%*.*s.v%2.2d %s
", pptr, zoneExt, nTimeDig, nTimeDig, wildcard, n, cfxExportVariableName(n, alias));
    }
}
fclose( fp );
```

### 3.1.1.9. Creating Files with Results for Each Variable

The results for each variable are written to separate files, called `<basename>.s01`, `<basename>.s02`, `<basename>.v03`, for example. Each file with an extension containing a letter "s" contains a scalar variable, and each with a "v" contains a vector variable. Which variable is written to each file is tabulated in the Template results file that has just been written.

The following code reads the information for each variable, after you decide that it should be exported - the logic is very similar to that used when counting the relevant variables when creating the Template results file. The marked `if` loop executes if the variable needs to be exported. It checks to make sure that the variable information can be read, and (assuming it can) then builds the filename and checks
Chapter 3: Mesh and Results Export API
to see if it can be opened. Continuing, it writes to the screen where it is putting the variable, and then
loops through all the values, writing them to the file, inserting a new line every six values. After each
variable, the memory used to store that variable is restored.
After all the variable files have been written, the program calls the cfxExportDone routine, which
close the CFX results file, and frees up any remaining memory. This routine must be the last call to any
of the API routines. The program then exits.

Note
This program makes no use of any of the region routines, which enable access to boundary
condition data, nor the volume routines that enable access to the subdomains that are
defined for a problem.
•

Region Routines (p. 56)

•

Volume Routines (p. 59)
/* output each timestep to a different file */
for(t = t1; t <= t2; t++) {
ts = cfxExportTimestepNumGet(t);
if(cfxExportTimestepSet(ts) < 0) {
continue;
}
/* build file name and open file */
if(!isTimestep)
sprintf( fileName, "%s%s.%c%2.2d", baseFileName, zoneExt,
1 == dim ? ‘s’ : ‘v’, n);
else if(t1 == t2)
sprintf( fileName, "%s%s_t%d.%c%2.2d", baseFileName, zoneExt,
ts, 1 == dim ? ‘s’ : ‘v’, n);
else
sprintf( fileName, "%s%s_t%*.*d.%c%2.2d", baseFileName, zoneExt,
nTimeDig, nTimeDig, t-1, 1 == dim ? ‘s’ : ‘v’, n);
if (NULL == (fp = fopen (fileName, "w+"))) {
sprintf (errmsg, "can’t open <%s> for writing\n", fileName);
cfxExportFatal (errmsg);
}
printf (" %-*s -> %s ...", namelen,
cfxExportVariableName(n, alias), fileName);
fflush (stdout);
fprintf( fp, "%s\n", cfxExportVariableName(n, alias));
length = nnodes * dim;
for ( i = 0; i < length; i++, var++ ) {
fprintf( fp, "%12.5e ", *var );
if ( i && 5 == (i % 6) )
putc (‘\n’, fp);
}
if ( 0 != ( nvalues % 6 ) )
putc( ‘\n’, fp );
fclose( fp );
cfxExportVariableFree (n);
printf (" done\n");
}
}
} /* loop for each timestep */
cfxExportDone();
exit (0);
}

3.1.2. Example of Output Produced
If the export program is correctly compiled and run, the following output is obtained. For details, see
Using a Customized Export Program.
46

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.


In this example, the CFX results file contains three variables at user level 1: pressure, temperature and velocity. This is in a file named file.res. No timesteps or domains were specified, and the basename was specified as an example.

The following is displayed on screen:

```
reading CFX results from <file.res>
processing all domains
writing Template Geometry file to <example.geom>
    writing 2365 nodes ... done
    writing 11435 elements... done
writing Template results file to <example.res>
writing variable output files
    Pressure  -> example.s01 ... done
    Temperature -> example.s02 ... done
    Velocity    -> example.v03 ... done
```

Five files are produced: the geometry file example.geom, the Template results file example.res, and three variable files called example.s01, example.s02 and example.v03, which contain the results for pressure, temperature and velocity, respectively. For details, see:

- `example.geom` (p. 47)
- `example.res` (p. 47)
- `example.s01` (p. 48)

### 3.1.2.1. example.geom

The content of this file appears as:

```
Template Geometry file exported from CFX
node id given
element id off
coordinates
  2365
     1  2.00000e+00  0.00000e+00  0.00000e+00
     2-2.00000e+00-6.51683e-07  0.00000e+00
     3  2.00000e+00  0.00000e+00  2.00000e+00
     4-2.00000e+00-6.51683e-07  2.00000e+00
     5  3.00000e+00  1.00000e+00  5.00000e-01
     ....
     ....
     2362-1.13337e+00  2.18877e-01  4.02491e-01
     2363-1.12115e+00-3.66598e-01  2.22610e-01
     2364  1.36924e+00  4.78359e-01  1.22588e-01
     2365-3.30703e-01  1.38487e+00  2.23515e+00
```

part 1
volume elements
tetra4
  11435
     754  230  12  145
     755  216   8  122
     756  212  125  215
     ....
     ....
     2365  496  475  474
pentra6
  0
hexa8
  0

### 3.1.2.2. example.res

The content of this file appears as:
2 1 0
1
0.0
0 1
example.s01 Pressure
eexample.s02 Temperature
example.v03 Velocity

### 3.1.2.3. example.s01

The content of this file appears as:

Pressure

```
1.42748e+04 1.42621e+04 1.43425e+04 1.43350e+04 1.44118e+04 1.44777e+04
1.38639e+04 1.37352e+04 1.44130e+04 1.44755e+04 1.37733e+04 1.37626e+04
....
....
....
1.39092e+04 1.40699e+04 1.24139e+04 1.34786e+04 1.34859e+04 1.37959e+04
```

### 3.1.3. Source Code for getargs.c

The following code is the C code that defines the functions `cfxUsage` and `getargs`, both of which are called by the example listing above. You do not need to include this code with your custom export program (it is automatically linked in if you use the compiler as described in the next section).

```c
#include <stdio.h>
#include <string.h>
#include <ctype.h>
#include "getargs.h"

/*---------- usage --------------------------------------------------
* display usage message and exit
*-------------------------------------------------------------------*/
void cfxUsage (char **usgmsg, char *errmsg)
{
    int n;
    if (NULL != errmsg)
        fprintf (stderr, "ERROR: %s
", errmsg);
    for (n = 0; NULL != usgmsg[n]; n++)
        fprintf (stderr, "%s
", usgmsg[n]);
    exit (NULL != errmsg);
}

/*---------- getargs ---------------------------------------------------
* get option letter from argument vector or terminates on error
* this is similar to getopt()
*-------------------------------------------------------------------*/
int getargs (char *argarg; /* pointer to argument string */
int getargs (char *argarg; /* pointer to argument string */
{
    int argind = 0;  /* index into argv array */
    char **usgmsg, *errmsg;
    char **usgmsg, *errmsg;
    endif
{
    int n;
    if (NULL != errmsg)
        fprintf (stderr, "ERROR: %s
", errmsg);
    for (n = 0; NULL != usgmsg[n]; n++)
        fprintf (stderr, "%s
", usgmsg[n]);
    exit (NULL != errmsg);
}
/*---------- getargs ---------------------------------------------------
* get option letter from argument vector or terminates on error
* this is similar to getopt()
*-------------------------------------------------------------------*/
int getargs (int argc, char **argv, char *ostr)
{
    int argind = 0;  /* index into argv array */
    char **argv, *ostr;
    endif
{
    int argopt;
    char *o11;
    static char *place;
    static int nextarg;
    /* initialisation */
    if (!argind)
```
nextarg = 1;
if (nextarg) { /* update scanning pointer */
    nextarg = 0;
    /* end of arguments */
    if (++argind >= argc || '-' != argv[argind][0])
        return (0);
    place = argarg = &argv[argind][1];
}
/* check for valid option */
if ((argopt = *place++) == ':' ||
    (oli = strchr (ostr, argopt)) == NULL) {
    fprintf (stderr, "invalid command line option \"%c\"\n", argopt);
    exit (1);
}
/* check for an argument */
if (*++oli != ':') { /* don't need argument */
    argarg = NULL;
    if (!*place)
        nextarg = 1;
} else { /* need an argument */
    if (!*place) {
        if (++argind >= argc) {
            fprintf (stderr, "missing argument for option \"%c\"\n", argopt);
            exit (1);
        }
        place = argv[argind];
    }
    argarg = place;
    nextarg = 1;
}
return (argopt); /* return option letter */

3.2. Compiling Code with the Mesh and Results Export API

Compilation of a customized executable must be performed using an appropriate compiler and compiler flags.

The customized executable must also be linked with the provided Mesh and Results Export API library and the provided i/o library as detailed in Linking Code with the Mesh and Results Export API (p. 49).

3.2.1. Compiler Flags

No compiler flags are necessary for successful compilation on linux-ia64, but use the icc compiler.

3.3. Linking Code with the Mesh and Results Export API

In order to build a customized export utility, it must be linked with several libraries. With the exception of bufferoverflowu.lib, these libraries are located in <CFXROOT>/lib/<os>/:

- libmeshexport.lib (on Windows), or libmeshexport.a (on Linux)
- libratlas_api.lib (on Windows), or libratlas_api.a (on Linux)
- libratlas.lib (on Windows), or libratlas.a (on Linux)
- libpgtapi.lib (on Windows), or libpgtapi.a (on Linux)
- libunits.lib (on Windows), or libunits.a (on Linux)
- libccclapilt.lib (on Windows), or libccclapilt.a (on Linux)
- libio.lib (on Windows), or libio.a (on Linux)
- bufferoverflowu.lib (on Windows 64-bit)
3.3.1. UNIX

On most UNIX systems, build the executable with the command:

\texttt{cc export.c -o export.exe -I<CFXROOT>/include/ -L<CFXROOT>/lib/<OSDIR> -lmeshexport -lratlas_api -lratlas -lpgtapi -lcclapilt -lunits -lio -lm -lc}

where <CFXROOT> is the directory in which CFX is installed and <OSDIR> is a directory name corresponding to the architecture of the machine that you are running on (that is, linux-ia64). In this example, your own export program is named export.c and the executable file will be called export.exe.

The compiler flags and required libraries may vary, depending on the compiler and the custom program.

3.3.2. Windows (32-bit)

You can build the executables on 32-bit Windows systems that have Microsoft Visual C++ 2008 Express Edition. An example command line follows:

\texttt{cl /MD /I "C:\Program Files\Ansys Inc\v140\CFX\include" ExportTemplate.c /link /libpath:"C:\Program Files\Ansys Inc\v140\CFX\lib\winnt" libcclapilt.lib libio.lib libmeshexport.lib libunits.lib libpgtapi.lib libratlas_api.lib libratlas.lib

3.3.3. Windows (64-bit)

You can build the executables on 64-bit Windows systems that have the compiler from VS2008. An example command line follows:

\texttt{cl /MD /I "C:\Program Files\Ansys Inc\v140\CFX\include" ExportTemplate.c /link /libpath:"C:\Program Files\Ansys Inc\v140\CFX\lib\winnt-amd64" libcclapilt.lib libio.lib libmeshexport.lib libunits.lib libpgtapi.lib libratlas_api.lib libratlas.lib bufferoverflowu.lib

3.4. Details of the Mesh Export API

The full list of constants, data structures, types and functions available to the programmer are given in the following sections:

- 3.4.1. Defined Constants and Structures
- 3.4.2. Initialization and Error Routines
- 3.4.3. Zone Routines
- 3.4.4. Node Routines
- 3.4.5. Element Routines
- 3.4.6. Region Routines
- 3.4.7. Face Routines
- 3.4.8. Volume Routines
- 3.4.9. Boundary Condition Routines
- 3.4.10. Variable Routines

3.4.1. Defined Constants and Structures

The following constants and data structures are defined in the header file \texttt{cfxExport.h}, which should be included in the export program.
3.4.1.1. Element Types

CFX can use 4 types of element, which are identified by the number of nodes: tetrahedrons (4 nodes), pyramids (5 nodes), prisms/wedges (6 nodes), and hexahedrons (8 nodes). The element types are identified in the Export API by the following constants:

```
#define cfxELEM_TET 4
#define cfxELEM_PYR 5
#define cfxELEM_WDG 6
#define cfxELEM_HEX 8
```

3.4.1.2. Volume List Types

The Export API contains functions that enable the user to query how volumes are defined in the results file. It is possible to request how a volume is defined in terms of nodes or elements. (For details, see Volume Routines (p. 59).)

The following constants are defined in the header file and should be used as arguments to the Volume routines:

```
#define cfxVOL_NODES 0
#define cfxVOL_ELEMS 1
```

3.4.1.3. Region List Types

The Export API contains functions that enable the user to query how regions are defined in the results file. It is possible to request how a region is defined in terms of nodes or faces. (For details, see Region Routines (p. 56).)

The following constants are defined in the header file and should be used as arguments to the Region routines:

```
#define cfxREG_NODES 0
#define cfxREG_FACES 1
```

In the case of nodes, the global node number is returned, while in the case of faces, the returned value is a combination of the global element number and local face number of the element. The following macros are available to enable the user to extract the element and face number from the combined value:

```
#define cfxFACENUM(face) ((face) & 7)
#define cfxELEMNUM(face) ((face) >> 3)
```

3.4.1.4. Count Entries

Two routines exist for initializing the Export API (see cfxExportInit (p. 52)) and requesting the totals of certain quantities in a zone (see cfxExportZoneSet (p. 53)). The array returned from both of these routines requires the following constants to be used by the calling program to reference the correct quantities.

```
enum cfxCounts {
  cfxCNT_NODE = 0, /* number of nodes */
  cfxCNT_ELEMENT, /* number of elements */
  cfxCNT_VOLUME, /* number of volumes */
  cfxCNT_REGION, /* number of regions */
  cfxCNT_VARIABLE, /* number of variables */
  cfxCNT_TET, /* number of tetrahedral elements */
  cfxCNT_PYR, /* number of pyramid elements */
  cfxCNT_WDG, /* number of wedge elements */
  cfxCNT_HEX, /* number of hexahedral elements */
  cfxCNT_SIZE /* size of count array */
};
```
3.4.1.5. **Node Data Structure**

Nodes are represented in the Export API using the following structure (note the change in data type of x, y and z):

```c
typedef struct cfxNode {
    float x, y, z;
} cfxNode;
```

where x, y, and z are the coordinates of the node. A pointer to an array of these structures is returned by `cfxExportNodeList`. For details, see `cfxExportNodeList` (p. 54).

3.4.1.6. **Element Data Structure**

Elements are represented by the Export API using the following structure:

```c
typedef struct cfxElement {
    int type;
    int *nodeid;
} cfxElement;
```

where `type` is the element type and `nodeid` is an array of node numbers that define the topology of the element. A pointer to an array of these structures is returned by `cfxExportElementList`. For details, see `Element Types` (p. 51) and `cfxExportElementList` (p. 55).

3.4.2. **Initialization and Error Routines**

The following routines open and close the CFX results file, initialize the Export API, and handle fatal error processing. The first call to any of the API routines must be `cfxExportInit` and the last call should be `cfxExportDone`. For details, see:

- `cfxExportInit` (p. 52)
- `cfxExportDone` (p. 52).

3.4.2.1. **cfxExportInit**

```c
int cfxExportInit (char *resfile, int counts[cfxCNT_SIZE])
```

Opens the CFX results file named `resfile` and initializes the Export API. This should be the first call made to the API.

The routine returns the total number of zones. If the array `counts` is supplied to the routine (that is, it is not `NULL`), the array is filled with values representing the total number of nodes, elements, volumes, regions and variables for all the zones are returned in this array.

3.4.2.2. **cfxExportDone**

```c
void cfxExportDone ()
```

Closes the CFX results file and destroys any internal storage used by the API. This should be the final call made to the Export API.

3.4.2.3. **cfxExportError**

```c
void cfxExportError (void (*callback) (char *errmsg))
```

Release 14.0 - © SAS IP Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
Specify a callback function that will be executed when a fatal error is generated by a call to `cfxImportFatal` (see `cfxImportFatal` (p. 15)). The argument, callback, is the function that will be called, it should take an argument that is the error message passed to `cfxImportFatal`. It is the responsibility of the function to terminate the application if required.

### 3.4.2.4. cfxExportFatal

```c
void cfxExportFatal (char *errmsg)
```

Generate a fatal error message (`errmsg`) and close the ANSYS CFX results file. This routine also calls a callback function, if one has been specified by `cfxExportError` (see `cfxExportError` (p. 52)). If no callback function has been specified the function also terminates the application. There is no return from this call.

### 3.4.3. Zone Routines

A zone is defined as groups of nodes or faces that are located on the external boundaries of the domain. The following routines provide functionality for returning the number of zones in the open CFX results file specifying and requesting the current zone, and destroying any internal storage associated with a zone. All other routines in the Export API refer to quantities in the current zone being accessed by the API. By default the current zone is the global zone (a combination of all zones in the ANSYS CFX results file), but this can be the current zone can be altered by making a call to `cfxExportZoneSet` (see `cfxExportZoneSet` (p. 53)). Once this call has been made, any other function returns information about this zone until a subsequent call is made.

#### 3.4.3.1. cfxExportZoneCount

```c
int cfxExportZoneCount ()
```

Return the number of zones in the CFX results file.

#### 3.4.3.2. cfxExportZoneSet

```c
int cfxExportZoneSet (int zone, int counts[cfxCNT_SIZE])
```

Set the current zone being accessed by the Export API.

The value of `zone` should be between 1 and the value returned by `cfxExportZoneCount` (see `cfxExportZoneCount` (p. 53)) or 0 if the global zone is to be accessed.

The function returns 0 if the value of `zone` is invalid or the value `zone` if setting of the zone was successful.

The argument `counts` can be passed as a NULL pointer. In this case no information is returned to the calling function other than the return value mentioned above. If `counts` is specified it must be at least cfxCNT_SIZE in size, not specifying an array large enough can result in errors. In the case when `counts` is supplied correctly the total number of nodes, elements, volumes, regions and variables will be returned.

#### 3.4.3.3. cfxExportZoneGet

```c
int cfxExportZoneGet ()
```

Returns the current zone number.

#### 3.4.3.4. cfxExportZoneFree

```c
void cfxExportZoneFree ()
```
While a zone is being accessed, internal storage is allocated; this storage should be deallocated when no longer required. This can be done by calling `cfxExportZoneFree` or by calling `cfxExportNodeFree`, `cfxExportElementFree`, `cfxExportVolumeFree`, `cfxExportRegionFree` and `cfxExportVariableFree`. Details on each of these routines is available; see:

- `cfxExportNodeFree` (p. 55)
- `cfxExportElementFree` (p. 56)
- `cfxExportVolumeFree` (p. 60)
- `cfxExportRegionFree` (p. 58)
- `cfxExportVariableFree` (p. 63).

### 3.4.3.5. `cfxExportZoneIsRotating`

```c
int cfxExportZoneIsRotating(double rotationAxis[][3], double *angularVelocity)
```

Query whether the current zone is rotating and describe axis and angular velocity of the rotation if applicable. Returns 1 if the current zone is rotating and 0 if it is not; for the combined zone the return value is always -1. If successful the rotation axis is returned in `rotationAxis` and the velocity in `angularVelocity` in radians/second.

### 3.4.3.6. `cfxExportZoneMotionAction`

```c
int cfxExportZoneMotionAction(const int zone, const int flag)
```

Specify whether grid coordinates and variables should have the appropriate rotation applied to them if the zone is rotating so that grid coordinates appear in their correct locations and velocities (for examples) take this rotation into consideration. If `cfxExportZoneList` and `cfxExportVariableList` should return rotated values, flag should be set to `cfxMOTION_USE`. The default behavior for a particular zone will be used if `cfxMOTION_IGNORE` is specified or this function isn’t called. If zone is not valid or flag is not `cfxMOTION_USE`, `cfxMOTION_IGNORE` the return value will be -1 otherwise 0 is returned.

### 3.4.4. Node Routines

Accessing nodes within the current zone (see `cfxExportZoneSet` (p. 53)) is performed by making calls to the following functions.

It should be noted that the nodes for a zone are not loaded into the Export API until either `cfxExportNodeList` (see `cfxExportNodeList` (p. 54)) or `cfxExportNodeGet` (see `cfxExportNodeGet` (p. 55)) are called. This reduces memory overheads in the API by not allocating space until required.

When access to nodes in the current zone is no longer required, a call to `cfxExportNodeFree` (see `cfxExportNodeFree` (p. 55)) should be made to deallocate any internal storage.

#### 3.4.4.1. `cfxExportNodeCount`

```c
int cfxExportNodeCount ()
```

Query the number of nodes defined in the current zone.

#### 3.4.4.2. `cfxExportNodeList`

```c
cfxNode *cfxExportNodeList ()
```

Release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
Return a pointer to an array of cfxNode elements (see `cfxnode (p. 22)`) containing the coordinate values of each node in the current zone. The first node in the zone is the first element of the array, the second the second and so on.

The memory allocated to represent this information should be deallocated using `cfxExportNodeFree` (see `cfxExportNodeFree (p. 55)`) when no longer required.

### 3.4.4.3. cfxExportNodeGet

```c
int cfxExportNodeGet (int nodeid, double *x, double *y, double *z)
```

Query the coordinates of a specific node in the current zone.

The index (nodeid) is specified between 1 and the number of nodes returned by `cfxExportNodeCount` (see `cfxExportNodeCount (p. 54)`). If the value of nodeid is out of range the return value is 0 otherwise it is nodeid.

### 3.4.4.4. cfxExportNodeFree

```c
void cfxExportNodeFree ()
```

Deallocate any internal storage allocated by the Export API after calls to `cfxExportNodeList` (see `cfxExportNodeList (p. 54)`) and `cfxExportNodeGet` (see `cfxExportNodeGet (p. 55)`) have been made in the current zone.

### 3.4.5. Element Routines

Accessing elements within the current zone (see `cfxExportZoneSet (p. 53)`) is performed by making calls to the following functions. It should be noted that the elements for a zone are not loaded into the Export API until either `cfxExportElementList` (see `cfxExportElementList (p. 55)`) or `cfxExportElementGet` (see `cfxExportElementGet (p. 56)`) are called. This reduces memory overheads in the API by not allocating space until required.

When access to elements in the current zone is no longer required a call to `cfxExportElementFree` (see `cfxExportElementFree (p. 56)`) should be made to deallocate any internal storage.

### 3.4.5.1. cfxExportElementCount

```c
int cfxExportElementCount ()
```

Query the number of elements defined in the current zone.

### 3.4.5.2. cfxExportElementList

```c
cfxElement *cfxExportElementList ()
```

Return a pointer to an array of cfxElement elements (see `cfxelem (p. 23)`) containing the type and vertices of each element in the current zone. The first element in the zone is the first element of the array, the second the second and so on.

The memory allocated to represent this information should be deallocated using `cfxExportElementFree` (see `cfxExportElementFree (p. 56)`) when no longer required.

The following diagrams show the order of the nodes and connections that ANSYS CFX uses for exporting elements:
Note

The vertex ordering for the import API is different. For details, see *cfxImportElement* (p. 16).

### 3.4.5.3. cfxExportElementGet

```c
int cfxExportElementGet (int elemid, int elemtype, int *nodelist)
```

Query the type and vertices of a specific element in the current zone.

The index (elemid) is specified between 1 and the number of elements returned by *cfxExportElementCount* (see *cfxExportElementCount* (p. 55)). If the value of elemid is out of range the return value is 0 otherwise it is elemid.

The type of the element is returned in elemtype and the vertices defining the element in nodelist. Note that nodelist must be large enough to hold the element number of vertices in the element (normally an array of 8 integers is used as this allows space enough for all element types to be handled).

### 3.4.5.4. cfxExportElementFree

```c
void cfxExportElementFree ()
```

Deallocates any internal storage allocated by making calls to *cfxExportElementList* (see *cfxExportElementList* (p. 55)) or *cfxExportElementGet* (see *cfxExportElementGet* (p. 56)).

### 3.4.6. Region Routines

Regions are groups of faces in an ANSYS CFX results file. Accessing regions within the current zone (see *cfxExportZoneSet* (p. 53)) is performed by making calls to the following functions. It should be noted that the region information is not loaded into the Export API until either *cfxExportRegionList*
(see cfxExportRegionList (p. 57)) or cfxExportRegionGet (see cfxExportRegionGet (p. 57)) are called. This reduces memory overheads in the API by not allocating space until required.

When access to region in the current zone is no longer required a call to cfxExportRegionFree (see cfxExportRegionFree (p. 58)) should be made to deallocate any internal storage.

3.4.6.1. cfxExportRegionCount

```c
int cfxExportRegionCount ()
```

Query the number of regions defined in the current zone.

3.4.6.2. cfxExportRegionSize

```c
int cfxExportRegionSize (int regnum, int type)
```

Query the number of faces (if type is cfxREG_FACES) or nodes (if type is cfxREG_NODES) defined in the region identified by regnum in the current zone.

The function returns the number of faces or nodes in the current zone or 0 if either regnum is out of range or type is invalid.

3.4.6.3. cfxExportRegionName

```c
char *cfxExportRegionName (int regnum)
```

Query the name of the region in the current zone identifies by regnum.

The function returns the name of the region or NULL if the region number supplied is out of range. The pointer returned points to static storage, which will be overwritten by the next call to cfxExportRegionName.

3.4.6.4. cfxExportRegionList

```c
int *cfxExportRegionList (int regnum, int type)
```

Query the nodes (type is cfxREG_NODES) or faces (cfxREG_FACES) that define a region. This function returns a pointer to an array of node ids or face ids that define the region identified by regnum or NULL if the region number is out of range or the type is not recognized. If type is specified as cfxREG_FACES, the returned ids will represent faces. The element number and local element face number may be extracted from each face id returned by using the macros cfxELEMNUM and cfxFACENUM. The node numbers for the face may be obtained by calling cfxExportFaceNodes. For details, see cfxExportFaceNodes (p. 58).

3.4.6.5. cfxExportRegionGet

```c
int cfxExportRegionGet (int regnum, int type, int index, int *id)
```

Query the index'th element (type is cfxREG_ELEM) or index'th node (type is cfxREG_NODE) that defines a the region regnum in the current zone.

If regnum is out of range or type is not recognized or index is out of range, 0 is returned.

Otherwise id will contain the id of the appropriate node or face defining the region and the function will return index.
If type is specified as cfxREG_FACES, the returned id will represent the identity of a face. The element number and local element face number may be extracted from the id by using the macros cfxELEMNUM and cfxFACENUM.

### 3.4.6.6. cfxExportRegionFree

```c
void cfxExportRegionFree (int regnum)
```

Deallocate any internal data storage associated with the region defined by `regnum`.

### 3.4.7. Face Routines

Faces are 2 dimensional (2D) units of mesh. Each global face ID is returned from `cfxExportBoundaryList` (see `cfxExportBoundaryList` (p. 61)) or `cfxExportRegionList` (see `cfxExportRegionList` (p. 57)).

Within CFX faces are either represented as Triangles (three vertices) or Quadrilaterals (two vertices). Each face in a CFX .res file will be parented by a single 3D element. The parent element of a face can be returned by the `cfxELEMNUM` macro with the global face ID, and the local face of that element can be determined by calling `cfxFACENUM` with the same global face ID.

#### 3.4.7.1. cfxExportFaceNodes

```c
int cfxExportFaceNodes (int faceid, int *nodes)
```

Requests the vertices for the face identified by `faceid`. The argument `faceid` should be constructed from the element number and local face number using the following formula:

```
(element_number << 3) & local_face_number
```

Values returned from `cfxExportRegionGet` and `cfxExportRegionList` can be supplied directly to this function.

The number of vertices defining the face are returned if `faceid` is valid, otherwise 0 is returned. The node numbers are returned in the array `nodes`, which should be dimensioned to a minimum size of 4 in the calling routine.

The face numbers and associated node indices are tabulated here:

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Face</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td>tetrahedron</td>
<td>1</td>
<td>0 1 2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0 3 1</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>1 3 2</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>0 2 3</td>
</tr>
<tr>
<td>pyramid</td>
<td>1</td>
<td>0 3 4</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>1 4 2</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>0 4 1</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>2 4 3</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0 1 2</td>
</tr>
<tr>
<td>prism</td>
<td>1</td>
<td>0 2 5</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0 3 4</td>
</tr>
</tbody>
</table>
### 3.4.8. Volume Routines

Volumes are groups of elements in a CFX results file. Accessing volumes within the current zone (see `cfxExportZoneSet (p. 53)`) is performed by making calls to the following functions. It should be noted that the volume definitions for a zone are not loaded into the Export API until either `cfxExportVolumeList` (see `cfxExportVolumeList (p. 60)`) or `cfxExportVolumeGet` (see `cfxExportVolumeGet (p. 60)`) are called. This reduces memory overheads in the API by not allocating space until required.

When access to volume information in the current zone is no longer required a call to `cfxExportVolumeFree` (see `cfxExportVolumeFree (p. 60)`) should be made to deallocate any internal storage.

#### 3.4.8.1. `cfxExportVolumeCount`

```c
int cfxExportVolumeCount ()
```

Query the number of volumes defined in the current zone.

#### 3.4.8.2. `cfxExportVolumeSize`

```c
int cfxExportVolumeSize (int volnum, int type)
```

Query the number of nodes (if type is `cfxVOL_NODES`) or number of elements (if type is `cfxVOL_ELEMS`) defining the volume indexed by `volnum` in the current zone. The return value will be 0 if `volnum` is out of range or type is invalid.

#### 3.4.8.3. `cfxExportVolumeName`

```c
char *cfxExportVolumeName (int volnum)
```

Query the name of the volume in the current zone indexed by `volnum`. Returns NULL if the `volnum` is out of range.

---

#### Note

The face numbers and associated node indices are different when importing elements. For details, see `cfxImportGetFace (p. 18)`.

---

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Face</th>
<th>Nodes</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3</td>
<td>1 4</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>0 1</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>3 5</td>
</tr>
<tr>
<td>hexahedron</td>
<td>1</td>
<td>0 2</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>1 5</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>0 4</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>2 3</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0 1</td>
</tr>
<tr>
<td></td>
<td>6</td>
<td>4 6</td>
</tr>
</tbody>
</table>
Note

The returned pointer points to internal storage, which will be overwritten by the next call to cfxExportVolumeName.

### 3.4.8.4. cfxExportVolumeList

```c
int *cfxExportVolumeList (int volnum, int type)
```

Query the nodes (type is cfxVOL_NODES) or elements (cfxVOL_ELEMS) that define a volume.

This function returns a pointer to an array of node ids or element ids that define the volume identified by volnum or NULL if the volume number is out of range or the type is not recognized.

### 3.4.8.5. cfxExportVolumeGet

```c
int cfxExportVolumeGet (int volnum, int type, int index, int *id)
```

Query the [index]th element (type is cfxVOL_ELEM) or [index]th node (type is cfxVOL_NODE) that defines a the volume volnum in the current zone.

If volnum is out of range or type is not recognized or index is out of range, 0 is returned.

Otherwise id will contain the id of the appropriate node or element in defining the volume and the function will return index.

### 3.4.8.6. cfxExportVolumeFree

```c
void cfxExportVolumeFree (int volnum)
```

Deallocate any internal data storage associated with the volume defined by volnum.

### 3.4.9. Boundary Condition Routines

Boundary condition are located on groups of faces in a CFX results file. Accessing boundary condition locations within the current zone (see cfxExportZoneSet (p. 53)) is performed by making calls to the following functions. It should be noted that the boundary condition location information is not loaded into the Export API until either cfxExportBoundaryList (see cfxExportBoundaryList (p. 61)) or cfxExportBoundaryGet (see cfxExportBoundaryGet (p. 61)) are called. This reduces memory overheads in the API by not allocating space until required. When access to regions in the current zone are no longer required a call to cfxExportBoundaryFree (see cfxExportBoundaryFree (p. 62)) should be made to deallocate any internal storage.

#### 3.4.9.1. cfxExportBoundaryCount

```c
int cfxExportBoundaryCount ()
```

Query the number of boundary conditions defined in the current zone.

The function returns the number of boundary conditions in the current zone.

#### 3.4.9.2. cfxExportBoundaryName

```c
const char *cfxExportBoundaryName (const int bcidx)
```

Query the name of the boundary condition in the current zone identified by bcidx.
The function returns the name of the boundary condition or NULL if the bcidx supplied is out of range.

The pointer returned points to static storage, which will be overwritten by the next call to cfxExportBoundaryName.

**Note**

The following routines use bcidx which must lie between 1 and cfxExportBoundaryCount() and use index which must lie between 1 and cfxExportBoundarySize(bcidx, type).

### 3.4.9.3. cfxExportBoundaryType

```c
const char *cfxExportBoundaryType (const int bcidx)
```

Query the type (for example, Inlet, Outlet etc.) of the boundary condition in the current zone identified by bcidx.

The function returns the type of the boundary condition or NULL if the bcidx supplied is out of range.

The pointer returned points to static storage, which will be overwritten by the next call to cfxExportBoundaryType.

### 3.4.9.4. cfxExportBoundarySize

```c
int cfxExportBoundarySize (const int bcidx, const int type)
```

Query the number of faces (if type is cfxREG_FACES) or nodes (if type is cfxREG_NODES) defined in the boundary condition identified by bcidx in the current zone.

The function returns the number of faces or nodes or 0 if either bcidx is out of range or type is invalid.

### 3.4.9.5. cfxExportBoundaryList

```c
int *cfxExportBoundaryList (const int bcidx, const int type)
```

Query the faces (if type is cfxREG_FACES) or nodes (if type is cfxREG_NODES) that define a boundary condition.

This function returns a pointer to an array of node ids or face ids that define the location of the boundary condition identified by bcidx or NULL if bcidx is out of range or the type is not recognized. If type is specified as cfxREG_FACES, the returned ids will represent faces. The element number and local element face number may be extracted from each face id returned by using the macros cfxELEMNUM and cfxFACENUM respectively. The node numbers for the face may be obtained by calling cfxExportFaceNodes. For details, see cfxExportFaceNodes (p. 58).

The returned pointer points to static data which should be destroyed using cfxExportBoundaryFree. Subsequent calls to cfxExportBoundaryList will overwrite the array.

### 3.4.9.6. cfxExportBoundaryGet

```c
int cfxExportBoundaryGet (const int bcidx, const int type, const int index, int *id)
```
Query the index'th face (type is cfxREG_FACES) or index'th node (type is cfxREG_NODES) that defines the boundary condition location indexed by bcidx in the current zone. If bcidx is out of range or type is not recognized or index is out of range (not between 1 and cfxExportBoundarySize), 0 is returned. Otherwise id will contain the identifier of the appropriate node or face defining the boundary condition location and the function will return index. If type is specified as cfxREG_FACES, the returned id will represent the identity of a face. The element number and local element face number may be extracted from the id by using the macros cfxELEMNUM and cfxFACENUM respectively.

3.4.9.7. cfxExportBoundaryFree

    void cfxExportBoundaryFree (const int bcidx)

Deallocation any internal data storage associated with the boundary condition defined by bcidx.

3.4.10. Variable Routines

These routines access the variable data defined on the current zone as defined by cfxExportZoneSet. For details, see cfxExportZoneSet (p. 53). The variable data arrays are not loaded into memory until either cfxExportVariableList or cfxExportVariableGet are called, and remain in memory until cfxExportVariableFree is called. For details, see:

• cfxExportVariableList (p. 63)
• cfxExportVariableGet (p. 63)
• cfxExportVariableFree (p. 63).

3.4.10.1. cfxExportVariableCount

    int cfxExportVariableCount(int usr_level)

Query the number of variables at interest level usr_level or below. If usr_level is 0, then the total number of variables is returned.

3.4.10.2. cfxExportVariableSize

    int cfxExportVariableSize (int varnum, int *dimension, int *length, int *bdnflag)

Query the dimension, dimension, and length, length, for the variable identified by varnum, which should be from 1 to the number of variables, returned by cfxExportVariableCount (cfxExportVariableCount (p. 62)). The length, length, will either be 1 or the same as the number of nodes returned by cfxExportNodeCount (see cfxExportNodeCount (p. 54)). If 1, then the variable has meaningful values only at the boundary nodes, with a constant value in the interior.

The function also returns bdnflag which indicates if the variable contains corrected boundary node values (1) or not (0).

The function returns varnum if successful, or 0 if the variable number is out of range.

3.4.10.3. cfxExportVariableName

    char *cfxExportVariableName (int varnum, int alias)

Query the name of the variable identified by varnum.

The return value of the function is NULL if the variable number is out of range or the name of the variable.
The pointer returned points to static storage, which will be overwritten by the next call to cfxExportVariableName.

The argument alias indicates whether the short name (alias=0) or long name (alias=1) should be returned. For example, the short and long names for the total temperature variable are TEMPOT and Total Temperature, respectively.

### 3.4.10.4. cfxExportVariableList

```c
float *cfxExportVariableList (int varnum, int correct)
```

Query the results data for a variable identified by varnum.

Returns NULL if the variable number is out of range or the variable data if successful.

The flag correct indicates whether to correct boundary node data (correct=1) or not (correct=0), assuming that it exists.

The data is in the same order as the nodes returned from cfxExportNodeList (see cfxExportNodeList (p. 54)).

For multidimensional variables, the data is stored with dimension consecutive values for each node.

The storage for the data is created by the Export API when this function is called. When the data is no longer required a call to cfxExportVariableFree (see cfxExportVariableFree (p. 63)) should be made by the calling function.

### 3.4.10.5. cfxExportVariableGet

```c
int cfxExportVariableGet (int varnum, int correct, int index, float *value)
```

Request the values of the variable identified by varnum at the location given by index, which should be from 1 to the length of the variable, inclusively.

The flag correct indicates whether to correct boundary node data (correct=1) or not (correct=0), assuming that it exists.

The function returns index, or 0 if the location is out of range.

The values of the variable are returned in value which should be dimensioned at least as large as the dimension of the variable.

### 3.4.10.6. cfxExportVariableFree

```c
void cfxExportVariableFree (int varnum)
```

Deallocates the internal data storage for the variable identified by varnum for the current zone.
Chapter 4: Remeshing Guide

Periodic remeshing is an important part of running analyses that involve significant mesh deformation. Remeshing is often required simply to maintain acceptable mesh quality, as described in Discretization Errors in the *CFX-Solver Theory Guide* and Measures of Mesh Quality in the *CFX-Solver Modeling Guide*.

A schematic illustrating the integration of remeshing into the general simulation workflow is shown in the figure below.

**Figure 4.1 Integration of a Remeshing Loop into the General Simulation Workflow**

As shown in *Figure 4.1 (p. 65)*, in addition to the **Pre-processing** and **Solution** steps of the standard simulation workflow, the remeshing loop includes three additional steps:

- **Data Extraction**: Extract any data needed to guide geometry modifications and mesh re-creation from the most recent analysis results and monitor point values.
- **Geometry Modification**: Update the analysis' geometry so that it conforms to that of the most recent analysis results (that is, account for mesh deformation).
- **Mesh Recreation**: Generate new mesh(es) that correspond to the updated geometry.

In the context of remeshing, those steps are responsible for completing the following sub-steps:

- **Data Extraction**: Extract any data needed to guide geometry modifications and mesh re-creation from the most recent analysis results and monitor point values.
- **Geometry Re-Creation**: Update the analysis' geometry so that it conforms to that of the most recent analysis results (that is, account for mesh deformation).
- **Mesh Re-Creation**: Generate new mesh(es) that correspond to the updated geometry.
**Pre-processing**: Insert the new mesh(es) into the analysis definition, and generate an updated CFX-Solver Input file.

**Solution**: Interpolate the previously generated analysis results onto the new mesh, re-partition the mesh if a parallel run mode is selected, and continue the solution process.

As described in Remeshing Tab in the CFX-Pre User’s Guide, there are two options available for remeshing: **User Defined** and **ICEM CFD Replay**. As outlined in the discussions that follow, the Pre-processing and Solution steps (and their respective sub-steps) are automatically executed for both remeshing options. Although the remaining steps are automatically executed for the **ICEM CFD Replay** remeshing option, they become the responsibility of a user defined external command for the **User Defined** remeshing option.

### 4.1. User Defined Remeshing

**User Defined** remeshing offers the greatest flexibility to customize the remeshing process. This comes at the expense of requiring that the data extraction, and geometry and mesh re-creation steps are executed by a user-specified external command, as illustrated in the figure below where the dashed line identifies steps that must be executed by the user-specified **External Command**.

**Figure 4.2  Schematic for User Defined remeshing**

This remeshing option is ideally suited for users who have previously completed an ‘in-house’ remeshing solution involving scripts or varying degrees of manual user-intervention. When this option is used, the following steps are automatically executed:

- Run the specified external command to generate a new mesh(es)
- Insert the new mesh(es) into the analysis definition, and generate an updated CFX-Solver Input file
- Interpolate the previously generated analysis results onto the new mesh, re-partition the mesh if a parallel run mode is selected, and continue the solution process.
The following examples outline the use of the User Defined remeshing option:

- **Remeshing with Key-Frame Meshes** (p. 67)
- **Remeshing with Automatic Geometry Extraction** (p. 67).

### 4.1.1. Remeshing with Key-Frame Meshes

In some analyses involving mesh deformation, the motion of various boundaries and sub-domains is known beforehand. Thus, the iteration or time step number at which unacceptable mesh quality will occur due to mesh motion is also known. A sequence of ‘key-frame’ meshes (of any mesh file type) corresponding to these instances of poor mesh quality can consequently be generated and applied during the analysis.

Once the sequence of key-frame meshes has been generated, they should be placed in a location that will be accessible during the analysis’ execution. The analysis definition is then modified to include one or more control conditions that will interrupt the solver at the iteration or time step at which a key-frame mesh should be inserted. A configuration is subsequently defined (unless this has already been done), and a remeshing definition is created with the following settings:

- Set **Option** to **User Defined**.
- Set the **Activation Condition**(s) to the previously created interrupt control condition(s).
- Set the **Location** to the mesh region that will be replaced.
- Set the **External Command** to the command that will be used to generate the replacement mesh file.
- Set the **Replacement File** to the name of the file that will be generated by the external command.

The **External Command** is typically a shell script or batch file that completes the following tasks:

- Determine which key-frame mesh to use. This will require parsing the run’s output file for the iteration or time step number, or the actual simulation time. Output generated from the cfx5mondata executable can also be parsed instead of the run’s output file. For details, see Exporting Monitor Data from the Command Line in the CFX-Solver Manager User’s Guide.
- Copy the key-frame mesh to the path the specified by the **Replacement File** setting.

### 4.1.2. Remeshing with Automatic Geometry Extraction

In some analyses involving mesh deformation, the motion of various boundaries and sub-domains is not known beforehand and the key-frame remeshing strategy presented above is not applicable. In these analyses, geometrical information must be extracted from the most recent analysis results and applied in the remeshing process.

In such cases, the analysis definition is modified to include one or more control conditions that will interrupt the solver when, for example, mesh quality deteriorates significantly. A configuration is subsequently defined (unless this has already been done), and a remeshing definition is created with the following settings:

- Set **Option** to **User Defined**.
- Set the **Activation Condition**(s) to the previously created interrupt control condition(s).
- Set the **Location** to the mesh region that will be replaced.
• Set the **External Command** to the command that will be used to generate the replacement mesh file.

• Set the **Replacement File** to the name of the file that will be generated by the external command.

The **External Command** is typically a shell script or batch file that completes the following tasks:

• Extract geometry data from the most recent solution of the analysis, and either update or replace the original geometry. This may be done using mesh-to-geometry conversion tools available in software such as ANSYS ICEM CFD, or by extracting monitor point data values (for example, the Total Centroid Displacement variable) using the `cfx5mondata` executable. For details, see Exporting Monitor Data from the Command Line in the CFX-Solver Manager User’s Guide.

• Create a replacement mesh file using the updated or newly generated geometry. This may be done in any suitable mesh generation application.

Note that some mesh-to-geometry conversion tools are unable to extract the latest mesh coordinates from the most recent CFX-Solver Results file. If this is the case, then introduce a call to CFX-Pre (within the **External Command**) that executes a session file that simply loads the latest CFX-Solver Results file and writes a new CFX-Solver Input file. That CFX-Solver Input file will contain the required, latest mesh coordinates.

### 4.2. ICEM CFD Replay Remeshing

ICEM CFD Replay remeshing provides a highly automated remeshing process that is ideally suited for users of the ANSYS ICEM CFD mesh generation software and cases that involve translational mesh motion only (that is, no rotation or general deformation). When this option is used, a master replay file is assembled from other task-oriented replay files and submitted to the ANSYS ICEM CFD mesh generator for batch execution. These replay files are illustrated in the figure below, along with the general process flow for this remeshing option. The dashed line in the figure highlights components of the master replay file and identifies files and steps that you can modify. Unless otherwise noted, files are contained in the `<CFXROOT>/etc/Remeshing` directory.
Figure 4.3  Schematic for ICEM CFD Replay remeshing

When this option is used, the following steps are automatically executed:

- Extract geometry and mesh control data and write them to the `cfx_params.rpl` replay file in the run directory. The data includes:
  - Centroid displacements for boundaries that are included in ANSYS ICEM CFD Part Maps
  - Mesh control parameters (for example, `ehgt` and `emax`)
  - Scalar parameters.

- Run (in batch) the ANSYS ICEM CFD mesh generation program using the master replay file. This master replay file executes the following tasks:
  - Read the `cfx_params.rpl` file.
  - Load the reference geometry from the Geometry File identified in the Remesh definition.
  - Apply displacements (including scaling and any offsets) corresponding to all ANSYS ICEM CFD Part Map definitions contained in the Remesh definition. This is done using the default geometry replay file provided, or using the user defined replay file if specified in the ICEM CFD Geometry Control setting.
  - Apply ICEM CFD Mesh Controls defined in the Remesh definition. This is done using the provided controls, or using the user-defined replay file if specified in the ICEM CFD Mesh Control setting.
  - Load your Mesh Replay File, specified in the Remesh definition.
  - Export a new mesh for ANSYS CFX.
- Insert the new mesh(es) into the analysis definition, and generate an updated CFX-Solver Input file.
- Interpolate the previously generated analysis results onto the new mesh, re-partition the mesh if a parallel run mode is selected, and continue the solution process.
You must create the reference **Geometry File** and the **Mesh Replay File** because these are specific to each case. However, the generic default replay files (icemcfd_Remesh.rpl, icemcfd_GeomMod.rpl, and icemcfd_MeshMod.rpl) used by this option are provided in the `<CFXROOT>/etc/Remeshing` directory. These files may be edited to provide installation-wide changes to the ICEM CFD Replay remeshing behavior. Alternatively, the geometry and mesh modification files may be copied and edited to provide case-specific changes.

**Note**

As indicated previously, only translational mesh motion is automatically handled by the ICEM CFD Replay remeshing option. This is accomplished by applying the displacements of centroids of boundaries in the ANSYS CFX analysis definition to parts in the ANSYS ICEM CFD geometry. All other mesh motion (such as rotation about the centroid or another point, or general deformation) will not be applied, and an inconsistency in the analysis geometry before and after remeshing will be introduced.

### 4.2.1. Steps to Set Up a Simulation Using ICEM CFD Replay Remeshing

The following discussion presents the three general steps required to set up a simulation using the ICEM CFD Replay remeshing option.

The first step involves creating the reference **Geometry File** within the ANSYS ICEM CFD environment. If the geometry was not created within that environment, use one of the **File > Import Geometry** options in the ANSYS ICEM CFD environment. At this point, ensure that all required Parts (or Families) are defined and named so that they can be referenced when completing the ICEM CFD Replay remeshing definition later in CFX-Pre. Finally, store the geometry in the ICEM CFD native geometry file format (namely, a .tin file).

The second step involves generating the **Mesh Replay File**, again, from within the ANSYS ICEM CFD environment. Start with the previously created geometry loaded, and work sequentially through the mesh generation process until acceptable mesh controls have been specified. This may require fine tuning, which will involve the regeneration of your mesh after moving the geometry through its expected range of motion. Once you are satisfied with the mesh control settings, purge the last mesh using **File > Mesh > Close Mesh**, and reload the original reference geometry. Complete the following tasks to generate the required **Mesh Replay File**:

1. Use **File > Replay Scripts > Replay Control** to begin recording the commands for the **Mesh Replay File**. The **Replay Control** dialog box is displayed.
2. Revisit all of the mesh related tabs and settings used to generate the mesh, clicking either the **Apply** or **OK** to commit the settings into the **Replay Control** panel.
3. Generate the mesh.
4. In the **Replay Control** panel, clear the **Record (after current)** toggle and select **Save** to write the settings to replay file.

You may also want to export the mesh that was (re)generated for use in the simulation definition (as in the next step).

The third step involves defining the simulation within CFX-Pre. Complete the following tasks to prepare the simulation:

1. Start a new simulation and import the (previously generated) mesh.
2. Define expressions for the motion of the geometry (for example, see the expressions for the ball movement in *Modeling a Ball Check Valve using Mesh Deformation and the CFX Rigid Body Solver in the CFX Tutorials*).

   **Note**

   See also the discussion in *Mesh Re-Initialization During Remeshing (p. 72).*

3. Define the flow analysis including the definition of one or more solver interrupt controls, as described in *Interrupt Control in the CFX-Pre User’s Guide*, to identify the condition(s) under which solver execution will be interrupted.

4. Define a configuration and complete the ICEM CFD Replay remeshing setup as described in *ANSYS ICEM CFD Replay Remeshing in the CFX-Pre User’s Guide*. The **Geometry File** and **Mesh Replay File** created above are referenced here. Note also, that references to one or more of the previously defined solver interrupt control conditions are required to activate remeshing.

5. Complete any execution controls for the simulation and either start the solver or write the CFX-Solver Input file for later use.

### 4.3. Directory Structure and Files Used During Remeshing

CFX-Solver runs that include remeshing will have a slightly non-standard directory structure during execution. For example, using a CFX-Solver input file named *case.def*, a directory structure similar to the following will exist just after solution execution is interrupted and the second instance of remeshing begins:

```plaintext
    case.def
    case_001/
        1_full.trn
        0_full.trn
        2_full.trn
        3_oldmesh.res
        3_remesh.out
    case_001.dir/
        3_full.trn
        4_full.trn
        res mon
```

The first instance of remeshing occurred when the solver was interrupted after the third time step. Following this instance of remeshing, all CFX-Solver Results files (such as transient, backup, and remeshing) contained in the run directory, *case_001.dir*, were moved into the final solution directory, *case_001*. The results file written when the solver was interrupted before remeshing was renamed to *3_oldmesh.res*. Any text output to the console window during remeshing was redirected to the file named *3_remesh.out*, which is also placed in the final solution directory.

The second, and currently running, instance of remeshing began when the solver was interrupted after the fifth time step. The results file written by the solver still has the generic name, *res*, and monitor data (contained in the *mon* file) has not yet been inserted into the results file.

Just after inserting the new mesh(es) into the analysis definition, the files contained in the final solution and run directories change slightly. The results and console output files are renamed (to *5_oldmesh.res* and *5_remesh.out*, respectively) and moved from the run directory into the final solution directory. An automatically generated session file, *meshUpdate.pre*, is used by CFX-Pre to generate the updated solver input file, *5_newmesh.def*, and each of these files are present in the run directory. These files are, however, replaced or removed during the next instance of remeshing or when the analysis ends and the run directory is deleted.
4.4. Additional Considerations

This section discusses additional considerations for remeshing.

4.4.1. Mesh Re-Initialization During Remeshing

4.4.2. Software License Handling

4.4.1. Mesh Re-Initialization During Remeshing

The following points are important to note during remeshing:

- The total mesh displacement variable is relative to a specific mesh topology. Because the mesh topology changes, this variable is reset each time remeshing occurs.
- The new variable called total centroid displacement tracks the displacement of each boundary’s centroid since the beginning of the analysis (that is, relative to the original mesh).
- The specified displacement based mesh motion is relative to the initial mesh and must therefore include an offset to account for mesh re-initialization. The Mesh Initialisation Time variable corresponds to the time at which mesh re-initialization last occurred. This can be used to evaluate the required offset for time varying mesh displacement.

An example of the expressions used to evaluate an applied displacement that includes the required offset to account for mesh re-initialization is given below. In this example, the applied displacement is evaluated as the desired displacement minus the value of the desired displacement at the Mesh Initialisation Time.

\[
\text{Disp Desired} = 1[m] \times 0.5 \times (1 - \cos(2[s^{-1}] \times \pi \times t))
\]
\[
\text{Disp Mesh ReInit} = 1[m] \times 0.5 \times (1 - \cos(2[s^{-1}] \times \pi \times \text{Mesh Initialisation Time}))
\]
\[
\text{Disp Applied} = \text{Disp Desired} - \text{Disp Mesh ReInit}
\]

4.4.2. Software License Handling

Several software components (for example, CFX-Pre, the CFX-Solver, ANSYS ICEM CFD, and so on) are used while executing steps in the overall remeshing process. Rather than holding all of these licenses for the entire duration of the analysis, they are only ‘checked out’ as required. Although this frees up the licenses for other users when remeshing is not executing, it also introduces the possibility that required licenses are not available when they are needed for remeshing.

This model for software license handling may cause problems in multi-user environments, but work is underway to provide a broader range of handling options for future releases.
Chapter 5: Reference Guide for Mesh Deformation and Fluid-Structure Interaction

This guide is part of a series that provides advice for using CFX in specific engineering application areas. It is aimed at users with little or moderate experience using CFX for applications involving Mesh Deformation and/or Fluid Structure Interaction.

This guide describes:
- 5.1. Mesh Deformation
- 5.2. Fluid Structure Interaction

5.1. Mesh Deformation

Mesh deformation is an important part of executing simulations with changing domain geometry. In CFX, this capability is available in fluid and solid domains. Motion can be specified on selected regions via CEL or an external solver coupling (for example, ANSYS Multi-field MFX), or on all nodes in an entire domain via a user-Fortran junction box routine.

5.1.1. Mesh Folding: Negative Sector and Element Volumes

It is not uncommon for the mesh to become folded (or tangled) during the mesh deformation process. When this occurs, a message indicating the existence and location of either negative sector volumes or negative (that is, topologically invalid) elements is written to the simulation output file. Notification of negative sector volumes highlights the existence of non-convex mesh elements that still have a positive volume. Although the existence of negative sector volumes is not a fatal condition, it does indicate that:

- Mesh elements are only barely positive
- Further mesh deformation is likely to yield elements with negative volumes, which is a fatal condition

Some of the most common causes for mesh folding during deformation are identified in the following sections.

5.1.2. Applying Large Displacements Gradually

In many simulations that require mesh deformation, the motion is known a priori. In these cases, the motion can be applied gradually, by relating it to the iteration or timestep counters, to reduce the likelihood of mesh folding. Mesh folding is often avoided with this strategy because the mesh displacement equations are assembled using the updated meshes from each deformation step (that is, outer iteration or timestep). In general, the desired total mesh deformation should be split up so that regions where motion is specified move through less than approximately 5 adjacent elements per step.

In some simulations, the motion is not known a priori. Fluid Structure Interaction is an excellent example of this. In these cases, mechanisms available for under-relaxing the displacements applied per deformation step should be used. For details, see Solver Controls, External Coupling Tab in the CFX-Solver Modeling Guide.
5.1.3. Consistency of Mesh Motion Specifications

Mesh motion options such as Specified Displacement may be applied on multiple boundary and subdomain regions. Because the specified motion is applied directly to mesh nodes, rather than control volume integration points, care is required to ensure that motion specified on adjacent regions is self-consistent. For example, the motion specified on one moving wall should be reduced to zero for any nodes that are shared with another stationary wall. If this is not done, then the motion applied to the shared nodes will be either the moving or stationary condition, depending on which was applied last during the equation assembly process.

Folded meshes often result from the application of inconsistent motion specifications.

5.1.4. Solving the Mesh Displacement Equations and Updating Mesh Coordinates

During each outer iteration or timestep, the mesh displacement equations are solved to the specified convergence level and the resulting displacements are applied to update the mesh coordinates. This occurs before proceeding to solve the general transport (for example, hydrodynamics, turbulence, etc.) equations.

Unlike other equation classes, the convergence level (that is, controls and criteria) applied to mesh displacement equations is unaffected by changes made to the basic settings for all other equations. The default convergence controls and criteria for the mesh displacement equation are tabulated below, and are changed by visiting the Mesh Displacement entry in the Equation Class Settings tab under Solver Control.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Number of Coefficient Loops</td>
<td>5</td>
</tr>
<tr>
<td>Minimum Number of Coefficient Loops</td>
<td>1</td>
</tr>
<tr>
<td>Residual Type</td>
<td>RMS</td>
</tr>
<tr>
<td>Residual Target</td>
<td>1.0E-4</td>
</tr>
</tbody>
</table>

Mesh folding occurs and is detected when the displacements are used to update the mesh coordinates. Folded meshes can occur if the displacement equations are incompletely solved. In this case, the un converged displacement solution field does not vary smoothly enough to ensure that adjacent mesh nodes move by similar amounts.

5.1.5. Mesh Displacement Diffusion Scheme

A number of numerical schemes are available for the solution of the mesh displacement diffusion equation. In many cases the default scheme is appropriate, but in some situations mesh folding can be avoided and improved mesh quality can be obtained by using a different scheme. The expert parameter meshdisp diffusion scheme controls which numerical scheme is used. For details, see Discretization Parameters. Setting meshdisp diffusion scheme to 3 can be helpful if the mesh folds unexpectedly at sharp corners or if uniform mesh deformation is expected but non-uniform deformation is observed. The figures below show an example of using different mesh displacement diffusion schemes.
Figure 5.1 Original Undeformed Mesh
Figure 5.2 Deformed Mesh with the Default Diffusion Scheme
5.1.6. Mesh Displacement vs. Total Mesh Displacement

A number of new variables become available when executing simulations with mesh deformation. Two of these variables are **Mesh Displacement** and **Total Mesh Displacement**.

**Mesh Displacement** is the principal variable that is solved for by the mesh motion model (see Mesh Deformation in the CFX-Solver Modeling Guide). This variable represents the displacement relative to the previous mesh locations. Conversely, **Total Mesh Displacement** is a derived quantity that represents the displacement relative to the initial mesh.

5.1.7. Simulation Restart Behavior

The following table summarizes the behavior that occurs when simulations with (or without) mesh deformation are restarted with (or without) mesh deformation. With only the exception noted, the simulation type (that is, steady state or transient) used for the initial or restart run does not affect behavior.
### 5.2. Fluid Structure Interaction

CFX provides the ability to solve, or take part in the solution of cases that involve the coupling of solution fields in fluid and solid domains. This coupling is commonly referred to as Fluid Structure Interaction (FSI). One example of FSI is the simulation of an internal combustion engine, which involves the solution of fluid flow, conjugate heat transfer and combustion problems on deforming meshes.

In the discussion that follows, examples are presented to demonstrate the FSI capabilities using CFX by itself or with other CAE packages like ANSYS Mechanical and ANSYS Multiphysics. These examples are grouped according to the degree of coupling that must be maintained during the simulation in order to ensure that accurate results are obtained.

#### 5.2.1. Unidirectional (One-Way) FSI

In many FSI simulations, the coupling between the solution fields is predominantly unidirectional; a given field may strongly affect, but not be affected by other fields. In CFX, there are a variety of strategies to efficiently execute such simulations. These strategies are identified in the following examples.

##### 5.2.1.1. Using CFX Only

One of the most useful examples of unidirectional FSI within CFX involves prescribed mesh deformation of fluid or solid domains. This is possible using the CEL to specify the motion of sub-domains or domain boundaries, or by reading a sequence of pre-defined meshes.

##### 5.2.1.2. Using CFX and the Mechanical Application

In many FSI simulations, the capabilities of additional solvers are required to compliment those of CFX. In these circumstances, CFX provides tools to facilitate the import and export of solution data in a variety of formats.

##### 5.2.1.2.1. Importing Data from the Mechanical Application Solver

The recommended method for importing boundary condition data from the Mechanical application into CFX is via boundary profile data. For information about the creation and use of profile data files, refer to Chapter 6, Unidirectional Load Transfer and Use Profile Data in the CFX-Pre User’s Guide.
5.2.1.2.2. Export Data to Other ANSYS Software Products

Two methods exist for exporting data from CFX for use in other ANSYS software products. The first method requires the use of the MFS variant of the ANSYS Multi-field solver and the second method does not.

- For information about exporting mechanical and thermal surface data and thermal volumetric data for use with the MFS solver, refer to Export to ANSYS Multi-field Solver Dialog Box in the CFX-Solver Manager User's Guide. For information about using the exported results and the MFS Solver, refer to Chapter 3, The ANSYS Multi-field (TM) Solver - MFS Single-Code Coupling.

- For information about exporting mechanical and thermal surface data for general use, refer to Mechanical Import/Export Commands in the CFD-Post User's Guide. This method involves reading a Mechanical Coded Database (CDB) file and interpolating CFX solution data onto the mesh contained in that file. For more information about how these steps are automated in the Mechanical application, see Custom Systems in the Workbench User Guide.

5.2.1.2.3. Mechanical Import/Export Example: One-Way FSI Data Transfer

You can perform one-way FSI operations manually (by exporting CDB files from the Mechanical APDL application, importing the surface in CFD-Post, and exporting the SFE commands).

To create a Mechanical load file using CFD-Post to transfer FSI data:

1. Load the fluids results file, from which you want to transfer results, into CFD-Post
2. Select File > Import > Import Mechanical CDB Surface. The Import Mechanical CDB Surface dialog box appears.
3. In the Import Mechanical CDB Surface dialog box, either:
   - Select the CDB file that specifies the surface mesh of the solid object to which to transfer data. Also select the Associated Boundary for the surface to map onto, and make other selections as appropriate.
   - Select the XML document that provides all transfer information. Click OK, and the surface data is loaded.
5. In the Export Mechanical Load File dialog box, select a filename to which to save the data. For the Location parameter value, select the imported ANSYS mesh object. Under File Format select ANSYS Load Commands (FSE or D). (Alternatively, you can select WB Simulation Input (XML) to get XML output.) Also select the appropriate data to export: Normal Stress Vector, Tangential Stress Vector, Stress Vector, Heat Transfer Coefficient, Heat Flux, or Temperature. Click Save, and the data file is created.

The one-way FSI data transfer described above is performed automatically when using the FSI: Fluid Flow (CFX) > Static Structural custom system in ANSYS Workbench. For details, see the FSI: Fluid Flow (CFX) > Static Structural in the Workbench User Guide section in the ANSYS documentation.

5.2.1.3. Using CFX and Other CAE Software

Solution data can be exported from CFX in a variety of general formats during or after execution of the CFX-Solver. For information about the export of data in CGNS format during the execution of the solver, refer to Export Results Tab in the CFX-Pre User's Guide. For information about the extraction and export...
of CGNS, MSC Patran, FIELDVIEW, EnSight and custom data from CFX results files, refer to Generic Export Options in the CFX-Solver Manager User's Guide.

5.2.2. Bidirectional (Two-Way) FSI

In some simulations, there is a strong and potentially nonlinear relationship between the fields that are coupled in the Fluid Structure Interaction. Under these conditions, the ability to reach a converged solution will likely require the use of bidirectional FSI. As for unidirectional interaction, examples are provided below that demonstrate the variety of strategies to execute such simulations.

5.2.2.1. Using CFX Only

Conjugate heat transfer is an example of bidirectional interaction that can be solved using the CFX-Solver only.

5.2.2.2. Using CFX and the Mechanical Application

Communicating data between CFX and the Mechanical application is automated by the MFX branch of the ANSYS Multi-field solver. In this branch of the ANSYS Multi-field solver, data is communicated between the CFX and the Mechanical application field solvers through standard internet sockets using a custom client-server communication protocol. This custom solution maximizes execution efficiency and robustness, and greatly facilitates future extensibility.

Setup requires creation of the fluid and solid domain/physical models in the CFX-Pre and the Mechanical application user interfaces, respectively, and the specification of coupling data transfers and controls in the CFX-Pre user interface. Execution and run-time monitoring of the coupled simulation is performed from the CFX-Solver Manager. Note that a dedicated MFX-ANSYS/CFX tab is also provided in the ANSYS Product Launcher to begin execution of the coupled simulation (see General Procedure in the CFX-Solver Manager User's Guide).

Refer to the following sections for more information:

- Coupling CFX to an External Solver: ANSYS Multi-field Simulations in the CFX-Solver Modeling Guide
- Chapter 4, Multi-field Analysis Using Code Coupling.

Coupled simulations begin with the execution of the Mechanical application and CFX field solvers. The Mechanical application solver acts as a coupling master process to which the CFX-Solver connects. Once that connection is established, the solvers advance through a sequence of six pre-defined synchronization points (SPs), as illustrated in Figure 5.4 (p. 81). At each of these SPs, each field solver gathers the data it requires from the other solver in order to advance to the next point.

The first three SPs are used to prepare the solvers for the calculation intensive solution process, which takes place during the final three SPs. These final SPs define a sequence of coupling steps, each of which consists of one or more stagger/coupling iterations. During every stagger iteration, each field solver gathers the data it requires from the other solver, and solves its field equations for the current coupling step. Stagger iterations are repeated until a maximum number of stagger iterations is reached or until the data transferred between solvers and all field equations have converged. The latter guarantees an implicit solution of all fields for each coupling step.
Figure 5.4 Sequence of Synchronization Points

- Start

  ANSYS Field Solver
  CFX Field Solver

  Solver Setup Synchronization Point (SP)
  - Coupled solver hand-shaking
  - Versioning information

  Coupling Setup SP
  - Distribute coupling control and data transfer specifications

  Simulation Initialization SP
  - Share interface mesh information
  - Initialize solution data and share initial loads

  Start new Coupling Step

  Start new Stagger Iteration

  Solution Initialization SP
  - Share coupling step and stagger iteration counters/status

  Solution SP
  - Transfer loads for current stagger iteration
  - Execute field solution
    - ANSYS: internal iterations as required
    - CFX: iterations as outlined in Discretization and Solution Theory flow chart

  Convergence SP
  - Distribute convergence status/information

  Coupling Step Converged?
  No
  No
  Yes
  Simulation Complete?
  Yes
  Stop
  Yes

  Coupling Step Converged?
  No
  No
  Yes
  Simulation Complete?
  Yes
  Stop
  Yes
5.2.2.3. Using CFX and Other CAE Software

Third party code-coupling software or proprietary interfaces provided by the CAE software vendors can also be used in conjunction with CFX. Contact those software providers and your CFX service representative for more information.

This guide provides best practice guidelines for Computational Fluid Dynamics (CFD) simulation and documentation of the verification, validation, and demonstration test cases. It describes:

- An Approach to Error Identification, Estimation and Validation (p. 83)
- Definition of Errors in CFD Simulations (p. 84)
- General Best Practice Guidelines (p. 94)
- Selection and Evaluation of Experimental Data (p. 104)

This guide is aimed at users who have moderate or little experience using ANSYS CFX. It is part of a series that provides advice for using ANSYS CFX in specific engineering application areas. The current guidelines are adapted from Best Practice Guidelines developed for the nuclear reactor safety applications [143 (p. 264)].

6.1. An Approach to Error Identification, Estimation and Validation

An evaluation of CFD capabilities has to ensure that the different types of errors are identified and, as far as possible, treated separately. It is known from single-phase studies that the quantification and documentation of modeling errors (as in turbulence models, for example) can be achieved only if the other major sources of errors are reduced below an “acceptable” level. In an ideal world, this would mean, among other demands, that solutions are provided for grids and with timesteps that are fine enough so that numerical errors can be neglected. This is not a trivial task and the separation of errors cannot always be achieved. These difficulties will be greatly increased by the inclusion of multi-phase physics and unsteady effects. Nevertheless, the worst strategy would be to avoid the subject and to provide solutions on a single grid, with a single timestep, and with other uncertainties in initial conditions and boundary conditions not evaluated. This would result in solutions that would be of little use for the validation goals.

An essential quantity in the quality assurance procedure is the definition of target variables. They will mainly be scalar (integral) quantities (for instance, forces, heat transfer rates, and maximum temperature) or one-dimensional distributions, such as the wall heat transfer along a certain line. Convergence studies can be based on these variables without a reference to the grid used in the simulation. They can also be used for an asymptotic evaluation of convergence on unstructured meshes. Even more important, these quantities are of immediate meaning to engineers and allow them to understand the uncertainty from a physical standpoint. A danger of integral or local scalar quantities is that they might not be sensitive enough to detect local changes in the solutions under grid refinement. This should be kept in mind during the analysis.

In order to tackle the problem, it is necessary to first define the different types of errors that can impact a CFD simulation. It is then required that you list the most promising strategies in order to reduce or avoid these errors. Based on these strategies, procedures have to be defined that can be used for the test case simulations.

It might be not possible to rigorously perform the error estimation and reduction procedures described in the following sections for the complex demonstration cases. However, the best attempt should be
made to follow the principal ideas and to avoid single grid solutions without sensitivity studies. For these cases, it is even more important to follow a stringent documentation procedure and to list the possible deficiencies and uncertainties in the simulations.

The strategies for the reduction and evaluation of numerical errors have been developed for single-phase flows. There is no principal difference between the single- and multi-phase flow formulations. They are both based on (ensemble) averaged equations, and are mathematically similar. From a physical standpoint, there are however significant additional challenges due to the presence of the different phases, besides the obviously higher demands on model formulation. One of the additional complication lies in the presence of sharp interfaces between the phases, which require a higher degree of grid resolution than usually necessary for single-phase flows. In addition, multi-phase flows have a higher affinity to physical instabilities that might be suppressed on coarse grids, but appear under grid refinement. (This effect is sometimes also observed in single-phase flows. An example is the blunt trailing edge of an airfoil, where extreme grid refinement will eventually capture the vortex shedding of the mixing layer). It is to be kept in mind that the brute application of procedures might not lead to the desired results. Also in these cases, the spirit behind the guidelines should be followed and carried as far as possible.

Validation studies have to be based on experimental data. These data can introduce significant errors into the comparison. It is therefore required to select the project test cases with attention to potential error sources and experimental uncertainties. Definitions on the different types of test cases as well as on the requirements for the project are given in Selection and Evaluation of Experimental Data (p. 104).

6.2. Definition of Errors in CFD Simulations

CFD simulations have the following potential sources for errors or uncertainties:

- **Numerical Errors** (p. 85)
  
  Numerical errors result from the differences between the exact equations and the discretized equations solved by the CFD code. For consistent discretization schemes, these errors can be reduced by an increased spatial grid density and/or by smaller timesteps.

- **Modeling Errors** (p. 92)
  
  Modeling errors result from the necessity to describe flow phenomena such as turbulence, combustion, and multi-phase flows by empirical models. For turbulent flows, the necessity for using empirical models derives from the excessive computational effort to solve the exact equations with a Direct Numerical Simulation (DNS) approach. Turbulence models are therefore required to bridge the gap between the real flow and the statistically averaged equations. Other examples are combustion models and models for interpenetrating continua, for example, two-fluid models for two-phase flows.

- **User Errors** (p. 92)
  
  User errors result from incorrect use of CFD software and are usually a result of insufficient expertise by the CFD user. Errors can be reduced or avoided by additional training and experience in combination with high-quality project management and by provision and use of Best Practice Guidelines and associated checklists.

- **Application Uncertainties** (p. 93)

1 The Navier-Stokes equations for single-phase, Newtonian fluids
Application uncertainties are related to insufficient information to define a CFD simulation. A typical example is insufficient information on the boundary conditions.

- **Software Errors** (p. 93).

  Software errors are the result of an inconsistency between the documented equations and the actual implementation in the CFD software. They are usually a result of programming errors.

A more detailed definition of the different errors follows.

### 6.2.1. Numerical Errors

Numerical Errors are of the following types:

- **Solution Errors** (p. 85)
- **Spatial Discretization Errors** (p. 86)
- **Time Discretization Errors** (p. 86)
- **Iteration Errors** (p. 88)
- **Round-off Error** (p. 88)
- **Solution Error Estimation** (p. 89)

#### 6.2.1.1. Solution Errors

The most relevant errors from a practical standpoint are solution errors. They are the difference between the exact solution of the model equations and the numerical solution. The relative solution error can be formally defined as:

\[
E_s = \frac{f_{\text{exact}} - f_{\text{numeric}}}{f_{\text{exact}}}
\]  

\textit{Equation 6–1} (p. 85) is valid for every grid point for which the numerical solution exists. A global number can be defined by applying suitable norms, as:

\[
\hat{E}_s = \frac{\|f_{\text{exact}} - f_{\text{numeric}}\|}{\|f_{\text{exact}}\|}
\]  

\textit{Equation 6–2}

The goal of a numerical simulation is to reduce this error below an acceptable limit.

Obviously, this is not a straightforward task, as the exact solution is not known and the error cannot therefore not be computed. Exceptions are simple test cases for code verification where an analytical solution is available.

Given a grid spacing \( \Delta \), and the truncation error order of a consistent discretization scheme, \( p \), a Taylor series can be written to express the exact solution as:

\[ f_{\text{exact}} = f_{\text{numeric}} + \sum_{n=1}^{\infty} \frac{\Delta^n}{n!} \frac{\partial^n f}{\partial x^n} + O(\Delta^{p+1}) \]
In other words, the numerical solution converges towards the exact solution with the $p^{th}$ power of the grid spacing. Analogous definitions are available for time discretization errors.

### 6.2.1.2. Spatial Discretization Errors

Spatial discretization errors are the result of replacing the analytical derivatives or integrals in the exact equations by numerical approximations that have a certain truncation error. The truncation error can be obtained by inserting a Taylor series expansion of the numerical solution into the different terms of the discretized equations:

$$f_{\text{numerical}} = f_{\text{exact}} + \sum_{i=1}^{\infty} c_i f^{(i)} \Delta^i$$  \hspace{1cm} (6-4)

where $f^{(i)}$ is the $i^{th}$ derivative of the exact solution at a given location. An example is a central difference for a spatial derivative:

$$\frac{\partial f}{\partial x} \approx \frac{f_{i+1} - f_{i-1}}{x_{i+1} - x_{i-1}}$$

$$= \left( f_{\text{exact}} + f^{(1)} \Delta x + c_2 f^{(2)} \Delta x^2 + c_3 f^{(3)} \Delta x^3 + \text{HOT} \right) / (2 \Delta x) - \left( f_{\text{exact}} - f^{(1)} \Delta x + c_2 f^{(2)} \Delta x^2 - c_3 f^{(3)} \Delta x^3 + \text{HOT} \right) / (2 \Delta x)$$

$$= f^{(1)} + o(\Delta x^2)$$  \hspace{1cm} (6-5)

This formulation has a truncation error of order 2 and is therefore second-order accurate. The overall truncation error order of the spatial discretization scheme is determined by the lowest order truncation error after all terms have been discretized.

In the $o(\Delta x^2)$ term of Equation 6–5 (p. 86), the leading term is proportional to $f^{(3)} \Delta x^2$. First-order upwind differencing of the convective terms yields truncation errors $o(\Delta x)$ with leading term proportional to $f^{(2)} \Delta x$. This term then contributes to the diffusion term (numerical/false diffusion), which is most dangerous in 3D problems with grid lines not aligned to the flow direction. These schemes enhance the dissipation property of the numerical algorithm (see for example, Ferziger and Peric [141 (p. 264)]) and are not desirable in high-quality CFD simulations.

From a practical standpoint, it is important to understand that for a first-order method, the error is reduced to 50% by a doubling of the grid resolution in each spatial direction. For a second-order method, it is reduced to 25% for the same grid refinement.

### 6.2.1.3. Time Discretization Errors

Time adds another dimension to a CFD simulation. The definition of time discretization errors is therefore similar to the definition of the spatial discretization errors. The spatial discretization usually results in a system of nonlinear algebraic equations of the form:
\[
\frac{\partial \varphi}{\partial t} = g(\varphi)
\]  \hspace{1cm} (6–6)

The error in the time discretization can again be obtained by a Taylor series expansion of the numerical formulation of this equation. With the example of a backward Euler integration:

\[
\frac{\varphi^{n+1} - \varphi^n}{\Delta t} = g(\varphi^{n+1})
\]  \hspace{1cm} (6–7)

the discretization error is:

\[
\frac{\varphi^{n+1} - (\varphi^{n+1} - \varphi^{(1)}) \Delta t + c_2 \varphi^{(2)} \Delta^2 t + \text{HOT}}{\Delta t} = \frac{\partial \varphi^{n+1}}{\partial t} + c_2 \varphi^{(2)} \Delta t + \text{HOT}
\]  \hspace{1cm} (6–8)

The error is therefore first-order for the time derivative.

An additional complication for implicit methods comes from the inclusion of the unknown \(\varphi^{n+1}\) in the right hand side of \textit{Equation 6–7} (p. 87). In order to benefit from an implicit method, a linearization of \(g\) has to be included:

\[
g(\varphi^{n+1}) = g(\varphi^n) + G \frac{\Delta \varphi}{\Delta t} \Delta t + o(\Delta t^2) \quad \text{with} \quad G = \frac{\partial g}{\partial \varphi}
\]  \hspace{1cm} (6–9)

The resulting discretized equation is therefore:

\[
\left[ \frac{1}{\Delta t} - G \right] (\varphi^{n+1} - \varphi^n) = g(\varphi^n)
\]  \hspace{1cm} (6–10)

This constitutes an implicit formulation with first-order accuracy. A second-order time differencing is not compatible with this linearization of the right hand side, as the linearization introduced a first-order error in \(\Delta t\). In order to be able to satisfy the implicit dependency of the right hand side on the time level \(n + 1\) more closely, inner iterations (or coefficient loops) are frequently introduced:

\[
\frac{\varphi^{n+1,m+1} - \varphi^n}{\Delta t} = g(\varphi^{n+1,m+1})
\]  \hspace{1cm} (6–11)

\[
= g(\varphi^{n+1,m}) + G \left( \varphi^{n+1,m+1} - \varphi^{n+1,m} \right) + o \left( \varphi^{n+1,m+1} - \varphi^{n+1,m} \right)^2
\]

where an additional iteration over the index \(m\) is carried out. This equation can be reformulated as:
\[
\left[ \frac{1}{\Delta t} - G \right] \left( \varphi^{n+1,m+1} - \varphi^{n+1,m} \right) = g \left( \varphi^{n+1,m} \right) - \frac{\varphi^{n+1,m} - \varphi^n}{\Delta t}
\]  

(6–12)

This equation can be converged completely (left hand side goes to zero) in \( m \) in order to solve the original exact implicit formulation given by Equation 6–7 (p. 87). It is obvious that it is not necessary to converge the coefficient loop to zero, while the right hand side has a finite (first-order) error in \( \Delta t \). It can be shown that for a first-order time integration, one coefficient loop is consistent with the accuracy of the method. In a case where a second-order accurate scheme is used in the time derivative, two coefficient loops will ensure overall second-order accuracy of the method. Note, however, that this is correct only if the coefficient loops are not under-relaxed in any way.

For explicit methods, no coefficient loops are required and the time discretization error is defined solely from a Taylor series expansion.

### 6.2.1.4. Iteration Errors

The iteration error is similar to the coefficient loop error described above. It occurs in a case where a steady-state solution is sought from an iterative method. In most CFD codes, the iteration is carried out via a (pseudo-) timestepping scheme as given in this example, which also appears above:

\[
\left[ \frac{1}{\Delta t} - G \right] \left( \varphi^{n+1} - \varphi^n \right) = g \left( \varphi^n \right)
\]  

(6–13)

Zero iteration error would mean that the left hand side is converged to zero, leading to the converged solution \( g \left( \varphi \right) = 0 \). However, in practical situations, the iterative process is stopped at a certain level, in order to reduce the numerical effort. The difference between this solution and the fully converged solution defines the iteration error.

The iteration error is usually quantified in terms of a residual or a residual norm. This can be the maximum absolute value of the right hand side, \( g \left( \varphi \right) \), for all grid points, or a root mean square of this quantity. In most CFD methods, the residual is non-dimensionalized to allow for a comparison between different applications with different scaling. However, the non-dimensionalization is different for different CFD codes, making general statements as to the required absolute level of residuals impractical. Typically, the quality of a solution is measured by the overall reduction in the residual, compared to the level at the start of the simulation.

The iteration error should be controlled with the use of the target variables. The value of the target variable can be plotted as a function of the convergence level. In case of iterative convergence, the target variable should remain constant with the convergence level. It is desirable to display the target variable in the solver monitor during the simulation.

### 6.2.1.5. Round-off Error

Another numerical error is the round-off error. It results from the fact that a computer only solves the equations with a finite number of digits (around 8 for single-precision and around 16 for double-precision). Due to the limited number of digits, the computer cannot differentiate between numbers that are different by an amount below the available accuracy. For flow simulations with large-scale differences (for instance, extent of the domain vs. cell size), this can be a problem for single-precision simulations. Round-off errors are often characterized by a random behavior of the numerical solution.
6.2.1.6. Solution Error Estimation

The most practical method to obtain estimates for the solution error is systematic grid refinement or timestep reduction. In the following, the equations for error estimation are given for grid refinement. The same process can be used for timestep refinement.

If the asymptotic range of the convergence properties of the numerical method is reached, the difference between solutions on successively refined grids can be used as an error estimator. This allows the application of Richardson extrapolation to the solutions on the different grids (Roache [139 (p. 263)]). In the asymptotic limit, the solution can be written as follows:

\[ f_{\text{exact}} = f_i + g_i h_i + g_2 h_i^2 + ... \]  \hspace{1cm} (6–14)

In this formulation, \( h \) is the grid spacing (or a linear measure of it) and the \( g_i \) are functions independent of the grid spacing. The subscript, \( i \), refers to the current level of grid resolution. Solutions on different grids are represented by different subscripts.

The assumption for the derivation of an error estimate is that the order of the numerical discretization is known. This is usually the case. Assuming a second-order accurate method, the above expansion can be written for two different grids:

\[ f_{\text{exact}} = f_1 + g_2 h_1^2 + ... \]  \hspace{1cm} (6–15)

\[ f_{\text{exact}} = f_2 + g_2 h_2^2 + ... \]

Neglecting higher-order terms, the unknown function \( g_2 \) can be eliminated from this equation. An estimate for the exact solution is therefore:

\[ f_{\text{exact}} = \frac{h_2^2 f_1 - h_1^2 f_2}{h_2^2 - h_1^2} + \text{HOT} \]  \hspace{1cm} (6–16)

The difference between the fine grid solution and the exact solution (defining the error) is therefore:

\[ E = f_{\text{exact}} - f_1 = \frac{f_1 - f_2}{r^2 - 1} + \text{HOT} \quad \text{with} \quad r = \frac{h_2}{h_1} \]  \hspace{1cm} (6–17)

For an arbitrary order of accuracy, \( p \), of the underlying numerical scheme, the error is given by:

\[ E = f_{\text{exact}} - f_1 = \frac{f_1 - f_2}{r^p - 1} + \text{HOT} \]  \hspace{1cm} (6–18)

In order to build the difference between the solutions \( f_1 \) and \( f_2 \), it is required that the coarse and the fine grid solution is available at the same location. In the case of a doubling of the grid density without a movement of the coarse grid nodes, all information is available on the coarse grid nodes. The applic-
The correction to the fine-grid solution requires an interpolation of the correction to the fine grid nodes (Roache [139 (p. 263)]). In the case of a general grid refinement, the solutions are not available on the same physical locations. An interpolation of the solution between the different grids is then required for a direct error estimate. It has to be ensured that the interpolation error is lower than the solution error in order to avoid a contamination of the estimate.

Richardson interpolation can also be applied to integral quantities (target variables), such as lift or drag coefficients. In this case, no interpolation of the solution between grids is required.

Note that the above derivation is valid only if the underlying method has the same order of accuracy everywhere in the domain and if the coarse grid is already in the asymptotic range (the error decreases with the order of the numerical method). In addition, the method magnifies round-off and iteration errors.

The intention of the Richardson interpolation was originally to improve the solution on the fine grid. This requires an interpolation of the correction to the fine grid and introduces additional inaccuracies into the extrapolated solution, such as errors in the conservation properties of the solution. A more practical use of the Richardson extrapolation is the determination of the relative solution error, \( A_i \):

\[
A_i = \frac{f_i - f_{\text{exact}}}{f_{\text{exact}}} \quad \text{(6–19)}
\]

An estimate, \( E_i \), of this quantity can be derived from Equation 6–16 (p. 89):

\[
A_i = \frac{f_2 - f_1}{f_1} \frac{1}{r^p - 1} \quad \text{(6–20)}
\]

It can be shown (Roache [139 (p. 263)]) that the exact relative error and the approximation are related by:

\[
A_i = E_i + O \left( h^p \right) \quad \text{(6–21)}
\]

Equation 6–20 (p. 90) can also be divided by the range of \( f_i \) or another suitable quantity in order to prevent the error to become infinite as \( f_i \) goes to zero.

In order to arrive at a practical error estimator, the following definitions are proposed:

**Field error:**

\[
A_f = \frac{|f_2 - f_1|}{\text{range} (f_i)} \frac{1}{(r^p - 1)} \quad \text{(6–22)}
\]

**Maximum error:**
\[
A_{\text{max}} = \max \frac{(f_2 - f_i)}{\text{range} (f_i)} \frac{1}{(r_p - 1)} \quad (6-23)
\]

**RMS error:**

\[
A_{\text{rms}} = \frac{\text{rms} (f_2 - f_i)}{\text{range} (f_i)} \frac{1}{(r_p - 1)} \quad (6-24)
\]

**Target variable error:**

\[
A_{\text{rms}} = \frac{|\Theta_1 - \Theta_2|}{|\Theta_1|} \frac{1}{(r_p - 1)} \quad (6-25)
\]

where \(\Theta\) is the defined target variable (list, drag, heat transfer coefficient, maximum temperature, mass flow, and so on).

Similar error measures can be defined for derived variables, which can be specified for each test case. Typical examples would be the total mass flow, the pressure drop, or the overall heat transfer. This will be the recommended strategy, as it avoids the interpolation of solutions between the coarse and the fine grid.

For unstructured meshes, the above considerations are valid only in cases of a global refinement of the mesh. Otherwise, the solution error will not be reduced continuously across the domain. For unstructured refinement the refinement level, \(r\), can be defined as follows:

\[
r_{\text{effective}} = \left( \frac{N_i}{N_2} \right)^{1/D} \quad (6-26)
\]

where \(N_i\) is the number of grid points and \(D\) is the dimension of the problem.

It must be emphasized that these definitions do not impose an upper limit on the real error, but are estimates for the evaluation of the quality of the numerical results. Limitations of the above error estimates are:

- The solution has to be smooth
- The truncation error order of the method has to be known
- The solution has to be sufficiently converged in the iteration domain
- The coarse grid solution has to be in the asymptotic range.

For three-dimensional simulations, the demand that the coarse grid solution be in the asymptotic range is often hard to ensure. It is therefore required to compute the error for three different grid levels, to avoid fortuitous results. If the solution is in the asymptotic range, the following indicator should be close to constant:
6.2.2. Modeling Errors

In industrial CFD methods, numerous physical and chemical models are incorporated. Models are usually applied to avoid the resolution of a large range of scales, which would result in excessive computing requirements.

The classical model used in almost all industrial CFD applications is a turbulence model. It is based on time or ensemble averaging of the equations resulting in the so-called Reynolds Averaged Navier-Stokes (RANS) equations. Due to the averaging procedure, information from the full Navier-Stokes equations is lost. It is supplied back into the code by the turbulence model. The most widely used industrial models are two-equation models, such as the $k-\varepsilon$ or $k-\omega$ models.

The statistical model approach reduces the resolution requirements in time and space by many orders of magnitude, but requires the calibration of model coefficients for certain classes of flows against experimental data. There is a wide variety of models that are introduced to reduce the resolution requirements for CFD simulations, including:

- Turbulence models
- Multi-phase models
- Combustion models
- Radiation models.

In combustion models, the reduction can be both in terms of the chemical species and in terms of the turbulence-combustion interaction. In radiation, the reduction is typically in terms of the wavelength and/or the directional information. For multi-phase flows, it is usually not possible to resolve a large number of individual bubbles or droplets. In this case, the equations are averaged over the different phases to produce continuous distributions for each phase in space and time.

As all of these models are based on a reduction of the ‘real’ physics to a reduced ‘resolution’, information has to be introduced from outside the original equations. This is usually achieved by experimental calibration, or by available DNS (p. 84) results.

Once a model has been selected, the accuracy of the simulation cannot be increased beyond the capabilities of the model. This is the largest factor of uncertainty in CFD methods, as modeling errors can be of the order of 100% or more. These large errors occur in cases where the CFD solution is very sensitive to the model assumptions and where a model is applied outside its range of calibration.

Because of the complexity of industrial simulations, it cannot be ensured that the models available in a given CFD code are suitable for a new application. While in most industrial codes a number of different models are available, there is no a priori criterion as to the selection of the most appropriate one. Successful model selection is largely based on the expertise and the knowledge of the CFD user.

6.2.3. User Errors

User errors result from the inadequate use of the resources available for a CFD simulation. The resources are given by:

- Problem description
• Computing power
• CFD software
• Physical models in the software
• Project time frame.

According to the ERCOFTAC Best Practice Guidelines [140 (p. 263)], some of the sources for user errors are:

• Lack of experience
• Lack of attention to detail or other mistakes.

Often, user errors are related to management errors when insufficient resources are assigned to a project, or inexperienced users are given a too complex application. Typical user errors are:

• Oversimplification of a given problem; for example, geometry, equation system, and so on
• Poor geometry and grid generation
• Use of incorrect boundary conditions
• Selection of non-optimal physical models
• Incorrect or inadequate solver parameters; for example, timestep, and so on
• Acceptance of non-converged solutions
• Post-processing errors.

6.2.4. Application Uncertainties

Application uncertainties result from insufficient knowledge to carry out the simulation. This is in most cases a lack of information on the boundary conditions or of the details of the geometry. A typical example is the lack of detailed information at the inlet. A complete set of inlet boundary conditions is composed of inflow profiles for all transported variables (momentum, energy, turbulence intensity, turbulence length scale, volume fractions, and so on). This information can be supplied from experiments or from a CFD simulation of the upstream flow. In most industrial applications, this information is not known and bulk values are given instead. In some cases, the detailed information can be obtained from a separate CFD simulation (for instance a fully developed pipe inlet flow). In other cases, the boundaries can be moved far enough away from the area of interest to minimize the influence of the required assumptions for the complete specification of the boundary conditions.

Typical application uncertainties are:

• Lack of boundary condition information
• Insufficient information on the geometry
• Uncertainty in experimental data for solution evaluation.

6.2.5. Software Errors

Software errors are defined as any inconsistency in the software package. This includes the code, its documentation, and the technical service support. Software errors occur when the information you have on the equations to be solved by the software is different from the actual equations solved by the code. This difference can be a result of:

• Coding errors (bugs)
• Errors in the graphical user interface (GUI)
• Documentation errors
• Incorrect support information.

6.3. General Best Practice Guidelines

In order to reduce the numerical errors, it is necessary to have procedures for the estimation of the different errors described in Definition of Errors in CFD Simulations (p. 84). The main goal is to reduce the solution error to a minimum with given computer resources.

6.3.1. Avoiding User Errors

User errors are directly related to the expertise, the thoroughness, and the experience of the user. For a given user, these errors can only be minimized by good project management and thorough interaction with others. In case of inexperienced users, day-to-day interaction with a CFD expert/manager is required to avoid major quality problems. A structured work plan with intermediate results is important for intermediate and long-term projects.

A careful study of the CFD code documentation and other literature on the numerical methods as well as the physical models is highly recommended. Furthermore, benchmark studies are recommended to enable you to understand the capabilities and limitations of CFD methods. A comparison of different CFD methods is desirable, but not always possible.

6.3.2. Geometry Generation

Before the grid generation can start, the geometry has to be created or imported from CAD-data. In both cases, attention should be given to:

• The use of a correct coordinate system
• The use of the correct units
• The use of geometrical simplification, for example, symmetry planes
• Local details. In general, geometrical features with dimensions below the local mesh size (for example, wall roughness or porous elements) are not included in the geometrical model. These should be incorporated through a suitable model.

In the case that the geometry is imported from CAD-data, the data should be checked beforehand. Frequently, after the import of CAD-data, the CAD-data has to be adapted (cleaned) before it can be used for mesh generation. It is essential for mesh generation to have closed volumes. The various CAD-data formats do not always contain these closed volumes. Therefore, the CAD-data has to be altered in order to create the closed volumes. It has to be ensured that these changes do not influence the flow to be computed.

6.3.3. Grid Generation

In a CFD analysis, the flow domain is subdivided in a large number of computational cells. All these computational cells together form the so-called mesh or grid. The number of cells in the mesh should be taken sufficiently large, such that an adequate resolution is obtained for the representation of the geometry of the flow domain and the expected flow phenomena in this domain.

A good mesh quality is essential for performing a good CFD analysis. Therefore, assessment of the mesh quality before performing a large and complex CFD analysis is very important. Most of the mesh gener-
ators and CFD solvers offer the possibility of checking the mesh on several cells or mesh parameters, such as aspect ratio, internal angle, face warpage, right handiness, negative volumes, cracks, and tetrahedral quality. The reader is referred to the user guides of the various mesh generators and CFD solvers for more information on these cells and mesh parameters.

Recommendations for grid generation are:

- Avoid high grid stretching ratios.
  - Aspect ratios should not be larger than 20 to 50 in regions away from the boundary.
  - Aspect ratios may be larger than that in unimportant regions.
  - Aspect ratios may, and should, be larger than that in the boundary layers. For well resolved boundary layers at high Re numbers, the near-wall aspect ratios can be of the order of $10^5$–$10^6$.

- Avoid jumps in grid density.
  - Growth factors should be smaller than 1.3.

- Avoid poor grid angles.

- Avoid non-scalable grid topologies. Non-scalable topologies can occur in block-structured grids and are characterized by a deterioration of grid quality under grid refinement.

- Avoid non-orthogonal, for example, unstructured tetrahedral meshes, in (thin) boundary layers.

- Use a finer and more regular grid in critical regions, for example, regions with high gradients or large changes such as shocks.

- Avoid the presence of arbitrary grid interfaces, mesh refinements, or changes in element types in critical regions. An arbitrary grid interface occurs when there is no one-to-one correspondence between the cell faces on both sides of a common interface, between adjacent mesh parts.

If possible, determine the size of the cells adjacent to wall boundaries where turbulence models are used, before grid generation has started.

Numerical diffusion is high when computational cells are created that are not orthogonal to the fluid flow. If possible, avoid computational cells that are not orthogonal to the fluid flow.

Judge the mesh quality by using the possibilities offered by the mesh generator. Most mesh generators offer checks on mesh parameters, such as aspect ratio, internal angle, face warpage, right handiness, negative volumes, cracks, and tetrahedral quality.

It should be demonstrated that the final result of the calculations is independent of the grid that is used. This is usually done by comparison of the results of calculations on grids with different grid sizes.

Some CFD methods allow the application of grid adaptation procedures. In these methods, the grid is refined in critical regions (high truncation errors, large solution gradients, and so on). In these methods, the selection of appropriate indicator functions for the adaptation is essential for the success of the simulations. They should be based on the most important flow features to be computed.

As a general rule, any important shear layer in the flow (boundary layer, mixing layer, free jets, wakes, and so on) should be resolved with at least 10 nodes normal to the layer. This is a very challenging requirement that often requires the use of grids that are aligned with the shear layers.
6.3.4. Model Selection and Application

Modeling errors are the most difficult errors to avoid, as they cannot be reduced systematically. The most important factor for the reduction of modeling errors is the quality of the models available in the CFD package and the experience of the user. There is also a strong interaction between modeling errors and the time and space resolution of the grid. The resolution has to be sufficient for the model selected for the application.

In principle, modeling errors can only be estimated in cases where the validation of the model is ‘close’ to the intended application. Model validation is essential for the level of confidence you can have in a CFD simulation. It is therefore required that you gather all available information on the validation of the selected model, both from the open literature and from the code developers (vendors). In case that CFD is to be applied to a new field, it is recommended that you carry out additional validation studies, in order to gain confidence that the physical models are adequate for the intended simulation.

If several modeling options are available in the code (as is usually the case for turbulence, combustion and multi-phase flow models), it is recommended that you carry out the simulation with different models in order to test the sensitivity of the application with respect to the model selection.

In case you have personal access to a modeling expert in the required area, it is recommended that you interact with the model developer or expert to ensure the optimal selection and use of the model.

6.3.4.1. Turbulence Models

There are different methods for the treatment of turbulent flows. The need for a model results from the inability of CFD simulations to fully resolve all time and length scales of a turbulent motion. In classical CFD methods, the Navier-Stokes equations are usually time- or ensemble-averaged, reducing the resolution requirements by many orders of magnitude. The resulting equations are the RANS (p. 92) equations. Due to the averaging procedure, information is lost, which is then fed back into the equations by a turbulence model.

The amount of information that has to be provided by the turbulence model can be reduced if the large time and length scales of the turbulent motion are resolved. The equations for this so-called Large Eddy Simulation (LES) method are usually filtered over the grid size of the computational cells. All scales smaller than the resolution of the mesh are modeled and all scales larger than the cells are computed. This approach is several orders of magnitude more expensive than a RANS (p. 92) simulation and is therefore not used routinely in industrial flow simulations. It is most appropriate for free shear flows, as the length scales near the solid walls are usually very small and require small cells even for the LES (p. 96) method.

RANS (p. 92) methods are the most widely used approach for CFD simulations of industrial flows. Early methods, using algebraic formulations, have been largely replaced by more general transport equation models, for both implementation and accuracy considerations. The use of algebraic models is not recommended for general flow simulations, due to their limitations in generality and their geometric restrictions. The lowest level of turbulence models that offer sufficient generality and flexibility are two-equation models. They are based on the description of the dominant length and time scale by two independent variables. Models that are more complex have been developed and offer more general platforms for the inclusion of physical effects. The most complex RANS (p. 92) model used in industrial CFD applications are Second Moment Closure (SMC) models. Instead of two equations for the two main turbulent scales, this approach requires the solution of seven transport equations for the independent Reynolds stresses and one length (or related) scale.
The challenge for the user of a CFD method is to select the optimal model for the application at hand from the models available in the CFD method. In most cases, it cannot be specified beforehand which model will offer the highest accuracy. However, there are indications as to the range of applicability of different turbulence closures. This information can be obtained from validation studies carried out with the model.

In addition to the accuracy of the model, consideration has to be given to its numerical properties and the required computer power. It is often observed that more complex models are less robust and require many times more computing power than the additional number of equations would indicate. Frequently, the complex models cannot be converged at all, or, in the worst case, the code becomes unstable and the solution is lost.

It is not trivial to provide general rules and recommendations for the selection and use of turbulence models for complex applications. Different CFD groups have given preference to different models for historical reasons or personal experiences. Even turbulence experts cannot always agree as to which model offers the best cost-performance ratio for a new application.

### 6.3.4.1.1. One-equation Models

A number of one-equation turbulence models based on an equation for the eddy viscosity have been developed over the last years. Typical applications are:

- Airplane- and wing flows
- External automobile aerodynamics
- Flow around ships.

These models have typically been optimized for aerodynamic flows and are not recommended as general-purpose models.

### 6.3.4.1.2. Two-equation Models

The two-equation models are the main-stand of industrial CFD simulations. They offer a good compromise between complexity, accuracy and robustness. The most popular models are the standard model and different versions of the $k-\omega$ model, see Wilcox [30 (p. 247)]. The standard $k-\omega$ model of Wilcox is the most well known of the $k-\omega$ based models, but shows a severe free-stream dependency. It is therefore not recommended for general industrial flow simulations, as the results are strongly dependent on the user input. Alternative formulations are available, see for example, the Shear Stress Transport (SST) model, Menter [9 (p. 244)].

An important weakness of standard two-equation models is that they are insensitive to streamline curvature and system rotation. Particularly for swirling flows, this can lead to an over-prediction of turbulent mixing and to a strong decay of the core vortex. There are curvature correction models available, but they have not been generally validated for complex flows.

The standard two-equation models can also exhibit a strong build-up of turbulence in stagnation regions, due to their modeling of the production terms. Several modifications are available to reduce this effect, for instance by Kato and Launder [128 (p. 262)]. They should be used for flows around rods, blades, airfoils, and so on.

### 6.3.4.1.3. Second Moment Closure (SMC) Models

SMC (p. 96) models are based on the solution of a transport equation for each of the independent Reynolds stresses in combination with the $\varepsilon$- or the $\omega$-equation. These models offer generally a wider...
modeling platform and account for certain effects due to their exact form of the turbulent production terms. Some of these models show the proper sensitivity to swirl and system rotation, which have to be modeled explicitly in a two-equation framework. SMC (p. 96) models are also superior for flows in stagnation regions, where no additional modifications are required.

One of the weak points of the SMC (p. 96) closure is that the same scale equations are used as in the two-equation framework. As the scale equation is typically one of the main sources of uncertainty, it is found that SMC (p. 96) models do not consistently produce superior results compared to the simpler models. In addition, experience has shown that SMC (p. 96) models are often much harder to handle numerically. The model can introduce a strong nonlinearity into the CFD method, leading to numerical problems in many applications.

SMC (p. 96) models are usually not started from a pre-specified initial condition, but from an already available solution from a two-equation (or simpler) model. This reduces some of the numerical problems of the SMC (p. 96) approach. In addition, it offers an important sensitivity study, as it allows quantifying the influence of the turbulence model on the solution. It is therefore recommended that you fully converge the two-equation model solution and save it for a comparison with the SMC (p. 96) model solution. The difference between the solutions is a measure of the influence of the turbulence model and therefore an indication of the modeling uncertainty. This is possible only in steady state simulations. For unsteady flows, the models usually have to be started from the initial condition.

6.3.4.1.4. Large Eddy Simulation Models

LES (p. 96) models are based on the numerical resolution of the large turbulence scales and the modeling of the small scales. LES (p. 96) is not yet a widely used industrial approach, due to the large cost of the required unsteady simulations. For certain classes of applications, LES (p. 96) will be applicable in the near future. The most appropriate area will be free shear flows, where the large scales are of the order of the solution domain (or only an order of magnitude smaller). For boundary layer flows, the resolution requirements are much higher, as the near-wall turbulent length scales become much smaller. The internal flows (pipe flows, channel flows) are in between, as they have a restricted domain in the wall normal direction, but small scales have to be resolved in the other two directions.

LES (p. 96) simulations do not easily lend themselves to the application of grid refinement studies both in the time and the space domain. The main reason is that the turbulence model adjusts itself to the resolution of the grid. Two simulations on different grids are therefore not comparable by asymptotic expansion, as they are based on different levels of the eddy viscosity and therefore on a different resolution of the turbulent scales. From a theoretical standpoint, the problem can be avoided, if the LES (p. 96) model is not based on the grid spacing, but on a pre-specified filter-width. This would allow reaching grid-independent LES (p. 96) solutions above the DNS (p. 84) limit. However, LES (p. 96) is a very expensive method and systematic grid and timestep studies are prohibitive even for a pre-specified filter. It is one of the disturbing facts that LES (p. 96) does not lend itself naturally to quality assurance using classical methods. This property of the LES (p. 96) also indicates that (nonlinear) multigrid methods of convergence acceleration are not suitable in this application.

On a more global level, the grid convergence can be tested using averaged quantities resulting from the LES (p. 96) simulation. The averaged LES (p. 96) results can be analyzed in a similar way as RANS (p. 92) solutions (at least qualitatively). Again, it is expensive to perform several LES (p. 96) simulations and grid refinement will therefore be more the exception than the rule.

Due to the high computing requirements of LES (p. 96), modern developments in the turbulence models focus on a combination of RANS (p. 92) and LES (p. 96) models. The goal is to cover the wall boundary layers with RANS (p. 92) and to allow unsteady (LES (p. 96)-like) solutions in largely separated
and unsteady flow regions (for example, flow behind a building, or other blunt bodies). There are two alternatives of such methods available in ANSYS CFX.

The first alternative is called Scale-Adaptive-Simulation (SAS) model (Menter and Egorov [130 (p. 262)], [131 (p. 262)], [144 (p. 264)], [145 (p. 264)]). It is essentially an improved Unsteady RANS (URANS) method that develops LES (p. 96)-like solutions in unstable flow regimes.

The second alternative is called Detached Eddy Simulation (DES) (Spalart [146 (p. 264)]), implemented in the version of Strelets [58 (p. 251)]. The current recommendation is to use the SAS (p. 99) model, as it has less grid sensitivity than the DES (p. 99) formulation. In case that SAS (p. 99) does not provide an unsteady solution, the DES (p. 99) model should be applied. It should be noted that both model formulations require small timesteps with a Courant number of CFL<1. You are encouraged to read the original references before applying these models.

### 6.3.4.1.5. Wall Boundary Conditions

There are generally three types of boundary conditions that can be applied to a RANS (p. 92) simulation:

- Wall Function Boundary Conditions (p. 99)
- Integration to the wall (low-Reynolds number formulation) (p. 99)
- Mixed formulation (automatic near-wall treatment) (p. 100).

#### 6.3.4.1.5.1. Wall Function Boundary Conditions

Standard wall functions are based on the assumption that the first grid point off the wall (or the first integration point) is located in the universal law-of-the-wall or logarithmic region. Wall functions eliminate the need to resolve the very thin viscous sublayer, leading to a reduction in the number of cells and to a more moderate (and desirable) aspect ratio of the cells (ratio of the longest to the smallest side in a structured grid). High aspect ratios can result in numerical problems due to round-off errors.

On the other hand, standard wall function formulations are difficult to handle, because you have to ensure that the grid resolution near the wall satisfies the wall function requirements. If the grid becomes too coarse, the resolution of the boundary layer is no longer ensured. If the resolution becomes too fine, the first grid spacing can be too small to bridge the viscous sublayer. In this case, the logarithmic profile assumptions are no longer satisfied. You have to ensure that both limits are not overstepped in the grid generation phase.

The lower limit on the grid resolution for standard wall functions is a severe detriment to a systematic grid refinement process, as required by the best practice approach. In other words, instead of an improved accuracy of the solution with grid refinement, the solution will deteriorate from a certain level on, leading eventually to a singularity of the numerical method. Standard wall functions are therefore not recommended for systematic grid refinement studies. Recently, alternative formulations (scalable wall functions) have become available, Menter and Esch [142 (p. 264)], which allow for a systematic grid refinement when using wall functions.

#### 6.3.4.1.5.2. Integration to the wall (low-Reynolds number formulation)

The use of low-Reynolds (low-Re) number formulations of turbulence models for the integration of the equations through the viscous sublayer is generally more accurate, as no additional assumptions are required concerning the variation of the variables near the wall. On the downside, most low-Re extensions of turbulence models are quite complex and can reduce the numerical performance or even destabilize the numerical method. In addition, classical low-Re models require a very fine near-wall resolution of \( y^+ \sim 1 \) at all wall nodes. This is very hard to ensure for all walls of a complex industrial application. In
the case that significantly coarser grids are used, the wall shear stress and the wall heat transfer can be reduced significantly below their correct values.

### 6.3.4.1.5.3. Mixed formulation (automatic near-wall treatment)

In ANSYS CFX, hybrid methods are available for all \( \omega \)-equation based turbulence models (automatic near-wall treatment), which automatically switch from a low-Re formulation to wall functions based on the grid spacing you provide. These formulations provide the optimal boundary condition for a given grid. From a best practice standpoint, they are the most desirable, as they allow for an accurate near-wall treatment over a wide range of grid spacings. However, accurate boundary layer simulations do not depend only on the \( y^+ \) near-wall spacing, but also require a minimum of at least 10 grid nodes inside the boundary layer.

### 6.3.4.1.5.4. Recommendations for Model Selection

- Avoid the use of classical wall functions, as they are inconsistent with grid refinement.
- Avoid strict low-Re number formulations, unless it is ensured that all near-wall cells are within the resolution requirements of the formulation.
- In combination with the \( k-\varepsilon \) model, use scalable wall functions. They can be applied to a range of grids without immediate deterioration of the solution (default in ANSYS CFX).
- For more accurate simulations, use an automatic wall treatment in combination with SST (p. 97) turbulence model (default in ANSYS CFX).

### 6.3.4.2. Heat Transfer Models

The heat transfer formulation is strongly linked to the underlying turbulence model. For eddy viscosity models, the heat transfer simulation is generally based on the analogy between heat and momentum transfer. Given the eddy viscosity of the two-equation model, the heat transfer prediction is based on the introduction of a molecular and a turbulent Prandtl number. The treatment of the energy equation is therefore similar to the treatment of the momentum equations. No additional transport equations are required for the turbulent heat transfer prediction. The boundary conditions are the same as for the momentum equations and follow the same recommendations.

For SMC (p. 96) models, three additional transport equations must be solved for the turbulent heat transfer vector in order to be consistent with the overall closure level. Only a few CFD methods offer this option. In most cases, the heat transfer is computed from an eddy diffusivity with a constant turbulent Prandtl number.

### 6.3.4.3. Multi-Phase Models

Multi-phase models are required in cases where more than one phase is involved in the simulation (phases can also be non-miscible fluids). There is a wide variety of multi-phase flow scenarios, with the two extremes of small-scale mixing of the phases or a total separation of the phases by a sharp interface.

Depending on the flow simulation, different types of models are available. The main distinction of the models is given below.

Lagrange models solve a separate equation for individual particles, bubbles, or droplets in a surrounding fluid. The method integrates the three-dimensional trajectories of the particles based on the forces acting on them from the surrounding fluid and other sources. Turbulence is usually accounted for by a random motion, superimposed on the trajectory.
Lagrange models are usually applied to flows with low particle (bubble) densities. In these flows, the interaction between the particles can usually be neglected, thereby reducing the complexity of the problem significantly.

The Euler-Euler formulation is based on the assumption of interpenetrating continua. A separate set of mass, momentum, and energy conservation equations is solved for each phase. Interphase transfer terms have to be modeled to account for the interaction of the phases. Euler-Euler methods can be applied to separated and dispersed flows by changing the interface transfer model.

Additional models are required for flows with mass transfer between the phases (condensation, evaporation, boiling). These models can be applied in the form of correlations for a large number of particles (bubbles) in a given control volume, or directly at the interface between the resolved phase boundary.

6.3.5. Reduction of Application Uncertainties

Application uncertainties cannot always be avoided because the missing information can frequently not be recovered. The uncertainty can be minimized by interaction with the supplier of the test case. The potential uncertainties have to be documented before the start of the CFD application.

In the case that the assumptions have to be made concerning any input to a CFD analysis, they have to be communicated to the partners in the project. Alternative assumptions have to be proposed and the sensitivity of the solution to these assumptions has to be evaluated by case studies (alteration of inflow profiles, different locations for arbitrary boundary conditions, and so on).

Recommendations are:

- Identify all uncertainties in the numerical setup:
  - Geometry reduction
  - Boundary condition assumptions
  - Arbitrary modeling assumptions, for example, bubble diameter, and so on.
- Perform a sensitivity analysis with at least two settings for each arbitrary parameter.
- Document the sensitivity of the solution on the assumptions.

6.3.6. CFD Simulation

This section provides recommendations concerning the optimal application of a CFD method, once the grids are available and the basic physical models have been defined.

6.3.6.1. Target Variables

In order to monitor numerical errors, it is recommended that you define target variables. The convergence of the numerical scheme can then be checked more easily and without interpolation between different grids. You should select target variables that:

1. Are representative of the goals of the simulation.
2. Are sensitive to numerical treatment and resolution.
   This criteria should help to avoid the use of measures that are insensitive to the resolution, such as pressure-based variables in boundary layer simulations.
3. Can be computed with existing post-processing tools.
4. Can be computed inside the solver and displayed during run-time (optimal).
It is optimal if the variable can be computed during run-time and displayed as part of the convergence history. This enables you to follow the development of the target variable during the iterative process.

### 6.3.6.2. Minimizing Iteration Errors

A first indication of the convergence of the solution to steady state is the reduction in the residuals. Experience shows, however, that different types of flows require different levels of residual reduction. For example, it is found regularly that swirling flows can exhibit significant changes even if the residuals are reduced by more than 5 - 6 orders of magnitude. Other flows are well converged with a reduction of only 3 - 4 orders.

In addition to the residual reduction, it is therefore required to monitor the solution during convergence and to plot the pre-defined target quantities of the simulation as a function of the residual (or the iteration number). A visual observation of the solution at different levels of convergence is recommended.

It is also recommended that you monitor the global balances of conserved variables, such as mass, momentum and energy, vs. the iteration number.

Convergence is therefore monitored and ensured by the following steps:

- Reduce residuals by a pre-specified level and provide residual plots.
- Plot evolution of r.m.s. and maximum residual with iteration number.
- Report global mass balance with iteration number.
- Plot target variables as a function of iteration number or residual level.
- Report target variables as a function of r.m.s. residual (table).

It is desirable to have the target variable written out at every timestep in order to display it during the simulation run.

Depending on the numerical scheme, the recommendations may also be relevant to the iterative convergence within the timestep loop for transient simulations.

### 6.3.6.3. Minimizing Spatial Discretization Errors

Spatial discretization errors result from the numerical order of accuracy of the discretization scheme and from the grid spacing. It is well known that only second- and higher-order space discretization methods are able to produce high quality solutions on realistic grids. First-order methods should therefore be avoided for high quality CFD simulations.

As the order of the scheme is usually given (mostly second-order), spatial discretization errors can be influenced only by the provision of an optimal grid. It is important for the quality of the solution and the applicability of the error estimation procedures defined in *Solution Error Estimation* (p. 89), that the coarse grid already resolves the main features of the flow. This requires that the grid points are concentrated in areas of large solution variation. For the reduction of spatial discretization errors, it is also important to provide a high-quality numerical grid.

For grid convergence tests, the simulations are carried out for a minimum of three grids. The target quantities will be given as a function of the grid density. In addition, an error estimate based on the definition given in *Solution Error Estimation* (p. 89) *(Equation 6–25 (p. 91))* will be carried out. It is also recommended that you compute the quantity given by *Equation 6–27 (p. 92)* to test the assumption of asymptotic convergence.
It is further recommended that the graphical comparison between the experiments and the simulations show the grid influence for some selected examples. The following information should be provided:

- Define target variable as given in *Target Variables* (p. 101).
- Provide three (or more) grids using the same topology (or for unstructured meshes, a uniform refinement over all cells).
- Compute solution on these grids:
  - Ensure convergence of the target variable in the time- or iteration domain. See *Iteration Errors* (p. 88) and *Minimizing Iteration Errors* (p. 102).
  - Compute target variables for these solutions.
- Compute and report error measure for target variable(s) based on *Equation 6–25* (p. 91).
- Plot selected variables for the different grids in one picture.
- Check if the solution is in the asymptotic range using *Equation 6–27* (p. 92).

### 6.3.6.4. Minimizing Time Discretization Errors

In order to reduce time integration errors for unsteady-state simulations, it is recommended that you use at least a second-order-accurate time-discretization scheme. Usually, the relevant frequencies can be estimated beforehand and the timestep can be adjusted to provide at least 10 - 20 steps for each period of the highest relevant frequency. In case of unsteadiness due to a moving front, the timestep should be chosen as a fraction of:

\[
\Delta t \sim \frac{\Delta x}{U}
\]  

(6–28)

with the grid spacing \( \Delta x \) and the front speed \( U \).

It should be noted that under strong grid and timestep refinement, sometimes flow features are resolved that are not relevant for the simulation. An example is the (undesirable) resolution of the vortex shedding at the trailing edge of an airfoil or a turbine blade in a *RANS* (p. 92) simulation for very fine grids and timesteps. Another example is the gradual switch to a *DNS* (p. 84) for the simulation of free surface flows with a *Volume of Fluid* (VOF) method (for example, drop formation, wave excitation for free surfaces, and so on). This is a difficult situation, as it usually means that no grid/timestep converged solution exists below the *DNS* (p. 84) range, which can usually not be achieved.

In principle, the time dependency of the solution can be treated as another dimension of the problem with the definitions in *Solution Error Estimation* (p. 89). However, a four-dimensional grid study would be very demanding. It is therefore more practical to carry out the error estimation in the time domain separately from the space discretization. Under the assumption that a sufficiently fine space discretization is available, the error estimation in the time domain can be performed as a one-dimensional study.

Studies should be carried out with at least two and if possible three different timesteps for one given spatial resolution. Again, the error estimators given in *Solution Error Estimation* (p. 89) (*Equation 6–25* (p. 91)) can be used, if \( \Delta \) is replaced by the timestep. The following information should be provided:

- Unsteady target variables as a function of timestep (graphical representation)
- Error estimate based on *Equation 6–25* (p. 91) for (time averaged) target variables
- Comparison with experimental data for different timesteps.
6.3.6.5. Avoiding Round-Off Errors

Round-off errors are usually not a significant problem. They can occur for high-Reynolds number flows where the boundary layer resolution can lead to very small cells near the wall. The number of digits of a single precision simulation can be insufficient for such cases. The only way to avoid round-off errors with a given CFD code is the use of a double precision version. In case of an erratic behavior of the CFD method, the use of a double precision version is recommended.

6.3.7. Handling Software Errors

Software errors can be detected by verification studies. They are based on a systematic comparison of CFD results with verified solutions (in the optimal case analytical solutions). It is the task of the software developer to ensure the functionality of the software by systematic testing.

In most cases, pre-existing software will be used. It is assumed that all CFD packages have been sufficiently tested to ensure that no software verification studies have to be carried out in the project (except for newly developed modules). In case that two CFD packages give different results for the same application, using the same physical models, the sources for these differences will have to be evaluated. In case of code errors, they will be reported to the code developers and if possible removed.

6.4. Selection and Evaluation of Experimental Data

Because of the necessity to model many of the unresolved details of technical flows, it is necessary to assess the accuracy of the CFD method with the help of experimental data. Experiments are required for the following tasks and purposes:

- Verification of model implementation
- Validation and calibration of statistical models
- Demonstration of model capabilities.

There is no philosophical difference between the different types of test cases. The same test case can be used for the different phases of model development, implementation, validation, and application, depending on the status of the model and the suitability of the data.

6.4.1. Verification Experiments

The purpose of verification tests is to ensure the correct implementation of all numerical and physical models in a CFD method. The best verification data would be the analytical solutions for simple cases that allow testing all relevant implementation aspects of a CFD code and the models implemented. As analytical solutions are not always available, simple experimental test cases are often used instead.

6.4.1.1. Description

For CFD code verification, convergence can be tested against exact analytical solutions like:

- Convection of disturbances by a given flow
- Laminar Couette flow
- Laminar channel flow.

For the verification of newly implemented models, verification can only in limited cases be based on analytical solutions. An example is the terminal rise velocity of a spherical bubble in a calm fluid.
In most other cases, simple experiments are used for the verification. It is recommended that you compute the test cases given by the model developer in the original publication of the model, or other trustworthy publications. Quite often experimental correlations can be applied, without the need for comparison with one specific experiment. For instance for turbulence model verification, the most frequently used correlations are those for flat plate boundary layers.

6.4.1.2. Requirements

The only requirement for verification data is that they allow a judgement of the correct implementation of the code and/or the models. This requires information from other sources concerning the performance of the model for the test case. Strictly speaking, it is not required that the simulations are in good agreement with the data, but that the differences between the simulations and the data are as expected.

The test suite for model verification must be diverse enough to check all aspects of the implementation. As an example, a fully developed channel flow does not allow to test the correct implementation of the convective terms of a transport equation. The test suite should also allow testing the correct interaction of the new model with existing other features of the software.

Software verification for physical models should be carried out in the same environment that the end-user has available. Testing of the new features in an expert environment might miss some of error sources, such as the GUI (p. 94).

Verification cases should be selected before the model is implemented. They must be considered an integral part of the model implementation.

6.4.2. Validation Experiments

The purpose of validation tests is to check the quality of a statistical model for a given flow situation. Validation tests are the only method to ensure that a new model is applicable with confidence to certain types of flows. The more validation tests a model passes with acceptable accuracy, the more generally it can be applied to industrial flows. The goal of validation tests is to minimize and quantify modeling errors. Validation cases are often called building block experiments, as they test different aspects of a CFD code and its physical models. The successful simulation of these building blocks is a prerequisite for a complex industrial flow simulation.

6.4.2.1. Description

Examples of validation cases are flows with a high degree of information required to test the different aspects of the model formulation. In an ideal case, a validation test case should be sufficiently complete to allow for an improvement of the physical models it was designed to evaluate. Increasingly, validation data are obtained from DNS (p. 84) studies. The main limitation here is in the low-Reynolds number and the limited physical complexity of DNS (p. 84) data. Typically, validation cases are geometrically simple and often based on two-dimensional or axisymmetric geometries.

6.4.2.2. Requirements

Validation cases are selected to be as close as possible to the intended application of the model. As an example, the validation of a turbulence model for a flat plate boundary layer does not ensure the applicability of the model to flows with separation (as is known from the \( k-\varepsilon \) model). It is well accepted by the CFD community and by model developers that no model (turbulence, multi-phase or other) will be able to cover all applications with sufficient accuracy. This is the reason why there are always multiple models for each application. The validation cases allow the CFD user to select the most appropriate model for the intended type of application.
Test case selection requires that the main features of the CFD models that are to be tested be clearly identified. They must then be dominant in the validation case. Validation cases are often ‘single physics’ cases, but it will be more and more necessary to validate CFD methods for combined effects.

The requirements for validation cases are that there should be sufficient detail to be able to compute the flow unambiguously and to evaluate the performance of the CFD method for a given target application.

Completeness of information is one of the most important requirements for a validation test case. This includes all information required to run the simulation, like:

- Geometry
- Boundary conditions
- Initial conditions (for unsteady flows)
- Physical effects involved.

While the first three demands are clearly necessary to be able to set up and run the simulation, the knowledge of all physical effects taking place in the experiment is not always considered. However, it is crucial to have a clear understanding of the overall flow in order to be able to judge the quality of a test case. Typical questions are:

- Is the flow steady-state or does it have a large-scale unsteadiness?
- Is the flow two-dimensional (axisymmetric, for example)?
- Are all the relevant physical effects known (multi-phase, transition, and so on)?
- Have any corrections been applied to the data and are they appropriate?
- Was there any measurement/wind or water tunnel interference?

Completeness of information is also essential for the comparison of the simulation results with the experimental data. A validation case should have sufficient detail to identify the sources for the discrepancies between the simulations and the data. This is a vague statement and cannot always be ensured, but a validation experiment should provide more information than isolated point measurements. Profiles and distributions of variables at least in one space dimension should be available (possibly at different locations). More desirable is the availability of field data in two-dimensional measuring planes including flow visualizations.

Completeness also relates to the non-dimensionalization of the data. Frequently the information provided is not sufficient to reconstruct the data in the form required by the validation exercise.

In case that the data provided are not sufficient, the impact of the missing information has to be assessed. Most crucial is the completeness of the data required to set up the simulation. In case of missing information, the influence of this information deficit has to be assessed. Typical examples are incomplete inlet boundary conditions. While the mean flow quantities are often provided, other information required by the method, as profiles for turbulent length scales and volume fractions is frequently missing. The importance of this deficit can be estimated by experience with similar flows and by sensitivity studies during the validation exercise.

Next to the completeness of the data, their quality is of primary importance for a successful validation exercise. The quality of the data is mainly evaluated by error bounds provided by the experimentalists. Unfortunately, most experiments still do not provide this information. Moreover, even if error estimates are available, they cannot exclude systematic errors by the experimentalist.
In addition to error bounds, it is therefore desirable to have an overlap of experimental data that allow testing the consistency of the measurements. Examples are the same data from different experimental techniques. It is also a quality criterion when different experimental groups in different facilities have carried out the same experiment. Consistency can also be judged from total balances, like mass, momentum and energy conservation. Quality and consistency can frequently be checked if validation exercises have already been carried out by other CFD groups, even if they used different models.

The availability of the data has to be considered before any CFD validation is carried out. This includes questions of ownership. For most CFD code developers, data that cannot be shown publicly are much less valuable than freely available experimental results.

### 6.4.3. Demonstration Experiments

The purpose of a demonstration exercise is to build confidence in the ability of a CFD method to simulate complex flows. While validation studies have shown for a number of building block experiments that the physical models can cover the basic aspects of the target application, the demonstration cases test the ability of a method to predict combined effects, including geometrical complexity.

#### 6.4.3.1. Description

For an aerodynamic study, a typical hierarchy would be:

- Verification - Flat plate
- Validation - Airfoil or wing
- Demonstration - Complete aircraft.

Similar hierarchies can be established for other industrial areas.

#### 6.4.3.2. Requirements

Typically, the detail of the experimental data is much lower than for verification or validation cases.

Completeness of information to set up the test case is of similar importance as for validation cases and involves the same aspects as listed below:

- Geometry
- Boundary conditions
- Initial conditions (for unsteady flows)
- Physical effects involved.

Typically, the level of completeness of the data for demonstration cases is much lower than for validation cases. It is therefore even more essential to identify the missing information and to carry out sensitivity studies with respect to these data.

In terms of post-processing, demonstration cases often do not provide a high degree of detail. They are usually not appropriate to identify specific weaknesses in the physical models or the CFD codes. Typically, only the point data or global parameters, as efficiencies, are provided.

Even though the density of data is usually lower, the quality should satisfy the same criteria as for validation cases. Error estimates are desirable and so are independent measurements.
Due to the limited amount of data available, the information is usually not sufficient to carry out consistency checks.

The requirements in terms of availability/openness are usually lower than for validation cases, as the demonstration applies usually to a smaller audience. A demonstration case might be carried out for a single customer or one specific industrial sector. It has to be ensured, as in all cases, that the data can be shown to the target audience of the simulation.
Chapter 7: CFX Best Practices Guide for Cavitation

This guide is part of a series that provides advice for using CFX in specific engineering application areas. It is aimed at users with moderate or little experience using CFX for applications involving cavitation.

This guide describes Liquid Pumps (p. 109).

Cavitation is the formation of vapor bubbles within a liquid where flow dynamics cause the local static pressure to drop below the vapor pressure. The bubbles of vapor usually last a short time, collapsing when they encounter higher pressure. Cavitation should not be confused with boiling. When a liquid boils, thermal energy drives the local temperature to exceed the saturation temperature.

Cavitation is a concern in several application areas, including pumps, inducers, marine propellers, water turbines, and fuel injectors. One of the major problems caused by cavitation is a loss of pressure rise across a pump. Other problems include noise, vibration, and damage to metal components.

The next section discusses the effects of cavitation on the performance of liquid pumps.

7.1. Liquid Pumps

Water pumps must take in water and deliver it at a higher total pressure with an acceptable flow rate. Under certain conditions, cavitation may occur on the low pressure side of the pump, causing a loss of pressure rise and/or flow rate.

Both pump performance without cavitation and the affects of cavitation on performance will be discussed.

7.1.1. Pump Performance without Cavitation

As long as the static pressure remains sufficiently high everywhere in the system, cavitation will not occur. In this case, for a given pump RPM, the pressure rise and flow rate are directly coupled, and can be plotted in a pump performance diagram, as shown below.
7.1.2. Pump Performance with Cavitation

If the inlet total pressure is below the critical value for a particular flow rate and RPM, cavitation will occur causing the pressure rise to diminish. The following performance diagram shows the effect of cavitation on pressure rise.

NPSH is the Net Positive Suction Head, a quantity directly related to the inlet total pressure by the relation:
\[ NPSH = \left( \frac{p_{T,\text{inlet}} - p_v}{\rho g} \right) \]  

(7-1)

where \( p_{T,\text{inlet}} \) is the inlet total pressure, \( p_v \) is the vapor pressure, \( \rho \) is density, and \( g \) is the acceleration due to gravity. As the inlet total pressure drops, so does the NPSH value, and the amount of cavitation increases.

To generate this diagram, RPM and flow rate are fixed, and the pressure rise is measured at progressively lower inlet total pressures. For the part of the test where the inlet total pressure is sufficiently high to prevent cavitation, the pressure rise across the pump is constant, equal to the amount predicted by the first performance diagram. This results in a horizontal trend in the performance curve as the inlet total pressure is dropped. Because the pressure rise remains constant, the total pressure at the outlet drops by the same amount as at the inlet. Using CFX software, a mass flow outlet boundary condition can be specified to fix the flow rate while the inlet total pressure is varied.

When the inlet total pressure reaches a sufficiently low value, cavitation occurs. A further reduction in inlet total pressure causes more cavitation, which almost always causes a large loss of pressure rise. In rare cases, pressure rise can actually increase slightly with small amounts of cavitation. Even in such cases, however, a further increase in cavitation causes a sudden loss of pressure rise. In the lab, the pressure rise will eventually become insufficient to maintain the required flow rate. Using CFX software, the solution will eventually fail to converge. Before this point, data should be collected with a sufficient resolution (sufficiently small changes in inlet pressure) to resolve the part of the performance curve where the pressure starts to drop. The point of cavitation is often marked by the NPSH at which the pressure rise has fallen by a few percent.

### 7.1.3. Procedure for Plotting Performance Curve

1. Set up a simulation with cavitation turned on and pressure levels set high enough to avoid levels of cavitation that significantly affect pressure rise.
   
   If you have trouble getting a converged solution, try running a simulation with cavitation turned off, then use the result as an initial guess for a simulation with cavitation turned on.

2. Run the solver to obtain a solution.

3. Calculate the pressure rise across the pump and the NPSH value, then plot a point in the performance diagram.

4. Lower the pressure boundary condition by about 5% to 10%.

5. Repeat starting from step 2, using the previous solution as the initial guess, until cavitation has caused a significant loss of pump head.

### 7.1.4. Setup

To facilitate setting up typical domain settings for the cavitation of water, you may load a single-domain mesh, then run the template `.ccl` file:

```
CFX/etc/model-templates/cavitating_water.ccl
```

This file should be examined in a text editor before using it so that you understand which settings it specifies.
For the domain fluids list, specify both a liquid and a vapor for the same material. In most cases, it is sufficient to use a constant-density vapor.

Under **Fluid Models** for the domain, it is strongly recommended that you select **Homogeneous Model** under **Multiphase Options**. You do not need to select **Free Surface Model** for the purpose of simulating cavitation.

Under **Fluid Pairs** for the domain, select the fluid pair from the list and, for **Mass Transfer**, set **Option to Cavitation**. Select the **Rayleigh Plesset** cavitation model or a **User Defined Cavitation Model**. For the **Rayleigh Plesset** model, the **Mean Diameter** for cavitation bubbles represents the mean nucleation site diameter and must be specified. The default value of 2e-06 m is a reasonable value in most cases. The **Saturation Pressure** must be defined unless the materials you have selected are the components of a homogeneous binary mixture. In the latter case, the saturation properties will already be defined in the mixture definition, but you may still choose to override the **Saturation Pressure** by specifying it on the **Fluid Pairs** tab.

When initializing the domain, set the volume fraction of vapor to zero and the volume fraction of liquid to unity. These settings (represented by the Automatic setting for **Volume Fraction**) are used by default in CFX.

Set up the problem with one of the following boundary condition combinations:

1. Inlet total pressure and outlet mass flow (recommended)
2. Inlet velocity profile and outlet static pressure

The inlet boundary condition should specify that the volume fraction of vapor is zero.

Turbulence models should be chosen as usual (e.g., k-epsilon or SST). For turbulence induced cavitation, consider using the DES model.

For advection scheme, use high resolution, or a specified blend factor of unity.

If editing a material, remember that the vapor pressure is on an absolute scale; it does not depend on the specified reference pressure.

Cavitation models cannot be combined with other types of interphase mass transfer, such as thermal phase changes.

### 7.1.5. Convergence Tips

If performing a single solution, initially turn off cavitation, then turn on cavitation and use the first set of results as an initial guess.

If performing a series of simulations using one solution to initialize the next, solve the cases in order of decreasing pressure (i.e., approaching cavitation).

### 7.1.6. Post-Processing

A contour plot of volume fraction for the vapor can show where cavitation bubbles exist.

To calculate the inlet and outlet pressures, use the function calculator.
Chapter 8: CFX Best Practices Guide for Combustion

This guide is part of a series that provides advice for using CFX in specific engineering application areas. It is aimed at users with moderate or little experience using CFX for applications involving combustion.

This guide describes:

- Gas Turbine Combustors (p. 113)
- Combustion Modeling in HVAC Cases (p. 115)

8.1. Gas Turbine Combustors

Gas turbines are widely used in stationary and aircraft applications. The combustor receives the working fluid in a compressed state, burns fuel to increase its temperature, and passes it to the turbine. One of the key design goals for the combustor is to achieve a stable combustion process. Another key design goal is to minimize the emission of pollutants, particularly oxides of nitrogen.

8.1.1. Setup

8.1.1.1. Steady State vs. Transient

Most simulations are steady-state, particularly for stationary gas turbines that operate at a constant load.

8.1.1.2. Turbulence Model

The $k - \varepsilon$ turbulence model is used in many applications, but the SST model should be considered for flows with separated boundary layers, and the Reynolds Stress Model is the best choice for highly swirling flows.

8.1.1.3. Reference Pressure

Because of the high inlet pressure, a reference pressure between 4 and 20 atmospheres is common, and depends upon the type of simulation you are running.

8.1.1.4. Combustion Model

The choice of combustion model depends of whether the fuel/oxidant combination is premixed. The following table outlines some of the differences.

<table>
<thead>
<tr>
<th>Premixed Combustion</th>
<th>Non-Premixed Combustion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commonly used for recent stationary gas turbines in power generation.</td>
<td>Typically used for flight engines because it is easier to control variable operating conditions.</td>
</tr>
</tbody>
</table>
### Premixed Combustion

Combustion Models: EDM with product limiter and/or extinction submodels, FRC/EDM combined, Partially Premixed (Turbulent Flame Speed Closure (TFC))

Note that the EDM model usually needs adjusting for premixed combustion (for example, extinction by temperature or by mixing/chemical time scales).

### Non-Premixed Combustion

Combustion Models: EDM, FRC/EDM combined, Flamelet (and, for some cases, also the Premixed model).

For the preliminary analysis of high speed turbulent flow, the Eddy Dissipation combustion model is a sensible choice, but cannot simulate burning velocities or flame position.

The Laminar Flamelet model is applicable for turbulent flow with non-premixed combustion, and provides a robust solution at a low computational expense for multi-step reactions. The Flamelet model uses a chemistry library, meaning that only two additional transport equations are solved to calculate multiple species. As a result, the Flamelet model is a very good choice for modeling the formation of various pollutants during the combustion process. The Flamelet model predicts incomplete combustion to some extent (CO in exhaust gas), which helps to predict reduction in temperature (unlike EDM).

#### 8.1.2. Reactions

During the initial analysis of a combustor, the highest values of temperature and outgoing heat flux are likely to be of primary concern. For this purpose, a single-step Eddy Dissipation reaction can be used. Such a reaction is likely to overpredict the temperature, and will not predict emissions correctly, but can provide a conservative indicator of the expected temperature levels.

Other reaction steps might then be added to the simulation to account for the formation of combustion byproducts. Each reaction step has its own separate time scale. As a result, convergence can become very difficult when a multi-step reaction contains more than about 5 steps.

#### 8.1.3. Convergence Tips

The Equation Class Settings tab in CFX-Pre can be used to set different advection schemes and time scales for each class of equation you are solving. For multi-step Eddy Dissipation reactions, convergence can be improved by temporarily increasing the mass fraction time scale by a factor of about 5-10.

For the Eddy Dissipation Model, multistep convergence can be aided by first running a simplified single-step simulation and using the results from the run as an initial values file for a multi-step run.

You may restart a Flamelet model from a cold solution. You should avoid restarting with the Flamelet model from an EDM solution. You may restart an EDM case from a Flamelet model solution.

The High Resolution advection scheme is always recommended for combustion simulations because it is bounded and prevents over/undershoots. Care must be taken, however, to provide a mesh of sufficient quality to resolve most of the flow features. A very poor mesh will result in the scheme using a blend factor close to zero (therefore not providing a solution as accurate as expected).

For simulations which include Finite Rate Chemistry, small temperature variations can result in large changes in reaction rate. When a solution is converging, temperature values may change sufficiently
to make the solution unstable. To aid convergence, add a TEMPERATURE DAMPING CCL structure within a SOLVER CONTROL block, as follows:

FLOW:
  SOLVER CONTROL:
  TEMPERATURE DAMPING:
    Option = Temperature Damping
    Temperature Damping Limit = <Real number>
    Under Relaxation Factor = <Real number>
  END
  END
END

Depending on the location of the SOLVER CONTROL block, the temperature damping may be applied to a particular domain or phase. Set the Temperature Damping Limit to 0 so that positive damping is always applied. The Under Relaxation Factor can be set to multiply changes in temperature by a value between 0 and 1. You should try a factor of 0.2 if you are having trouble converging a solution.

8.1.4. Post-Processing

Some of the most common plots to create in CFD-Post include:

- Mass Fractions: fuel, O₂, products, intermediate species (CO), pollutants (NO)
- Turbulent Mixing Time Scale (Eddy Dissipation / Turbulent Kinetic Energy)
- Reaction Rates
  The variable "<my reaction>.Molar Reaction Rate" is available for every "Single Step" reaction (EDM, FRC or combined model).
- Plots of the turbulent Damköhler number (the ratio of the turbulent time scale to the chemical time scale)

8.2. Combustion Modeling in HVAC Cases

This section deals with the setup of combustion cases for HVAC simulations, where it is important to accurately model the combustion process. Such processes are known as "combusting fire" simulations, as opposed to "inert fire" simulations.

Using a combusting fire simulation is the most accurate way to model fires in all HVAC cases. It is particularly important in cases when the fire is under-ventilated, or when the ventilation cannot be easily predicted. The drawback is the additional computational expense involved in solving a full combustion model as part of the main solution.

8.2.1. Set Up

Most simulations are set up as transient. The choice of timestep is generally model dependent, but will usually fall into the range 0.5 s to 2 s. The Total Energy heat transfer model should be selected to fully model buoyancy.

Note

When modeling buoyancy, it is very important to correctly specify the buoyancy reference density when opening boundary conditions are used.
The RNG $k-\varepsilon$ turbulence model is a good choice for combusting flows, with either no buoyancy terms in equations or buoyancy terms in both the equations (with $C3=1$). The SST model is also reasonable, but may not converge well for natural convection. The SSG model is accurate, but convergence may be very slow.

The most common fuels used are hydrocarbons such as methane, diesel and petroleum. Cellulosic materials, plastics and wood are also used. The simulation will dictate the type of materials to use as a fuel.

The Eddy Dissipation Model is widely used, combined with an Additional Variable for toxins. The flamelet model is more rigorous, and is a better choice when the fire is under ventilated.

### 8.2.2. Convergence Tips

Convergence can be slowed if care is not taken in the setup of buoyancy and openings.

The presence of an instantaneous fuel supply is sometimes not physical, and can slow convergence. In many transient cases, the amount of fuel available can be controlled by using time-dependent expressions.

### 8.2.3. Post-processing

The most common parameters of interest in a combusting fire model are simulation-dependent, but will usually include one of more of the following:

- Temperature
- Products (including carbon monoxide and other toxins)
- Visibility
- Wall Temperature
- Wall convective and radiative heat fluxes
Chapter 9: CFX Best Practices Guide for HVAC

This guide discusses best practices for setting up, solving, and post processing an HVAC simulation:
9.1. HVAC Simulations
9.2. Convergence Tips

This guide is part of a series that provides advice for using CFX in specific engineering application areas. It is aimed at users with moderate or little experience using CFX for HVAC applications.

9.1. HVAC Simulations

HVAC studies range in scale from single components (such as a radiator) to large and complicated systems (such as a climate control system for a large building).

Physical processes that are commonly modeled in HVAC simulations include:

- Buoyancy
- Thermal radiation
- Conjugate heat transfer (CHT) between fluids and solids.

Typical HVAC systems include the following components:

- Heating/cooling units such as furnaces, heaters, air conditioners, and radiators
- Fans/pumps
- Thermostats.

9.1.1. Setting Up HVAC Simulations

This section discusses how to set up various physical processes, CFD features, and components involved in HVAC simulations.

9.1.1.1. Buoyancy

Most HVAC cases involve flow that is affected by buoyancy. Buoyancy can be activated on the Basic Settings tab of the Domain details view.

Two buoyancy models are available: Full and Boussinesq. These models are automatically selected according to the properties of the selected fluid(s).

- The Full buoyancy model is used if fluid density is a function of temperature and/or pressure (which includes all ideal gases and real fluids). In this case, a Buoyancy Reference Density must be set as the expected average density of the domain.
- The Boussinesq model is used if fluid density is not a function of temperature or pressure. In this case, a Buoyancy Reference Temperature must be set as the expected average temperature of the domain.

1HVAC is a reference to Heating, Ventilation (or Ventilating), and Air Conditioning. Often, it is also used as a reference to refrigeration.
When fluid properties are functions of pressure, the absolute pressure is used to evaluate them. The calculation of absolute pressure requires a Buoyancy Reference Location to be defined, preferably by specifying coordinates.

When modeling fire, it is recommended that you choose a compressible fluid because density variations will be significant. An incompressible fluid should be chosen only if density variations are small (a few percent or less).

**9.1.1.2. Thermal Radiation**

To set the radiation model for a fluid domain, visit the **Fluid Models** panel for that domain and set the following:

**9.1.1.2.1. Thermal Radiation Model**

For HVAC studies, select either **Monte Carlo** or **Discrete Transfer**. If directed radiation is to be modeled, Monte Carlo must be used.

**9.1.1.2.2. Spectral Model**

Select either **Gray** or **Multiband**. Spectral bands are used to discretize the spectrum and should therefore be able to adequately resolve all radiation quantities that depend on wavelength (or frequency or wave number). For HVAC, two bands will usually suffice.

**9.1.1.2.3. Scattering Model**

A scattering model should not be used if you are modeling clear air. The isotropic scattering model should be used if you are modeling air that contains dust or fog.

To set up radiation for a solid domain, visit the **Solid Models** panel for that domain (each solid domain must be set up separately). The only radiation model available for solid domains is Monte Carlo.

**Note**

If any solid domain uses the Monte Carlo radiation model (that is, if it uses radiation at all), then all fluid domains using a radiation model must use the Monte Carlo model.

The material used in a domain that transmits radiation has radiation properties that specify **Absorption Coefficient**, **Scattering Coefficient**, and the **Refractive Index**. These properties may be edited in the **Materials** details view.

**Note**

Radiation modeling cannot be used with Eulerian multiphase simulations.

Thermal radiation properties are specified on the **Boundary Details** panel for each boundary of a domain that transmits radiation. For opaque surfaces, the properties that must be specified are: **Emissivity** and **Diffuse Fraction**. For inlets, outlets, and openings, you may specify either the **Local Temperature** or an **External Blackbody Temperature**.

The Monte Carlo and Discrete Transfer models allow radiation sources to be specified on the **Sources** panel for any subdomain or wall boundary. For subdomains, radiation sources per unit volume are
specified; for boundaries, radiation fluxes are specified. Radiation sources may be directed or isotropic. Multiple isotropic sources and up to one directed source may be specified for any given wall boundary or subdomain.

Material properties related to radiation, thermal radiation properties for boundaries, and source strengths can be specified as expressions that depend on one or more of the built-in variables: Wavelength in Vacuum (or wavelo), Frequency (or freq), Wavenumber in Vacuum (or waveno).

A domain representing an opaque solid should not have a radiation model set. The boundaries of radiation-transmitting domains that interface with such a solid domain should be specified as opaque.

External windows of a room can be modeled as solid domains which interface with the room (air) domain; they may also be modeled as an external boundary of the room domain. In either case, the exterior boundary must be modeled as an opaque wall. A diffuse and a directed radiation source emitted from the opaque surface can be used to simulate sunlight. In order to simulate the motion of the sun, the direction vector for directed radiation can be specified by CEL expressions that depend on time (t). Radiation escaping through a window can be modeled by specifying a non-zero emissivity (to cause radiation absorption) and either:

- Specifying a heat transfer coefficient via a CEL expression that accounts for the thermal energy lost
- Specifying a fixed wall temperature.

When using solid domains that transmit radiation, a spectral radiation model is recommended. If a simulation contains no solid domains that transmit radiation, a gray radiation model can be used for rough calculations but a spectral model should be used for more detailed modeling.

### 9.1.1.3. CHT (Conjugate Heat Transfer) Domains

CHT domains are solid domains that model heat transfer. In CFX, all solid domains must model heat transfer, and are therefore CHT domains. If you do not want to model heat transfer in a particular region, do not assign the mesh for that region to any domain.

Boundaries between domains that model heat transfer have temperatures and thermal fluxes calculated automatically, and should not have thermal boundary conditions specified. External boundaries (which can represent solids that are not explicitly modeled) require the specification of a thermal boundary condition.

Boundary conditions other than thermal boundary conditions (for example, wall roughness) may be specified on the boundaries of a fluid domain that interface with a solid domain.

Sources of thermal energy and/or radiation can be added to a subdomain of a CHT domain.

### 9.1.1.4. Mesh Quality

Ensure that wall boundary layers have adequate mesh resolution. This is important regardless of the type of wall heat transfer: adiabatic, specified temperature, specified heat flux, or heat transfer coefficient.

The mesh resolution in a boundary layer affects the prediction of convective heat transfer and the temperature gradient near the wall. For walls without a specified temperature, the temperature gradient near the wall affects the calculated wall temperature and, consequently, the amount of radiation emitted (provided that the emissivity of the wall is non-zero).
9.1.1.5. **Fans**

Fans should be represented by momentum sources if they are embedded in the domain. Fans can also be represented by an inlet or outlet boundary condition or both.

9.1.1.6. **Thermostats**

A Thermostat can be defined using a User Fortran routine. Refer to [Air Conditioning Simulation in the CFX Tutorials](#) for details.

9.1.1.7. **Collections of Objects**

If your HVAC simulation models a large number of people/equipment/items, consider volumetric sources of heat, CO\textsubscript{2}, and resistances.

9.2. **Convergence Tips**

Buoyancy and coupling between the relevant equations often make convergence difficult. Smaller timesteps may help convergence.
Chapter 10: CFX Best Practices Guide for Multiphase

This guide is part of a series that provides advice for using CFX in specific engineering application areas. It is aimed at users with moderate or little experience using CFX for applications involving multiphase flows.

In the context of CFX, a multiphase flow is a flow composed of more than one fluid. Each fluid may possess its own flow field, or all fluids may share a common flow field. Unlike multicomponent flow\(^1\), the fluids are not mixed on a microscopic scale; rather, they are mixed on a macroscopic scale, with a discernible interface between the fluids. CFX includes a variety of multiphase models to allow the simulation of multiple fluid streams, bubbles, droplets, and free surface flows.

This guide describes:

- **Bubble Columns** (p. 121)
- **Mixing Vessels** (p. 122)
- **Free Surface Applications** (p. 122)

### 10.1. Bubble Columns

Bubble columns are tall gas-liquid contacting vessels and are often used in processes where gas absorption is important (for example, bioreactors to dissolve oxygen in broths) and to limit the exposure of micro-organisms to excessive shear imparted by mechanically driven mixers. There are two types of bubble columns in general use: airlift reactors that use a baffle to separate the riser and downcomer regions, and other columns that do not use a baffle.

#### 10.1.1. Setup

The choice of a steady state or transient simulation depends on the type of simulation you want to analyze. For example, an analysis using a steady-state simulation is often satisfactory for monitoring global quantities. A transient simulation can be used to observe transient effects, such as recirculation zones.

Most bubble columns use two fluids: one continuous fluid and one dispersed fluid. The \( k - \varepsilon \) model is typically used in the continuous fluid, and the dispersed phase zero equation is used for the dispersed phase.

Non-drag forces become less significant with increasing size of the bubble column. For smaller columns, non-drag forces may be significant.

The Grace drag model is recommended, especially for modeling air/water.

A degassing boundary condition is generally employed at the top of the bubble column. The degassing boundary behaves as an outlet boundary to the dispersed phase, but as a wall to the continuous phase.

---

\(^1\)Note that a fluid in a multiphase flow may be a multicomponent mixture.
A reasonable estimate of the time scale is given by a factor of the length of the domain divided by the velocity scale (for example, $0.5 \times \frac{L}{U}$).

### 10.1.2. Convergence Tips

Sometimes, physical instabilities (such as recirculation zones) can result in slow or stalled convergence. In these cases, you can still obtain an indicator of convergence for a global quantity by creating a monitor point at some point in the domain. As a result, you can determine whether values for selected global quantities (such as gas hold-up) are meaningful.

### 10.1.3. Post-Processing

The main design objective for bubble columns is efficient mixing, which is strongly influenced by the dispersed phase. Mixing efficiency can be measured in a number of ways. One example is to measure the gas hold-up in the riser as a function of the superficial gas velocity. This would require solving for the gas volume fraction for a number of simulations, each with a different mass flow rate of the dispersed phase at the sparger. Another option would be to use the same input parameters, this time measuring the liquid velocity in the downcomer.

### 10.2. Mixing Vessels

Mixing vessels are widely used in the chemical industry to optimize mixing and/or heat transfer between fluids. Mixing must be efficient, precise and repeatable to ensure optimum product quality. Quantities of interest may include mixing times, gas hold-up, power draw, local shear and strain rates, and solids distribution. The application of Computational Fluid Dynamics to address these needs results in faster and lower cost design through reduced experimentation, more reliable scale-up, and better understanding of the processes, leading to higher yields and reduced waste.

#### 10.2.1. Setup

Mixing vessels generally use two domains. The impeller domain is a small, rotating domain which encloses the impeller. The rest of the tank is represented by a stationary domain. Different types of domain interfaces are available for the connection between the stationary and the rotating domains. The recommended types are:

- **Frozen Rotor**: faster but cruder
- **Transient**: slower (transient analysis) but much more accurate

The choice of a steady state or transient simulation is dependent on the type of interface that exists between the two domains. Where a Frozen Rotor interface is used, a steady state simulation is usually carried out. Performing a transient simulation allows you to use the transient rotor/stator frame change model to account for transient effects.

The initial guess for velocity can be set to zero in the relative frame for each domain.

### 10.3. Free Surface Applications

Free Surface flow refers to a multiphase situation where the fluids (commonly water and air) are separated by a distinct resolvable interface. Such flows occur, for example, around the hull of a ship, or in a breaking wave.
10.3.1. Setup

The choice of using a steady-state or transient simulation is problem-dependent. There are two models available for free surface flow: homogeneous and inhomogeneous. The homogeneous model can be used when the interface between the two phases remains well defined and none of the dispersed phase becomes entrained in the continuous phase. An example of homogeneous free surface flow is flow in an open channel. A breaking wave is one example of an inhomogeneous flow case.

The same choice of turbulence model as for single phase simulations is appropriate. When using the inhomogeneous model, you should use the homogeneous turbulence option in CFX-Pre. The Buoyancy Reference Density should be set to the density of the least dense fluid.

When setting boundary conditions, the volume fractions can be set up using step functions to set the liquid height at each boundary. An outlet boundary having supercritical flow should use the Supercritical option for Mass And Momentum. This requires that you set the relative pressure of the gas above the free surface at the outlet.

For most free surface applications, the initial conditions can use step functions to set the volume fractions of the phases as a function of height. The initial condition for pressure should be set to hydrostatic conditions for the specified volume fraction initialization and the buoyancy reference density.

The timestep for free surface flows should be based on a L/U (Length/Velocity) scale. The length scale should be a geometric length scale. The velocity scale should be the maximum of a representative flow velocity and a buoyant velocity, which is given by:

$$U_{buoyant} = \sqrt{gL}$$

In addition, it is sometimes helpful to reduce the timestep for the volume fraction equations by an order of magnitude below that of the other equations.

10.3.2. Convergence Tips

The interface between the liquid and gas phase can sometimes become blurry. This could be due to physical properties (such as a breaking wave or sloshing in a vessel). Where the dispersed phase becomes entrained in the continuous phase, the inhomogeneous model is a better choice.

A technique to increase the mesh density in the region of a liquid-gas interface is to create a subdomain which occupies the same region as the liquid (or gas) phase, and inflate the mesh in both directions from the edge of the subdomain, as shown in Figure 10.1 (p. 124). The inflation layers can increase the resolution in the region of the interface and enhance the results.
10.4. Multiphase Flow with Turbulence Dispersion Force

For Release 14, in order to reduce convergence difficulties encountered in some multiphase flow problems, the value of the expert parameter $g_{gi \_ap \_relaxation}$ is multiplied internally by 0.75. This occurs in the following situation only:

- Multiphase flow
- Nontrivial turbulence dispersion force included
- Coupled volume fraction solution algorithm.

In this situation, the default value of 1.0 is converted internally to 0.75. If you override the default with a smaller value, the new value is also multiplied internally by 0.75. This ensures that you retain some control over this parameter. The above restrictions ensure that the numerics changes are focused on a narrow range of problems and do not deteriorate convergence of other classes of problems.
Chapter 11: CFX Best Practices Guide for Turbomachinery

Turbomachinery applications can generally be divided into three main categories: gas compressors and turbines, liquid pumps and turbines, and fans and blowers. Each category is discussed in a separate section below.

This guide describes best practices for setting up simulations involving:

11.1. Gas Compressors and Turbines
11.2. Liquid Pumps and Turbines
11.3. Fans and Blowers
11.4. Frame Change Models
11.5. Domain Interface Setup

This guide is part of a series that provides advice for using CFX in specific engineering application areas. It is aimed at users with moderate or little experience using CFX for applications involving turbomachinery.

11.1. Gas Compressors and Turbines

This section describes:

- Setup for Simulations of Gas Compressors and Turbines (p. 125)
- Convergence Tips (p. 126)
- Post-Processing (p. 126)

11.1.1. Setup for Simulations of Gas Compressors and Turbines

Heat transfer and viscous work are involved, and can be modeled by using the Total Energy heat transfer model and enabling the Viscous Work Term option in CFX-Pre.

The industry-standard $k - \omega$ turbulence model is widely used, and the Shear Stress Transport model is also a good choice for these cases. When using the Shear Stress Transport model, ensure a resolution of the boundary layer of more than 10 points. For details, see The k-omega and SST Models in the CFX-Solver Modeling Guide.

A common boundary condition configuration is to specify the total pressure and total temperature at the inlet and the mass flow at the outlet. Other configurations are also commonly used.

A good estimate of the timestep is within the region $0.1/\omega$ to $1/\omega$, where $\omega$ is the angular velocity of the rotating domain in radians per second. Selecting an automatic timestep will result in a timestep of $0.2/\omega$.

The second-order high-resolution advection scheme is generally recommended.
11.1.2. Convergence Tips

For high speed compressors where a specified mass flow outlet boundary condition is applied, the flow can “choke” when the velocity approaches Mach 1, resulting in possible solver failure. A suggested workaround to this problem is to run the simulation using a static pressure outlet, which is more stable.

If you have trouble converging a simulation involving real gases, try to obtain a solution first using an ideal gas. Ideal gases are available in the real gas library.

If you have trouble converging a problem with many stages, you may find that solving for a reduced number of stages can give you a better understanding of the physics, and may allow you to restart a multi-stage problem with a better initial guess. You can also try ramping up boundary conditions and the RPM.

Low pressure ratio Gas compressors (1.1 or less) can be treated more like liquid pumps. For details, see Liquid Pumps and Turbines (p. 127).

11.1.3. Post-Processing

CFD-Post offers a powerful array of post-processing tools for turbomachinery applications, including turbo-specific plots and performance calculation macros. To use many of the Turbo Post tools, you must first initialize each domain by specifying the locations of turbo regions and instancing information.

The Turbo Calculator from the Turbo menu in CFD-Post allows you to perform calculations on the type of application you are modeling. The macro prints a report in HTML showing a number of calculated variables, including torque, head and flow coefficients, blade loading, and efficiency.

You can also create your own macros to customize post-processing using Power Syntax, which is based on the Perl language.

The optimal performance characteristics can be determined by creating a curve of pressure ratio versus flow rate.

Figure 11.1 Flow Rate vs Pressure Rise for a Gas Compressor
In Figure 11.1 (p. 126), Region 1 shows an area where a large change in mass flow rate represents a small change in pressure rise. When modeling flow in this region, a mass flow rate specified outlet is better than a pressure specified outlet. Region 2 shows an area where a small change in flow rate represents a large pressure variation. This region is close to “choking”, and a pressure-specified outlet is the best choice. For details, see Convergence Tips (p. 126).

If a total pressure inlet boundary condition is used (recommended), it will also provide a useful starting point for streamlines that are colored by total pressure during post-processing. The uniform total pressure distribution means lines will begin with a uniform color. It may be harder to visually resolve these pressure values if an inlet velocity profile is used.

CFD-Post provides a performance macro for gas compressors and turbines.

### 11.2. Liquid Pumps and Turbines

This section describes:

- Setup for Simulations of Liquid Pumps and Turbines (p. 127)
- Convergence Tips (p. 127)
- Post-Processing (p. 128)

#### 11.2.1. Setup for Simulations of Liquid Pumps and Turbines

Heat transfer is not significant in most cases, so the heat transfer option can be set to None in CFX-Pre.

The $k - \varepsilon$ and Shear Stress Transport models are appropriate choices for modeling turbulence. When using the Shear Stress Transport model, ensure a resolution of the boundary layer of more than 10 points. For details, see The $k$-epsilon Model in the CFX-Solver Modeling Guide.

When setting boundary conditions, a total pressure specified inlet and a mass flow outlet are a recommended practice. The total pressure inlet condition is often more appropriate than the uniform velocity or massflow inlet condition for cases that assume that the machine is drawing fluid directly from a static reservoir.

As with gas compressors, a good estimate of the timestep is within the region $0.1/\omega$ to $1/\omega$, where $\omega$ is the angular velocity of the rotating domain in radians per second. Selecting an automatic timestep will result in a timestep of $0.2/\omega$.

The high-resolution advection scheme is recommended.

This document deals with obtaining solutions for cases without cavitation, but cavitation may be present. For advice on how to deal with cavitation, see CFX Best Practices Guide for Cavitation (p. 109).

#### 11.2.2. Convergence Tips

When only a poor initial guess is available, it may be helpful to first run with a specified mass flow inlet and a static pressure outlet. The outlet pressure in this case is fairly arbitrary and is usually set at, or close to zero to reduce round-off error. The specification of a mass flow inlet may be more robust. However, a mass flow inlet assumes a uniform inlet velocity which may not be appropriate. Once the overall flow is established, the boundary conditions may then be changed to total pressure at the inlet and mass flow at the outlet.
11.2.3. Post-Processing

If a total pressure inlet boundary condition is used (recommended where possible), it will also provide a useful starting point for streamlines that are colored by total pressure during post-processing. The uniform total pressure distribution means lines will begin with a uniform color. It may be harder to visually resolve these pressure values if an inlet velocity profile is used.

CFD-Post provides a performance macro for liquid pumps and turbines.

11.3. Fans and Blowers

This section describes:

• Setup for Simulations of Fans and Blowers (p. 128)
• Convergence Tips (p. 128)
• Post-Processing (p. 128)

11.3.1. Setup for Simulations of Fans and Blowers

Fans and blowers behave like liquid pumps, and require a similar model setup. The flow is generally modeled as incompressible and isothermal. The fluid is typically air as a general fluid or as an ideal gas at a specified temperature. The $k - \varepsilon$ or SST model is used to model turbulence.

Boundary conditions, turbulence models and choice of timestep are the same as for liquid pumps and turbines.

11.3.2. Convergence Tips

The use of the alternate rotation model is an important consideration when modeling fans and blowers. Where long axisymmetric inlets exist, the absolute frame velocity has less swirl than the relative frame velocity. Because the alternate rotation model solves for the absolute frame velocity, it can reduce numerical error in such inlet sections. The model may introduce errors in the exit stream if the flow is highly swirling. Hence, the length of the inlet and exit sections can be an important factor when choosing whether to implement the model. The alternate rotation model is generally recommended, especially for axial fans. In most realistic flow situations, this model reduces (or at least will not increase) numerical errors.

Airfoil drag is significant and boundary layer friction is an important modeling issue for fans and blowers. A good resolution of the boundary layer, requiring a high concentration of nodes close to the blade surfaces, is therefore important. The Shear Stress Transport model can provide relatively accurate results where the boundary layer is sufficiently resolved by the mesh.

11.3.3. Post-Processing

A similar post-processing approach to pumps and turbines is also useful for fans and blowers. For details, see Post-Processing (p. 128). See the following figure for a plot of flow rate vs pressure rise for a blower.
11.4. Frame Change Models

When specifying domain interfaces in CFX-Pre, you must select the type of analysis that will be carried out in the solver. The choices are:

- **Frozen Rotor** (p. 129)
- **Stage** (p. 129)
- **Transient Rotor-Stator** (p. 130)

### 11.4.1. Frozen Rotor

The Frozen Rotor model treats the flow from one component to the next by changing the frame of reference while maintaining the relative position of the components. Usually, periodicity is used to reduce the number of components to a subset that has approximately the same pitch ratio as the full geometry. To account for differences in pitch ratio between the subset and the full geometry, the flow passing through the interface is scaled according to the net pitch ratio of the subsets.

The Frozen Rotor model must be used for non-axisymmetric flow domains, such as impeller/volute, turbine/draft tube, propeller/ship and scroll/volute cases. It can also be used for axial compressors and turbines. The Frozen Rotor model has the advantages of being robust, using less computer resources than the other frame change models, and being well suited for high blade counts. The drawbacks of the model include inadequate prediction of physics for local flow values and sensitivity of the results to the relative position of the rotor and stator for tightly coupled components.

### 11.4.2. Stage

The Stage model circumferentially averages the fluxes in bands and transmits the average fluxes to the downstream component. Possible applications include axial turbines, compressors and pumps, as well as fans and torque converters. The model is useful for large pitch ratios and still takes a relatively short time to solve. The model is not suitable for applications with tight coupling of components and/or significant wake interaction effects and may not accurately predict loading.
11.4.3. Transient Rotor-Stator

The Transient Rotor-Stator model takes into account all of the transient flow characteristics. A sliding interface is used to allow a smooth rotation between components. As with the Frozen Rotor model, the Transient Rotor-Stator model scales the flow from one component to the next in order to account for a non-unity net pitch ratio. This model is robust and yields high accuracy predictions of loading. The drawbacks include high computational cost and large amounts of storage required to hold the transient data.

11.5. Domain Interface Setup

The setup of domain interfaces is an important consideration when defining a problem. The following section outlines some approved practices for use in turbomachinery applications.

11.5.1. General Considerations

- Domain interfaces should typically be placed midway between the rotor and stator for turbomachinery cases.
- To avoid numerical errors, the aspect ratio of elements on the domain interface should be between 0.1:1 and 10:1, as measured by x/y in Figure 11.2 (p. 130).
- Where circular domain interfaces exist, they must be axisymmetric in shape as shown in Figure 11.3 (p. 131).

11.5.2. Case 1: Impeller/Volute

A basic impeller/volute sketch is shown in Figure 11.3 (p. 131). The edge of the inner circle shows the maximum extent of the impeller blades. A good practice here is to create the domain interface halfway across the narrowest gap between the blade and volute wall. This usually occurs around the cut-off or “tongue” illustrated in the diagram.
11.5.3. Case 2: Step Change Between Rotor and Stator

For the case shown, there is a step change in the passage height between the rotor and stator. A common choice for placement of the interface would be choice 1. However, take care with this setup because the non-overlap regions of the interface should be specified as walls. A better alternative may be to use a domain interface upstream or downstream of the step change, at position 2 or position 3.

11.5.4. Case 3: Blade Passage at or Close to the Edge of a Domain

*Figure 11.5 (p. 132)* shows a blade which extends to the edge of the rotating domain. Although it is convenient to place a domain interface at the blade edge (1), this can result in unrealistic results (The area of the interface would be reduced on one side where the interface is displaced by the blade edge, resulting in an inaccurate pitch change calculation. Also, in the case of a stage interface, the wake would
be mixed out at the trailing edge.) A better arrangement is to extend the rotating domain away from the blade edge. Domain Interfaces can then be created at (2), (3), and (4).

**Figure 11.5 Radial Compressor**

11.5.5. Case 4: Impeller Leakage

A close-up view of part of Figure 11.5 (p. 132), which models flow leaking from a volute back into the impeller region. To model the feature, you can use two domain interfaces (at positions 1 and 2), or a single domain interface downstream of the leak (position 3).
11.5.6. Case 5: Domain Interface Near Zone of Reversed Flow

Be wary of flow moving backwards across stage or frozen rotor interfaces. Because of the approximations implied by these interfaces, flow moving upstream and downstream on the same interface will lead to unphysical results. Try relocating the interface to prevent this from occurring.

As an example, Figure 11.7 (p. 134) shows two blade rows of an axial machine with a frozen rotor interface between them. The flow moves from left to right everywhere except in a small region just downstream of the trailing edge of the first row of blades. In this case, the domain interface, shown as a dashed line, should be located to the right of this region, as shown.
Figure 11.7 Domain Interface Between Blade Rows in an Axial Machine
Chapter 12: CFX Command Language (CCL)

The CFX Command Language (CCL) is the internal communication and command language of ANSYS CFX. It is a simple language that can be used to create objects or perform actions in the post-processor. All CCL statements can be classified into one of three categories:

• Object and parameter definitions, which are described in Object Creation and Deletion.
• CCL actions, which are commands that perform a specific task (such as reading a session file) and which are described in Command Actions in the CFD-Post User's Guide.
• Power Syntax programming, which uses the Perl programming language to allow loops, logic, and custom macros (subroutines). Power Syntax enables you to embed Perl commands into CCL to achieve powerful quantitative post-processing. For details, see Power Syntax in ANSYS CFX (p. 229).

State files and session files contain object definitions in CCL. In addition, session files can also contain CCL action commands. You can view and modify the CCL in these files by using a text editor.

For more information, see Object Creation and Deletion.

12.1. CFX Command Language (CCL) Syntax

The following topics will be discussed:

• Basic Terminology (p. 135)
• The Data Hierarchy (p. 136)
• Simple Syntax Details (p. 136)
  – Case Sensitivity (p. 136)
  – CCL Names Definition (p. 137)
  – Indentation (p. 137)
  – End of Line Comment Character (p. 137)
  – Continuation Character (p. 137)
  – Named Objects (p. 137)
  – Singleton Objects (p. 137)
  – Parameters (p. 137)
  – Lists (p. 138)
  – Parameter Values (p. 138)
  – Escape Character (p. 139)

12.1.1. Basic Terminology

The following is an example of a CCL object that defines an isosurface.
ISOSURFACE: Iso1
  Variable = Pressure
  Value = 15000 [Pa]
  Color = 1,0,0
  Transparency = 0.5
END

- **ISOSURFACE** is an object type
- **Iso1** is an object name
- **Variable = Pressure** is a parameter
- **Variable** is a parameter name
- **Pressure** is a parameter value
- If the object type does not need a name, it is called a singleton object. Only one object of a given singleton type can exist.

### 12.1.2. The Data Hierarchy

Data is entered via parameters. These are grouped into objects that are stored in a tree structure.

```
OBJECT1: object name
  name1 = value
  name2 = value
END
```

Objects and parameters may be placed in any order, provided that the information is set prior to being used further down the file. If data is set in one place and modified in another, the latter definition overrides the first.

In CFD-Post, all object definitions are only one object level deep (that is, objects contain parameters, but not other objects).

### 12.1.3. Simple Syntax Details

The following applies to any line that is not a Power Syntax or action line (that is, the line does not start with a ! or >).

#### 12.1.3.1. Case Sensitivity

Everything in the file is sensitive to case.

Case sensitivity is not ideal for typing in many long parameter names, but it is essential for bringing the CFX Expression Language (CEL) into CCL. This is because some names used to define CCL objects (such as **Fluids**, **Materials** and **Additional Variables**) are used to construct corresponding CEL names.

For simplicity and consistency, the following is implemented:

- Singletons and object types use upper case only.
- Parameter names, and predefined object names, are mixed case. The CFX Expression Language tries to follow the following conventions:
  1. Major words start with an upper case letter, while minor words such as prepositions and conjunctions are left in lower case (for example, **Mass Flow in**).
  2. Case is preserved for familiar names (for variables $k$ or $\tau$), or for abbreviation **RNG**.
12.1.3.2. CCL Names Definition

Names of singletons, types of object, names of objects, and names of parameters all follow the same rules:

- In simple syntax, a CCL name must be at least one character. This first character must be alphabetic; there may be any number of subsequent characters and these can be alphabetic, numeric, space or tab.
- The effects of spaces in CCL names are:
  - Spaces appearing before or after a name are not considered to be part of the name.
  - Single spaces appearing inside a name are significant.
  - Multiple spaces and tabs appearing inside a name are treated as a single space.

12.1.3.3. Indentation

Nothing in the file is sensitive to indentation, but indentation can be used for easier reading.

12.1.3.4. End of Line Comment Character

The `#` character is used for this. Any text to the right of this character will be treated as comments. Any characters may be used within comments.

12.1.3.5. Continuation Character

If a line ends with the character `\`, the following line will be linked to the existing line. There is no restriction on the number of continuation lines.

12.1.3.6. Named Objects

A named object consists of an object type at the start of a line, followed by a `:` and an object name. Subsequent lines may define parameters and child objects associated with this object. The object definition is terminated by the string `END` on a line by itself.

Object names must be unique within the given scope, and the name must not contain an underscore.

12.1.3.7. Singleton Objects

A singleton object consists of an object type at the start of a line, followed by a `:`. Subsequent lines may define parameters and child objects associated with this object. The object definition is terminated by the string `END` on a line by itself.

The difference between a singleton object and a named object is that (after the data has been processed), a singleton can appear just once as the child of a parent object. However, there may be several instances of a named object of the same type defined with different names.

12.1.3.8. Parameters

A parameter consists of a parameter name at the start of a line followed by an `=` character followed by a parameter value. A parameter may belong to many different object types. For example, `U Velocity`
= 1.0 \ [m/s] \ may \ belong \ to \ an \ initial \ value \ object \ and \ U \ Velocity \ = \ 2.0 \ [m/s] \ may \ belong \ to \ a \ boundary \ condition \ object. \ Both \ refer \ to \ the \ same \ definition \ of \ U \ velocity \ in \ the \ rules \ file.

12.1.3.9. Lists

Lists are used within the context of parameter values and are comma separated.

12.1.3.10. Parameter Values

All parameter values are initially handled as data of type String, and should first of all conform to the following definition of allowed String values:

12.1.3.10.1. String

• Any characters can be used in a parameter value.
• String values or other parameter type values are normally unquoted. If any quotes are present, they are considered part of the value. Leading and trailing spaces are ignored. Internal spaces in parameter values are preserved as given, although a given application is free to subsequently assume a space condensation rule when using the data.
• The characters $ and # have a special meaning. A string beginning with $ is evaluated as a Power Syntax variable, even if it occurs within a simple syntax statement. This is useful for performing more complex Power Syntax variable manipulation, and then using the result as part of a parameter or object definition. The appearance of # anywhere in the CCL file denotes the start of a comment.
• The characters such as [, ], { and } are special only if used in conjunction with $. Following a $, such characters terminate the preceding Perl variable name.
• Other characters that might be special elsewhere in power syntax are escaped automatically when they appear in parameter values. For example, @, % and & are escaped automatically (that is, you do not need to precede these characters with the escape character \ when using them in parameter values).
• Parameter values can contain commas, but if the string is processed as a List or part of a List then the commas may be interpreted as separators (see below under List data types).

Some examples of valid parameter values using special characters in power syntax are:

- Estimated cost = \$500
- Title = Run\#1
- Sys Command = "echo 'Starting up Stress solver' ; fred.exe &"
- Pressure = $myArray[4]
- Option = $myHash("foo")
- Fuel = C$\{numberCatoms\}H$\{numberHatoms\}

Parameter values for data types other than String will additionally conform to one of the following definitions.

12.1.3.10.2. String List

A list of string items separated by commas. Items in a String List should not contain a comma unless contained between parentheses. One exception can be made if the String List to be is interpreted as a Real List (see below). Otherwise, each item in the String List follows the same rules as String data.

names = one, two, three, four
12.1.3.10.3. Integer

Sequence of digits containing no spaces or commas. If a real is specified when an integer is needed, the real is rounded to the nearest integer.

12.1.3.10.4. Integer List

List of integers, separated by commas.

12.1.3.10.5. Real

A single-precision real number that may be specified in integer, floating point, or scientific format, followed optionally by a dimension. Units use the same syntax as CEL.

Expressions are allowed to include commas inside function call argument lists.

Example usage:

```
a = 12.24
a = 1.224E01
a = 12.24 [m s^-1]
```

A real may also be specified as an expression such as:

```
a = myvel^2 + b
a = max(b,2.0)
```

12.1.3.10.6. Real List

List of reals, comma separated. Note that all items in the list must have the same dimensions. Items that are expressions may include commas inside function call argument lists, and the enclosed commas will be ignored when the list is parsed into individual items. Example usage:

```
a = 1.0 [m/s], 2.0 [m/s], 3.0 [m/s], 2.0*myvel, 4.0 [cm/s]
```

The list syntax 5*2.0 to represent 5 entries of the value 2.0 is not supported within CCL and hence within CFD-Post.

12.1.3.10.7. Logical

Several forms are acceptable: YES, TRUE, 1 or ON are all equivalent; NO or FALSE or 0 or OFF are all equivalent; initial letter variants Y, T, N, F are accepted (O is not accepted for On/Off); all case variants are accepted. Logical strings are also case insensitive (YeS, nO).

12.1.3.10.8. Logical List

List of logicals, separated by commas.

12.1.3.11. Escape Character

The \ character to be used as an escape character, for example, to allow $ or # to be used in strings.
Chapter 13: CFX Expression Language (CEL)

CFX Expression Language (CEL) is an interpreted, declarative language that has been developed to enable CFX users to enhance their simulations without recourse to writing and linking separate external Fortran routines.

You can use CEL expressions anywhere a value is required for input in ANSYS CFX.

CEL can be used to:

• Define material properties that depend on other variables.
• Specify complex boundary conditions.
• Add terms to the solved equations.

You can also monitor the value of an expression during the solution using monitor points.

**Important**

There is some CEL that works elsewhere in ANSYS CFX, but not in CFD-Post. Any expression created in CFX-Pre and used as a Design Exploration output parameter could potentially cause fatal errors during the Design Exploration run, so you should create all expressions for Design Exploration output parameters in CFD-Post.

This chapter describes:

13.1. CEL Fundamentals
13.2. CEL Operators, Constants, and Expressions
13.3. CEL Examples
13.4. CEL Technical Details

### 13.1. CEL Fundamentals

The following topics will be discussed:

• *Values and Expressions* (p. 141)
• *CFX Expression Language Statements* (p. 142)

### 13.1.1. Values and Expressions

CEL can be used to generate both values and expressions. Values are dimensional (that is, with units) or dimensionless constants. The simplest type of definition is the dimensionless value, for example:

\[ b = 3.743 \]

You can also specify a value with units, for example:

\[ g = 9.81 \text{ [m s}^{-2}\text{]} \]
The dimensions of the quantities of interest for CFD calculations can be written in terms of mass, length, time, temperature and angle. The concept of units is fundamental to the behavior of values and expressions.

Values can be used directly, or they can be used as part of an expression. For example, you can use an expression to add two values together:

\[ <\text{Expr}_1> = <\text{Value}_1> + <\text{Value}_2> \]

In this example, you may want to predefine \(<\text{Value}_1>\) and \(<\text{Value}_2>\), but this is not required. However, in order to add two quantities together, \(they must have the same dimension\); that is, it is meaningful to add a quantity in inches to one expressed in meters, but it is not meaningful to add one expressed in kilograms to one in square feet.

Expressions can also be functions of other (predefined) expressions:

\[ <\text{Expr}_2> = <\text{Expr}_1> + <\text{Value}_3> \]

Units follow the conventions in the rest of CFX, in that a calculation has a set of solution units (by default, SI units), and that any quantity can be defined either in terms of the solution units, or any other set of units with the correct form.

An expression does not have its own units string, but if it references quantities that have dimensions, these will determine the resulting units for the expression. For example, if an expression depends inversely on the square of the \(x\) coordinate, then it has \(implied\) \(dimensions\) of length to the power \(-2\).

### 13.1.1.1. Using Locators in Expressions

A CFX simulation has physics areas and mesh areas; physics areas are boundaries while mesh areas are regions. These two types of area can occupy completely different spaces in a simulation; however, there is no requirement that area names be unique between physics and mesh. This can lead to ambiguities when you use these names in expressions.

To avoid these ambiguities, ANSYS CFX first checks to see if \("@<\text{locator}>"\) is a physics name; if this is not found, the name is checked in the list of mesh names. Thus if \("in1"\) is both the name of a physics area and the name of a mesh area, \("@<\text{locator}>"\) is taken to indicate the physics area.

ANSYS CFX also has \(@\text{REGION CEL}\) syntax so that you can identify a named area as being a mesh area. Thus to identify the mesh area \(in1\), you would use the syntax:

\[ @\text{REGION}:in1 \]

Note that if \(<\text{locator}>\) does not appear as a physics name or a mesh name, the expression fails.

### 13.1.2. CFX Expression Language Statements

The CFX Expression Language is declarative. You declare the name and definition of the expression using expression language statements. The statements must conform to a predefined syntax that is similar to Fortran mathematical statements and to C statements for logical expressions.

The statement must consist of the following:

- a number, optionally with associated units. This defines a \(constant\). Constants without units are termed \(dimensionless\).
- for mathematical expressions, one or more references to mathematical constants, system variables, or existing user variables, separated by + (addition), − (subtraction), * (multiplication), / (division) and ^
(exponentiation), with optional grouping of these by parentheses. The syntax rules for these expressions are the same as those for conventional arithmetic.

- for logical expressions involving relational operators, one or more references to mathematical constants or results from mathematical expressions, separated by <= (is less than or equal to), < (is less than), == (is equal to), != (is not equal to), > (is greater than) and >= (is greater than or equal to) with optional grouping of these by parentheses.

- for logical expressions involving logical operators, one or more references to logical constants or results from relational operations separated by ! (negation), && (logical AND) and || (logical OR), with optional grouping by parentheses.

### 13.1.2.1. Use of Constants

Constants do not need to be defined prior to being used in an expression. For example, you could choose to evaluate the expression \( x + 5 \) \([m]\). Or, you could define a constant, \( b = 5 \) \([m]\) and then create an expression \( x + b \).

The logical constants are `false` and `true`. Results of logical expressions are either false or true, which are evaluated as 0 and 1 (corresponding to `false` and `true`, respectively) when a numerical representation is required.

The use of constants may be of benefit in generating complicated expressions or if you have several expressions that use the same constants.

### 13.1.2.2. Expression Syntax

All numbers are treated as real numbers.

The precedence of mathematical operators is as follows (from highest to lowest):

- The power operator ^ as in \( x^y \).
- The unary minus or negation operator – as in \(-x\).
- Multiplication and division as in \( x*y/z \).
- Addition and subtraction as in \( x+y-z \).

The precedence of logical and relational operators is as follows (from highest to lowest):

- The negation operator ! as in \(!x\).
- The relational operators involving less than or greater than (<=, <, > and >=) as in \(x >= y\).
- The relational operator is equal to and is not equal to (== and !=) as in \(x != y\).
- The logical AND operator (&&) as in \(x && y\).
- The logical OR operator (||) as in \(x || y\).

### 13.1.2.3. Multiple-Line Expressions

It is often useful, particularly with complex expressions, to use more than one line when creating your expression. CFX allows you to use multiple lines to generate an expression, provided each line is separated by an appropriate operator.

For example, you may have an equation, \( A + B/C \), that consists of three complex terms, \(A\), \(B\), and \(C\). In this case, you could use three lines to simplify creating the expression:
Note that the operator may be used at the end of a line (A +) or at the beginning of a line (/ C). You do not need to enter the operator twice.

Once the expression has been created, it will appear in the Existing Definitions list box as if it were generated on a single line (A + B/C).

13.2. CEL Operators, Constants, and Expressions

The following topics are discussed:

- **CEL Operators** (p. 144)
- **Conditional if Statement** (p. 145)
- **CEL Constants** (p. 146)
- **Using Expressions** (p. 146)

13.2.1. CEL Operators

CFX provides a range of mathematical, logical and operational operators as built-in functions to help you create complex expressions using the Expression details view.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>-x</td>
<td>Any</td>
<td>Any</td>
<td>[x]</td>
<td></td>
</tr>
<tr>
<td>x+y</td>
<td>Any</td>
<td>[x]</td>
<td>Any</td>
<td>[x]</td>
</tr>
<tr>
<td>x-y</td>
<td>Any</td>
<td>[x]</td>
<td>Any</td>
<td>[x]</td>
</tr>
<tr>
<td>x*y</td>
<td>Any</td>
<td>Any</td>
<td>[x]*[y]</td>
<td></td>
</tr>
<tr>
<td>x/y</td>
<td>Any</td>
<td>Any</td>
<td>[y] ≠ 0</td>
<td>[x]/[y]</td>
</tr>
<tr>
<td>x^y</td>
<td>Any</td>
<td>Dimensionless</td>
<td>Any^b</td>
<td>[x]^y</td>
</tr>
<tr>
<td>x^y</td>
<td>Any</td>
<td>Dimensionless</td>
<td>x &gt; 0</td>
<td>[x]^y</td>
</tr>
<tr>
<td>x^y</td>
<td>Dimensionless</td>
<td>Dimensionless</td>
<td>x &gt; 0</td>
<td>Dimensionless</td>
</tr>
</tbody>
</table>
### 13.2.2. Conditional if Statement

CEL supports the conditional if statement using the following syntax:

```plaintext
if( cond_expr, true_expr, false_expr )
```

where:

- **cond_expr**: is the logical expression used as the conditional test
- **true_expr**: is the mathematical expression used to determine the result if the conditional test is true.
- **false_expr**: is the mathematical expression used to determine the result if the conditional test is false.

#### Note

The expressions `true_expr` and `false_expr` are always evaluated independent of whether the evaluation of `cond_expr` is true or false. As a consequence, a conditional statement cannot be used to avoid division by zero as in `if( x>0, 1/x, 1.0)`. In this case, when `x=0.0`, a division by zero will still occur because the expression `1/x` is evaluated independent of whether `x>0` is satisfied or not.
13.2.3. CEL Constants

Right-click in the Expression details view to access the following useful constants when developing expressions:

Table 13.2 CEL Constants

<table>
<thead>
<tr>
<th>Constant</th>
<th>Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>J K⁻¹ mol⁻¹</td>
<td>Universal Gas Constant: 8.314472</td>
</tr>
<tr>
<td>avogadro</td>
<td>mol⁻¹</td>
<td>6.02214199E+23</td>
</tr>
<tr>
<td>boltzmann</td>
<td>J K⁻¹</td>
<td>1.3806503E-23</td>
</tr>
<tr>
<td>clight</td>
<td>m s⁻¹</td>
<td>2.99792458E+08</td>
</tr>
<tr>
<td>e</td>
<td>Dimensionless</td>
<td>Constant: 2.7182817</td>
</tr>
<tr>
<td>echarge</td>
<td>A s</td>
<td>Constant: 1.60217653E-19</td>
</tr>
<tr>
<td>epspermo</td>
<td></td>
<td>1./(clight<em>clight</em>mupermo)</td>
</tr>
<tr>
<td>g</td>
<td>m s⁻²</td>
<td>Acceleration due to gravity: 9.8066502</td>
</tr>
<tr>
<td>mupermo</td>
<td>N A⁻²</td>
<td>4<em>pi</em>1.E-07</td>
</tr>
<tr>
<td>pi</td>
<td>Dimensionless</td>
<td>Constant: 3.141592654</td>
</tr>
<tr>
<td>planck</td>
<td>J s</td>
<td>6.62606876E-34</td>
</tr>
<tr>
<td>stefan</td>
<td>W m⁻² K⁻⁴</td>
<td>5.670400E-08</td>
</tr>
</tbody>
</table>

13.2.4. Using Expressions

The interaction with CEL consists of two phases:

- a definition phase, and,
- a use phase.

The definition phase consists of creating a set of values and expressions of valid syntax. The purpose of the Expression details view is to help you to do this.

13.2.4.1. Use of Offset Temperature

When using temperature values in expressions, it is generally safer to use units of [K] only. When units are used that posses an offset (for example, [°C]), they are converted internally to [K]. For terms that have temperature to the power of unity, any unit conversion will include the offset between temperature scales. However, in all other cases the offset is ignored because this is usually the most appropriate behavior. You should therefore take care when specifying an expression involving non-unit powers of temperature. For example, each of the expressions below is equivalent:

- Temperature = 30 [°C]
- Temperature = 303.15 [K]
- Temperature = 0 [°C] + 30 [K]
- Temperature = 273.15 [K] + 30 [K]
These are only equivalent because all units are to the power of unity and units other than [K] appear no more than once in each expression. The following expression will not produce the expected result:

\[ \text{Temperature} = 0 \, \text{[C]} + 30 \, \text{[C]} \]

This is equivalent to \(576.30 \, \text{[K]}\) because each value is converted to [K] and then summed. The two expression below are equivalent (as expected) because the offset in scales is ignored for non-unit powers of temperature:

\[
\text{Specific Heat} = 4200 \, \text{[J kg}^{-1} \text{ C}^{-1}] \\
\text{Specific Heat} = 4200 \, \text{[J kg}^{-1} \text{ K}^{-1}] \\
\]

### 13.3. CEL Examples

The following examples are included in this section:

- **Example: Reynolds Number Dependent Viscosity** (p. 147)
- **Example: Feedback to Control Inlet Temperature** (p. 148)

#### 13.3.1. Example: Reynolds Number Dependent Viscosity

In this example it is assumed that some of the fluid properties, including the dynamic viscosity, are not known. However the Reynolds number, inlet velocity and a length scale are known. The flow is compressible and therefore the density is variable.

Given this information it is possible to calculate the fluid dynamic viscosity based on the Reynolds number. The Reynolds number is given by:

\[ Re = \frac{\rho \, U \, L}{\mu} \]

where \(\rho\) is density, \(U\) a velocity scale, \(L\) a length scale and \(\mu\) the dynamic viscosity. The velocity scale is taken as the inlet velocity, the length scale as the inlet width and the density is calculated as the average density over the inlet area.

The LIBRARY section of the CCL (CFX Command Language) file appears as follows:

```
LIBRARY :
  CEL :
    EXPRESSIONS :
      Re = 4.29E6 [ ] 
      Vel = 60 [m s^{-1}] 
      L=1.044[m] 
      Visc=areaAve(density)@in*Vel*L/Re 
    END 
  END 
MATERIAL : Air Ideal Gas
  Option = Pure Substance 
  PROPERTIES :
    Option = Ideal Gas 
    Molar Mass = 2.896E1 [kg kmol^{-1}] 
    Dynamic Viscosity = Visc 
    Specific Heat Capacity = 1.E3 [J kg^{-1} K^{-1}] 
    Thermal Conductivity = 2.52E-2 [W m^{-1} K^{-1}] 
  END 
END 
END 
```

This shows that four CEL expressions have been created. The first three expressions define constant values that are used in the \(\text{Visc}\) expression. The \(\text{Visc}\) expression calculates the dynamic viscosity.
based on the equation for Reynolds number given above. Within the expression the function 
\text{areaAve(density)}@in is used to evaluate the average density at the inlet.

The \text{Visc} expression can now be used to replace the value of \text{Dynamic Viscosity} in the \text{MATERIAL > PROPERTIES} section.

13.3.2. Example: Feedback to Control Inlet Temperature

In this example a feedback loop is used to control the outlet temperature by varying the temperature at an inlet. To illustrate the example consider the geometry shown below:

\textbf{Figure 13.1 Temperature Feedback Loop}

Fluid from a main and a side inlet enter at temperatures of 275 K and 375 K respectively. The temperature of the fluid entering from the third inlet depends on the outlet temperature. When the outlet temperature is greater than 325 K, the fluid from the third inlet is set to 275 K. When the outlet temperature is less than 325 K, the fluid from the third inlet is set to 375 K. In addition an expression is used to set the dynamic viscosity to be a linear function of temperature.

The \text{LIBRARY} section of the .ccl (CFX Command Language) file appears as follows. Note that the “\" character indicates a line continuation in CCL.

\textbf{LIBRARY:}
\begin{verbatim}
MATERIAL: Water at STP Modified 
  Option = Pure Substance 
  PROPERTIES: 
    Option = General Fluid 
    Density = 9.999E2 [kg m^-3] 
    Dynamic Viscosity = VisT 
    Specific Heat Capacity = 4.21E3 [J kg^-1 K^-1] 
    Thermal Conductivity = 5.69E-1 [W m^-1 K^-1] 
END # PROPERTIES 
CEL: 
  EXPRESSIONS: 
    Tupper = 375.0 [ K ]  # Upper temp. 
    Tlower = 275.0 [ K ]  # Lower temp. 
    Visupper = 0.000545 [ N s m^-2 ]  # Vis. at Tupper 
    Vislower = 0.0018 [ N s m^-2 ]  # Vis. at Tlower 
    VisT = Vislower+(Visupper-Vislower)*(T-Tlower)/ 
       (Tupper-Tlower) 
    # Vis.-Temp. relationship 
    Tm=(Tupper+Tlower)/2 
    Tout=areaAve(Water at STP Modified.T)@outlet 
    Tcontrol=Tlower*step((Tout-Tm)/1[K]) 
    +Tupper*step((Tm-Tout)/1[K]) 
END # EXPRESSIONS 
END # CEL 
END # LIBRARY 
\end{verbatim}
The first four expressions, $T_{upper}$, $T_{lower}$, $Vis_{upper}$ and $Vis_{lower}$ are simply constant values to define temperature and viscosity values. The expression $Vis_{T}$ produces a linear function for the dynamic viscosity taking a value of $Vis_{upper}$ at $T_{upper}$ and a value of $Vis_{lower}$ at $T_{lower}$. The expression $T_{m}$ sets the desired value of the outlet temperature. In this case it is set to a mean value of the two inlet temperatures.

$T_{out}$ calculates the outlet temperature using the $areaAve$ function.

Finally the expression $T_{control}$ is used to set the temperature of the third inlet. Two step functions are used so that the temperature is equal to $T_{lower}$ when $T_{out} - T_{m}$ is positive (that is, the outlet temperature is greater than $T_{m}$), and is equal to $T_{upper}$ when $T_{out} - T_{m}$ is positive.

### 13.3.3. Examples: Using Expressions in CFD-Post

The first example is a single-valued expression that calculates the pressure drop through a pipe. The names of inlet and outlet boundaries are “inlet” and “outlet.”

Create a new expression named “dp”:

\[ dp = massFlowAve(Pressure)@inlet - massFlowAve(Pressure)@outlet \]

When you click **Apply**, the value is shown below the editor.

**Tip**

Alternatively, type the expression in a table cell and prefix with ‘=’ sign. The cell displays the result when you click outside of the cell.

The second example is a variable expression that plots the pressure coefficient variation on a surface or a line:

1. Click the **Expressions** tab, then right-click in the **Expressions** area and select **New**.
2. Create these three expressions:

   \[
   \begin{align*}
   \text{RefPressure} &= 100000 \text{ [Pa]} \\
   \text{dynHead} &= 0.5 \times areaAve(Density)@inlet \times areaAve(Velocity)@inlet^2 \\
   \text{cpExp} &= (Pressure - \text{RefPressure})/\text{dynHead}
   \end{align*}
   \]

3. Click the **Variables** tab, then right-click and select **New**.
4. Create a user variable defined by $\text{cpExp}$.
5. Select **Insert > Location > Line** and use the details view to position the line in the simulation.

   From the details view **Color** tab, plot the user variable on a surface or a line (just as you would with any other variable).

### 13.4. CEL Technical Details

CEL is a byte code compiled language. Compiled languages, such as Fortran, rely on a translation program to convert them into the native machine language of the host platform. Interpreted languages are of two types: the fully interpreted languages such as the UNIX C shell, and the byte code compiled languages such as CEL. With byte codes, host machines are loaded with a client program (written in a compiled language and compiled for that machine architecture) that interprets the byte stream. The advantage...
of the byte code is that they can be the same on all host platforms, obviating the need for platform dependent codes.

Because the byte codes are interpreted, there is no need to re-link executable programs to perform a different calculation. Furthermore, many of the problems encountered by writing and linking in separate routines, for instance in C or Fortran, are averted, and the time taken to set up and debug complicated problems reduced considerably.

The link between CEL and the CFX-Solver is accomplished through an internal program called genicode. Genicode generates intermediate code from your CEL definitions and writes to a file that is then interpreted by the CFX-Solver during the solution process.
Chapter 14: Functions in ANSYS CFX

This chapter describes predefined functions in ANSYS CFX:
14.1. CEL Mathematical Functions
14.2. Quantitative CEL Functions in ANSYS CFX
14.3. Functions Involving Coordinates
14.4. CEL Functions with Multiphase Flow
14.5. Quantitative Function List

14.1. CEL Mathematical Functions

The following mathematical functions are available for use with all CEL expressions.

**Note**

In the **Function** column in the table below, \([a]\) denotes any dimension of the first operand.

<table>
<thead>
<tr>
<th>Function</th>
<th>Operand's Values</th>
<th>Result's Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>abs( [a] )</td>
<td>Any</td>
<td>[a]</td>
</tr>
<tr>
<td>acos( [ ] )</td>
<td>(-1 \leq x \leq 1)</td>
<td>Radians</td>
</tr>
<tr>
<td>asin( [ ] )</td>
<td>(-1 \leq x \leq 1)</td>
<td>Radians</td>
</tr>
<tr>
<td>atan( [ ] )a</td>
<td>Any</td>
<td>Radians</td>
</tr>
<tr>
<td>atan2( [a], [a] )a</td>
<td>Any</td>
<td>Radians</td>
</tr>
<tr>
<td>besselJ( [ ] , [ ] )b</td>
<td>(0 \leq n)</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>besselY( [ ] , [ ] )b</td>
<td>(0 \leq n)</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>cos( [radians] )</td>
<td>Any</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>cosh( [ ] )</td>
<td>Any</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>exp( [ ] )</td>
<td>Any</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>int([ ] )c</td>
<td>Dimensionless</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>loge( [ ] )d</td>
<td>(0 &lt; x)</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>log10( [ ] )e</td>
<td>(0 &lt; x)</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>min( [a], [a] )</td>
<td>Any</td>
<td>[a]</td>
</tr>
<tr>
<td>max( [a], [a] )</td>
<td>Any</td>
<td>[a]</td>
</tr>
<tr>
<td>mod( [a], [a] )f</td>
<td>Any</td>
<td>[a]</td>
</tr>
<tr>
<td>nint([ ] )g</td>
<td>Dimensionless</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>sin( [radians] )</td>
<td>Any</td>
<td>Dimensionless</td>
</tr>
</tbody>
</table>
### Function List

<table>
<thead>
<tr>
<th>Function</th>
<th>Operand’s Values</th>
<th>Result’s Dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td>sinh( [ ] )</td>
<td>Any</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>sqrt( [a] )</td>
<td>( 0 \leq x )</td>
<td>([a]^{0.5})</td>
</tr>
<tr>
<td>step( [ ] )</td>
<td>Any</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>tan( [radians] )</td>
<td>Any</td>
<td>Dimensionless</td>
</tr>
<tr>
<td>tanh( [ ] )</td>
<td>Any</td>
<td>Dimensionless</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>a atan does not determine the quadrant of the result, but atan2 does.</td>
</tr>
<tr>
<td>b The value of the first dimensionless operand n, also referred to as the order of the Bessel function, must be an integer (n=0, 1, 2, ...). The second argument is a dimensionless real number.</td>
</tr>
<tr>
<td>c The int() function truncates the dimensionless argument to its integer part.</td>
</tr>
</tbody>
</table>

Examples:

- `int(1) = 1`
- `int(2.5) = 2`
- `int(-3.1) = -3`
- `int(-4.8) = -4`

The `int()` function requires a dimensionless argument but will not report an error if the argument of the function has a dimension of radians or degrees.

- `ln(x)` is valid as an alias for `loge(x)`
- `log(x)` is valid as an alias for `log10(x)`
- `mod(x, y)` returns the remainder on dividing \( x \) by \( y \); the function is not defined for \( y = 0 \).
- The nint function requires a dimensionless argument and is defined as:
  - \( \text{int}(x + 0.5) \) if \( x \geq 0 \)
  - \( \text{int}(x - 0.5) \) if \( x < 0 \)

See the implementation of `int()` function in the table above.

Examples:

- `nint(2.6) = 3`
- `nint(2.5) = 3`
- `nint(2.4) = 2`
- `nint(1) = 1`
- `nint(-1) = -1`
- `nint(-2.4) = -2`
- `nint(-2.5) = -3`
- `nint(-2.6) = -3`

Note that the nint() function will not report an error if the argument of the function has a dimension of radians or degrees.

<table>
<thead>
<tr>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>d step(x) is 0 for negative ( x ), 1 for positive ( x ) and 0.5 for ( x=0 ). ( x ) must be dimensionless.</td>
</tr>
<tr>
<td>e tan(x) is undefined for ( x=n\pi/2 ), where ( n=1, 3, 5, ... )</td>
</tr>
</tbody>
</table>

## 14.2. Quantitative CEL Functions in ANSYS CFX

CEL expressions can incorporate specialized functions that are useful in CFD calculations. All CEL functions are described in [Quantitative Function List](p. 156). For a description of the full CFX Expression Language, see [CFX Expression Language (CEL)](p. 141).
Important

You must use consistent units when adding, subtracting, or comparing values.

There are some differences between CEL functions in CFX-Pre and CFX-Solver and those in CFD-Post. For details, see below.

The syntax used for calling these functions when used within CEL expressions is:

\[
[<\text{Phase\_Name}>] [<\text{Component\_Name}>] <\text{Function}> ([<\text{Operand}>]) @<\text{Location}>
\]

where:

- Terms enclosed in square brackets \([ ]\) are optional and terms in angle brackets \(< >\) should be replaced with the required entry.
- \(<\text{Phase\_Name}>\): specifies a valid name of a phase. The phase can be fluid, particle, solid, fluid pair, or polydispersed fluid. For multi-phase cases in CFX-Pre, if the phase name is not specified in the \(<\text{Operand}>\), then the phase name associated with the domain, subdomain, domain boundary, initialization or function in which the operand is being evaluated will be used. For multi-phase cases in CFX-Pre, a discussion of the handling of the phase name when it is not used to qualify (prepended to) \(<\text{Function}>\) and/or \(<\text{Operand}>\) can be found in CEL Functions with Multiphase Flow (p. 155). For multi-phase cases in CFD-Post, if the phase name is not specified then the bulk quantity (if available for the CFX-Solver Results file) is used.
- \(<\text{Component\_Name}>\): specifies a valid name of a component material, size group, or reaction
- \(<\text{Function}>\): specifies the CEL function to evaluate. See Quantitative Function List (p. 156). The function can be further qualified by appending _Coordinate\_Direction. In CFX-Pre, if the coordinate frame is not specified (in _Coordinate\_Direction) then the function will use the coordinate frame associated with the object (such as for a material, domain, subdomain, domain boundary, source point, monitor point, initialization, reference location or spark ignition object) in which it is being invoked.
- \(<\text{Coordinate\_Direction}>\): specifies a particular coordinate direction. The syntax of the coordinate direction is \([x|y|z][_<\text{Coordinate\_Frame}>]\) where the coordinate frame can be the global coordinate frame or any user defined coordinate frame. In CFD-Post, if the coordinate frame is not specified then the global frame is used. See Coordinate Frame Command in the CFD-Post User's Guide, for discussion of creating a coordinate frame in CFD-Post.
- \(<\text{Operand}>\): specifies the argument of the function (if required). The operand can be either a valid mathematical CEL expression (only in CFD-Post) or specified using the following general variable syntax:

\[
[<\text{Phase\_Name}>] [<\text{Comp\_Name}>] [<\text{Var\_Name}>] [_.<\text{Var\_Operator}>] [_.Difference]
\]

where \(<\text{Comp\_Name}>\), \(<\text{Var\_Name}>\), and \(<\text{Var\_Operator}>\) represent \(<\text{Component\_Name}>\), \(<\text{Variable\_Name}>\), and \(<\text{Variable\_Operator}>\), respectively.

In CFX-Pre the operand cannot be a CEL expression or any operand qualified by \(<\text{Variable\_Operator}>\). However, you can create an Additional Variable based on any expression and then use the Additional Variable as the operand. The operand always uses the conservative values unless the Boundcon variable operator is specified (for details, see Data Acquisition Routines in the CFX-Solver Modeling Guide). For primitive or composite mesh regions, conservative values will be used even if the Boundcon variable operator is specified.

The operand must be valid for the physical models being used over the entire location. For example, if the location spans fluid and solid domains, then the operand cannot be \text{Pressure}. 
For some functions the operand must be left blank as in area()@Inlet.

In CFD-Post, difference variables created during case comparison are appended by .Difference.

- **<Variable_Name>** specifies the base name of the variable. You can use the short or long form for variable names. In CFX-Pre the variable name can be further qualified by appending _<Coordinate_Direction>. This is useful for specifying a particular component of a vector or tensor, for example Velocity_y_myLocalFrame. In CFX-Pre, if the variable name corresponds to that of a component of a vector or a tensor and coordinate frame is not prescribed (as part of the coordinate direction) then the global coordinate frame is used. An exception applies for the position vector \(x, y, z\) (or \(r, \theta, z\)) components, which are always local, see *Functions Involving Coordinates* (p. 155).

- **<Variable_Operator>** specifies the name of the variable operator. The variable operators are.

<table>
<thead>
<tr>
<th>Long Name</th>
<th>Short Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnitude</td>
<td>magnitude</td>
</tr>
<tr>
<td>Gradient</td>
<td>grad</td>
</tr>
<tr>
<td>Curl</td>
<td>curl</td>
</tr>
<tr>
<td>Laplacian</td>
<td>laplacian</td>
</tr>
<tr>
<td>Time Derivative</td>
<td>dt</td>
</tr>
<tr>
<td>Transient Minimum</td>
<td>Trnmin</td>
</tr>
<tr>
<td>Transient Maximum</td>
<td>Trnmax</td>
</tr>
<tr>
<td>Transient Std Deviation</td>
<td>Trnstdv</td>
</tr>
<tr>
<td>Transient RMS</td>
<td>Trnrms</td>
</tr>
<tr>
<td>Transient Average</td>
<td>Trnavg</td>
</tr>
<tr>
<td>Boundcon</td>
<td>hybrid</td>
</tr>
</tbody>
</table>

All but the <Derived> operator are available in CFX-Pre and the CFX-Solver. See Data Acquisition Routines in the CFX-Solver Modeling Guide. The <Derived> variable operator is available only in CFD-Post, for example Absolute Helicity derived for use with Vortex Cores, see Vortex Core Region in the CFD-Post User’s Guide. In CFX-Pre the variable operator can be further qualified by appending _<Coordinate_Direction>.

The Magnitude and Curl operators may only be applied to vector variables. All other operators may be applied to scalar variables and vector components.

- **<Location>** specifies the location over which the function is to be applied. The syntax of location is:

  [Case:<Case_Name>.][REGION:<Location_Name>]

The case syntax [Case:<Case_Name>.] is only available in CFD-Post and is used when multiple cases are loaded to indicate the name of the desired case.

In CFX-Pre [<Location_Name>] must be a domain boundary, domain, subdomain, or, primitive or composite mesh region. If the location name of a mesh region is the same as the name of a named boundary, domain or subdomain, then the mesh location name must be prepended by REGION:. For primitive or composite mesh regions, conservative values will be used even if the name of the mesh region is the same as that of a named boundary.

In CFD-Post [<Location_Name>] can be any loaded or user-defined location (for example, a point, domain boundary, plane, mesh region etc.). The syntax REGION:<Region Name> can also be used in CFD-Post to refer to any mesh region. If a mesh region is present with the same name
as, for example, a domain boundary, then the mesh region is imported into CFD-Post with a Region suffix. For example, if there is both a domain boundary and a mesh region called in1 in the CFX-Solver Results file, then in CFD-Post the mesh region will appear in CFD-Post as in1 Region. The syntax in1 will refer to the domain boundary, and either of in1 Region or REGION:in1 can be used to refer to the mesh region as desired.

**Note**

You cannot use a composite region that consists of a mixture of 2D and 3D regions.

<table>
<thead>
<tr>
<th>Table 14.2 Examples of the Calling Syntax for an Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>areaAve(p)@Inlet</td>
</tr>
<tr>
<td>area()@REGION:myCompositeMeshRegion</td>
</tr>
<tr>
<td>areaAve(Pressure - 10000 [Pa])@outlet</td>
</tr>
<tr>
<td>area_x()@inlet</td>
</tr>
</tbody>
</table>

### 14.3. Functions Involving Coordinates

The CEL variables x, y, z, r and theta, representing the local coordinates, cannot be used as the variable. However, the variables xGlobal, yGlobal and zGlobal can be used. For example, the following is a valid expression definition:

\[ z \times \text{areaAve}(xGlobal)@inlet \]

### 14.4. CEL Functions with Multiphase Flow

**Note**

These functions are available in CFX-Pre and CFX-Solver without restrictions, and in CFD-Post with the restriction that you cannot use short names.

If the function is fluid-specific, various behaviors are possible depending on the function type:

- For massFlow and massFlowAve, if the phase name is not specified for the function, then the bulk mass flows will be used. See cases 1 to 7 in the table below.
- For other fluid-specific functions:
  - if a fluid-specific operand is specified and no fluid is specified for the function, then the fluid specified for the operand will be assumed for the function as well. See case 8 in the table below.
  - if the function is specified and no fluid is specified for the operand, then the fluid specified for the function will be assumed for the operand as well. See cases 7 and 9 in the table below.
If both the function or operand are fluid-specific, and a phase name is not given for either, the solver will stop with an error. See case 10 in the table below.

### Table 14.3 CEL Multiphase Examples

<table>
<thead>
<tr>
<th>Case</th>
<th>CEL Function - Multiphase</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>massFlow()@inlet</td>
<td>Bulk mass flow rate through inlet</td>
</tr>
<tr>
<td>2</td>
<td>Air.massFlow()@inlet</td>
<td>Air mass flow rate through inlet</td>
</tr>
<tr>
<td>3</td>
<td>massFlowAve(Pressure)@inlet</td>
<td>Bulk mass flow averaged pressure on inlet</td>
</tr>
<tr>
<td>4</td>
<td>Air.massFlowAve(Pressure)@inlet</td>
<td>Air mass flow averaged pressure on inlet</td>
</tr>
<tr>
<td>5</td>
<td>massFlowAve(Air.Volume Fraction)@inlet</td>
<td>Bulk mass flow averaged air volume fraction on inlet</td>
</tr>
<tr>
<td>6</td>
<td>Air.massFlowAve(Air.Volume Fraction)@inlet</td>
<td>Air mass flow averaged air volume fraction on inlet</td>
</tr>
<tr>
<td>7</td>
<td>Air.massFlowAve(Volume Fraction)@inlet</td>
<td>Same as Air.massFlowAve(Air.Volume Fraction)@inlet</td>
</tr>
<tr>
<td>8</td>
<td>massInt(Air.Volume Fraction)@domain1</td>
<td>Same as Air.massInt(Air.Volume Fraction)@domain1</td>
</tr>
<tr>
<td>9</td>
<td>Air.massInt(Volume Fraction)@domain1</td>
<td>Same as Air.massInt(Air.Volume Fraction)@domain1</td>
</tr>
<tr>
<td>10</td>
<td>massFlowAve(Volume Fraction)@inlet</td>
<td>Error because no fluid specified</td>
</tr>
</tbody>
</table>

### 14.5. Quantitative Function List

The available quantitative functions are outlined in the sections that follow.

In the table that follows, `<Expression>` in CFD-Post means any expression; however, in CFX-Pre and CFX-Solver `<Expression>` means "Additional Variable Expression".

The behavior of the functions in the table below depends on the type of `<Location>`. Typically:

- on a domain the functions use vertex values for the operand,
- on a subdomain the functions use element values for the operand,
- on a boundary the functions use conservative values for the operand unless this is overridden by the `Boundcon` variable operator in CFX-Pre,
- on user locations in CFD-Post the functions use values interpolated from nodal values.

### Table 14.4 CEL Functions in CFX-Pre/CFX-Solver and in CFD-Post

<table>
<thead>
<tr>
<th>Function Name and Syntax</th>
<th>Operation</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>area()</code></td>
<td>Area of a boundary or interface.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See <code>area</code> (p. 161).</td>
<td></td>
</tr>
<tr>
<td>Function Name and Syntax</td>
<td>Operation</td>
<td>Availability</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>area_x<a href="">&lt;Coord Frame&gt;</a></td>
<td>The (signed) component of the normal area vector in the local x, y or z direction. The normal area vectors are always directed out of the domain, therefore you may obtain positive or negative areas depending on the orientation of your domain and the boundary you are operating on. The area of a closed surface will always be zero.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td>All</td>
</tr>
<tr>
<td>area_y<a href="">&lt;Coord Frame&gt;</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>area_z<a href="">&lt;Coord Frame&gt;</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>areaAve(&lt;Expression&gt;)</td>
<td>Area-weighted average of &lt;Expression&gt; on a boundary.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See areaAve (p. 162).</td>
<td></td>
</tr>
<tr>
<td>areaAve_x<a href="">&lt;Coord Frame&gt;</a></td>
<td>The (signed) component of the normal area vector weighted average in the local x, y or z direction. The normal area vectors are always directed out of the domain, therefore you may obtain positive or negative areas depending on the orientation of your domain and the boundary you are operating on. The area of a closed surface will always be zero.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td>CFD-Post</td>
</tr>
<tr>
<td>areaAve_y<a href="">&lt;Coord Frame&gt;</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>areaAve_z<a href="">&lt;Coord Frame&gt;</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>areaInt(&lt;Expression&gt;)</td>
<td>Area-weighted integral of &lt;Expression&gt; on a boundary.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>The areaInt function projects the location onto a plane normal to the specified direction (if the direction is not set to None) and then performs the calculation on the projected location (the direction specification can also be None). The direction of the normal vectors for the location is important and will cancel out for surfaces such as closed surfaces.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See areaInt (p. 163).</td>
<td></td>
</tr>
<tr>
<td>areaInt_x<a href="">&lt;Coord Frame&gt;</a></td>
<td>The (signed) component of the normal area vector weighted integral in the local x, y or z direction. The normal area vectors are always directed out of the domain, therefore you may obtain positive or negative areas depending on the orientation of your domain and the boundary you are operating on. The area of a closed surface will always be zero.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>All</td>
</tr>
<tr>
<td>areaInt_y<a href="">&lt;Coord Frame&gt;</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>areaInt_z<a href="">&lt;Coord Frame&gt;</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Function Name and Syntax &lt;required&gt; [optional]</td>
<td>Operation</td>
<td>Availability</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>Supports @&lt;Location&gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ave(&lt;Expression&gt;)</td>
<td>Arithmetic average of &lt;Expression&gt; over nodes within a domain or subdomain. Supports @&lt;Location&gt; See <em>ave</em> (p. 164).</td>
<td></td>
</tr>
<tr>
<td>count( )</td>
<td>Counts the number of evaluation points (nodes) on the named region. See <em>count</em> (p. 164).</td>
<td></td>
</tr>
<tr>
<td>countTrue(&lt;Expression&gt;)</td>
<td>Counts the number of nodes at which the logical expression evaluates to true. Supports @&lt;Location&gt; See <em>countTrue</em> (p. 165).</td>
<td></td>
</tr>
<tr>
<td>force( )</td>
<td>The magnitude of the force vector on a boundary. Supports [&lt;Phase&gt;., @&lt;Location&gt; See <em>force</em> (p. 165).</td>
<td></td>
</tr>
<tr>
<td>forceNorm <a href="">_&lt;Axis&gt;[&lt;Coord Frame&gt;]</a></td>
<td>The length of the normalized force on a curve in the specified direction. Supports [&lt;Phase&gt;., @&lt;Location&gt; See <em>forceNorm</em> (p. 167).</td>
<td></td>
</tr>
<tr>
<td>force_x<a href="">_&lt;Coord Frame&gt;</a></td>
<td>The (signed) component of the force vector in the local x, y or z direction. Supports [&lt;Phase&gt;., @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td>force_y<a href="">_&lt;Coord Frame&gt;</a></td>
<td>All^a</td>
<td></td>
</tr>
<tr>
<td>force_z<a href="">_&lt;Coord Frame&gt;</a></td>
<td>All^a</td>
<td></td>
</tr>
<tr>
<td>inside()</td>
<td>Similar to the subdomain variable, but allows a specific 2D or 3D location to be given. Supports @&lt;Location&gt; See <em>inside</em> (p. 167).</td>
<td></td>
</tr>
<tr>
<td>length()</td>
<td>Length of a curve. Supports @&lt;Location&gt; See <em>length</em> (p. 168).</td>
<td></td>
</tr>
<tr>
<td>lengthAve(&lt;Expression&gt;)</td>
<td>Length-weighted average. Supports @&lt;Location&gt; See <em>lengthAve</em> (p. 168).</td>
<td></td>
</tr>
<tr>
<td><strong>Function Name and Syntax</strong></td>
<td><strong>Operation</strong></td>
<td><strong>Availability</strong></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------</td>
<td>-----------------</td>
</tr>
<tr>
<td><code>lengthInt(&lt;Expression&gt;)</code></td>
<td>Length-weighted integration. Supports @&lt;Location&gt; See <em>lengthInt</em> (p. 169).</td>
<td>CFD-Post</td>
</tr>
<tr>
<td><code>mass()</code></td>
<td>The total mass within a domain or subdomain. This is fluid-dependent. Supports @&lt;Location&gt; See <em>mass</em> (p. 169).</td>
<td>CFX-Pre, CFX-Solver</td>
</tr>
<tr>
<td><code>massAve(&lt;Expression&gt;)</code></td>
<td>Mass-weighted average of &lt;Expression&gt; on a domain or subdomain. Supports @&lt;Location&gt; See <em>massAve</em> (p. 169).</td>
<td>CFX-Pre, CFX-Solver</td>
</tr>
<tr>
<td><code>massFlow()</code></td>
<td>Mass flow through a boundary. Supports [&lt;Phase&gt;], @&lt;Location&gt; See <em>massFlow</em> (p. 169).</td>
<td>All</td>
</tr>
<tr>
<td><code>massFlowAve(&lt;var&gt;)</code></td>
<td>Mass flow weighted average of &lt;Expression&gt; on a boundary. Supports [&lt;Phase&gt;], @&lt;Location&gt; See <em>massFlowAve</em> (p. 171).</td>
<td>All</td>
</tr>
<tr>
<td><code>massFlowAveAbs(&lt;var&gt;)</code></td>
<td>Absolute mass flow weighted average of &lt;Expression&gt; on a boundary. Supports [&lt;Phase&gt;], @&lt;Location&gt; See <em>massFlowAveAbs</em> (p. 171).</td>
<td>All</td>
</tr>
<tr>
<td><code>massFlowInt(&lt;var&gt;)</code></td>
<td>Mass flow weighted integration of &lt;Expression&gt; on a boundary. Supports [&lt;Phase&gt;], @&lt;Location&gt; See <em>massFlowInt</em> (p. 173).</td>
<td>All</td>
</tr>
<tr>
<td><code>massInt(&lt;Expression&gt;)</code></td>
<td>The mass-weighted integration of &lt;Expression&gt; within a domain or subdomain. Supports @&lt;Location&gt; See <em>massInt</em> (p. 174).</td>
<td>CFX-Pre, CFX-Solver</td>
</tr>
<tr>
<td><code>maxVal(&lt;Expression&gt;)</code></td>
<td>Maximum Value of &lt;Expression&gt; within a domain or subdomain. Supports @&lt;Location&gt;</td>
<td>All</td>
</tr>
<tr>
<td>Function Name and Syntax</td>
<td>Operation</td>
<td>Availability</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>&lt;required&gt; [&lt;optional&gt;]</td>
<td>See <em>maxVal</em> (p. 174).</td>
<td></td>
</tr>
<tr>
<td>minVal(&lt;Expression&gt;)</td>
<td>Minimum Value of &lt;Expression&gt; within a domain or subdomain.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See <em>minVal</em> (p. 174).</td>
<td></td>
</tr>
<tr>
<td>probe(&lt;Expression&gt;)</td>
<td>Returns the value of the specified variable on the specified Point locator.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See <em>probe</em> (p. 175).</td>
<td></td>
</tr>
<tr>
<td>rbstate(&lt;rbvar&gt;[&lt;axis&gt;])</td>
<td>Returns the position/velocity/acceleration or orientation/angular velocity/angular acceleration (or axis components of these) of a rigid body object or immersed solid that is governed by a rigid body solution. These quantities are with respect to the global coordinate frame.</td>
<td>CFX-Pre, CFX-Solver</td>
</tr>
<tr>
<td></td>
<td>See <em>rbstate</em> (p. 175).</td>
<td></td>
</tr>
<tr>
<td>rmsAve(&lt;Expression&gt;)</td>
<td>RMS average of &lt;Expression&gt; within a 2D domain.</td>
<td>CFX-Pre, CFX-Solver</td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See <em>rmsAve</em> (p. 176).</td>
<td></td>
</tr>
<tr>
<td>sum(&lt;Expression&gt;)</td>
<td>Sum of &lt;Expression&gt; over all domain or subdomain vertices.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See <em>sum</em> (p. 176).</td>
<td></td>
</tr>
<tr>
<td>torque( )</td>
<td>Magnitude of the torque vector on a boundary.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Supports [&lt;Phase&gt;., @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See <em>torque</em> (p. 177).</td>
<td></td>
</tr>
<tr>
<td>torque_x<a href="">&lt;Coord Frame&gt;</a></td>
<td>The (signed) components of the torque vector about the local x, y, or z coordinate axis.</td>
<td>All</td>
</tr>
<tr>
<td>torque_y<a href="">&lt;Coord Frame&gt;</a></td>
<td>Supports [&lt;Phase&gt;., @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td>torque_z<a href="">&lt;Coord Frame&gt;</a></td>
<td></td>
<td></td>
</tr>
<tr>
<td>volume( )</td>
<td>The total volume of a domain or subdomain.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Supports @&lt;Location&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>See <em>volume</em> (p. 177).</td>
<td></td>
</tr>
<tr>
<td>Function Name and Syntax</td>
<td>Operation</td>
<td>Availability</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td><code>volumeAve(&lt;Expression&gt;)</code></td>
<td>Volume-weighted average of <code>&lt;var&gt;</code> on a domain.</td>
<td>All</td>
</tr>
<tr>
<td><code>volumeAve(&lt;Expression&gt;)</code></td>
<td>Supports <code>@&lt;Location&gt;</code></td>
<td>All</td>
</tr>
<tr>
<td><code>volumeAve(&lt;Expression&gt;)</code></td>
<td>See <code>volumeAve</code> (p. 178).</td>
<td>All</td>
</tr>
<tr>
<td><code>volumeInt(&lt;Expression&gt;)</code></td>
<td>Volume-weighted integration of <code>&lt;var&gt;</code> within a domain or subdomain.</td>
<td>All</td>
</tr>
<tr>
<td><code>volumeInt(&lt;Expression&gt;)</code></td>
<td>Supports <code>@&lt;Location&gt;</code></td>
<td>All</td>
</tr>
<tr>
<td><code>volumeInt(&lt;Expression&gt;)</code></td>
<td>See <code>volumeInt</code> (p. 178).</td>
<td>All</td>
</tr>
</tbody>
</table>

*See the definition for `[_<Coordinate_ Direction>]` in *Quantitative CEL Functions in ANSYS CFX* (p. 152)

### 14.5.1. area

The `area` function is used to calculate the area of a 2D locator.

```plaintext
area[_<Axis>[_<Coord Frame>]]()@<Location>
```

where:

- `<Axis>` is `x`, `y`, or `z`
- `<Coord Frame>` is the coordinate frame
- `<Location>` is any 2D region (such as a boundary or interface).

An error is raised if the location specified is not a 2D object. If an axis is not specified, the total area of the location is calculated.

`area()@Isosurface1` calculates the total area of the location, and `Isosurface1.area_y()@Isosurface1` calculates the projected area of `Isosurface1` onto a plane normal to the Y-axis.

#### 14.5.1.1. Tools > Command Editor Example

```plaintext
>calculate area, <Location>, [<Axis>]  
```

The specification of an axis is optional. If an axis is not specified, the value held in the object will be used. To calculate the total area of the location, the axis specification should be left blank (that is, type a comma after the location specification).

```plaintext
>calculate area, myplane calculates the area of the locator myplane projected onto a plane normal to the axis specification in the CALCULATOR object.  
```

```plaintext
>calculate area, myplane, calculates the area of the locator myplane. Note that adding the comma after myplane removes the axis specification.  
```

#### 14.5.1.2. Tools > Function Calculator Example

The following example will calculate the total area of the locator `Plane1`:
**Function:** area, **Location:** Plane1.

### 14.5.2. areaAve

The areaAve function calculates the area-weighted average of an expression on a 2D location. The area-weighted average of a variable is the average value of the variable on a location when the mesh element sizes are taken into account. Without the area weighting function, the average of all the nodal variable values would be biased towards variable values in regions of high mesh density.

\[
areaAve[^<Axis>[^<Coord Frame>](<Expression>)@<Location>
\]

where:
- \(<Axis>\) is x, y, or z
- \(<Coord Frame>\) is available in CFD-Post only
- \(<Expression>\) is an expression
- \(<Location>\) is any 2D region (such as a boundary or interface). An error is raised if the location specified is not a 2D object.

To calculate the pressure coefficient \(C_p\) use:

\[
(Pressure - 1[bar])/(0.5*Density*(areaAve(Velocity)@inlet)^2)
\]

You can create an expression using this, and then create a user variable using the expression. The user variable can then be plotted on objects like any other variable.

---

**Note**

Projected areaAve (for example, areaAve_x) works as expected only for surfaces that do not fold in the selected direction. In extreme case, if the surface is fully closed, the projected average will result in a randomly large number, as the projected area will be zero.

### 14.5.2.1. Tools > Command Editor Example

>`calculate areaAve, <Expression>, <Location>, <Axis>`

### 14.5.2.2. Tools > Function Calculator Examples

- This example will calculate the average magnitude of Velocity on outlet.
  
  **Function:** areaAve, **Location:** outlet, **Variable:** Velocity.
  
  Note that flow direction is not considered because the magnitude of a vector quantity at each node is calculated.
- You can use the scalar components of Velocity (such as Velocity u) to include a directional sign. This example will calculate the area-weighted average value of Velocity u, with negative values of Velocity u replaced by zero. Note that this is not the average positive value because zero values will contribute to the average.
  
  **Function:** areaAve, **Location:** outlet, **Variable:** max(Velocity u, 0.0[m s^-1]).
14.5.3. areaInt

The areaInt function integrates a variable over the specified 2D location. To perform the integration over the total face area, select the None option from the Axis drop-down menu. If a direction is selected, the result is an integration over the projected area of each face onto a plane normal to that direction. Each point on a location has an associated area which is stored as a vector and therefore has direction. By selecting a direction in the function calculator, you are using only a single component of the vector in the area-weighting function. Because these components can be positive or negative, depending on the direction of the normal on the location, it is possible for areas to cancel out. An example of this would be on a closed surface where the projected area will always be zero (the results returned will not in general be exactly zero because the variable values differ over the closed surface). On a flat surface, the normal vectors always point in the same direction and never cancel out.

areaInt[<Axis>[<Coord Frame>](<Expression>)@<Location>

where:

• <Axis> is x, y, or z.
  Axis is optional; if not specified the integration is performed over the total face area. If axis is specified, then the integration is performed over the projected face area. A function description is available.

• <Coord Frame> is the coordinate frame.

• <Location> is any 2D region (such as a boundary or interface). An error is raised if the location specified is not a 2D object.

areaInt_y_Frame2(Pressure)@boundary1 calculates the pressure force acting in the y-direction of the coordinate frame Frame2 on the locator boundary1. This differs from a calculation using the force function, which calculates the total force on a wall boundary (that is, viscous forces on the boundary are included).

14.5.3.1. Tools > Command Editor Example

>calculate areaInt, <Expression>, <Location>, [<Axis>]

Axis is optional. If it is not specified, the value held in the object will be used. To perform the integration over the total face area, the axis specification should be blank (that is, type a comma after the location name). A function description is available in areaInt (p. 163).

14.5.3.2. Tools > Function Calculator Examples

• This example integrates Pressure over Plane 1. The returned result is the total pressure force acting on Plane 1. The magnitude of each area vector is used and so the direction of the vectors is not considered.

  Function: areaInt, Location: Plane 1, Variable: Pressure, Direction: None

• This example integrates Pressure over the projected area of Plane 1 onto a plane normal to the X-axis. The result is the pressure force acting in the X-direction on Plane 1. This differs slightly from using the force function to calculate the X-directional force on Plane 1. The force function includes forces due to the advection of momentum when calculating the force on an internal arbitrary plane or a non-wall boundary (inlets, etc.).

  Function: areaInt, Location: Plane 1, Variable: Pressure, Direction: Global X.
14.5.4. ave

The ave function calculates the arithmetic average (the mean value) of a variable or expression on the specified location. This is simply the sum of the values at each node on the location divided by the number of nodes. Results will be biased towards areas of high nodal density on the location. To obtain a mesh independent result, you should use the lengthAve, areaAve, volumeAve or massFlowAve functions.

```
ave(<var|Expression>)@<Location>
```

where:
- `<var|Expression>` is a variable or a logical expression
- `<Location>` is any 3D region (such as a domain or subdomain).

The ave function can be used on point, 1D, 2D, and 3D locations.

```
ave(Yplus)@Default  calculates the mean Yplus values from each node on the default walls.
```

14.5.4.1. Tools > Command Editor Example

```
>calculate ave, <var|Expression>, <Location>
```

**Note**

To obtain a mesh-independent result, you should use the lengthAve, areaAve, volumeAve or massFlowAve functions.

The average of a vector value is calculated as an average of its magnitudes, not the magnitude of component averages. As an example, for velocity:

\[
|\mathbf{v}|_{\text{ave}} = \frac{|v_1| + |v_2|}{2}
\]  

(14–1)

where

\[
|v_i| = \sqrt{v_{x,i}^2 + v_{y,i}^2 + v_{z,i}^2}
\]  

(14–2)

14.5.4.2. Tools > Function Calculator Example

This example calculates the mean temperature at all nodes in the selected domain.

**Function:** ave, **Location:** MainDomain, **Variable:** Temperature.

14.5.5. count

The count function returns the number of nodes on the specified location.

```
count()@<Location>
```

where:
• <Location> is valid for point, 1D, 2D, and 3D locations.

count()@Polyline1 returns the number of points on the specified polyline locator.

**14.5.5.1. Tools > Command Editor Example**

>calculate count, <Location>

**14.5.5.2. Tools > Function Calculator Example**

This example returns the number of nodes in the specified domain.


**14.5.6. countTrue**

The `countTrue` function returns the number of mesh nodes on the specified region that evaluate to "true", where true means greater than or equal to 0.5. The `countTrue` function is valid for 1D, 2D, and 3D locations.

`countTrue(<Expression>)@<Location>`

where <Expression> is:

• In CFD-Post, an expression that contains the logical operators `=`, `>`, `<`, `<=`, or `>=`.
• In CFX-Solver, an Additional Variable that you define. For example:

  ```
  TemperatureLE = Temperature > 300[K]
  ```

`countTrue(TemperatureLE)@Polyline1` returns the number of nodes on the specified polyline locator that evaluate to true.

**14.5.6.1. Tools > Command Editor Examples**

In CFD-Post:

>calculate countTrue(Temperature > 300[K]), Domain1

In CFX-Solver:

>calculate countTrue(TemperatureLE), Domain1

**14.5.6.2. Tools > Function Calculator Example**

This example returns the number of nodes that evaluate to "true" in the specified domain.


**14.5.7. force**

This function returns the force exerted by the fluid on the specified 2D locator in the specified direction.

`[<Phase>.]force[_<Axis>[_<Coord Frame>]]@<Location>`

where:
• `<Phase>` is an optional prefix that is not required for single-phase flows. For details, see CEL Functions with Multiphase Flow (p. 155).

• `<Axis>` is x, y, or z

• `<Coord Frame>` is the coordinate frame

• `<Location>` is any 2D region (such as a boundary or interface).

Force calculations on boundaries require additional momentum flow data.

```
Water at RTP.force_x()@wall1 returns the total force in the x-direction acting on wall1 due to the fluid Water at RTP.
```

The force on a boundary is calculated using momentum flow data from the results file, if it is available. The result can be positive or negative, indicating the direction of the force. For non-boundary locators, an approximate force is always calculated.

CFD-Post calculates the approximate force as follows:

• If the locator is a wall boundary, the force is equal to the pressure force.

• For all other locators, the force is equal to the pressure force plus the mass flow force (due to the advection of momentum).

• In all cases, if wall shear data exists in the results file, the viscous force is added to the calculated force.

The `force` function enables you to select the fluids to use when performing your calculation. The result returned is the force on the locator due to that fluid/those fluids. Because the pressure force is the same at each node irrespective of the choice of fluids, the only difference is in the viscous forces (on wall boundaries) or the mass flow forces.

It is important to note that forces arising as a result of the reference pressure are not included in the force calculation. You can include reference pressure effects in the force calculation in the CFX-Solver by setting the expert parameter `<include pref in forces = t>`.

When performing transient simulations in rotating domains, forces may be reported in one of two reference frames. The first is a reference frame attached to the rotating domain. The second is a reference frame that does not rotate with the domain, having an orientation fixed by the initial orientation. The forces reported by the CFX Solver are always given with respect to the second choice. The forces reported by CFD-Post may be given in either reference frame, depending on the context:

• If the forces are calculated from boundary flows available in the Results file (see Output Boundary Flows Check Box in the CFX-Pre User’s Guide), then the forces are calculated with respect to the second choice.

• If the forces are not calculated from boundary flows available in the Results file, they are calculated by CFD-Post with respect to the first choice if the domain is rotated by CFD-Post (according to the Angular Shift for Transient Rotating Domains option), and with respect to the second choice otherwise.

### 14.5.7.1. Tools > Command Editor Example

```
>calculate force, <Location>, <Axis>, [<Phase>]
```

### 14.5.7.2. Tools > Function Calculator Examples

• This calculates the total force on the default wall boundaries in the x-direction. Pressure and viscous forces are included.

  **Function:** `force`, **Location:** Default, **Direction:** Global X, **Phase:** All Fluids.
• This calculates the forces on inlet1 due to pressure and the advection of momentum.

**Function:** force, **Location:** inlet1, **Direction:** Global X, **Phase:** Water at RTP.

### 14.5.8. forceNorm

Returns the per unit width force on a line in the direction of the specified axis. It is available only for a polyline created by intersecting a locator on a boundary. Momentum data must also be available. The magnitude of the value returned can be thought of as the force in the specified direction on a polyline, if the polyline were 2D with a width of one unit.

```
[[<Phase>.]forceNorm[_<Axis>[_<Coord Frame>]]()@<Location>
```

where:

• `[<Phase>.]` is an optional prefix that is not required for single-phase flows. For details, see *CEL Functions with Multiphase Flow* (p. 155).  
• `<Axis>` is x, y, or z  
• `<Coord Frame>` is available in CFD-Post only  
• `<Location>` is any 1D location. An error will be raised if the location specified is not one-dimensional.

**forceNorm_y()@Polyline1** calculates the per unit width force in the y-direction on the selected polyline.

#### 14.5.8.1. Tools > Command Editor Example

```
>calculate forceNorm, <Location>, <Axis>, [<Phase>]
```

#### 14.5.8.2. Tools > Function Calculator Example

The result from this calculation is force per unit width on Polyline1 in the x-direction.

**Function:** forceNorm, **Location:** Polyline1, **Direction:** Global X, **Phase:** All Fluids.

### 14.5.9. inside

The inside CEL function is essentially a step function variable, defined to be unity within a subdomain and zero elsewhere. This is useful for describing different initial values or fluid properties in different regions of the domain. It is similar to the CEL subdomain variable, but allows a specific 2D or 3D location to be given. For example, 273 [K] * inside()@Subdomain 1 has a value of 273 [K] at points in Subdomain 1 and 0 [K] elsewhere. The location does not need to be a subdomain, but can be any 2D or 3D named sub-region of the physical location on which the expression is evaluated. For immersed solids simulations, the location can also be a specific immersed solid domain, and the inside function will be updated automatically at the beginning of each time step.

```
inside()@<Location>
```

where:

• `<Location>` is any 2D or 3D named sub-region of the physical location on which the expression is evaluated.  
• `<Location>` can also be an immersed solid domain on which the expression is evaluated dynamically.
Note

The inside CEL function is not available in CFD-Post.

14.5.9.1. Tools > Command Editor Example

>calculate inside, <Location>

14.5.10. length

Computes the length of the specified line as the sum of the distances between the points making up the line.

\[ \text{length}()@<\text{Location}> \]

where:

- \(<\text{Location}>\) is any 1D location. Specifying a 2D location will not produce an error; the sum of the edge lengths from the elements in the locator will be returned.

\[ \text{length}()@\text{Polyline1} \] returns the length of the polyline.

14.5.10.1. Tools > Command Editor Example

>calculate length, <Location>

Note

While using this function in Power Syntax, the leading character is capitalized to avoid confusion with the Perl internal command “length”.

14.5.10.2. Tools > Function Calculator Example

This example calculates the length of a polyline.

Function: length, Location: Polyline1.

14.5.11. lengthAve

Computes the length-based average of the variable on the specified line. This is the 1D equivalent of the areaAve function. The result is independent of the nodal distribution along the line because a weighting function assigns a higher weighting to areas of sparse nodal density.

\[ \text{lengthAve}(<\text{Expression}>@<\text{Location}> \]

where:

- \(<\text{Expression}>\) is an expression
- \(<\text{Location}>\) is any 1D or 2D location.

\[ \text{lengthAve}(T)@\text{Polyline1} \] calculates the average temperature on \text{Polyline1} weighted by the distance between each point (\(T\) is the system variable for temperature).
14.5.11.1. Tools > Command Editor Example
>calculate lengthAve, <Expression>, <Location>

14.5.11.2. Tools > Function Calculator Example
This calculates the average velocity on the location Polyline1 using a length-based weighting function to account for the distribution of points along the line.

Function: lengthAve, Location: Polyline1, Variable: Velocity.

14.5.12. lengthInt
Computes the length-based integral of the variable on the specified line. This is the 1D equivalent of the areaInt function.

lengthInt(<Expression>)@<Location>

where:

- <Expression> is an expression
- <Location> is any 1D location.

14.5.12.1. Tools > Command Editor Example
>calculate lengthInt, <Expression>, <Location>.

14.5.13. mass
mass()@<Location>

where:

- <Location> is any 3D region (such as a domain or subdomain).

14.5.13.1. Tools > Command Editor Example
>calculate mass, <Location>.

14.5.14. massAve
massAve(<var>)@<Location>

where:

- <var> is a variable
- <Location> is any 3D region (such as a domain or subdomain).

14.5.14.1. Tools > Command Editor Example
>calculate massAve, <var>, <Location>.

14.5.15. massFlow
Computes the mass flow through the specified 2D location.

[<Phase>.]massFlow()@<Location>
where:

- `<Phase>.
  is an optional prefix that is not required for single-phase flows. For details, see CEL
  Functions with Multiphase Flow (p. 155).
- `<Location>` is any fluid surfaces (such as Inlets, Outlets, Openings and fluid-fluid interfaces).

`Air at STP.massFlow()@DegassingOutlet` calculates the mass flow of `Air at STP` through
the selected location.

For boundary locators:

- The mass flow is calculated using mass flow data from the results file, if it is available. Otherwise, an
  approximate mass flow is calculated.
- For multiphase cases, the mass flow through a boundary on a GGI interface evaluated in CFD-Post is
  an approximation to the 'exact' mass flow evaluated by the solver. This approximation vanishes as the
  mesh is refined or as the volume fraction on the interface becomes uniform.

For non-boundary locators (that is, internal locators):

- If the locator is an edge based locator (such as a slice plane or isosurface), the domain mass flow data
  from the results file will be used.
- In all other cases, an approximate mass flow is calculated.

The `massFlow` function enables you to select the fluids to use when performing your calculation. The
result returned is the mass flow of the selected fluids through the locator.

If a user specifies a boundary mass source, this mass source is not included in the `massFlow` calculator.
This will affect all `massFlow` related calculations, such as `massFlowInt()`.

**14.5.15.1. Mass Flow Sign Convention**

The mass flow through a surface is defined by 
\[- \rho \mathbf{V} \cdot \mathbf{n}\]
where \(\mathbf{V}\) is the velocity vector and \(\mathbf{n}\) is the
surface normal vector. By convention, the surface normal at a domain boundary is directed out of the
domain. Therefore, the mass flow is positive at an inlet boundary with the velocity directed into the
domain. For planes and surfaces that cut through a domain, the normal of the plane or surface is de-
termined by from the right-hand rule and the manner in which the plane or surface is constructed. For
example, the surface normal for a Z-X plane has the same sense and direction as the Y-axis.

**14.5.15.2. Tools > Command Editor Example**

>`calculate massFlow, <Location>, [<Phase>]`

**14.5.15.3. Tools > Function Calculator Example**

This calculates the mass flow for all fluids in the domains through the location `outlet2`:

**Function:** `massFlow`, **Location:** `outlet2`, **Phase:** `All Fluids`.

---

\(^1\)The availability depends on the setting for **Output Boundary Flows** for the file (see **Output Boundary Flows Check Box in the CFX-
14.5.16. massFlowAve

Computes the average of a variable/expression on the specified 2D location. The massFlowAve function allows you to select the fluids to use when performing your calculation. The result returned is the average variable value, evaluated according to the formula:

\[
massFlowAve (\Phi) = \frac{\sum (m \Phi)}{\sum m}
\]  

(14–3)

where \( \Phi \) represents the variable/expression being averaged and \( m \) represents the local mass flow (net local mass flow if more than one fluid is selected). Each summation term is evaluated on, and corresponds to, a node on the 2D locator. The mass flow for each term is derived from summing contributions from the surrounding solver integration points. As a result, the denominator evaluates to the conservative net mass flow through the 2D locator.

In cases where there is significant flow, but little or no net flow through the 2D locator (as can happen with recirculation), the denominator of the averaging formula becomes small, and the resulting average value may become adversely affected. In such cases, the massFlowAveAbs function is a viable alternative to the massFlowAve function.

\[ [<\text{Phase}>.]\text{massFlowAve}\{<\text{var|Expression}>\}@<\text{Location}>\]

where:

- \[ [<\text{Phase}>.] \] is an optional prefix that is not required for single-phase flows. For details, see CEL Functions with Multiphase Flow (p. 155).
- \[ <\text{var|Expression}> \] is a variable or expression
- \[ <\text{Location}> \] is any fluid surfaces (such as Inlets, Outlets, Openings and fluid-fluid interfaces). An error is raised if the location specified is not 2D.

massFlowAve(Density)@Plane1 calculates the average density on Plane1 weighted by the mass flow at each point on the location.

See the Advanced Mass Flow Considerations (p. 172) and Mass Flow Technical Note (p. 172) sections under massFlowAveAbs (p. 171) for more information.

14.5.16.1. Tools > Command Editor Example

> calculate massFlowAve, <var|Expression>, <Location>, [<Phase>]

14.5.16.2. Tools > Function Calculator Example

This example calculates the average velocity on Plane1 weighted by the mass flow for all fluids assigned to each point on Plane1:

**Function:** massFlowAve, **Location:** Plane1, **Variable:** Velocity, **Phase:** All Fluids

14.5.17. massFlowAveAbs

This function is similar to the massFlowAve function (see massFlowAve (p. 171)), except that each local mass flow value used in the averaging formula has the absolute function applied. That is:
massFlowAveAbs (\( \Phi \)) = \frac{\sum (|m| \cdot \Phi)}{\sum |m|} \quad (14-4)

where:

- \([\text{Phase}.\]) is an optional prefix that is not required for single-phase flows. For details, see CEL Functions with Multiphase Flow (p. 155).
- \(<\text{var}\mid\text{Expression}>\) is a variable or expression
- \(<\text{Location}>\) is any fluid surfaces (such as Inlets, Outlets, Openings and fluid-fluid interfaces). An error is raised if the location specified is not 2D.

massFlowAve(Density)@Plane1 calculates the average density on Plane1 weighted by the mass flow at each point on the location.

In cases where there is significant flow, but little or no net flow through the 2D locator (as can happen with recirculation), the massFlowAveAbs function is a viable alternative to the massFlowAve function (see massFlowAve (p. 171)).

14.5.18. Advanced Mass Flow Considerations

Note that the massFlowAveAbs and massFlowAve functions provide the same result, and that the denominator evaluates to the net mass flow through the 2D locator, only when all of the flow passes through the 2D locator in the same general direction (in other words, when there is no backflow). If there is any backflow through the 2D locator, the denominator in the function for massFlowAveAbs evaluates to a value of greater magnitude than the conservative net mass flow through the 2D locator (although this is not necessarily harmful to the resulting average value).

The values of variables other than mass flow are stored at the mesh nodes and are applied to the locator nodes by linear interpolation. For the mass flow variable, CFD-Post uses the integration point mass flow data if it is available; otherwise, it will approximate mass flow values based on mesh node values of velocity (and density, if available).


When integration point mass flow data is stored, backflow through the 2D locator may occur as an artifact of how the mass flow data is applied to the locator nodes, even though there may be no actual backflow (as evidenced by a vector plot on the locator). The figure below illustrates how this may occur.
In order to visualize this type of backflow through a locator, try making a contour plot of the variable Mass Flow, setting a user defined Range from 0 to 1 and the # of Contours to 3. This will produce a contour plot with two color bands: one for each general flow direction. This visualization technique works because the method of applying integration-point mass-flow data to locator nodes is the same for all uses of the mass flow variable involving a 2D locator (contour plots, massFlowAve, massFlowAveAbs, etc.).

**14.5.20. massFlowInt**

Integrates a variable over the specified 2D location. A weighting function is applied to the variable value at each point based on the mass flow assigned to that point. You can also specify the fluid(s) used to calculate the mass flow at each locator point.

```
[<Phase>.]massFlowInt(<var|Expression>)@<Location>
```

where:

- `[<Phase>.]` is an optional prefix that is not required for single-phase flows. For details, see **CEL Functions with Multiphase Flow** (p. 155).
- `<var|Expression>` is a variable or expression
- `<Location>` is any fluid surfaces (such as Inlets, Outlets, Openings and fluid-fluid interfaces). An error is raised if the location specified is not 2D.
14.5.20.1. Tools > Command Editor Example
>calculate massFlowInt, <var|Expression>, <Location>, [<Phase>]

14.5.20.2. Tools > Function Calculator Example
This example integrates pressure over Plane1. The result is the pressure force acting on Plane1 weighted by the mass flow assigned to each point on Plane1:

Function: massFlowInt, Location: Plane1, Variable: Pressure, Phase: All Fluids

14.5.21. massInt
The mass-weighted integration of a variable within a domain or subdomain.

massInt(<var|Expression>)@<Location>

where:
- <var> is a variable
- <Location> is any 3D region (such as a domain or subdomain)

14.5.21.1. Tools > Command Editor Example
>calculate massInt, <var>, <Location>

14.5.22. maxVal
Returns the maximum value of the specified variable on the specified locator. You should create a User Variable if you want to find the maximum value of an expression.

maxVal(<var|Expression>)@<Location>

where:
- <var|Expression> is a variable or expression
- <Location> in CFX-Solver is any 2D or 3D region (such as a domain or subdomain); in CFD-Post, Point and 1D, 2D, and 3D locators can be specified.

14.5.22.1. Tools > Command Editor Example
>calculate maxVal, <var|Expression>, <Location>

14.5.22.2. Tools > Function Calculator Example
This will return the maximum Yplus value on the default wall boundaries:

Function: maxVal, Location: Default, Variable: Yplus

14.5.23. minVal
Returns the minimum value of the specified variable on the specified locator. You should create a User Variable if you want to find the minimum value of an expression.

minVal(<var|Expression>)@<Location>
where:

- `<var|Expression>` is a variable or expression
- `<Location>` in CFX-Solver is any 2D or 3D region (such as a domain or subdomain); in CFD-Post, Point and 1D, 2D, and 3D locators can be specified.

### 14.5.23.1. Tools > Command Editor Example

```plaintext
>calculate minVal, <var|Expression>, <Location>
```

### 14.5.23.2. Tools > Function Calculator Example

These settings will return the minimum temperature in the domain:

**Function:** minVal, **Location:** MainDomain, **Variable:** Temperature

### 14.5.24. probe

Returns the value of the specified variable on the specified Point object.

```plaintext
probe(<var|Expression>)@<Location>
```

where:

- `<var|Expression>` is a variable or expression
- `<Location>` is any point object (such as a Source Point or Cartesian Monitor Point).

**Important**

This calculation should be performed only for point locators described by single points. Incorrect solutions will be produced for multiple point locators.

### 14.5.24.1. Tools > Command Editor Example

```plaintext
>calculate probe, <Expression>, <Location>
```

### 14.5.24.2. Tools > Function Calculator Example

This example returns the density value at `Point1`:

**Function:** probe, **Location:** `Point1`, **Variable:** Density

### 14.5.25. rbstate

Returns the value of the specified rigid body state variable, or axis component thereof, on the specified:

- Rigid Body object (for a standard rigid body definition), or
- Immersed Solid domain that is governed by a rigid body solution.

The rigid body state variables are:

- Position
- Linear Velocity
• Linear Acceleration
• Euler Angle
• Angular Velocity
• Angular Acceleration

Syntax:

rbstate(<rbvar>[<Axis>])@<Location>

where:

• <rbvar> is a rigid body state variable.
• <Axis> is X, Y, or Z.

For the Euler Angle rigid body state variable, an axis must be specified. For all of the other rigid body state variables, the axis is optional. If you do not specify an axis, the magnitude of the vector is returned. For example, if the variable is Position and you do not specify an axis, the distance from the origin will be returned.

• <Location> is any rigid body object or any immersed solid domain that is governed by a rigid body solution.

Results are given with respect to the global coordinate frame (Coord 0).

14.5.25.1. Expressions Details View Example

rbstate(Linear Velocity Z)@Buoy

14.5.26. rmsAve

Returns the RMS average of the specified variable within a domain.

rmsAve(<var>)@<Location>

where:

• <var> is a variable
• <Location> is any 2D region (such as a domain or subdomain).

14.5.26.1. Tools > Command Editor Example

>calculate rmsAve, <var>, <Location>

14.5.27. sum

Computes the sum of the specified variable values at each point on the specified location.

sum(<var|Expression>)@<Location>

where:

• <var|Expression> is a variable or expression
• <Location> in CFX-Solver is any 3D region (such as a domain or subdomain); in CFD-Post, Point and 1D, 2D, and 3D locators can be specified.
14.5.27.1. Tools > Command Editor Example

>calculate sum, <var|Expression>, <Location>

14.5.27.2. Tools > Function Calculator Example

This example returns the sum of the finite volumes assigned to each node in the location SubDomain1. In this case, this sums to the volume of the subdomain:

**Function:** sum, **Location:** SubDomain1, **Variable:** Volume of Finite Volume

14.5.28. torque

Returns the torque on a 2D locator about the specified axis. The force calculated during evaluation of the torque function has the same behavior as the force function. For details, see *force* (p. 165). You can select the fluids involved in the calculation.

\[ \text{[(Phase).]torque[(Axis)[(_Coord Frame)] ]}@<Location> \]

where:

- [Phase] is an optional prefix that is not required for single-phase flows. For details, see *CEL Functions with Multiphase Flow* (p. 155).
- Axis is x, y, or z
- Coord Frame
- Location is any 2D region (such as a wall). If the location specified is not 2D, an error is raised.

14.5.28.1. Tools > Command Editor Example

>calculate torque, <Location>, <Axis>, [Phase]

14.5.28.2. Tools > Function Calculator Example

This example calculates the torque on Plane1 about the z-axis due to all fluids in the domain.

**Function:** torque, **Location:** Plane1, **Axis:** Global Z, **Phase:** All Fluids

14.5.29. volume

Calculates the volume of a 3D location.

\[ \text{volume}@<Location> \]

where:

- Location is any 3D region (such as a domain or subdomain). An error is raised if the location specified is not a 3D object. For details, see *volume* (p. 177).

14.5.29.1. Tools > Command Editor Example

>calculate volume, <Location>

14.5.29.2. Tools > Function Calculator Example

This example returns the sum of the volumes of each mesh element included in the location Volume1.
Function: volume, Location: Volume1

14.5.30. volumeAve

Calculates the volume-weighted average of an expression on a 3D location. This is the 3D equivalent of the areaAve function. The volume-weighted average of a variable is the average value of the variable on a location weighted by the volume assigned to each point on a location. Without the volume weighting function, the average of all the nodal variable values would be biased towards values in regions of high mesh density. The following example demonstrates use of the function.

\[ \text{volumeAve}(<\text{var|Expression}>)<@<\text{Location}> \]

where:

- \(<\text{var|Expression}>\) is a variable or expression
- \(<\text{Location}>\) is any 3D region (such as a domain or subdomain).

14.5.30.1. Tools > Command Editor Example

>calculate volumeAve, <var|Expression>, <Location>

14.5.30.2. Tools > Function Calculator Example

This example calculates the volume-weighted average value of density in the region enclosed by the location Volume1:

Function: volumeAve, Location: Volume1, Variable: Density

14.5.31. volumeInt

Integrates the specified variable over the volume location. This is the 3D equivalent of the areaInt function.

\[ \text{volumeInt}(<\text{var|Expression}>)<@<\text{Location}> \]

where:

- \(<\text{var|Expression}>\) is a variable or expression
- \(<\text{Location}>\) is any 3D region (such as a domain or subdomain). An error is raised if the location specified is not a 3D object.

For example, \(\text{volumeInt}(\text{Density})@\text{StaticMixer}\) will calculate the total fluid mass in the domain StaticMixer.

Note

Because the Density variable represents the average density during the timestep rather than the density at the end of the timestep, the \(\text{volumeInt}(\text{Density})\) does not accurately give the mass of fluid at the end of a timestep. Use the \(\text{mass()}\) function instead.

14.5.31.1. Tools > Command Editor Example

>calculate volumeInt, <var|Expression>, <Location>
14.5.31.2. Tools > Function Calculator Example

This example calculates the integral of density (the total mass) in Volume1.

**Function:** volumeInt, **Location:** Volume1, **Variable:** Density
Chapter 15: Variables in ANSYS CFX

This chapter describes the variables available in ANSYS CFX:

15.1. Hybrid and Conservative Variable Values
15.2. List of Field Variables
15.3. Particle Variables Generated by the Solver
15.4. Miscellaneous Variables

15.1. Hybrid and Conservative Variable Values

The CFX-Solver calculates the solution to your CFD problem using polyhedral finite volumes surrounding the vertices of the underlying mesh elements (hexahedrons, tetrahedrons, prisms, pyramids). Analytical solutions to the Navier-Stokes equations exist for only the simplest of flows under ideal conditions. To obtain solutions for real flows, a numerical approach must be adopted whereby the equations are replaced by algebraic approximations which may be solved using a numerical method.

The solution values on the boundary vertices, called conservative values, are the values obtained from solving the conservation equations for the boundary control volumes. These values are not necessarily the same as the specified boundary condition values, although the specified boundary value is used to close boundary fluxes for the boundary control volume. For example, on a no-slip wall, the wall velocity is used to compute the viscous force for the boundary face of the boundary control volume, but the resulting control volume equation solution will not necessarily be the wall velocity. The conservative values are representative of the boundary control volume, not the boundary itself. For visualization purposes, it is often useful to view the specified boundary condition value for the boundary vertices rather than the conservative values. This is especially true when the value of a conservative solution variable (such as pressure or temperature, for instance) is specified at a particular boundary condition. The specified boundary values are called hybrid values. CFD-Post uses hybrid values by default for most variables. Hybrid values are obtained by overwriting the conservative results on the boundary nodes produced by the CFX-Solver with values based on the specified boundary conditions. This ensures, for example, that the velocity is displayed as zero on no-slip walls. For quantitative calculations, the conservative values should normally be used because they are consistent with the discrete solutions obtained by the solver. If you want to use these values in CFD-Post, you can select them from the Variables Editor dialog box as described above. By default, CFD-Post uses conservative values when the Calculate command is used.

The difference between hybrid and conservative values at wall boundaries can be demonstrated using the following figure:
Using velocity as an example, the velocity value calculated at a mesh node is based upon the ‘average’ in the control volume surrounding that node. For calculation purposes, the entire control volume is then assumed to possess that velocity. At a boundary node, its surrounding control volume includes an area in the bulk of the fluid (this area is highlighted around the boundary node marked 1). Hence, the conservative velocity calculated at the wall node is not zero, but an ‘average’ over the control volume adjacent to the boundary. At a wall boundary node the difference between conservative and hybrid values can be illustrated by considering the case of the mass flow rate through the wall-adjacent control volume. If a zero velocity was enforced at the boundary node, then this would produce zero mass flow through the control volume, which is clearly not correct.

15.1.1. Solid-Fluid Interface Variable Values

15.1.1.1. Conservative Values at 1:1 Interface

At a solid-fluid 1:1 interface, duplicate nodes exist. The conservative value for the solid-side node is the variable values averaged over the half on the control volume that lies inside the solid. The conservative value for the fluid-side node is the variable values averaged over the half of the control volume that lies in the fluid.

Consider the example of heat transfer from a hot solid to a cool fluid when advection dominates within the fluid. If you create a plot across the solid-fluid interface using conservative values of temperature, then you will see a sharp change in temperature across the interface. This is because values are interpolated from the interface into the bulk of the solid domain using the value for the solid-side node at the interface, while values are interpolated from the interface into the bulk of the fluid domain using the value for the fluid-side node at the interface. This results in a temperature discontinuity at the interface.

15.1.1.2. Hybrid Values at 1:1 Interface

When creating plots using hybrid variable values (the default in CFD-Post), the 1:1 interface is single valued and takes the solid-side conservative value. You can therefore expect to see the same plot within the solid, but the temperature profile between the interface and the first node in the fluid interpolates between the solid-side interface value and the first fluid node value. In this case, a discontinuity does not exist because all nodes are single valued.

Conservative values should be used for all quantitative calculations.
15.1.1.3. Conservative Values on a GGI Interface

At a GGI interface, the CFX Solver calculates both fluid-side and solid-side temperatures based on heat flux conservation. These values are representative of the temperature within the half-control volumes around the vertices on the interface. The fluid-side and solid-side temperatures are generally not equal. As a result, a plot of conservative values of temperature will generally show a discontinuity across a GGI interface.

15.1.1.4. Hybrid Values on a GGI Interface

At a GGI interface, the CFX Solver calculates a "surface temperature" based on a flux-conservation equation for the 'control surfaces' that lie between the fluid side and the solid side. The surface temperature is usually between the fluid-side and solid-side temperatures. Hybrid values of temperature on a GGI interface are set equal to the surface temperature. As a result, there is no discontinuity in hybrid values of temperature across a GGI interface.

15.2. List of Field Variables

This section contains a list of field variables that you may have defined in CFX-Pre or that are available for viewing in CFD-Post and exporting to other files. Many variables are relevant only for specific physical models.

The information given in this section includes:

- **Long Variable Name**: The name that you see in the user interface.
- **Short Variable Name**: The name that must be used in CEL expressions.
- **Units**: The default units for the variable. An empty entry [ ] indicates a dimensionless variable.

---

**Note**

The entries in the Units columns are SI but could as easily be any other system of units.

- In the **Availability** column:
  - A number represents the user level (1 indicates that the variable appears in default lists, 2 and 3 indicate that the variable appears in extended lists that you see when you click ...). This number is useful when using the CFX Export facility. For details, see File Export Utility in the CFX-Solver Manager User's Guide. Note that the CFX-Solver may sometimes override the user-level setting depending on the physics of the problem. In these cases, the User Level may be different from that shown in the tables that follow.
  - **Boundary (B)**: A B in this column indicates that the variable contains only non-zero values on the boundary of the model. See Boundary-Value-Only Variables in the CFD-Post User's Guide for more details.

**Boundary-Value-Only Variables in the CFD-Post User's Guide** describes the useful things that you can do with variables that are defined only on the boundaries of the model.

- A indicates the variable is available for mesh adaption
- C indicates the variable is available in CEL
- DT indicates the variable is available for data transfer to ANSYS
- M indicates the variable is available for monitoring
- P indicates the variable is available for particle user-routine argument lists
- PR indicates the variable is available for particle results
- R indicates the variable is available to be output to the results, transient results, and backup files
- RA indicates the variable is available for radiation results
- TS indicates the variable is available for transient statistics

• **Definition**: Defines the variable.

This is not a complete list of variables. Information on obtaining details on all variables is available in RULES and VARIABLES Files in the CFX-Solver Manager User’s Guide.

---

**Note**

Variables with names shown in **bold text** are not output to CFD-Post. However, some of these variables can be output to CFD-Post by selecting them from the **Extra Output Variables List** on the **Results** tab of the **Solver > Output Control** details view of CFX-Pre.

### 15.2.1. Common Variables Relevant for Most CFD Calculations

The following table contains a list of variables (with both long and short variable names) that can be used when working with CFD calculations. For an explanation of the column headings, see *List of Field Variables* (p. 183).

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
</table>
| Density            | density             | [kg m^-3]          | 1                  | For **Fixed** and **Variable Composition Mixture**, the density is determined by a mass fraction weighted harmonic average:  
<p>|                    |                     |                    | A, C, M, P, R, TS  | [ \frac{Y_A}{\rho_A} + \frac{Y_B}{\rho_B} + \cdots + \frac{Y_N}{\rho_N} = \frac{1}{\rho_{\text{mix}}} ] |
| Dynamic Viscosity  | viscosity           | [kg m^-1 s^-1]     | 2                  | Dynamic viscosity ($\mu$), also called <strong>absolute viscosity</strong>, is a measure of the resistance of a fluid to shearing forces, and appears in the momentum equations. Using an expression to set the dynamic viscosity is possible. For details, see <em>Non-Newtonian Flow in the CFX-Solver Modeling Guide</em>. |</p>
<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Velocity(^a)</td>
<td>vel</td>
<td>([\text{m s}^{-1}])</td>
<td>1</td>
<td>Velocity vector.</td>
</tr>
<tr>
<td>Velocity u</td>
<td>u</td>
<td>([\text{m s}^{-1}])</td>
<td>1</td>
<td>Components of velocity.</td>
</tr>
<tr>
<td>Velocity v</td>
<td>v</td>
<td>([\text{m s}^{-1}])</td>
<td>1</td>
<td>Components of velocity.</td>
</tr>
<tr>
<td>Velocity w</td>
<td>w</td>
<td>([\text{m s}^{-1}])</td>
<td>1</td>
<td>Components of velocity.</td>
</tr>
<tr>
<td>Pressure</td>
<td>p</td>
<td>([\text{kg m}^{-1} \text{s}^{-2}])</td>
<td>1</td>
<td>Both Pressure and Total Pressure are measured relative to the reference pressure that you specified on the Domains panel in CFX-Pre. Additionally, Pressure is the total normal stress, which means that when using the k-e turbulence model, Pressure is the thermodynamic pressure plus the turbulent normal stress. Static Pressure is the thermodynamic pressure, in most cases this is the same as Pressure. For details, see Modified Pressure in the CFX-Solver Theory Guide.</td>
</tr>
<tr>
<td>Static Pressure</td>
<td>pstat</td>
<td>([\text{kg m}^{-1} \text{s}^{-2}])</td>
<td>3</td>
<td>CFX solves for the relative Static Pressure (thermodynamic pressure) (p_{\text{stat}}) in the flow field, and is related to Absolute Pressure (p_{\text{abs}} = p_{\text{stat}} + p_{\text{ref}}).</td>
</tr>
<tr>
<td>Total Pressure</td>
<td>ptot</td>
<td>([\text{kg m}^{-1} \text{s}^{-2}])</td>
<td>2</td>
<td>The total pressure, (p_{\text{tot}}) is defined as the pressure that would exist at a point if the fluid was brought instantaneously to rest such that the dynamic energy of the flow converted to</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Wall shear</td>
<td>wall shear</td>
<td>Pa</td>
<td>3, B</td>
<td>pressure without losses. The following three sections describe how total pressure is computed for a pure component material with constant density, ideal gas equation of state and a general equation of state (CEL expression or RGP table). For details, see Scalable Wall Functions in the CFX-Solver Theory Guide.</td>
</tr>
<tr>
<td>X coordinate</td>
<td>x</td>
<td>[m]</td>
<td>2</td>
<td>Cartesian coordinate components.</td>
</tr>
<tr>
<td>Y coordinate</td>
<td>y</td>
<td>[m]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Z coordinate</td>
<td>z</td>
<td>[m]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Kinematic Diffusivity</td>
<td>visckin</td>
<td></td>
<td>2</td>
<td>C, M, P, R, TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Kinematic diffusivity describes how rapidly a scalar quantity would move through the fluid in the absence of convection. For convection-dominated flows, the kinematic diffusivity can have little effect because convection processes dominate over diffusion processes.</td>
</tr>
<tr>
<td>Shear Strain Rate</td>
<td>sstrnr</td>
<td>[s^-1]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>For details see Non-Newtonian Flow in the CFX-Solver Modeling Guide.</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Specific Heat Capacity at Constant Pressure</td>
<td>Cp</td>
<td>([m^2 s^{-2} K^{-1}])</td>
<td>2, A, C, M, R, TS</td>
<td>For details, see Specific Heat Capacity in the CFX-Solver Modeling Guide.</td>
</tr>
<tr>
<td>Specific Heat Capacity at Constant Volume</td>
<td>Cv</td>
<td>([m^2 s^{-2} K^{-1}])</td>
<td>2, A, C, M, P, R, TS</td>
<td></td>
</tr>
<tr>
<td>Thermal Conductivity</td>
<td>cond</td>
<td>([\text{kg m s}^{-3} K^{-1}])</td>
<td>2, A, C, M, R, TS</td>
<td>Thermal conductivity, (\lambda), is the property of a fluid that characterizes its ability to transfer heat by conduction. For details, see Thermal Conductivity in the CFX-Solver Modeling Guide.</td>
</tr>
<tr>
<td>Temperature</td>
<td>T</td>
<td>([K])</td>
<td>1, A, C, DT, M, P, R, TS</td>
<td>The static temperature, (T_{\text{stat}}), is the thermodynamic temperature, and depends on the internal energy of the fluid. In CFX, depending on the heat transfer model you select, the flow solver calculates either total or static enthalpy (corresponding to the total or thermal energy equations). For details, see Static Temperature in the CFX-Solver Theory Guide.</td>
</tr>
<tr>
<td>Total Temperature</td>
<td>Ttot</td>
<td>([K])</td>
<td>1, A, C, M, P, R, TS</td>
<td>The total temperature is derived from the concept of total enthalpy and is computed exactly the same way as static temperature, except that total enthalpy is used in the property relationships. For details, see Total Temperature in the CFX-Solver Theory Guide.</td>
</tr>
</tbody>
</table>
### 15.2.2. Variables Relevant for Turbulent Flows

The following table contains a list of variables (with both long and short variable names) that can be used when working with turbulent flows. For an explanation of the column headings, see *List of Field Variables* (p. 183).

A *B* in the **Type** column indicates that the variable contains only non-zero values on the boundary of the model.

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wall Heat Flux</td>
<td>Qwall</td>
<td>[W m⁻²]</td>
<td>2, B, C, DT, R, TS</td>
<td>A heat flux is specified across the wall boundary. A positive value indicates heat flux into the domain. For multiphase cases, when the bulk heat flux into both phases is set, this option is labeled Wall Heat Flux instead of Heat Flux. When set on a per fluid basis, this option is labelled Heat Flux.</td>
</tr>
<tr>
<td>Total Enthalpy</td>
<td>htot</td>
<td>[m² s⁻²]</td>
<td>A, C, M, R, TS</td>
<td>( h_{\text{tot}} ) \nFor details, see <em>Transport Equations in the CFX-Solver Theory Guide</em>.</td>
</tr>
<tr>
<td>Static Enthalpy</td>
<td>enthalpy</td>
<td>[m² s⁻²]</td>
<td>2, A, C, M, P, R, TS</td>
<td>For details, see <em>Static Enthalpy in the CFX-Solver Theory Guide</em>.</td>
</tr>
</tbody>
</table>

---

*When a rotating frame of reference is used, all variables in the CFX-S results file are relative to the rotating frame, unless specified as a Stn Frame variable.*
<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turbulence Kinetic Energy</td>
<td>ke</td>
<td>([m^2 s^{-2}])</td>
<td>1, A, C, M, P, R, TS</td>
<td>For details, see <em>The k-epsilon Model in the CFX-Solver Modeling Guide</em>.</td>
</tr>
<tr>
<td>Turbulence Eddy Dissipation</td>
<td>ed</td>
<td>([m^2 s^{-3}])</td>
<td>1, A, C, M, P, R, TS</td>
<td>The rate at which the velocity fluctuations dissipate. For details, see <em>The k-epsilon Model in the CFX-Solver Modeling Guide</em>.</td>
</tr>
<tr>
<td>Turbulent Eddy Frequency</td>
<td>tef</td>
<td>([s^{-1}])</td>
<td>1, A, C, M, P, R, TS</td>
<td></td>
</tr>
<tr>
<td>Eddy Viscosity</td>
<td>eddy viscosity</td>
<td>([kg m^{-1} s^{-1}])</td>
<td>2, A, C, M, P, R, TS</td>
<td>The “eddy viscosity model” proposes that turbulence consists of small eddies that are continuously forming and dissipating, and in which the Reynolds stresses are assumed to be proportional to mean velocity gradients. For details, see <em>Eddy Viscosity Turbulence Models in the CFX-Solver Theory Guide</em>.</td>
</tr>
<tr>
<td>Reynolds Stress</td>
<td>rs</td>
<td>([m^2 s^{-2}])</td>
<td>2, A, C, M, P, R, TS</td>
<td>This is a tensor quantity with six components. For details, see <em>Statistical Reynolds Stresses in the CFX-Solver Modeling Guide</em> and <em>Reynolds Stress Turbulence Models in the CFX-Solver Theory Guide</em> in the ANSYS CFX documentation.</td>
</tr>
<tr>
<td>Statistical Reynolds Stress uu</td>
<td>rsstat uu</td>
<td>([m^2 s^{-2}])</td>
<td>3, M, R</td>
<td>In LES runs, Reynolds Stress components are automatically generated using running statistics of the instantaneous, transient velocity field. For details, see <em>Statistical Reynolds Stresses in the CFX-Solver Modeling Guide</em>.</td>
</tr>
<tr>
<td>Statistical Reynolds Stress vv</td>
<td>rsstat vv</td>
<td>([m^2 s^{-2}])</td>
<td>3, M, R</td>
<td></td>
</tr>
</tbody>
</table>
### Table: Variables in ANSYS CFX

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistical Reynolds Stress ww</td>
<td>rssstat ww</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>M, R</td>
</tr>
<tr>
<td>Statistical Reynolds Stress uv</td>
<td>rssstat uv</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>M, R</td>
</tr>
<tr>
<td>Statistical Reynolds Stress uw</td>
<td>rssstat uw</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>M, R</td>
</tr>
<tr>
<td>Statistical Reynolds Stress vw</td>
<td>rssstat vw</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>M, R</td>
</tr>
<tr>
<td>Velocity Correlation uu</td>
<td>uu</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>C, M, R</td>
</tr>
<tr>
<td>Velocity Correlation vv</td>
<td>vv</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>C, M, R</td>
</tr>
<tr>
<td>Velocity Correlation ww</td>
<td>ww</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>C, M, R</td>
</tr>
<tr>
<td>Velocity Correlation uv</td>
<td>uv</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>C, M, R</td>
</tr>
<tr>
<td>Velocity Correlation uw</td>
<td>uw</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>C, M, R</td>
</tr>
<tr>
<td>Velocity Correlation vw</td>
<td>vw</td>
<td>([\text{m}^2 \text{s}^{-2}])</td>
<td>3</td>
<td>C, M, R</td>
</tr>
<tr>
<td>Yplus</td>
<td>yplusstd</td>
<td>[ ]</td>
<td>2, B</td>
<td>C, R, TS</td>
</tr>
</tbody>
</table>

For details, see [Statistical Reynolds Stresses in the CFX-Solver Modeling Guide](#).

A variable based on the distance from the wall to the first node and the wall shear stress. For details, see [Solver Yplus and Yplus in the CFX-Solver Modeling Guide](#).
### 15.2.3. Variables Relevant for Buoyant Flow

The following table contains a list of variables (with both long and short variable names) that can be used when working with buoyant flows. For an explanation of the column headings, see List of Field Variables (p. 183).

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thermal Expansivity</td>
<td>beta</td>
<td>[K^-1]</td>
<td>2, C</td>
<td>For details, see Buoyancy in the CFX-Solver Modeling Guide.</td>
</tr>
</tbody>
</table>

### 15.2.4. Variables Relevant for Compressible Flow

The following table contains a list of variables (with both long and short variable names) that can be used when working with compressible flows.

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Isobaric Compressibility</td>
<td>compisoP</td>
<td>[K^-1]</td>
<td>2, C, M, R</td>
<td>$-\frac{1}{\rho} \frac{\partial \rho}{\partial T} \bigg</td>
</tr>
<tr>
<td>Isothermal Compressibility</td>
<td>compisoT</td>
<td>[m s^-2 kg^-1]</td>
<td>2, C, M, R</td>
<td>Defines the rate of change of the system volume with pressure. $\frac{1}{\rho} \frac{\partial \rho}{\partial p} \bigg</td>
</tr>
<tr>
<td>Mach Number</td>
<td>Mach</td>
<td>[ ]</td>
<td>1, A, C, M, R, TS</td>
<td>For details, see List of Symbols in the CFX-Solver Theory Guide.</td>
</tr>
</tbody>
</table>
The variable takes a value of 0 away from a shock and a value of 1 in the vicinity of a shock.

The extent to which a material reduces its volume when it is subjected to compressive stresses at a constant value of entropy.

\[ \left( \frac{1}{\rho} \right) \left( \frac{\partial \rho}{\partial \rho} \right)_s \]

### 15.2.5. Variables Relevant for Particle Tracking

The following table contains a list of variables (with both long and short variable names) that can be used when working with compressible flows.

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>User Level</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Particle Momentum Source</td>
<td>pt-moms-rc</td>
<td>[]</td>
<td>2</td>
<td>Momentum source from particle phase to continuous phase.</td>
</tr>
<tr>
<td>Particle Diameter</td>
<td>particle diameter</td>
<td>[]</td>
<td>3</td>
<td>Diameter of a particle phase.</td>
</tr>
</tbody>
</table>

### 15.2.6. Variables Relevant for Calculations with a Rotating Frame of Reference

The following table contains a list of variables (with both long and short variable names) that can be used when working with a rotating frame of reference. For an explanation of the column headings, see List of Field Variables (p. 183).
### 15.2.7. Variables Relevant for Parallel Calculations

The following table contains a list of variables (with both long and short variable names) that can be used when working with parallel calculations. For an explanation of the column headings, see *List of Field Variables* (p. 183).

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Real Partition Number</td>
<td>[]</td>
<td>[]</td>
<td>2</td>
<td>The partition that the node was in for the parallel run.</td>
</tr>
</tbody>
</table>

### 15.2.8. Variables Relevant for Multicomponent Calculations

The following table contains a list of variables (with both long and short variable names) that can be used when working with multicomponent calculations. For an explanation of the column headings, see *List of Field Variables* (p. 183).
### 15.2.9. Variables Relevant for Multiphase Calculations

The following table contains a list of variables (with both long and short variable names) that can be used when working with multiphase calculations. For an explanation of the column headings, see *List of Field Variables* (p. 183).

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface Area Density</td>
<td>area density</td>
<td>[m^1]</td>
<td>3</td>
<td>Interface area per unit volume for Eulerian multiphase fluid pairs.</td>
</tr>
<tr>
<td>Interphase Mass Transfer Rate</td>
<td>ipmt rate</td>
<td>[]</td>
<td>3</td>
<td>Interface mass transfer rate for Eulerian multiphase fluid pairs.</td>
</tr>
<tr>
<td>Mean Particle Diameter</td>
<td>mean particle diameter</td>
<td>[m]</td>
<td>3</td>
<td>Mean particle diameter for an Eulerian dispersed phase (including Polydispersed Fluids).</td>
</tr>
<tr>
<td>Volume Fraction</td>
<td>vf</td>
<td>[]</td>
<td>1</td>
<td>For details, see <em>Volume Fraction in the CFX-Solver Modeling Guide</em>.</td>
</tr>
<tr>
<td>Conservative Volume Fraction</td>
<td>vfc</td>
<td>[]</td>
<td>2</td>
<td>For details, see <em>Volume Fraction in the CFX-Solver Modeling Guide</em>.</td>
</tr>
</tbody>
</table>
## 15.2.10. Variables Relevant for Radiation Calculations

The following table contains a list of variables (with both long and short variable names) that can be used when working with radiation calculations. For an explanation of the column headings, see *List of Field Variables* (p. 183).

A **B** in the **Type** column indicates that the variable contains only non-zero values on the boundary of the model.

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drift Velocity</td>
<td>drift velocity</td>
<td>[]</td>
<td>2</td>
<td>Velocity of an algebraic slip component relative to the mixture.</td>
</tr>
<tr>
<td>Slip Reynolds Number</td>
<td>slip Re</td>
<td>[]</td>
<td>3</td>
<td>Reynolds number for Eulerian multiphase fluid pairs.</td>
</tr>
<tr>
<td>Slip Velocity</td>
<td>slipvel</td>
<td>[]</td>
<td>1</td>
<td>Velocity of an algebraic slip component relative to the continuous component.</td>
</tr>
<tr>
<td>Surface Tension Coefficient</td>
<td>surface tension coefficient</td>
<td>[N m^-1]</td>
<td>2</td>
<td>Surface tension coefficient between fluids in a fluid pair.</td>
</tr>
<tr>
<td>Unclipped Interfacial Area Density</td>
<td>unclipped area density</td>
<td>[m^-1]</td>
<td>3</td>
<td>Similar to area density, but values are not clipped to be non-zero.</td>
</tr>
</tbody>
</table>

### Example

**Table:**

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drift Velocity</td>
<td>drift velocity</td>
<td>[]</td>
<td>2</td>
<td>Velocity of an algebraic slip component relative to the mixture.</td>
</tr>
<tr>
<td>Slip Reynolds Number</td>
<td>slip Re</td>
<td>[]</td>
<td>3</td>
<td>Reynolds number for Eulerian multiphase fluid pairs.</td>
</tr>
<tr>
<td>Slip Velocity</td>
<td>slipvel</td>
<td>[]</td>
<td>1</td>
<td>Velocity of an algebraic slip component relative to the continuous component.</td>
</tr>
<tr>
<td>Surface Tension Coefficient</td>
<td>surface tension coefficient</td>
<td>[N m^-1]</td>
<td>2</td>
<td>Surface tension coefficient between fluids in a fluid pair.</td>
</tr>
<tr>
<td>Unclipped Interfacial Area Density</td>
<td>unclipped area density</td>
<td>[m^-1]</td>
<td>3</td>
<td>Similar to area density, but values are not clipped to be non-zero.</td>
</tr>
</tbody>
</table>
Wall Radiative Heat Flux represents the net radiative energy flux leaving the boundary. It is computed as the difference between the radiative emission and the incoming radiative flux (Wall Irradiation Flux).

Wall Heat Flux is sum of the Wall Radiative Heat Flux and the Wall Convective Heat Flux. For an adiabatic wall, the sum should be zero.

Wall Irradiation Flux represents the incoming radiative flux. It is computed as the solid angle integral of the incoming Radiative Intensity over a hemisphere on the boundary. For simulations using the multiband model, the Wall Irradiation Flux for each spectral band is also available for post-processing.

### 15.2.11. Variables for Total Enthalpies, Temperatures, and Pressures

The following table lists the names of the various total enthalpies, temperatures, and pressures when visualizing results in CFD-Post or for use in CEL expressions. For an explanation of the column headings, see *List of Field Variables* (p. 183).

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Enthalpy</td>
<td>htot</td>
<td>[m^2s^-2]</td>
<td>A, C, M, R, TS</td>
<td>$h_{tot}$</td>
</tr>
<tr>
<td>Total Enthalpy in Stn Frame</td>
<td>htotstn</td>
<td>[m^2s^-2]</td>
<td>A, C, M, R, TS</td>
<td>$h_{tot, stn}$</td>
</tr>
<tr>
<td>Total Temperature in Rel Frame</td>
<td>Ttotrel</td>
<td>[K]</td>
<td>A, C, DT, M, P, R, TS</td>
<td>$T_{tot, rel}$</td>
</tr>
</tbody>
</table>
### 15.2.12. Variables and Predefined Expressions Available in CEL Expressions

The following is a table of the more common variables and predefined expressions that are available for use with CEL when defining expressions. To view a complete list, open the Expressions workspace. For an explanation of the column headings, see List of Field Variables (p. 183).

Many variables and expressions have a long and a short form (for example, Pressure or p).

Additional variables and expressions are available in CFD-Post. For details, see CFX Expression Language (CEL) in CFD-Post in the CFD-Post User’s Guide.

#### Table 15.1 Common CEL Single-Value Variables and Predefined Expressions

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accumulated Coupling Step</td>
<td>acplgstep</td>
<td>[ ]</td>
<td>2 C</td>
<td>These single-value variables enable access to timestep, timestep interval, and iteration number in CEL expressions. They may be useful in setting parameters such as the Physical Timescale via CEL expressions. For details, see Timestep, Timestep Interval, and Iteration Number Variables (p. 207).</td>
</tr>
<tr>
<td>Accumulated Iteration Number</td>
<td>aitern</td>
<td>[ ]</td>
<td>2 C</td>
<td></td>
</tr>
<tr>
<td>Accumulated Time Step</td>
<td>atstep</td>
<td>[ ]</td>
<td>2 C</td>
<td></td>
</tr>
</tbody>
</table>
### Table 15.2 Common CEL Field Variables and Predefined Expressions

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Iteration Number</td>
<td>citern</td>
<td>[ ]</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Current Stagger Iteration</td>
<td>cstagger</td>
<td>[ ]</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Current Time Step</td>
<td>ctstep</td>
<td>[ ]</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Sequence Step</td>
<td>sstep</td>
<td>[ ]</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Time Step Size</td>
<td>dtstep</td>
<td>[s]</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Time</td>
<td>t</td>
<td>[s]</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

Variables with names shown in **bold text** in the tables that follow are not output to CFD-Post. However, some of these variables can be output to CFD-Post by selecting them from the **Extra Output Variables List** on the **Results** tab of the **Solver > Output Control** details view in CFX-Pre.
<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>within the medium. It can be interpreted as the inverse of the mean free path that a photon will travel before being absorbed (if the absorption coefficient does not vary along the path).</td>
</tr>
<tr>
<td>Boundary Distance</td>
<td>bnd distance</td>
<td>[m]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Boundary Scale</td>
<td>bnd scale</td>
<td>[m^-2]</td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Contact Area Fraction</td>
<td>af</td>
<td>[ ]</td>
<td>3</td>
<td>M</td>
</tr>
<tr>
<td>[AV name]</td>
<td>[AV name]</td>
<td></td>
<td></td>
<td>Additional Variable name</td>
</tr>
<tr>
<td>Thermal Expansivity</td>
<td>beta</td>
<td>[K^-1]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Effective Density</td>
<td>deneff</td>
<td>[kg m^-3]</td>
<td>3</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Density</td>
<td>density</td>
<td>[kg m^-3]</td>
<td>2</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Eddy Viscosity</td>
<td>eddy viscosity</td>
<td>[kg m^-1 s^-1]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Emissivity</td>
<td>emis</td>
<td>[ ]</td>
<td>1</td>
<td>C</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------</td>
<td>------------------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Extinction Coefficient</td>
<td>extinct</td>
<td>[m^-1]</td>
<td>1 C</td>
<td>The position of each node as it was at the start of the simulation (that is, the current position with Total Mesh Displacement subtracted). The individual components are referred to as &quot;Initial X&quot;, &quot;Initial Y&quot; and &quot;Initial Z&quot;.</td>
</tr>
<tr>
<td>Initial Cartesian Coordinates</td>
<td>initcart-crd</td>
<td>[m]</td>
<td>2 C</td>
<td></td>
</tr>
<tr>
<td>Mach Number</td>
<td>Mach</td>
<td>[ ]</td>
<td>1 A, C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Mass Fraction</td>
<td>mf</td>
<td>[ ]</td>
<td>1 A, C, M, P, R, TS</td>
<td></td>
</tr>
<tr>
<td>Mean Particle Diameter</td>
<td>mean particle diamet-er</td>
<td>[m]</td>
<td>3 C, P</td>
<td></td>
</tr>
<tr>
<td>Mesh Displacement</td>
<td>mesh-disp</td>
<td>[m]</td>
<td>3 C, M, R, TS</td>
<td>The displacement relative to the previous mesh</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Mesh Expansion Factor</td>
<td>mesh exp fact</td>
<td>[ ]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Mesh Initialisation Time</td>
<td>meshinit-time</td>
<td>[s]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Mixture Fraction</td>
<td>mixfrc</td>
<td>[ ]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Mixture Model Length Scale</td>
<td>mixture length scale</td>
<td>[m]</td>
<td>3</td>
<td>M</td>
</tr>
<tr>
<td>Mixture Fraction Variance</td>
<td>mixvar</td>
<td>[ ]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Molar Fraction</td>
<td>molf</td>
<td>[ ]</td>
<td>2</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Molar Mass</td>
<td>mw</td>
<td>[kg mol^-1]</td>
<td>3</td>
<td>C, P</td>
</tr>
<tr>
<td>Orthogonality Angle</td>
<td>orthangle</td>
<td>[rad]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Orthogonality Angle Minimum</td>
<td>orthanglemin</td>
<td>[rad]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Orthogonality Factor</td>
<td>orthfact</td>
<td>[ ]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------</td>
<td>-------------------------------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Orthogonality Factor Minimum</td>
<td>orthfactmin</td>
<td>[kg m^-1 s^-2]</td>
<td>2</td>
<td>A measure of the worst mesh orthogonality angle</td>
</tr>
<tr>
<td>Pressure</td>
<td>p</td>
<td>[kg m^-1 s^-2]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Absolute Pressure</td>
<td>pabs</td>
<td>[kg m^-1 s^-2]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Reference Pressure</td>
<td>pref</td>
<td>[kg m^-1 s^-2]</td>
<td>2</td>
<td>The Reference Pressure is the absolute pressure datum from which all other pressure values are taken. All relative pressure specifications in CFX are relative to the Reference Pressure. For details, see Setting a Reference Pressure in the CFX-Solver Modeling Guide.</td>
</tr>
<tr>
<td>Distance from local z axis</td>
<td>r</td>
<td>[m]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Radius</td>
<td>raxis</td>
<td>[m]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Radiative Emission</td>
<td>rademis</td>
<td>[kg s^-3]</td>
<td>1</td>
<td>RA</td>
</tr>
<tr>
<td>Incident Radiation</td>
<td>radinc</td>
<td>[kg s^-3]</td>
<td>1</td>
<td>C, DT, M, R, TS</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Radiation Intensity</td>
<td>radint</td>
<td>[kg (s^{-3})]</td>
<td>1 A, C, M, P, R, TS</td>
<td>Radiative Emission. This is written to the results file for Monte Carlo simulations as Radiation Intensity. Normalized Std Deviation.</td>
</tr>
<tr>
<td>Refractive Index</td>
<td>refrac</td>
<td>[_]</td>
<td>1 C, R, TS</td>
<td>A non-dimensional parameter defined as the ratio of the speed of light in a vacuum to that in a material.</td>
</tr>
<tr>
<td>Non-dimensional radius</td>
<td>rNoDim</td>
<td>[_]</td>
<td>2 C</td>
<td>Non-dimensional radius (available only when a rotating domain exists). For details, see CEL Variable rNoDim (p. 207).</td>
</tr>
<tr>
<td>Reynolds Stress</td>
<td>rs uu, rs vv, rs ww, rs uv, rs uw, rs vw</td>
<td>[m^2 (s^{-2})]</td>
<td>2 A, C, M, P, R, TS</td>
<td>The six Reynolds Stress components</td>
</tr>
<tr>
<td>Statistical Reynolds Stress</td>
<td>rsstat uu, rsstat vv, rsstat ww, rsstat uv, rsstat uw, rsstat vw</td>
<td>[m^2 (s^{-2})]</td>
<td>3 M, R</td>
<td>The six Statistical Reynolds Stress components</td>
</tr>
<tr>
<td>Scattering Coefficient</td>
<td>scatter</td>
<td>[m^-1]</td>
<td>1 C, M, R, TS</td>
<td>The property of a medium that describes the amount of scattering of thermal radiation per unit path length for propagation in the medium. It can be interpreted as the inverse of the mean free path that a photon will travel before undergoing scattering (if the scattering coefficient does not vary along the path).</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Soot Mass Fraction</td>
<td>sootmf</td>
<td>[]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Subdomain variable (1.0 in subdomain, 0.0 elsewhere). For details, see CEL Variable &quot;subdomain&quot; and CEL Function &quot;inside&quot; (p. 207).</td>
</tr>
<tr>
<td>Soot Nuclei Specific Concentration</td>
<td>sootncl</td>
<td>[m^-3]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Specific Volume</td>
<td>specvol</td>
<td>[m^3 kg^-1]</td>
<td>3</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Inside variable (1.0 in subdomain, 0.0 elsewhere). For details, see CEL Variable &quot;subdomain&quot; and CEL Function &quot;inside&quot; (p. 207).</td>
</tr>
<tr>
<td>Local Speed of Sound</td>
<td>speedofsound</td>
<td>[m s^-1]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Subdomain</td>
<td>subdomain</td>
<td>[]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Theta</td>
<td>taxis</td>
<td>[rad]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Theta is the angular spatial location measured around the locally-defined axis, when the latter is defined by the Coordinate Axis option. When the locally-defined axis is the z/(x/y)-axis, taxis is measured from the x/(y/z)-axis, positive direction as per right-hand rule.</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Angle around local z axis</td>
<td>theta</td>
<td>[rad]</td>
<td>2, C</td>
<td>Angle, arctan(y/x). For details, see CEL Variables r and theta (p. 206).</td>
</tr>
<tr>
<td>Total Mesh Displacement</td>
<td>mesh-displtot</td>
<td>[m]</td>
<td>1</td>
<td>C, DT, M, R, TS</td>
</tr>
<tr>
<td>Velocity u</td>
<td>u</td>
<td>[m s^{-1}]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Velocity v</td>
<td>v</td>
<td>[m s^{-1}]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Velocity w</td>
<td>w</td>
<td>[m s^{-1}]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Velocity in Stn Frame u</td>
<td>velstn u</td>
<td>[m s^{-1}]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Velocity in Stn Frame v</td>
<td>velstn v</td>
<td>[m s^{-1}]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Velocity in Stn Frame w</td>
<td>velstn w</td>
<td>[m s^{-1}]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Volume Fraction</td>
<td>vf</td>
<td>[ ]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Conservative Volume Fraction</td>
<td>vfc</td>
<td>[ ]</td>
<td>2</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Kinematic Viscosity</td>
<td>visckin</td>
<td>[m^2 s^{-1}]</td>
<td>2</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Wall Distance</td>
<td>wall distance</td>
<td>[m]</td>
<td>2</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Wall Scale</td>
<td>wall scale</td>
<td>[m^2]</td>
<td>3</td>
<td>M, R, TS</td>
</tr>
</tbody>
</table>
15.2.12.1. System Variable Prefixes

In order to distinguish system variables of the different components and fluids in your CFX model, prefixes are used. For example, if carbon dioxide is a material used in the fluid air, then some of the system variables that you might expect to see are:

- \textit{air.density} - the density of air
- \textit{air.viscosity} - the viscosity of air
- \textit{air.carbondioxide.mf} - the mass fraction of carbon dioxide in air
- \textit{air | water.surface tension coefficient} - the surface tension coefficient between air and water
- \textit{air | water.area density} - the interfacial area density between air and water.

In a single phase simulation the fluid prefix may be omitted.

For multiphase cases, a fluid prefix indicates either a specific fluid, or a specific fluid pair. The absence of a prefix indicates a bulk or fluid independent variable, such as pressure.

For porous solids, those variables that exist in the solid are prefixed by the name of the solid phase.

15.2.12.2. CEL Variables \textit{r} and \textit{theta}

\textit{r} is defined as the normal distance from the third axis with respect to the reference coordinate frame. \textit{theta} is defined as the angular rotation about the third axis with respect to the reference coordinate frame. For details, see Coordinate Frames in the \textit{CFX-Solver Modeling Guide}.

The variables \textit{Radius} and \textit{theta} are available only when the rotational axis has been defined. The rotational axis can either be defined in the results file or in CFD-Post through the Initialization panel in the Turbo workspace.

\begin{quote}
\textbf{Note}

\textit{theta} is expressed in radians and will have values between $-\pi$ and $\pi$.
\end{quote}

\textit{r} and \textit{theta} are particularly useful for describing radial distributions, for instance the velocity profile at the inlet to a pipe.

\textit{Figure 15.1} \textit{r} and \textit{theta} with Respect to the Reference Coordinate Frame
15.2.12.3. CEL Variable rNoDim

rNoDim is a dimensionless system variable that can be useful for rotating machinery applications. It is a ratio of radii, defined to be zero at the minimum radius and unity at the maximum radius, so that in general:

\[ r\text{NoDim} = \frac{R - R_{\text{min}}}{R_{\text{max}} - R_{\text{min}}} \]

where \( R \) is the radius of any point in the domain from the axis of rotation. \( r\text{NoDim} \) is only available for domains defined with a rotating frame of reference.

15.2.12.4. CEL Variable "subdomain" and CEL Function "inside"

subdomain is essentially a step function variable, defined to be unity within a subdomain and zero elsewhere. This is useful for describing different initial values or fluid properties in different regions of the domain. It works in all subdomains but cannot be applied to specific subdomains (for example, an expression for temperature in a subdomain could be \( 373 \times \text{subdomain} \ [K] \)).

The inside CEL function can be used in a similar way to the subdomain variable, but allows a specific 2D or 3D location to be given. For example, \( 273 \ [K] \times \text{inside()}@\text{Subdomain 1} \) has a value of 273 [K] at points in Subdomain 1 and 0 [K] elsewhere. Furthermore, the location can be any 2D or 3D named sub-region of the physical location on which the expression is evaluated. The location can also be an immersed solid domain.

15.2.12.5. Timestep, Timestep Interval, and Iteration Number Variables

These variables allow access to timestep, timestep interval, and iteration number in CEL expressions. They may be useful in setting parameters such as the Physical Timescale via CEL expressions.

In CFD-Post, ststep is the 'global' sequence time step. It is equivalent to the Step value in the Timestep Selector in the CFD-Post User's Guide.

15.2.12.5.1. Steady-State Runs

In steady-state runs, only aitern (or, equivalently atstep) and citern (or, equivalently ctstep) are of use. citern gives the outer iteration number of the current run. The outer iteration number begins at 1 for each run, irrespective of whether it is a restarted run. aitern gives the accumulated outer iteration number, which accumulates across a restarted run.

15.2.12.5.2. Transient Runs

In transient runs, atstep and ctstep are used for the accumulated and current timestep numbers of the outer timestep loop. citern gives the current coefficient loop number within the current timestep. Thus, citern will cycle between 1 and \( n \) for each timestep during a transient run, where \( n \) is the number of coefficient loops. aitern is equivalent to citern for transient runs.

15.2.12.5.3. ANSYS Multi-field Runs

For ANSYS Multi-field runs, cstagter and acplgstep are also available. cstagter gives the current stagger iteration, which will cycle between 1 and \( n \) for each coupling step of the run. acplgstep gives the accumulated coupling step. This gives the multi-field timestep number or "coupling step" number.
for the run, and accumulates across a restarted run. For transient ANSYS Multi-field runs where the CFX
timestep is the same as the multi-field timestep, acplgstep is equivalent to atstep.

15.2.12.6. Expression Names

Your CEL expression name can be any name that does not conflict with the name of a CFX system
variable, mathematical function, or an existing CEL expression. The RULES and VARIABLES files provide
information on valid options, variables, and dependencies. Both files are located in \(<CFXROOT>/etc/
and can be viewed in any text editor.

15.2.12.7. Scalar Expressions

A scalar expression is a real valued expression using predefined variables, user variables, and literal
constants (for example, 1.0). Note that literal constants have to be of the same dimension. Scalar expres-
sions can include the operators +, -, *, / and ^ and several of the mathematical functions found in
standard Fortran (for example, sin() and exp()).

An expression's value is a real value and has specified dimensions (except where it is dimensionless -
but this is also a valid dimension setting).

For example, if \( t \) is time and \( L \) is a length then the result of \( L/t \) has the same dimensions as speed.

The + and - operators are only valid between expressions with the same dimensions and result in an
expression of those dimensions.

The * and / operators combine the dimensions of their operands in the usual fashion. \( X^I \), where \( I \) is
an integer, results in an expression whose dimensions are those of \( X \) to the power \( I \). The trigonometric
functions all work in terms of an angle in radians and a dimensionless ratio.

15.2.12.8. Expression Properties

There are three properties of expressions:

- An expression is a simple expression if the only operations are +, -, *, / and there are no functions used
  in the expression.
- An expression is a constant expression if all the numbers in the expression are explicit (that is, they do
  not depend on values from the solver).
- An expression is an integer expression if all the numbers in the expression are integers and the result
  of each function or operation is an integer.

For example, \((3+5)/2\) is a simple, constant, integer expression. However, \(2^{(1/2)}\) is not a constant integer
expression because the result of 1/2 is 0.5, not an integer. Also \(3^4\) is not a constant integer expression
because 3 is not an integer. Moreover, \(2^3\) is not a simple, constant, integer expression because ^ is
not in the list (+, -, *, /).

Expressions are evaluated at runtime and in single precision floating point arithmetic.

15.2.12.9. Available and Unavailable Variables

CFX System Variables and user-defined expressions will be available or unavailable depending on the
simulation you are performing and the expressions you want to create. In some circumstances, System
Variables are logically unavailable; for instance, time (\( t \)) is not available for steady-state simulations. In
others, the availability of a System Variable is not allowed for physical model reasons. For example,
density can be a function of pressure \((p)\), temperature \((T)\) and location \((x, y, z)\), but no other system variables.

Information on how to find dependencies for all parameters is available in the RULES and VARIABLES files. Both files are located in \(<\text{CFXROOT}/>\text{/etc}/\) and can be viewed in any text editor.

The expression definition can depend on any system variable. If, however, that expression depends on a system variable that is unavailable for a particular context, then that expression will also be unavailable.

### 15.3. Particle Variables Generated by the Solver

This section describes the following types of particle variables that you may have defined in CFX-Pre or that are available for viewing in CFD-Post and exporting to other files. Many variables are relevant only for specific physical models.

- **Particle Track Variables** (p. 210)
- **Particle Field Variables** (p. 212)
- **Particle Boundary Vertex Variables** (p. 217)

Some variables are defined only on the boundaries of the model. When using these variables in CFD-Post, there are a limited number of useful things that you can do with these. For details, see [Boundary-Value-Only Variables in the CFD-Post User's Guide](#).

The following information is given for particle variables described in this section:

- **Long Variable Name**: The name that you see in the user interface.
- **Short Variable Name**: The name that must be used in CEL expressions.
- **Units**: The default units for the variable. An empty entry \([\ ]\) indicates a dimensionless variable.

**Note**

The entries in the Units columns are SI but could as easily be any other system of units.

- **Type (User Level, Boundary)**

  - **User Level**: This number is useful when using the CFX Export facility. For details, see [File Export Utility in the CFX-Solver Manager User’s Guide](#). Note that the CFX-Solver may sometimes override the user-level setting depending on the physics of the problem. In these cases, the User Level may be different from that shown in the table below.

  - **Boundary (B)**: A B in this column indicates that the variable contains only non-zero values on the boundary of the model. See [Boundary-Value-Only Variables in the CFD-Post User’s Guide](#) for more details.

This section does not cover the complete list of variables. For information on obtaining details on all variables, see [RULES and VARIABLES Files in the CFX-Solver Manager User’s Guide](#).
Note

Variables with names shown in **bold text** are not output to CFD-Post. However, some of these variables can be output to CFD-Post by selecting them from the Extra Output Variables List on the Results tab of the Solver > Output Control details view of CFX-Pre.

15.3.1. Particle Track Variables

Particle track variables are particle variables that are defined directly on each track. These variables are defined on the particle positions for which track information is written to the results file. Direct access to the particle track variables outside of CFD-Post is only possible if the raw track file is kept after a particle run.

Particle track variables can only be used in two ways: to color particle tracks in CFD-Post, and to be used as input to Particle User Fortran. Particle track variables can be exported from CFD-Post along the particle tracks.

Note

Particle track variables are not available for use in CEL expressions and general User Fortran, and they also cannot be monitored during a simulation.

For Particle User Fortran, additional track variables can be specified in the argument list for the user routine, which are not available in CFD-Post:

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Particle Type&gt;.Mean Particle Diameter</td>
<td>mean particle diameter</td>
<td>[m]</td>
<td>Particle diameter</td>
<td>3 PR</td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Particle Number Rate</td>
<td>particle number rate</td>
<td>[s^-1]</td>
<td>Particle number rate</td>
<td>3 PR</td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Particle Time</td>
<td>ptttime</td>
<td>[s]</td>
<td>Simulation time</td>
<td>2 PR</td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Particle Traveling Distance</td>
<td>ptdist</td>
<td>[m]</td>
<td>Distance along the particle track measured from the injection point</td>
<td>2 PR</td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Particle Traveling Time</td>
<td>[s]</td>
<td>Time measured from the time of injection of the particle. For steady-state simulations only, this time is identical to &lt;Particle Type&gt;.Particle Time.</td>
<td>2 PR</td>
<td></td>
</tr>
</tbody>
</table>
### Particle Variables Generated by the Solver

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Description</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Particle Type&gt;.Temperature</td>
<td>T</td>
<td>[K]</td>
<td>Particle temperature</td>
<td>1 PR</td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Total Particle Mass</td>
<td>pt-masst</td>
<td>[kg]</td>
<td>Particle total mass</td>
<td>2 PR</td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Velocity</td>
<td></td>
<td>[m/s]</td>
<td>Particle velocity</td>
<td>1 PR</td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Velocity u</td>
<td>u</td>
<td>[m/s]</td>
<td>Particle velocity components in x, y, and z-direction</td>
<td>1 PR</td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Velocity v</td>
<td>v</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>&lt;Particle Type&gt;.Velocity w</td>
<td>w</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Particle Eotvos Number</td>
<td>pteo</td>
<td>[]</td>
<td>2 PR</td>
</tr>
<tr>
<td>Particle Morton Number</td>
<td>ptmo</td>
<td>[]</td>
<td>2 PR</td>
</tr>
<tr>
<td>Particle Nusselt Number</td>
<td>ptnu</td>
<td>[]</td>
<td>2 PR</td>
</tr>
<tr>
<td>Particle Ohnesorge Number</td>
<td>pton</td>
<td>[]</td>
<td>2 PR</td>
</tr>
<tr>
<td>Particle Reynolds Number</td>
<td>ptre</td>
<td>[]</td>
<td>2 PR</td>
</tr>
<tr>
<td>Particle Weber Number&lt;sup&gt;a&lt;/sup&gt;</td>
<td>ptwe</td>
<td>[]</td>
<td>2 PR</td>
</tr>
<tr>
<td>Particle Slip Velocity</td>
<td>ptslipvel</td>
<td>[m s^-1]</td>
<td>2 PR</td>
</tr>
<tr>
<td>Particle Position</td>
<td>ptpos</td>
<td>[m]</td>
<td>2 PR</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td>-------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Particle Impact Angle (^{\text{b}})</td>
<td>particle impact angle</td>
<td>([\text{radian}])</td>
<td>3 PR</td>
</tr>
</tbody>
</table>

\(^{\text{a}}\)Note: The factors affecting the Weber number are particle diameter, particle slip velocity, fluid density, and surface tension.

\(^{\text{b}}\)Note: The impact angle is measured from the wall.

### 15.3.2. Droplet Breakup Variable

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Particle Type&gt;.Particle Weber Number</td>
<td>[-]</td>
<td>Particle Weber number along track</td>
</tr>
</tbody>
</table>

\[ We = \rho_f V_{\text{slip}}^2 \frac{D_p}{\sigma} \]

where

\( \rho_f = \text{fluid density} \)
\( V_{\text{slip}} = \text{slip velocity} \)
\( D_p = \text{particle diameter} \)
\( \sigma = \text{surface tension coefficient} \)

### 15.3.3. Multi-component Particle Variable

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;Particle Type&gt;.&lt;Particle Component&gt;.Mass Fraction</td>
<td></td>
<td>Fraction of mass of a particular particle component</td>
</tr>
</tbody>
</table>

### 15.3.4. Particle Field Variables

Particle field variables are particle variables that are defined at the vertices of the fluid calculation. In contrast to track variables, these variables can be used in the same way as “standard” Eulerian variables. This means that particle field variables are available for use in CEL expressions and User Fortran, they can be monitored during a simulation, and are available for general post-processing in CFD-Post. Additionally, particle field variables can be used in the same way as particle track variables as input to particle User Fortran and for coloring tracks. When used for coloring tracks, the field variables have to be interpolated onto the tracks, and so this operation will be slower than coloring with a track variable.

The following particle variables are available as field variables:

#### 15.3.4.1. Particle Sources into the Coupled Fluid Phase

For fully-coupled particle simulations involving energy, momentum and mass transfer to the fluid phase, the following variables are written to the results file:
<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Particle Energy Source</td>
<td>ptenysrc</td>
<td>[W m(^{-3})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
<tr>
<td>Particle Energy Source Coefficient</td>
<td>ptenysrcc</td>
<td>[W m(^{-3}) K(^{-1})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
<tr>
<td>Particle Momentum Source</td>
<td>ptmomsrc</td>
<td>[kg m(^{-2}) s(^{-2})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
<tr>
<td>Particle Momentum Source Coefficient</td>
<td>ptmomsrcc</td>
<td>[kg m(^{-3}) s(^{-1})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
<tr>
<td>Total Particle Mass Source</td>
<td>ptmassrcctot</td>
<td>[kg m(^{-1}) m(^{-3})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
<tr>
<td>Total Particle Mass Source Coefficient</td>
<td>ptmassrcctot</td>
<td>[kg m(^{-1}) m(^{-3})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
</tbody>
</table>

For multi-component mass transfer, the following Additional Variables are available:

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Particle Mass Source</td>
<td>ptmasssrc</td>
<td>[kg m(^{-1}) m(^{-3})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
<tr>
<td>Particle Mass Source Coefficient</td>
<td>ptmasssrcc</td>
<td>[kg m(^{-1}) m(^{-3})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
</tbody>
</table>

\(^{a}\)The variables for multi-component take the following form: <Particle Type>.<Particle Component>.<Variable Name>

Particle source terms are accumulated along the path of a particle through a control volume and stored at the corresponding vertex. A smoothing procedure can be applied to the particle source terms, which may help with convergence or grid independence. For details, see Particle Source Smoothing in the CFX-Solver Modeling Guide.

### 15.3.4.2. Particle Radiation Variables

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Particle Radiative Emission</td>
<td>ptremiss</td>
<td>[W m(^{-3})]</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A, C, M, P, R</td>
</tr>
</tbody>
</table>

release 14.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
Particles can also interact with the radiation field and either emit or absorb radiation.

### 15.3.4.3. Particle Vertex Variables

By default, particle vertex variables are not written to the results file, except for the Averaged Volume Fraction. The other vertex variables can be written to the results file if they are selected from the Extra Output Variables List in the Output Control section of CFX-Pre or if they are used in a monitor point, CEL expression or in (Particle) User Fortran.

The following particle variables are available:

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Averaged Velocity</td>
<td>averaged vel</td>
<td>([\text{m}\cdot s^{-1}])</td>
<td>1</td>
</tr>
<tr>
<td>Averaged Volume Fraction</td>
<td>vfpt</td>
<td>([\text{m}])</td>
<td>1 A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Temperature</td>
<td>averaged temperature</td>
<td>([\text{K}])</td>
<td>1 A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Mass Fraction (^{a})</td>
<td>averaged mf</td>
<td>([\text{m}])</td>
<td>1 A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Particle Time</td>
<td>averaged pt-time</td>
<td>([\text{s}])</td>
<td>2 A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Mean Particle Diameter (D43)</td>
<td>averaged mean particle diameter</td>
<td>([\text{m}])</td>
<td>2 A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Arithmetic Mean Particle Diameter (D10)</td>
<td>averaged arithmetic mean particle diameter</td>
<td>([\text{m}])</td>
<td>2 A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Surface Mean Particle Diameter (D20)</td>
<td>averaged surface mean</td>
<td>([\text{m}])</td>
<td>2</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
</tr>
<tr>
<td>Averaged Volume Mean Particle Diameter (D30)</td>
<td>averaged volume mean particle diameter</td>
<td>[m]</td>
<td>A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Sauter Mean Particle Diameter (D32)</td>
<td>averaged sauter mean particle diameter</td>
<td>[m]</td>
<td>A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Mass Mean Particle Diameter (D43)</td>
<td>averaged mass mean particle diameter</td>
<td>[m]</td>
<td>A, C, M, P, PR, R</td>
</tr>
<tr>
<td>Averaged Particle Number Rate</td>
<td>averaged particle number rate</td>
<td>[s^-1]</td>
<td>A, C, M, P, PR, R</td>
</tr>
</tbody>
</table>

For simulations with the particle wall film model activated, the following additional vertex variables are available:

<table>
<thead>
<tr>
<th>For simulations with the particle wall film model activated, the following additional vertex variables are available:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Averaged Volume Fraction Wall</td>
</tr>
<tr>
<td>Averaged Film Temperature</td>
</tr>
</tbody>
</table>

This variable takes the following form: <Particle Type>.<Particle Component>.<Variable Name>

The following are the formulae for particle vertex fields' size distributions:

Arithmetic Mean Diameter

\[ d_{10} = \frac{\sum n_i d_i}{\sum n_i} \]

Surface Mean Diameter

\[ d_{20} = \sqrt[2]{\frac{\sum n_i d_i^2}{\sum n_i}} \]

Volume Mean Diameter

\[ d_{30} = \sqrt[3]{\frac{\sum n_i d_i^3}{\sum n_i}} \]
### Sauter Mean Diameter

\[
d_{32} = \frac{\sum n_i d_i^3}{\sum n_i d_i^2}
\]

### Mass Mean Diameter

\[
d_{32} = \frac{\sum n_i d_i^4}{\sum n_i d_i^3}
\]

### 15.3.4.3.1. Variable Calculations

Particle vertex variables are calculated using the following averaging procedure:

\[
\bar{\Phi}_p = \frac{\sum (\Delta t \ m_p \ N_p \ \Phi_p)}{\sum (\Delta t \ m_p \ N_p)}
\]

(15–1)

With:

- \(\Sigma\): Sum over all particles and time steps in a control volume
- \(\Delta t\): Particle integration time step
- \(N_p\): Particle number rate
- \(m_p\): Particle mass
- \(\Phi\): Particle quantity

Slightly different averaging procedures apply to particle temperature and particle mass fractions:

**Averaged Particle Temperature**

\[
\bar{\Phi}_p = \frac{\sum (\Delta t \ m_p \ N_p \ c_{p,p} \ T_p)}{\sum (\Delta t \ m_p \ N_p \ c_{p,p})}
\]

(15–2)

With:

**Averaged Mass Fraction**

- \(c_{p,p}\): Particle specific heat capacity
- \(T_p\): Particle temperature

\[
\bar{\Phi}_p = \frac{\sum (\Delta t \ m_{c,p} \ N_p)}{\sum (\Delta t \ m_p \ N_p)}
\]

(15–3)

With:
• \( m_c, p \): Mass of species \( c \) in the particle

Due to the discrete nature of particles, vertex variables may show an unsmooth spatial distribution, which may lead to robustness problems. To reduce possible problems a smoothing option is available. For details, see Vertex Variable Smoothing in the CFX-Solver Modeling Guide.

### 15.3.4.4. Particle Boundary Vertex Variables

Particle-boundary vertex variables are particle variables that are defined on the vertices of domain boundaries. They are normalized with the face area of the corresponding boundary control volume.

You can use these variables to color boundaries and to compute average or integrated values of the corresponding particle quantities.

You cannot use these variables in CEL expressions or User Fortran, and you cannot monitor them during a simulation.

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Units</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Available at inlet, outlet, openings and interfaces:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mass Flow Density</td>
<td>([\text{kg m}^{-2} \text{s}^{-1}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td>Momentum Flow Density</td>
<td>([\text{kg m}^{-1} \text{s}^{-2}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td>Energy Flow Density</td>
<td>([\text{kg s}^{-3}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td><strong>Available at walls only:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wall Stress</td>
<td>([\text{kg m}^{-1} \text{s}^{-2}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td>Wall Mass Flow Density</td>
<td>([\text{kg m}^{-2} \text{s}^{-1}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td>Erosion Rate Density</td>
<td>([\text{kg m}^{-2} \text{s}^{-1}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td><strong>Available in transient runs:</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Integrated Mass Flow Density</td>
<td>([\text{kg m}^{-2}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td>Time Integrated Momentum Flow Density</td>
<td>([\text{kg m}^{-1} \text{s}^{-1}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td>Time Integrated Energy Flow Density</td>
<td>([\text{kg s}^{-2}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td>Time Integrated Wall Mass Flow Density</td>
<td>([\text{kg m}^{-2}])</td>
<td>2, B, R</td>
</tr>
<tr>
<td>Time Integrated Erosion Rate Density</td>
<td>([\text{kg m}^{-2}])</td>
<td>2, B, R</td>
</tr>
</tbody>
</table>
15.3.4.5. Particle RMS Variables

For some applications, it may be necessary to not only provide the mean values of particle quantities, but also their standard deviation in the form of particle RMS variables. Similar to particle vertex variables, these variables are also defined at the vertices of the fluid calculation. Particle RMS variables are available for use in CEL expressions and User Fortran; they can be monitored during a simulation, and are available for general post-processing in CFD-Post. Additionally, particle RMS variables can be used in the same way as particle track variables as input to particle User Fortran and for coloring tracks.

By default, particle RMS variables are not written to the results file; unless, they have been explicitly requested by the user (selected from the Extra Output Variables List in the Output Control section of CFX-Pre, usage in a CEL expression or in User Fortran) or if the stochastic particle collision model is used in a simulation.

The following particle variables are available as field variables, particularly useful for simulations that use the stochastic particle collision model:

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>RMS Velocity</td>
<td>rms velocity</td>
<td>[m s^-1]</td>
<td>B, R</td>
</tr>
<tr>
<td>RMS Mean Particle Diameter</td>
<td>rms mean particle diameter</td>
<td>[m]</td>
<td>3 A, C, M, P, PR, R</td>
</tr>
<tr>
<td>RMS Particle Number Rate</td>
<td>rms particle number rate</td>
<td>[s^-1]</td>
<td>3 A, C, M, P, PR, R</td>
</tr>
</tbody>
</table>

15.3.4.5.1. Variable Calculations

Particle RMS variables are calculated using the following procedure:

\[
\Phi = \Phi + \Phi'' \\
\Phi_{rms} = \sqrt{\Phi'^2} = \sqrt{\left(\Phi - \bar{\Phi}\right)^2} = \sqrt{\Phi^2 - \bar{\Phi}^2} \tag{15-4}
\]

With:

- \(\Phi\): Instantaneous particle quantity
• $\Phi$: Average particle quantity
• $\Phi'$: Fluctuating particle quantity
• $\Phi^2$: Average of square of particle quantity
• $\Phi^2$: Square of average of particle quantity

A smoothing option, as available for particle vertex variables, is available for particle RMS variables. For details, see Vertex Variable Smoothing in the CFX-Solver Modeling Guide.

15.4. Miscellaneous Variables

Variable names in **bold** are not output to CFD-Post.

In the **Availability** column:

- A number represents the user level (1 indicates that the variable appears in default lists, 2 and 3 indicate that the variable appears in extended lists that you see when you click ...)
- A indicates the variable is available for mesh adaptation
- C indicates the variable is available in CEL
- DT indicates the variable is available for data transfer to ANSYS
- M indicates the variable is available for monitoring
- P indicates the variable is available for particle user routine argument lists
- PR indicates the variable is available for particle results
- R indicates the variable is available to be output to the results, transient results, and backup files
- TS indicates the variable is available for transient statistics

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aspect Ratio</td>
<td>aspect ratio</td>
<td>[ ]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Autoignition</td>
<td>autoignition</td>
<td>[ ]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Boundary Scale</td>
<td>bnd scale</td>
<td>[ ]</td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
</tbody>
</table>

Similar to wall scale, this variable is used for controlling mesh stiffness near boundaries for moving mesh problems.
<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Burnt Density</td>
<td>burnt density</td>
<td>[kg m^-3]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Clipped Pressure</td>
<td>pclip</td>
<td>[Pa]</td>
<td>1</td>
<td>M, R, TS</td>
</tr>
<tr>
<td>Conservative Size Fraction</td>
<td>sfc</td>
<td>[]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Courant Number</td>
<td>courant</td>
<td>[]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Cumulative Size Fraction</td>
<td>csf</td>
<td>[]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Current Density</td>
<td>jcur</td>
<td></td>
<td>1</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td><strong>Dynamic Diffusivity</strong></td>
<td>diffdyn</td>
<td></td>
<td>2</td>
<td>C, M, P, R, TS</td>
</tr>
<tr>
<td>Electric Field</td>
<td>elec</td>
<td></td>
<td>1</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Electric Potential</td>
<td>epot</td>
<td></td>
<td>1</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Electrical Conductivity</td>
<td>conelec</td>
<td></td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Electrical Permittivity</td>
<td>permelec</td>
<td></td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Electromagnetic Force Density</td>
<td>bfemag</td>
<td></td>
<td>3</td>
<td>R</td>
</tr>
<tr>
<td>Equivalence Ratio</td>
<td>equivratio</td>
<td>[]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>External Magnetic Induction</td>
<td>bmagext</td>
<td>[]</td>
<td>1</td>
<td>M, R, TS</td>
</tr>
<tr>
<td>First Blending Function for</td>
<td>sstbf1</td>
<td>[]</td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------------</td>
<td>-----------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BSL and SST model</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Second Blending Function for SST model</td>
<td>sstbf2</td>
<td>[ ]</td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Flame Surface Density</td>
<td>fsd</td>
<td>[m^-1]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Frequency</td>
<td>freq</td>
<td></td>
<td>3</td>
<td>C</td>
</tr>
<tr>
<td>Fuel Tracer</td>
<td>trfuel</td>
<td>[ ]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Granular Temperature</td>
<td>grantemp</td>
<td>[m^2 s^-2]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Group I Index</td>
<td>groupi</td>
<td>[ ]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Group J Index</td>
<td>groupj</td>
<td>[ ]</td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Group I Diameter</td>
<td>diami</td>
<td></td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Group J Diameter</td>
<td>diamj</td>
<td></td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Group I Mass</td>
<td>massi</td>
<td></td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Group J Mass</td>
<td>massj</td>
<td></td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Group I Lower Mass</td>
<td>massi lower</td>
<td></td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Group J Lower Mass</td>
<td>massj lower</td>
<td></td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td><strong>Long Variable Name</strong></td>
<td><strong>Short Variable Name</strong></td>
<td><strong>Units</strong></td>
<td><strong>Availability</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------</td>
<td>-----------</td>
<td>-----------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>Group I Upper Mass</strong></td>
<td>massi upper</td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td><strong>Group J Upper Mass</strong></td>
<td>massj upper</td>
<td></td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Ignition Delay Elapsed Fraction</td>
<td>ignfrc</td>
<td>[ ]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Ignition Delay Time</td>
<td>tigndelay</td>
<td>[s]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Particle Integration Timestep</td>
<td>particle integration timestep</td>
<td>[s]</td>
<td>3</td>
<td>P</td>
</tr>
<tr>
<td>Isentropic Compressibility</td>
<td>compisoS</td>
<td>[m s(^2) kg(^{-1})]</td>
<td>2</td>
<td>C, M, R</td>
</tr>
<tr>
<td>Isentropic Compression Efficiency</td>
<td>icompeff</td>
<td>[ ]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Isentropic Expansion Efficiency</td>
<td>iexpeff</td>
<td>[ ]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Isentropic Total Enthalpy</td>
<td>htotisen</td>
<td></td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Isentropic Static Enthalpy</td>
<td>enthisen</td>
<td></td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td><strong>Isobaric Compressibility</strong></td>
<td>compisoP</td>
<td>[K(^{-1})]</td>
<td>2</td>
<td>C, M, R</td>
</tr>
<tr>
<td>Isothermal Compressibility</td>
<td>compisoT</td>
<td>[m s(^2) kg(^{-1})]</td>
<td>2</td>
<td>C, M, R</td>
</tr>
<tr>
<td>LES Dynamic Model Coefficient</td>
<td>dynmc</td>
<td>[ ]</td>
<td>1</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Laminar Burning Velocity</td>
<td>velburnlam</td>
<td>[m s(^{-1})]</td>
<td>2</td>
<td>A, C, R, TS</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>---------------------</td>
<td>----------------</td>
<td>--------------</td>
<td>-------------------------------------------------</td>
</tr>
<tr>
<td>Lighthill Stress</td>
<td>lighthill stress tensor</td>
<td></td>
<td>A, C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Magnetic Induction</td>
<td>bmag</td>
<td></td>
<td>C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Magnetic Field</td>
<td>hmag</td>
<td></td>
<td>C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Magnetic Vector Potential</td>
<td>bpot</td>
<td></td>
<td>C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Magnetic Permeability</td>
<td>permag</td>
<td></td>
<td>C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>External Magnetic Induction</td>
<td>bmagext</td>
<td></td>
<td>C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Mass Flux</td>
<td>mfllux</td>
<td></td>
<td>R</td>
<td></td>
</tr>
<tr>
<td>Mesh Diffusivity</td>
<td>diffmesh</td>
<td>[m^2 s^-1]</td>
<td>C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Normal Area</td>
<td>normarea</td>
<td>[ ]</td>
<td>C</td>
<td>Normal area vectors.</td>
</tr>
<tr>
<td>Total Force Density</td>
<td>forctden</td>
<td></td>
<td>DT</td>
<td></td>
</tr>
<tr>
<td>Total Pressure in Rel Frame</td>
<td>ptotrel</td>
<td></td>
<td>A, C, M, P, R, TS</td>
<td>Based on relative frame total enthalpy.</td>
</tr>
<tr>
<td>Turbulent Burning Velocity</td>
<td>velburnturb</td>
<td>[m s^-1]</td>
<td>A, C, R, TS</td>
<td></td>
</tr>
<tr>
<td>Mesh Velocity</td>
<td>meshvel</td>
<td></td>
<td>C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Molar Reaction Rate</td>
<td>reacrate</td>
<td></td>
<td>C, R, TS</td>
<td></td>
</tr>
</tbody>
</table>
## Variables in ANSYS CFX

<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Nonclipped Absolute Pressure</td>
<td>pabsnc</td>
<td></td>
<td>3 A, C, M, R, TS</td>
<td>Nonclipped absolute pressure for cavitation source. This is written to the .res file for all cases that have cavitation.</td>
</tr>
<tr>
<td>Nonclipped Density</td>
<td>densitync</td>
<td>[kg m$^{-3}$]</td>
<td>2 C</td>
<td>Nonclipped density for cavitation source</td>
</tr>
<tr>
<td>Normal Vector</td>
<td>normal</td>
<td></td>
<td>2 C</td>
<td></td>
</tr>
<tr>
<td>Orthogonality Factor Minimum</td>
<td>orthfactmin</td>
<td></td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Orthogonality Factor</td>
<td>orthfact</td>
<td></td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Orthogonality Angle Minimum</td>
<td>orthanglemin</td>
<td></td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Orthogonality Angle</td>
<td>orthangle</td>
<td></td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Particle Laplace Number</td>
<td>ptla</td>
<td></td>
<td>2 P</td>
<td></td>
</tr>
<tr>
<td>Particle Turbulent Stokes Number</td>
<td>ptstt</td>
<td></td>
<td>2 P</td>
<td></td>
</tr>
<tr>
<td>Polytropic Compression Efficiency</td>
<td>pcompeff</td>
<td></td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Polytropic Expansion Efficiency</td>
<td>pexpeff</td>
<td></td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Polytropic Total Enthalpy</td>
<td>htotpoly</td>
<td></td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Polytropic Static Enthalpy</td>
<td>entphpoly</td>
<td></td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------</td>
<td>----------------</td>
<td>--------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>Reaction Progress</td>
<td>reacprog</td>
<td>[]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>For premixed or partially premixed combustion.</td>
</tr>
<tr>
<td>Weighted Reaction Progress</td>
<td>wreacprog</td>
<td>[]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>For premixed or partially premixed combustion.</td>
</tr>
<tr>
<td>Weighted Reaction Progress Source</td>
<td>wreacprogsr</td>
<td>3</td>
<td>A, C, R, TS</td>
<td>For premixed or partially premixed combustion.</td>
</tr>
<tr>
<td>Residual Products Mass Fraction</td>
<td>mfresid</td>
<td>[]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Residual material model or exhaust gas recirculation (EGR)</td>
</tr>
<tr>
<td>Residual Products Molar Fraction</td>
<td>molfresid</td>
<td>[]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Residual material model or exhaust gas recirculation (EGR)</td>
</tr>
<tr>
<td>Restitution Coefficient</td>
<td>restitution</td>
<td>[]</td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td></td>
<td>coefficient</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rotation Velocity</td>
<td>rotvel</td>
<td></td>
<td>2</td>
<td>C, R, TS</td>
</tr>
<tr>
<td>Rotational Energy</td>
<td>rotenergy</td>
<td></td>
<td>2</td>
<td>C, R, TS</td>
</tr>
<tr>
<td>Shear Velocity</td>
<td>ustar</td>
<td></td>
<td>2</td>
<td>C</td>
</tr>
<tr>
<td>Size Fraction</td>
<td>sf</td>
<td>[]</td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Solid Bulk Viscosity</td>
<td>solid bulk viscosity</td>
<td>[kg m^-1 s^-1]</td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Solid Pressure Gradient</td>
<td>solid pressure</td>
<td>[]</td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Solid Shear Viscosity</td>
<td>solid shear viscosity</td>
<td>[kg m^-1 s^-1]</td>
<td>3</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------</td>
<td>------------------------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Static Entropy</td>
<td>entropy</td>
<td></td>
<td>3</td>
<td>A, C, M, P, R, TS</td>
</tr>
<tr>
<td>Temperature Variance</td>
<td>Tvar</td>
<td></td>
<td>1</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td><strong>Time This Run</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total Boundary Displacement</td>
<td>bnddisptot</td>
<td></td>
<td>1</td>
<td>C, DT, M, R, TS</td>
</tr>
<tr>
<td>Total Density</td>
<td>dentot</td>
<td>[kg m(^{-3})]</td>
<td>2</td>
<td>A, C, M, R</td>
</tr>
<tr>
<td>Total Density in Stn Frame</td>
<td>dentotstn</td>
<td>[kg m(^{-3})]</td>
<td>2</td>
<td>A, C, M, R</td>
</tr>
<tr>
<td>Total Density in Rel Frame</td>
<td>dentotrel</td>
<td>[kg m(^{-3})]</td>
<td>2</td>
<td>A, C, M, R</td>
</tr>
<tr>
<td><strong>Total Force</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unburnt Absolute Temperature</td>
<td>burnt Tabs</td>
<td>[K]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Unburnt Density</td>
<td>unburnt density</td>
<td>[kg m(^{-3})]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Unburnt Thermal Conductivity</td>
<td>unburnt cond</td>
<td>[W m(^{-1}) K(^{-1})]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Unburnt Specific Heat Capacity at Constant Pressure</td>
<td>unburnt Cp</td>
<td>[J kg(^{-1}) K(^{-1})]</td>
<td>2</td>
<td>A, C, M, R, TS</td>
</tr>
<tr>
<td>Volume Porosity</td>
<td>volpor</td>
<td>[ ]</td>
<td>2</td>
<td>C, M, R, TS</td>
</tr>
<tr>
<td>Volume of Finite Volumes</td>
<td>volcvol</td>
<td></td>
<td>3</td>
<td>C, R, TS</td>
</tr>
</tbody>
</table>

Total Density is the density evaluated at the Total Temperature and Total Pressure.
<table>
<thead>
<tr>
<th>Long Variable Name</th>
<th>Short Variable Name</th>
<th>Units</th>
<th>Availability</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vorticity</td>
<td>vorticity</td>
<td></td>
<td>2 A, C, M, R, TS</td>
<td>Note that Vorticity is the same as Velocity.Curl.</td>
</tr>
<tr>
<td>Vorticity in Stn Frame</td>
<td>vortstn</td>
<td></td>
<td>2 A, C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Wall External Heat Transfer Coefficient</td>
<td>htc</td>
<td></td>
<td>2 R, TS</td>
<td></td>
</tr>
<tr>
<td>Wall Adjacent Temperature</td>
<td>tnw</td>
<td>[K]</td>
<td>2 C, DT, R, TS</td>
<td></td>
</tr>
<tr>
<td>Wall Distance</td>
<td>wall distance</td>
<td>[m]</td>
<td>2 A, C, M, P, R, TS</td>
<td></td>
</tr>
<tr>
<td>Wall Film Thickness</td>
<td>film thickness</td>
<td>[m]</td>
<td>2 C, R</td>
<td></td>
</tr>
<tr>
<td>Wall Heat Transfer Coefficient</td>
<td>htc</td>
<td></td>
<td>2 C, R, TS</td>
<td></td>
</tr>
<tr>
<td>Wall Heat Flow</td>
<td>QwallFlow</td>
<td></td>
<td>3 C, DT, R, TS</td>
<td></td>
</tr>
<tr>
<td>Wall Normal Velocity</td>
<td>nwallvel</td>
<td></td>
<td>2 C, R, TS</td>
<td></td>
</tr>
<tr>
<td>Wall Scale</td>
<td>wall scale</td>
<td></td>
<td>3 R, M, TS</td>
<td></td>
</tr>
<tr>
<td>Wavelength in Vacuum</td>
<td>wavelo</td>
<td></td>
<td>3 C</td>
<td></td>
</tr>
<tr>
<td>Wavenumber in Vacuum</td>
<td>waveno</td>
<td></td>
<td>3 C</td>
<td></td>
</tr>
<tr>
<td>Normalized Droplet Number</td>
<td>spdropn</td>
<td>[m^-3]</td>
<td>2 C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Long Variable Name</td>
<td>Short Variable Name</td>
<td>Units</td>
<td>Availability</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------</td>
<td>-------</td>
<td>--------------</td>
<td>------------</td>
</tr>
<tr>
<td>Droplet Number</td>
<td>spdrop</td>
<td></td>
<td>C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Dynamic Bulk Viscosity</td>
<td>dynamic bulk viscosity</td>
<td></td>
<td>A, C, M, R, TS</td>
<td></td>
</tr>
<tr>
<td>Total MUSIG Volume Fraction</td>
<td>vft</td>
<td>[ ]</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Smoothed Volume Fraction</td>
<td>vfs</td>
<td>[ ]</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>Temperature Superheating</td>
<td>Tsuperheat</td>
<td></td>
<td>C</td>
<td>Temperature above saturation</td>
</tr>
<tr>
<td>Temperature Subcooling</td>
<td>Tsubcool</td>
<td></td>
<td>C</td>
<td>Temperature below saturation</td>
</tr>
</tbody>
</table>
Chapter 16: Power Syntax in ANSYS CFX

Programming constructs can be used within CCL for advanced usage. Rather than invent a new language, CCL takes advantage of the full range of capabilities and resources from an existing programming language, Perl. Perl statements can be embedded in between lines of simple syntax, providing capabilities such as loops, logic, and much, much more with any CCL input file.

Lines of Power Syntax are identified in a CCL file by an exclamation mark (!) at the start of each line. In between Perl lines, simple syntax lines may refer to Perl variables and lists.

A wide range of additional functionality is made available to expert users with the use of Power Syntax including:

- Loops
- Logic and control structures
- Lists and arrays
- Subroutines with argument handling (useful for defining commonly re-used plots and procedures)
- Basic I/O processing
- System functions
- Many other procedures (Object programming, World Wide Web access, simple embedded graphical user interfaces).

Any of the above may be included in a CCL input file or CFD-Post Session file.

**Important**

You should be wary when entering certain expressions because Power Syntax uses Perl mathematical operators. For example, in CEL, $2^2$ is represented as 2^2, but in Perl, it would be written 2 ** 2. If you are unsure about the validity of an operator, you should check a Perl reference guide.

There are many good reference books on Perl. Two examples are *Learning Perl* (ISBN 1-56592-042-2) and *Programming Perl* (ISBN 1-56592-149-6) from the O'Reilly series.

This chapter describes:

16.1. Examples of Power Syntax
16.2. Predefined Power Syntax Subroutines

**16.1. Examples of Power Syntax**

The following are some examples in which the versatility of power syntax is demonstrated. They become steadily more complex in the later examples.
Some additional, more complex, examples of Power Syntax subroutines can be found by viewing the session files used for the Macro Calculator. These are located in CFX/etc/. You can execute these subroutines from the Command Editor dialog box the same as calling any other Power Syntax subroutine. The required argument format is:

```perl
!cpPolar("BoundaryList", "SliceNormalAxis", "SlicePosition", "PlotAxis", "InletLocation", "ReferencePressure")
!compressorPerform("InletLocation", "OutletLocation", "BladeLocation", "MachineAxis", "RotationalSpeed", "TipRadius", "NumBlades", "FluidGamma")
```

These subroutines are loaded when CFD-Post is launched, so you do not need to execute the session files before using the functions.

Additional information on these macro functions is available in Gas Compressor Performance Macro and Cp Polar Plot Macro.

All arguments passed to subroutines should be enclosed in quotations, for example Plane 1 must be passed as "Plane 1" and Eddy Viscosity should be entered as "Eddy Viscosity". Any legal CFX Command Language characters that are illegal in Perl need to be enclosed in quotation marks.

### 16.1.1. Example 1: Print the Value of the Pressure Drop Through a Pipe

```perl
! $Pin = massFlowAve("Pressure","inlet");
! $Pout = massFlowAve("Pressure","outlet");
! $dp = $Pin-$Pout;
! print "The pressure drop is $dp\n";
```

Note

Function-specific Perl subroutines do not allow phase-specific evaluations; that is, you can get only bulk results (such as mass flow for all phases). A workaround is to use "evaluate" subroutine, which evaluates any CEL expression.

For example instead of

```perl
! $val = massFlow("Inlet", "Water")   # Does NOT work
```

you need to use:

```perl
! ($val, $units) = evaluate( "Water.massFlow()\@Inlet");
```
16.1.2. Example 2: Using a for Loop

This example demonstrates using Power Syntax that wraps a for loop around some CCL Object definitions to repetitively change the visibility on the outer boundaries.

```
# Make the outer boundaries gradually transparent in
# the specified number of steps.
$numsteps = 10;
$for ($i=0; $i < $numsteps; $i++) {
  $trans = ($i+1)/$numsteps;
  BOUNDARY:in
    Visibility = 1
    Transparency = $trans
  END
  BOUNDARY:out
    Visibility = 1
    Transparency = $trans
  END
  BOUNDARY:Default
    Visibility = 1
    Transparency = $trans
  END
}
```

The first line of Power Syntax simply defines a scalar variable called numsteps. Scalar variables (that is, simple single-valued variables) begin with a $ symbol in Perl. The next line defines a for loop that increments the variable i up to numsteps. Next, you determine the fraction you are along in the loop and assign it to the variable trans. The object definitions then use trans to set their transparency and then repeat. Note how Perl variables can be directly embedded into the object definitions. The final line of Power Syntax (!}) closes the for loop.

---

**Note**

Function-specific Perl subroutines do not allow phase-specific evaluations; that is, you can get only bulk results (such as mass flow for all phases). A workaround is to use "evaluate" subroutine, which evaluates any CEL expression.

For example instead of

```
! $val = massFlow("Inlet", "Water")   # Does NOT work
```

you need to use:

```
! ($val, $units) = evaluate( "Water.massFlow()@Inlet");
```

16.1.3. Example 3: Creating a Simple Subroutine

The following example defines a simple subroutine to make two planes at specified locations. The subroutine will be used in the next example.

```
!sub makePlanes {
  PLANE:plane1
    Option = Point and Normal
    Point = 0.09,0,-0.03
    Normal = 1,0,0
    Draw Lines = On
    Line Color = 1,0,0
    Color Mode = Variable
    Color Variable = Pressure
    Range = Local
  END
  PLANE:plane2
```
Although this subroutine is designed for use with the next example, you can execute it on its own by typing `!makePlanes();` in the Command Editor dialog box.

### 16.1.4. Example 4: Creating a Complex Quantitative Subroutine

This example is a complex quantitative subroutine that takes slices through the manifold geometry, as shown below, compares the mass flow through the two sides of the initial branch, and computes the pressure drop through to the four exit locations.
# Set-up an array that holds the approximate X location of each
# of the 4 exits. We then loop over the array to move the outlet
# plane and re-do the pressure drop calculation at each exit.
! @Xlocs = (0.15,0.25,0.35,0.45);
! $sum = 0;
! for ($i=0;$i<4;$i++) {
  PLANE:outlet
    Option = Point and Normal
    Normal = 0,-1,-1
    Point = $Xlocs[$i],-0.06,-0.2
    Plane Bound = Circular
    Bound Radius = 0.05
  END
  ! ($Pout, $punits) = evaluate( "massFlowAve(Pressure)@outlet" );
  ! ($massFl) = evaluate( "massFlow()@outlet" );
  ! $sum += $massFl;
  ! $Dp = $Pin-$Pout;
  ! $ii = $i+1;
  ! print "At outlet #$ii: Dp=$Dp [$punits], Mass Flow=$massFl [$mfunits]\n";
} # end loop
! print "Total Mass Flow = $sum  [$mfunits]\n";
} # end subroutine

After processing these commands to define the subroutine, you can execute it, in the same way as any
other subroutine, by typing !manifoldCalcs(); in the Command Editor dialog box.

16.2. Predefined Power Syntax Subroutines

CFD-Post provides predefined subroutines that add Power Syntax functionality. You can view a list of
these subroutines by entering !showSubs(); in the Command Editor dialog box. The list is printed
to the console window. The list shows all currently loaded subroutines, so it will include any custom
subroutines that you have processed in the Command Editor dialog box.

These subroutines provide access to the quantitative functionality of CFD-Post. Most of these routines
provide results in a single return value. For example, if the Perl variable $verbose = 1, then the
result is also printed to the screen. Information on the calculations performed by the subroutines is
available. For details, see Function Selection.

The following sections describe these predefined subroutines:

- Power Syntax Subroutine Descriptions (p. 233)
- Power Syntax Usage (p. 234)
- Power Syntax Subroutines (p. 234)

16.2.1. Power Syntax Subroutine Descriptions

In the next section, each subroutine will appear in the following format:

```
real Length("Location")
```

Return value(s)  Subroutine name  Subroutine argument(s)

Each of the subroutines contains an argument list (in brackets, separated by commas). If any argument
contains more than one word (for example, Plane 1), it must be within quotes. You should enclose
all arguments within quotes to avoid making possible syntax errors.
Each subroutine is preceded by its return value(s). For example:

```plaintext
real, string evaluate("Expression", "Locator")
```

will return two values, a real number and a string.

The return values will always be in the solution units of the CFX-Solver results file, even if you have changed the display units in the Edit menu. This means that if you have a plot of temperature in degrees C on Plane 1, the area averaged value of temperature on Plane 1 returned by the `areaAve` command will still be in degrees K.

### 16.2.2. Power Syntax Usage

All lines of power syntax must have an exclamation mark as the first character so that they are not treated as CCL statements. The statements must also end with a semicolon. The following is an example:

```plaintext
! $lengthVal = Length("Plane 1");
! print $lengthVal;
```

Some subroutines return more than one value. To store return values for a subroutine that returns two variables (such as the `evaluate` function), you could use the following:

```plaintext
! ($value, $units) = evaluate("Expression 1");
! print "The value of Expression 1 is $value, and the units are $units";
```

### 16.2.3. Power Syntax Subroutines

#### 16.2.3.1. area(Location, Axis)

```plaintext
real area("Location", "Axis")
```

Returns the area of a 2D locator. For details, see `area` (p. 161).

#### 16.2.3.2. areaAve(Variable, Location, Axis)

```plaintext
real areaAve("Variable", "Location", "Axis")
```

Returns the area-weighted average of the variable at a 2D locator. For details, see `areaAve` (p. 162).

#### 16.2.3.3. areaInt(Variable, Location, Axis)

```plaintext
real areaInt("Variable", "Location", "Axis")
```

Returns the result of the variable integrated over the 2D location. For details, see `areaInt` (p. 163).

#### 16.2.3.4. ave(Variable, Location)

```plaintext
real ave("Variable", "Location")
```

Returns the arithmetic average of the variable at a location. For details, see `ave` (p. 164).

#### 16.2.3.5. calcTurboVariables()

```plaintext
void calcTurboVariables()
```

Calculates all 'extra' turbo variables. (Works only in turbo mode.)
16.2.3.6. **calculate(function,...)**  
real calculate(function,...)

Evaluates the named function with the supplied argument list, and returns the float result. The function name is a required argument, which can be followed by a variable length list of arguments.

16.2.3.7. **calculateUnits(function,...)**  
string,string calculateUnits(function,...)

Evaluates the named function with the supplied argument list, and returns the value and units.

16.2.3.8. **collectTurboInfo()**

*This is an internal subroutine that is used only to initialize report templates.*

16.2.3.9. **comfortFactors()**

*This is an internal subroutine that is used only to initialize report templates.*

16.2.3.10. **compressorPerform(Location, Location, Location, Var, Args)**

This is a special macro; for details, see *Gas Compressor Performance Macro*. For example:

compressorPerform("Inlet", "Outlet", "Blade", "X", 600, 0.03, 10, 1.2)

16.2.3.11. **compressorPerformTurbo()**

*This is an internal subroutine that is used only to initialize report templates.*

16.2.3.12. **copyFile(FromPath, ToPath)**

void copyFile("FromPath", "ToPath")

A utility function for copying files.

16.2.3.13. **count(Location)**

real count("Location")

Returns the number of nodes on the location. For details, see *count* (p. 164).

16.2.3.14. **countTrue(Expression, Location)**

real countTrue("Expression", "Location")

Returns the number of mesh nodes on the specified region that evaluate to “true,” where true means greater than or equal to 0.5. "Expression" should contain one of the logical operators =, >, <, <=, or >=. The countTrue function is valid for 1D, 2D, and 3D locations. For details, see *countTrue* (p. 165).

16.2.3.15. **cpPolar(Location, Var, Arg, Var, Location, Arg)**

This is a special macro; for details, see *Cp Polar Plot Macro*. For example:

cpPolar("Plane 1", "Y", 0.3, "X", "Inlet", 10000)
16.2.3.16. `evaluate(Expression)`

real, string evaluate("Expression")

Returns the value of the expression and the units. Only one expression can be evaluated each time the subroutine is executed. The main advantage of using `evaluate` is that it takes any CEL expression. This means that you do not have to learn any other quantitative power syntax routines described in this section. Also, `evaluate` will return the result units in addition to the value.

An example is:

```python
evaluate("areaAve(Velocity v)@Location 1")
```

In this case, another subroutine is evaluated. The `evaluate` command takes an any expression as the argument, or more precisely, any expression that resolves to a quantity. This means that you cannot use:

* `2*Pressure`

but you can use:

* `2*minVal(Pressure)@locator 1`

or

* `"100 [m]"`

This is simply an alternative way of typing:

```python
! $myVal = 2 * minVal("Pressure", "Location");
```

The reason that the `@` is escaped calling `evaluate()` is to avoid Perl treating it as a special character.

16.2.3.17. `evaluateInPreferred(Expression)`

real, string evaluateInPreferred("Expression")

Returns the value of the expression in your preferred units. Preferred units are the units of the data that CFD-Post uses when information is displayed to you and are the default units when you enter information (as contrasted with units of the data that are stored in results files). Use the **Edit > Options > Common > Units** dialog box to set your preferred units.

16.2.3.18. `exprExists(Expression)`

bool exprExists("Expression")

Returns true if an expression with this name exists; false otherwise.

16.2.3.19. `fanNoiseDefault()`

*This is an internal subroutine that is used only to initialize report templates.*

16.2.3.20. `fanNoise()`

*This is an internal subroutine that is used only to initialize report templates.*

16.2.3.21. `force(Location, Axis)`

real force("Location", "Axis")
Predefined Power Syntax Subroutines

Returns the force on a 2D locator. For details, see force (p. 165).

16.2.3.22. forceNorm(Location, Axis)

real forceNorm("Location", "Axis")

Returns the per unit width force on a line in the direction of the specified axis. It is available only for a polyline created by intersecting a locator on a boundary. For details, see forceNorm (p. 167).

16.2.3.23. getBladeForceExpr()

This is an internal subroutine that is used only to initialize report templates.

16.2.3.24. getBladeTorqueExpr()

This is an internal subroutine that is used only to initialize report templates.

16.2.3.25. getCCLState()

This is an internal debugging call.

16.2.3.26. getChildrenByCategory(Category)

string getChildrenByCategory("Category")

Returns the children of an object that belong to the specified category in a comma-separated list. Each object type (for example, a PLANE) can have multiple categories associated with it such as "geometry", "surface", and so on). Categories are specified in <CFXROOT>/etc/CFXPostRules.ccl.

For example, to get a comma-separated list of all surfaces in a state at the top level (that is, not sub-objects of other objects):

! $surfaces = getChildrenByCategory("/", "surface" );

Use 'split ',"," to convert the string into an array of strings.

16.2.3.27. getChildren(Object Name, Child Type)

string getChildren("Object Name", "Child Type")

Returns the children of an object in a comma-separated list. If Child Type is not an empty string, this subroutine return only children of the specified type.

16.2.3.28. getExprOnLocators()

This is an internal subroutine that is used only to initialize report templates.

16.2.3.29. getExprString(Expression)

string getExprString("Expression")

Returns the value and the units of the expression in the form “value units”. For example: “100 m.”

16.2.3.30. getExprVal(Expression)

real getExprVal("Expression")
Returns only the "value" portion of the expression (units are not included).

**16.2.3.31. getObjectName(Object Path)**

```csharp
string getObjectName("Object Path")
```

Extracts the name of an object from its full path. For example:

```csharp
!string = getObjectName("/USER SURFACE:User Surface 1")
```

returns "User Surface 1". This is the form needed for evaluating a CEL expression.

**16.2.3.32. getParameterInfo(Object Name, Parameter Name, Info Type)**

```csharp
string getParameterInfo("Object Name", "Parameter Name", "Info Type")
```

Returns the requested information for a parameter of an object. **Object Name** returns the name or path of an object; "/" or an empty string specifies the root. **Parameter Name** returns the name of the parameter. **Info Type** returns the type of data requested; this can be one of "type", "value", "default value", or "allowed values". For example:

```csharp
! $info = getParameterInfo("/USER DEFINED/POINT:Point 1", "Symbol Size", "default value");
! print "getParameterInfo returned=$info\n";
```

prints:

```
getParameterInfo returned=2.5
```

**16.2.3.33. getParameters(Object Name)**

```csharp
string getParameters("Object Name")
```

Returns the parameters of an object in a comma-separated list. Use `split ","` to convert the string into an array of strings.

**16.2.3.34. getTempDirectory()**

```csharp
string getTempDirectory()
```

Returns the temporary directory path.

**16.2.3.35. getType(Object Name)**

```csharp
string getType("Object Name")
```

Returns the object type.

**16.2.3.36. getValue(Object Name, Parameter Name)**

```csharp
string getValue("Object Name", "Parameter Name")
```

Takes a CCL object and parameter name and returns the value of the parameter.

Returns the value stored in **Parameter Name**.

**16.2.3.36.1. Example**

1. Create a text object called **Text 1**.
2. In the **Text String** box, enter **Here is a text string.**
3. Click **Apply** to create the text object.

4. In the **Command Editor** dialog box, enter the following:

   ```
   !string = getValue( "/TEXT:Text 1/TEXT ITEM: Text Item 1", "Text String");
   ! print $string;
   ```

5. Click **Process**, and the string will be printed to your terminal window.

The same procedure can be carried out for any object.

### 16.2.3.37. `getViewArea()`

(string,string `getViewArea()`)

Calculates the area of the scene projected in the view direction. Returns the area and the units in an array of strings.

### 16.2.3.38. `isCategory(Object Name, Category)`

(bool `isCategory("Object Name", "Category")`)

A return of 1 indicates that the object matches the passed category; 0 otherwise. Categories are specified in `<CFXROOT>/etc/CFXPostRules.ccl`.

For example, the following prints "Plane 1 is a surface":

```
! if( isCategory( "Plane 1", "surface" )) {
!   print "Plane 1 is a surface\n";
! }
```  

### 16.2.3.39. `Length(Location)`

(real `Length("Location")`)

Returns the length of a line locator. For details, see *length* (p. 168).

---

**Note**

While using this function in Power Syntax the leading character is capitalized to avoid confusion with the Perl internal command "length."

### 16.2.3.40. `lengthAve(Variable, Location)`

(real `lengthAve("Variable", "Location")`)

Returns the length-based average of the variable on the line locator. For details, see *lengthAve* (p. 168).

### 16.2.3.41. `lengthInt(Variable, Location)`

(real `lengthInt("Variable", "Location")`)

Returns the length-based integral of the variable on the line locator. For details, see *lengthInt* (p. 169).

### 16.2.3.42. `liquidTurbPerformTurbo()`

This is an internal subroutine that is used only to initialize report templates.
16.2.3.43. liquidTurbPerform()

This is an internal subroutine that is used only to initialize report templates.

16.2.3.44. massFlow(Location)

    real massFlow("Location")

Returns the mass flow through the 2D locator. For details, see massFlow (p. 169).

16.2.3.45. massFlowAve(Variable, Location)

    real massFlowAve("Variable","Location")

Returns the average value of the variable, weighted by mass flow, through the 2D locator. For details, see massFlowAve (p. 171).

16.2.3.46. massFlowAveAbs(Variable, Location)

    real massFlowAveAbs("Variable","Location")

Returns the average value of the variable, weighted by absolute mass flow, through the 2D locator. For details, see massFlowAveAbs (p. 171).

16.2.3.47. massFlowInt(Variable, Location)

    real massFlowInt("Variable","Location")

Returns the integral of the variable, weighted by mass flow, over the 2D locator. For details, see massFlowInt (p. 173).

16.2.3.48. maxVal(Variable, Location)

    real maxVal("Variable","Location")

Returns the maximum value of the variable at the location. For details, see maxVal (p. 174).

16.2.3.49. minVal(Variable, Location)

    real minVal("Variable","Location")

Returns the minimum value of the variable at the location. For details, see minVal (p. 174).

16.2.3.50. objectExists(Object Name)

    bool objectExists("Object Name")

A return of 1 indicates that the object exists; 0 otherwise.

16.2.3.51. probe(Variable, Location)

    real probe("Variable","Location")

---

**Important**

This calculation should only be performed for point locators described by single points. Incorrect solutions will be produced for multiple point locators.
Returns the value of the variable at the point locator. For details, see *probe (p. 175).*

### 16.2.3.52. `pumpPerform()`

*This is an internal subroutine that is used only to initialize report templates.*

### 16.2.3.53. `pumpPerformTurbo()`

*This is an internal subroutine that is used only to initialize report templates.*

### 16.2.3.54. `range(Variable, Location)`

```c
real, real range("Variable", "Location")
```

Returns the minimum and maximum values of the variable at the location.

### 16.2.3.55. `reportError(String)`

```c
void reportError("String")
```

Pops up an error dialog box.

### 16.2.3.56. `reportWarning(String)`

```c
void reportWarning("String")
```

Pops up a warning dialog box.

### 16.2.3.57. `showPkgs()`

```c
void showPkgs()
```

Prints to the console a list of packages available which may contain other variables or subroutines in Power Syntax.

### 16.2.3.58. `showSubs(packageName)`

```c
void showSubs("packageName")
```

Prints to the console a list of the subroutines available in the specified package. If no package is specified, CFD-Post is used by default.

### 16.2.3.59. `showVars(packageName)`

```c
void showVars("packageName")
```

Prints to the console a list of the Power Syntax variables and their current value defined in the specified package. If no package is specified, CFD-Post is used by default.

### 16.2.3.60. `spawnAsyncProcess(command, arguments)`

```c
bool spawnAsyncProcess("command", "arguments")
```

Spawns a forked process. For example:

```bash
! spawnAsyncProcess("dir", "c:\");
```

Displays the contents of c:\ in the console window.
16.2.3.61. sum(Variable, Location)

real sum("Variable", "Location")

Returns the sum of the variable values at each point on the locator. For details, see sum (p. 176).

16.2.3.62. torque(Location, Axis)

real torque("Location", "Axis")

Returns the computed value of torque at the 2D locator about the specified axis. For details, see torque (p. 177).

16.2.3.63. turbinePerform()

This is an internal subroutine that is used only to initialize report templates.

16.2.3.64. turbinePerformTurbo()

This is an internal subroutine that is used only to initialize report templates.

16.2.3.65. verboseOn()

bool verboseOn()

Returns 1 or 0 depending if the Perl variable $verbose is set to 1.

16.2.3.66. volume(Location)

real volume("Location")

Returns the volume of a 3D locator. For details, see volume (p. 177).

16.2.3.67. volumeAve(Variable, Location)

real volumeAve("Variable", "Location")

Returns the average value of a variable over the 3D locator. For details, see volumeAve (p. 178).

16.2.3.68. volumeInt(Variable, Location)

real volumeInt("Variable", "Location")

Returns the integral of a variable over the 3D locator. For details, see volumeInt (p. 178).
Chapter 17: Bibliography

This bibliography contains entries referenced in the CFX documentation.

• References 1-20 (p. 243)
• References 21-40 (p. 246)
• References 41-60 (p. 249)
• References 61-80 (p. 252)
• References 81-100 (p. 255)
• References 101-120 (p. 258)
• References 121-140 (p. 261)
• References 141-160 (p. 264)
• References 161-180 (p. 267)
• References 181-200 (p. 270)

17.1. References 1-20

1

Hutchinson, B.R. and Raithby, G.D.,


2

Rhie, C.M. and Chow, W.L.,

“A Numerical Study of the Turbulent Flow Past an Isolated Airfoil with Trailing Edge Separation”,

AIAA Paper 82-0998, 1982

3

Raw, M.J.,

“A Coupled Algebraic Multigrid Method for the 3D Navier-Stokes Equations”,


4

Launder, B.E., Reece, G.J. and Rodi, W.,
“Progress in the developments of a Reynolds-stress turbulence closure”,

5

Speziale, C.G., Sarkar, S. and Gatski, T.B.,
“Modelling the pressure-strain correlation of turbulence: an invariant dynamical systems approach”,

6

Schiller, L. and Naumann, A.,
VDI Zeits, 77, p. 318, 1933.

7

Hughmark, G.A.,

8

Modest, M.,
“Radiative Heat Transfer; Second Edition

9

Menter, F.R.,
“Two-equation eddy-viscosity turbulence models for engineering applications”,

10

Grotjans, H. and Menter, F.R.,
“Wall functions for general application CFD codes”,

11

Wilcox, D.C.,
“Multiscale model for turbulent flows”,


12

Menter, F.R.,

“Multiscale model for turbulent flows”,


13

Launder, B.E. and Spalding, D.B.,

“The numerical computation of turbulent flows”,


14

White, F.M.,


15

Kader, B.A.,

“Temperature and concentration profiles in fully turbulent boundary layers”,


16

Huang, P.G., Bradshaw, P. and Coakley, T.J.,

“Skin friction and velocity profile family for compressible turbulent boundary layers”,


17

Bouillard, J.X, Lyczkowski, R.W.and Gidaspow, D.,

“Porosity Distribution in a Fluidised Bed with an Immersed Obstacle”,


18

Gidaspow, D.,
Chapter 17: Bibliography


19

Ishii, M. and Zuber, N.,
“Drag Coefficient and Relative Velocity in Bubbly, Droplet or Particulate Flows,”

20

Lopez de Bertodano, M.,
“Turbulent Bubbly Flow in a Triangular Duct,”

17.2. References 21-40

21

Lopez de Bertodano, M.,
“Two Fluid Model for Two-Phase Turbulent Jet,”

22

Sato, Y. and Sekoguchi, K.,
“Liquid Velocity Distribution in Two-Phase Bubbly Flow,”

23

Siegel, R and J.R. Howell,
“Thermal Radiation Heat Transfer,”

24

Goldstein, M. and J.R. Howell,
“Boundary Conditions for the Diffusion Solution of Coupled Conduction-Radiation Problems,”

25
Raw, M.J.,

“Robustness of Coupled Algebraic Multigrid for the Navier-Stokes Equations”,

AIAA 96-0297, 34th Aerospace and Sciences Meeting & Exhibit, January 15-18 1996, Reno, NV.

26

Kee, R. J., Rupley, F. M. and Miller, J. A.,

“Chemkin -II: A Fortran Chemical Kinetics Package for the Analysis of Gas-Phase Chemical Kinetics”,


27

Brackbill, J.U, Kothe, D.B. and Zemach, C.,

“A Continuum Method for Modelling Surface Tension”,


28

Barth, T.J., and Jesperson, D.C,

“The Design and Application of Upwind Schemes on Unstructured Meshes”,


29

Bird, R.B., Stewart, W.E. and Lightfoot, E.N.,

“Transport Phenomena”,


30

Wilcox, D.C.,

“Turbulence Modelling for CFD”,

DCW Industries, 2000, La Canada, CA 91011, p. 314.

31

Launder, B.E., Tselepidakis, D. P., Younis, B. A.,

“A second-moment closure study of rotating channel flow”,

32
Menter, F. R.,

“Eddy Viscosity Transport Equations and their Relation to the $k-\epsilon$ Model,”

33
Menter, F. R.,

“Eddy Viscosity Transport Equations and their Relation to the $k-\epsilon$ Model,”

34
Smagorinsky, J.,

“General Circulation Experiments with the Primitive Equations”,

35
Clift, R., Grace, J.R., Weber, M.E.,

“Bubbles, Drops and Particles”,

36
Liang, L., Michaelides, E. E.,

“The magnitude of Basset forces in unsteady multiphase flow computations”,

37
Peters, N.,

“Turbulent Combustion”,

38
Zimont, V.L., Polifke, W., Bettelini, M. and Weisenstein, W.,

“An efficient Computational Model for Premixed Turbulent Combustion at High Reynolds Numbers Based on a Turbulent Flame Speed Closure”,


39

Hinze, J. O.,

“Turbulence”,


40

Zimont, V.L.,

“Gas Premixed Combustion at High Turbulence. Turbulent Flame Closure Combustion Model”,


17.3. References 41-60

41

Zimont, V.L., Biagioli, F. and Syed, Khawar,

“Modelling turbulent premixed combustion in the intermediate steady propagation regime”,


42

Linan, A.,

“On the internal structure of laminar diffusion flames”,


43

Warnatz, J., Mass, U. and Dibble, R. W.,

“Combustion”,

Springer, Verlag, 1996, pp. 219-221.

44

Magnussen, B. F.,

“The Eddy Dissipation Concept for Turbulent Combustion Modelling. Its Physical and Practical Implications”,

References 41-60

45
“Kinetics of Dispersed Carbon Formation”,

46
Magnussen, B. F., and Hjertager, B. H.,
“On Mathematical Modeling of Turbulent Combustion with Special Emphasis on Soot Formation and Combustion”,

47
Vukalovich, M. P.,
“Thermodynamic Properties of Water and Steam”,

48
Hottel, H.C. and Sarofim, A.F.,
“Radiative transfer”,

49
Hadvig, S.,
“Gas emissivity and absorptivity”,

50
Leckner, B.,
“Spectral and total emissivity of water vapour and carbon dioxide”,

51
Taylor, P.B. and Foster, P.J.,
“The total emissivities of luminous and non-luminous flames”,


52

Beer, J.M., Foster, P.J. and Siddall, R.G.,

“Calculation methods of radiative heat transfer”,


53

Prakash, C.,

“Two phase model for binary liquid-solid phase change”,


54

CFX Limited, Waterloo, Ontario, Canada,

CFX-TASCflow Theory Documentation,


55

Menter, F. R. and Kuntz, M.,

“Development and Application of a Zonal DES Turbulence Model for CFX-5”,

CFX-Validation Report, CFX-VAL17/0503.

56

Menter, F.R., Kuntz, M.,

“Adaptation of Eddy-Viscosity Turbulence Models to Unsteady Separated Flow Behind Vehicles”,


57


“Comments on the feasibility of LES for wings, and on a hybrid RANS/LES approach”,


58
Strelets, M.,

“Detached Eddy Simulation of Massively Separated Flows”,

59

Ishii, M.,

“One-dimensional drift-flux model and constitutive equations for relative motion between phases in various two-phase flow regimes”,

60

Manninen, M. and Tavassalo, V.,

“On the Mixture Models for Multiphase Flow”,
VTT Publications, 1996.

17.4. References 61-80

61

Luo, S.M., and Svendsen, H.,

“Theoretical Model for Drop and Bubble Breakup in Turbulent Dispersions”,
AIChE Journal 42, 1225 -1233.

62

Prince, M. and Blanch, H.,

“Bubble Coalescence and Break-Up in Air-Sparged Bubble Columns”,
AIChE Journal 36, 1485-1499.

63

Hutchings, I.M.,

“Mechanical and metallurgical aspects of the erosion of metals”,

64

Dosanjh, S., and Humphrey, J.A.C.,

“The influence of turbulence on erosion by a particle laden fluid jet, Wear”,
Aungier, R.H.,
“Centrifugal Compressors: A strategy for Aerodynamic Design and Analysis”,

Westbrook, C.K., Dryer, F.L.,
“Simplified Reaction Mechanisms for the Oxidation of Hydrocarbon Fuels in Flames”,
Combustion Science and Technology Vol. 27, pp. 31-43, 1981.

Faeth, G. M.,
“Mixing, transport and combustion in sprays”,

Mijnbeek, G.,
“Bubble column, airlift reactors and other reactor designs”, Operational Modes of Bioreactors, Chapter 4,
Butterworth and Heinemann, 1992.

Bello, R. A., Robinson, C. W., and Moo-Young, M.,

García-Calvo, E. and Letón, P.,
“Prediction of gas hold-up and liquid velocity in airlift reactors using two-phase flow friction coefficients”,
Journal of Chemical Technology & Biotechnology, Vol. 67, pp. 388-396,
Wiley Interscience, 1996.
Chapter 17: Bibliography


72

Baker, J. L. L. and Chao, B. T.,


73

Hughmark, G. A.,


74

S. Lo, R. Bagatin and M. Masi,

“The Development of a CFD Analysis and Design Tool for Air-lift Reactors”,

75

Ranz, W.E. and Marshall, W.R.,


76

Bardina, J.E., Huang, P.G. and Coakley, T.J.,

“Turbulence Modeling Validation Testing and Development”,

77

H. Schlichting,

“Boundary Layer Theory”,

78

Badzioch, S., and Hawksley, P.G.W.,

17.5. References 81-100

81
Sutherland, W.,
“The Viscosity of Gases and Molecular Force”,
Phil. Mag. 5:507-531, 1893.

82
Hirschfelder, J.O., Taylor, and M.H., Bird, R.B.,
“Molecular Theory of Gases and Liquids”,

83
Chung, T.H., Lee, L.L., and Starling, K.E.,
“Applications of Kinetic Gas Theories and Multiparameter Correlation for Prediction of Dilute Gas Viscosity and Thermal Conductivity”,

84
Poling, B.E., Prausnitz, J.M., and O’Connell, J.P.,
“The Properties of Gases and Liquids”,

85
Redlich, O., and Kwong, J.N.S.,
"On the Thermodynamics of Solutions. V. An Equation of State. Fugacities of Gaseous Solutions."

86
Saffman, P. G.,
“The lift on a small sphere in a slow shear flow”,

87
Mei, R. and Klausner, J. F.,
“Shear lift force on spherical bubbles”,

88
Antal, S. P., Lahey, R. T., and Flaherty, J. E.,
“Analysis of phase distribution in fully developed laminar bubbly two-phase flow”,

89
Krepper, E., and Prasser, H-M.,
“Measurements and CFX Simulations of a bubbly flow in a vertical pipe”,

90
Burns, A.D.B., Frank, Th., Hamill, I., and Shi, J-M.,
“The Favre Averaged Drag Model for Turbulent Dispersion in Eulerian Multi-Phase Flows”,
5th International Conference on Multiphase Flow, ICMF-2004, Yokohama, Japan.

91
Moraga, J.F., Larreteguy, A.E., Drew, D.A., and Lahey, R.T.,
“Assessment of turbulent dispersion models for bubbly flows in the low Stokes number limit”,
92
CIBSE Guide A: Environmental Design

93
ISO 7730-1984(E), Moderate thermal environments - Determination of the PMV and PPD indices and specification of the conditions for thermal comfort
1984.

94
Yamada, T. and R.D. Gunn,

95
Pitzer, K.S., D.Z. Lippmann, R.F. Curl, C.M. Huggins, and D.E. Petersen,

96
Aungier, R.H.,
“A Fast, Accurate Real Gas Equation of State for Fluid Dynamic Analysis Applications”,

97
H. Enwald, E. Peirano and A. E. Almstedt,
“Eulerian Two-Phase Flow Theory Applied to Fluidisation”,

98
J. Ding and D. Gidaspow,
“A Bubbling Fluidisation Model using Theory of Granular Flow”,

99
C.K.K. Lun, S.B. Savage, D.J. Jeffery, and N. Chepurniy,
“Kinetic Theories for Granular Flow: Inelastic Particles in Couette Flow and Slightly Inelastic Particles in a General Flow Field”,

References 81-100
100

C.K.K. Lun, and S.B. Savage,

“The Effects of an Impact Velocity Dependent Coefficient of Restitution on Stresses Developed by Sheared Granular Materials,”


17.6. References 101-120

101

Menter, F.R., Langtry, R.B., Likki, S.R., Suzen, Y.B., Huang, P.G., and Völker, S.,

“A Correlation based Transition Model using Local Variables Part 1- Model Formulation,”


102

Langtry, R.B., Menter, F.R., Likki, S.R., Suzen, Y.B., Huang, P.G., and Völker, S.,

“A Correlation based Transition Model using Local Variables Part 2 - Test Cases and Industrial Applications”,


103

Langtry, R.B., Menter, F.R.,

“Transition Modeling for General CFD Applications in Aeronautics,”


104

Mayle, R.E.,

“The Role of Laminar-Turbulent Transition in Gas Turbine Engines,”


105

R. Schmehl,

“Advanced Modelling of Droplet Deformation and Breakup for CFD Analysis of Mixture Preparation”,

106
Miller A. and Gidaspow D,

107
F.X. Tanner,
“Liquid Jet Atomization and Droplet Breakup Modeling of Non-Evaporating Diesel Fuel Sprays”,

108
B. Liu, D. Mather and R.D. Reitz,
“Effects of Drop Drag and Breakup on Fuel Sprays”,

109
L.P. Hsiang and G.M. Faeth,
“Near-Limit Drop Deformation and Secondary Breakup”,

110
S. C. Kuensberg, S.-C., Kong and R. D. Reitz,
“Modelling the Effects of Injector Nozzle Geometry on Diesel Sprays”,

111
H. Hiroyasu and T. Kadota,
“Fuel droplet size distribution in diesel combustion chamber”,

112
R. Schmehl, G. Maier and S. Wittig,
“CFD Analysis of Fuel Atomization, Secondary Droplet Breakup and Spray Dispersion in the Premix Duct of a LPP Combustor”,
113
Schlichting, H., and Gersten, K.,
“Grenzschicht-Theorie”.

114
W.H. Nurick,
“Orifice Cavitation and Its Effect on Spray Mixing;”

115
R.D. Reitz and R. Diwakar,
“Structure of High-Pressure Fuel Sprays;”

116
P.J.O’Rourke and A.A. Amsden,
“The TAB Method for Numerical Calculation of Spray Droplet Breakup;”

117
M. Pilch and C.A. Erdman,
“Use of Breakup Time Data and Velocity History Data to Predict the Maximum Size of Stable Fragments for Acceleration-Induced Breakup of a Liquid Drop;”

118
S.V. Patankar,
“Numerical Heat Transfer and Fluid Flow;”

119
S. Majumdar,
“Role of Underrelaxation in Momentum Interpolation for Calculation of Flow with Non-staggered Grids;”

120

C. Baumgarten, H. Lettmann and G.P. Merker,
“Modelling of Primary and Secondary Break-Up Processes in High Pressure Diesel Sprays;”

17.7. References 121-140

121

T. Iijima and T. Takeno,
“Effects of pressure and temperature on burning velocity;”

122

B. Lewis and G. v. Elbe,
“Combustion, Flames and Explosions of Gases;”

123

B. E. Milton and J.C. Keck,
“Laminar burning velocities in stoichiometric hydrogen and hydrogen-hydrocarbon gas mixtures;”

124

M. Metghalchi and J.C. Keck,
“Burning Velocities of Mixtures of Air with Methanol, iso-octane and indolene at High Pressure and Temperature;”

125

W. Wagner, and A. Kruse,
“The Industrial Standard IAPWS-IF97: Properties of Water and Steam;”
Senecal, P.K., Schmidt, D.P., Nouar, I., Rutland, C.J., Reitz, R.D. and Corradin, M.L.,

"Modeling High-Speed Viscous Liquid Sheet Atomization",


127

Han, Z., Perrish, S., Farrell, P.V. and Reitz R.D.,

"Modeling Atomization Processes of Pressure-Swirl Hollow-Cone Fuel Sprays",


128

Kato, M., Launder, B.E.,

"The modelling of turbulent flow around stationary and vibrating square cylinders",


129

Menter, F. R.,

"Zonal two equation $k - \omega$ turbulence models for aerodynamic flows",


130

Menter F. R. and Egorov, Y.,

"Re-visiting the turbulent scale equation",

Proc. IUTAM Symposium; One hundred years of boundary layer research, Göttingen, 2004.

131

Menter, F.R. and Egorov, Y.,

"A Scale-Adaptive Simulation Model using Two-Equation Models",


132

Menter, F.R, Kunz, M., Bender R.,

"A scale-adaptive simulation model for turbulent flow predictions",

Menter. F. R., Kuntz, M. and Durand. L.,

"Adaptation of eddy viscosity turbulence models to unsteady separated flow behind vehicles."

The Aerodynamics Of Heavy Vehicles: Trucks, Buses And Trains, Monterey, Dec.2-6, 2002.

134

Rotta, J. C.,

"Turbulente Strömungen."


135

Spalart P. R.,

"Young-Person's Guide to Detached-Eddy Simulation Grids."


136

Wilcox, D. C.,

"Turbulence Modelling for CFD."


137

Squires, K.,

"Detached eddy simulation: Current status and future perspectives."


138

Jovic, S., Driver, D. M.,

"Backward-facing step measurement at low Reynolds number, Re_H=5000."


139

Roache, P. J.,

"Verification and Validation in Computational Science and Engineering."


140
Casey, M. and Wintergerste W.,
“Best Practice Guidelines”,

17.8. References 141-160

141
Ferziger, J. H. and Peric, M.,
“Computational methods for fluid dynamics”,

142
Menter, F. R. and Esch T.,
“Elements of Industrial Heat Transfer Predictions”,
16th Brazilian Congress of Mechanical Engineering (COBEM), Nov. 2001, Uberlandia, Brazil.

143
Menter, F.,
“CFD Best Practice Guidelines for CFD Code Validation for Reactor Safety Applications”,

144
Menter F. R. and Egorov, Y.,
“Turbulence Models based on the Length-Scale Equation”,

145
Menter F. R. and Egorov, Y.,
“SAS Turbulence Modelling of Technical Flows”,
DLES 6 - 6th ERCOFTAC Workshop on Direct and Large Eddy Simulation September, Poitiers, 2005.

146
Spalart P. R.,
“Strategies for turbulence modelling and simulations”,

147

A. D. Gosman and E. Ioannides,
“Aspects of computer simulation of liquid fuelled combustors”,

148

F. Bakir, R. Rey, A.G. Gerber, T. Belamri and B. Hutchinson,
“Numerical and Experimental Investigations of the Cavitating Behavior of an Inducer”,

149

Frank, Th.,
“Parallele Algorithmen für die numerische Simulation dreidimensionaler, disperser Mehrphasenströmungen und deren Anwendung in der Verfahrenstechnik”,

150

Hussmann, B. et al.,
“A stochastic particle-particle collision model for dense gas-particle flows implemented in the Lagrangian solver of ANSYS CFX and its validation”,

151

Oesterlé, B., Petitjean, A.,
“Simulations of particle-to-particle interactions in gas-solid flows”,

152

Sommerfeld, M.,
“Modellierung und numerische Berechnung von partikelbeladenen Strömungen mit Hilfe des Euler-Lagrange-Verfahrens”,
Habilitationsschrift, Shaker Verlag Aachen, 1996.

153
Lavieville, J., Deutsch, E. and Simonin, O.,

“Large eddy simulations of interactions between colliding particles and a homogeneous isotropic turbulence field”,


154

Sommerfeld, M.,

“Validation of a stochastic Lagrangian modeling approach for inter-particle collision in homogeneous isotropic turbulence”,


155

Huh, K.Y., Lee, E.,

“Diesel Spray Atomization Models Considering Nozzle Exit Turbulence Conditions”,


156

Chryssakis, C.A., Assanis, D.N.,

“A Secondary atomization Model for Liquid Droplet Deformations and Breakup under High Weber Number Conditions”,


157

Peng, D.Y. and Robinson, D.B.,

“A New Two-Constant Equation of State”,


158

Chung, T.H., M. Ajlan, L.L. Lee and K.E. Starling,

“Generalized Multiparameter Correlation for Nonpolar and Polar Fluid Transport Properties”,


159

Kurul, N. and Podowski, M. Z.,

“On the modeling of multidimensional effects in boiling channels”,

Chapter 17: Bibliography

160

Kocamustafaogullari, G. and Ishii, M.,

“Interfacial area and nucleation site density in boiling systems”;


17.9. References 161-180

161

Podowski, M. Z., Alajbegovic, A., Kurul, N., Drew, D.A. and Lahey, R. T.,

“Mechanistic modelling of CHF in forced-convection sub-cooled boiling”;

Int. Conference on Convective Flow and Pool Boiling, Irsee, Germany, 1997a.

162

Podowski, R. M., Drew, D.A., Lahey, R. T. and Podowski, M. Z.,

“A mechanistic model of the ebullition cycle in forced-convection sub-cooled boiling”;

NURETH-8, Kyoto, Japan, 1997b.

163

Egorov, Y. and Menter, F.,

“Experimental implementation of the RPI boiling model in CFX-5.6”;


164

Lemmert, M. and Chawla, J. M.,

“Influence of flow velocity on surface boiling heat transfer coefficient”;


165

Tolubinski, V. I. and Kostanchuk, D. M.,

“Vapour bubbles growth rate and heat transfer intensity at subcooled water boiling”;


166

Cole, R.,
“A photographic study of pool boiling in the region of CHF”,
AIChEJ, 6 pp. 533-542, 1960.

167
Mikic, B. B. and Rohsenow, W. M.,
“A new correlation of pool boiling data including the fact of heating surface characteristics”,

168
Del Valle, V. H. and Kenning, D. B. R.,
“Subcooled flow boiling at high heat flux”,

169
Ceumern-Lindenstjerna, W. C.,
“Bubble Departure and Release Frequencies During Nucleate Pool Boiling of Water and Aqueous NaCl Solutions”,

170
Saffman, P. G.,
Corrigendum to: “The lift on a small sphere in a slow shear flow”,

171
Legendre, D. and Magnaudet, J.,
“The lift force on a spherical bubble in a viscous linear shear flow”,

172
Tomiyama, A.,
“Struggle with computational bubble dynamics”,

173
Frank, Th., Shi, J. M. and Burns, A. D.,

“Validation of Eulerian Multiphase Flow Models for Nuclear Safety Applications;”


174

Wellek, R. M., Agrawal, A. K. and Skelland, A. H. P.,

“Shapes of liquid drops moving in liquid media”,


175

G. Elsässer,

“Experimentelle Untersuchung und numerische Modellierung der freien Kraftstoffstrahlausbreitung und Wandinteraktion unter motorischen Randbedingungen;”

Dissertation, Logos Verlag, Berlin, 2001

176

C. Bai and A.D. Gosman,

“Prediction of spray wall impingement in reciprocating engines”,

ILASS-Europe, July 1999

177

Frank, Th., Zwart, P. J., Krepper, E., Prasser, H. -M. and Lucas,

“Validation of CFD models for mono- and polydisperse air-water two-phase flows in pipes”


178

Lighthill, M. J.,

“On sound generated aerodynamically. I. General theory”


179

Lighthill, M. J.,

“On sound generated aerodynamically. II. Turbulence as a source of sound”

180

Ffowcs-Williams, J. E. and Hawkings, D. L.,

“Theory relating to the noise of rotating machinery”


17.10. References 181-200

181

Wen, C. Y. and Yu, Y. H.,

“Mechanics of Fluidization”


182

Choi, C. R. and Huh, K. Y.,

"Development and validation of a coherent flamelet model for a spark-ignited turbulent premixed flame in a closed vessel,"


183

A. M. Douaud, P. Eyzat,

“Four-Octane-Number Method for Predicting the Anti-Knock Behavior of Fuels and Engines,”


184

M. P. Halstead, L. J. Kirsch, C. P. Quinn,

“The Autoignition of Hydrocarbon Fuels at High Temperatures and Pressures – Fitting of a Mathematical Model,”


185

H. O. Hardenberg, F. W. Hase,

“An Empirical Formula for Computing the Pressure Rise Delay of a Fuel from Its Cetane Number and from the Relevant Parameters of Direct-Injection Diesel Engines,”

Meneveau, C., and Poinsot, T.,
“Stretching and quenching of flamelets in premixed turbulent combustion”,

187

T. Poinsot, D. Veynante,
“Theoretical and Numerical Combustion”,

188

Wallin, S. and Johansson A.,
“A complete explicit algebraic Reynolds stress model for incompressible and compressible flows”,

189

Wallin, S., and Johansson A.,
“Modelling streamline curvature effects in explicit algebraic Reynolds stress turbulence models”,

190

Hellsten, A.,
“New advanced $k - \omega$ turbulence model for high-lift aerodynamics”,

191

Spalart, P.R., and Shur, M.
“On the sensitization of turbulence models to rotation and curvature”,

192

Smirnov, P.E., and Menter, F.R.
“Sensitization of the SST turbulence model to rotation and curvature by applying the Spalart-Shur correction term”,
193
Coleman, H.W., Hodge, B.K., Taylor, R.P.,
“A Re-Evaluation of Schlichting’s Surface Roughness Experiment”,

194
Lechner, R., and Menter, F.,
“Development of a rough wall boundary condition for \( \omega \)-based turbulence models”,

195
Pimenta, M.M., Moffat, R.J. and Kays, W.M.,
“The Turbulent Boundary Layer: An Experimental Study of the Transport of Momentum and Heat with the Effect of Roughness”,

196
Lauder, B.E.,
“Second-moment closure: present … and future”,

197
Egorov, Y., and Menter, F.,
“Development and Application of SST-SAS Turbulence Model in the DESIDER Project”,

198
Germano, M., Piomelli, U., Moin, P., Cabot, W.H.,
“A Dynamic Subgrid-Scale Eddy Viscosity Model”,

199
Lilly, D.K.,
“A Proposed Modification of the Germano Subgrid-Scale Closure Method”,
Nicoud, F., Ducros, F.,
“Subgrid-Scale Stress Modelling Based on the Square of the Velocity Gradient Tensor”,

17.11. References 201 –

Abramzon, B. and Sirignano, W.A.,
“Droplet Vaporization Model for Spray Combustion Calculations”

Sazhin, Sergei S.,
“Advanced Models of Fuel Droplet Heating and Evaporation”

Hughes, T.J.R.,
“The Finite Element Method”

Simo, J.C. and Wong, K.K.,
“Unconditionally Stable Algorithms for Rigid Body Dynamics that exactly Preserves Energy and Momentum”

Hughes, Peter C.,
“Spacecraft Attitude Dynamic”
“The Dynamics of Atmospheric Flight”

207
Conaire, Marcus Ó, Curran, Henry J., Simmie, John M., Pitz, William J., Westbrook, Charles K.,
“A Comprehensive Modeling Study of Hydrogen Oxidation”
International Journal of Chemical Kinetics,

208
Frank, Th.
"Numerische Simulation der feststoffbeladenen Gasströmung im horizontalen Kanal unter Berücksichtigung von Wandrauhigkeiten"

209
Matsumoto, S., Saito, S., Maeda, S.
"Simulation of Gas-Solid Two-Phase Flow in Horizontal Pipe"
Journal of Chemical Engineering of Japan
Vol. 9, No. 1, pp. 23–28, 1976

210
Tsuji, Y., Oshima, T., Morikawa, Y.
"Numerical Simulation of Pneumatic Conveying in a Horizontal Pipe"
KONA Powder Science and Technology in Japan
No. 3, pp. 38–51, 1985

211
Frank, Th.
"Parallele Algorithmen für die numerische Simulation dreidimensionaler, disperser Mehrphasenströmungen und deren Anwendung in der Verfahrenstechnik"
Doctorial Dissertation, Shaker Verlag, 2002

212
Sommerfeld, M.
"Numerical Simulation of the Particle Dispersion in Turbulent Flow: the Importance of Particle Lift Forces and Particle/Wall Collision Models"

ASME Symposium on Numerical Methods for Multiphase Flows, Toronto, Canada

pp. 1–8, 1990

213

B. P. Leonard,

“The ULTIMATE conservative difference scheme applied to unsteady one-dimensional advection,“


88:17–74, 1991

214

Jasak, H.; Weller, H.G., Gosman, A.D.

“High resolution NVD differencing scheme for arbitrarily unstructured meshes,“

Int. J. Numer. Meth. Fluids, 1999,

pp. 413 – 449.

215

Erdos, J.A.

“Numerical Solution of Periodic Transonic Flow through a Fan Stage”


pp. 1559-1568.

216

Gerolymos G.A.

“Analysis and Application of Chorochronic Periodicity in Turbomachinery Rotor/Stator Interaction Computations”


pp. 1139-1152.

217

Giles, M.

“Calculation of Unsteady Wake/Rotor Interaction”

218

He, L.

“An Euler Solution for Unsteady Flows Around Oscillating Blades”


pp. 714-722.

219

Apsley, D.D. and Leschziner, M.A.

“A new low-reynolds-number nonlinear two-equation turbulence model for complex flows”

# Glossary

## Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;CFDPOSTROOT&gt;</code></td>
<td>The directory in which CFD-Post is installed; for example: <code>C:\Program Files\ANSYS Inc\v140\CFD-Post\</code></td>
</tr>
<tr>
<td><code>&lt;CFXROOT&gt;</code></td>
<td>The directory in which CFX is installed; for example: <code>C:\Program Files\ANSYS Inc\v140\CFX\</code></td>
</tr>
</tbody>
</table>

## A

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>absolute pressure</td>
<td>The summation of solver pressure, reference pressure, and hydrostatic pressure (if a buoyant flow) in the cavitation model. The absolute pressure is clipped to be no less than the vapor pressure of the fluid. It is used by the solver to calculate pressure-dependent properties (such as density for compressible flow).</td>
</tr>
<tr>
<td>absorption coefficient</td>
<td>A property of a medium that measures the amount of thermal radiation absorbed per unit length within the medium.</td>
</tr>
<tr>
<td>adaption criteria</td>
<td>The criteria that are used to determine where mesh adaption takes place.</td>
</tr>
<tr>
<td>adaption level</td>
<td>The degree that a mesh element has been refined during adaption. Each mesh element has an adaption level. Each time an element is split into smaller elements, the new elements have an adaption level that is one greater than the &quot;parent&quot; element. The maximum number of adaption levels is controlled to prevent over-refinement.</td>
</tr>
<tr>
<td>adaption step</td>
<td>One loop of the adapt-solve cycle in the mesh adaption process.</td>
</tr>
<tr>
<td>Additional Variable</td>
<td>A non-reacting, scalar component. Additional Variables are used to model the distribution of passive materials in the flow, such as smoke in air or dye in water. Additional Variables are typically specified as concentrations.</td>
</tr>
<tr>
<td>adiabatic</td>
<td>The description of any system in which heat is prevented from crossing the boundary of the system. You can set adiabatic boundary conditions for heat transfer simulations in ANSYS CFX or in FLUENT.</td>
</tr>
<tr>
<td>Advancing Front and Inflation (AFI)</td>
<td>The default meshing mode in CFX. The AFI mesher consists of a triangular surface/tetrahedral volume mesh generator that uses the advancing front method to discretize first the surface and then the volume into an unstructured (irregular) mesh. Inflation can be applied to selected surfaces to produce prismatic elements from the triangular surface mesh, which combine with the tetrahedra to form a hybrid mesh.</td>
</tr>
</tbody>
</table>
all domains  In immersed-solids cases in CFD-Post, "all domains" refers to all of the domains in the case excluding the immersed solid. This is done for backwards compatibility.

Generally speaking, only the wireframe needs to keep track of both "all domains" and the immersed solid.

ASM (Algebraic Slip Model)  A mathematical form in which geometry may be represented, known as parametric cubic.

aspect ratio  Also known as normalized shape ratio. A measure of how close to a regular tetrahedron any tetrahedron is. The aspect ratio is 1 for a regular tetrahedron, but gets smaller the flatter the tetrahedron gets. Used for judging how good a mesh is.

B

backup file  An intermediate CFX-Solver Results file that can be manually generated during the course of a solution from the CFX-Solver Manager interface by using the Backup action button. Backup files should be generated if you suspect your solution may be diverging and want to retain the intermediate solution from which you can do a restart.

batch mode  A way to run some components of ANSYS CFX without needing to open windows to control the process. When running in batch mode, a Viewer is not provided and you cannot enter commands at a command prompt. Commands are issued via a CFD-Post session file (*.cse), the name of which is specified when executing the command to start batch mode. The session file can be created using a text editor, or, more easily, by recording a session while running in line-interface or user-interface mode.

blend factor  A setting that controls the degree of first/second order blending for the advection terms in discrete finite volume equations.

body  A collection of surfaces that completely and unambiguously enclose a finite volume. Modelers that create so-called B-Rep models create "bodies." This term was coined to distinguish between the tri-parametric entities, known herein as solids, and the shell-like representations produced by most CAD systems.

boundary  A surface or edge that limits the extent of a space. A boundary can be internal (the surface of a submerged porous material) or external (the surface of an airfoil).

boundary condition  Physical conditions at the edges of a region of interest that you must specify in order to completely describe a simulation.

buoyant flow  Flow that is driven wholly or partially by differences in fluid density. For fluids where density is not a function of temperature, pressure, or Additional Variables, the Boussinesq approximation is employed.
If density is a function of one of these, then the Full Buoyancy model is employed.

**C**

**CEL (CFX Expression Language)**

A high level language used within CFX to develop expressions for use in your simulations. CEL can be used to apply user-defined fluid property dependencies, boundary conditions, and initial values. Expressions can be developed within CFX using the Expression Editor.

**CFD (Computational Fluid Dynamics)**

The science of predicting fluid flow, heat transfer, mass transfer (as in perspiration or dissolution), phase change (as in freezing or boiling), chemical reaction (as in combustion), mechanical movement (as in fan rotation), stress or deformation of related solid structures (such as a mast bending in the wind), and related phenomena by solving the mathematical equations that govern these processes using a numerical algorithm on a computer.

**CFX-Solver Input file**

A file that contains the specification for the whole simulation, including the geometry, surface mesh, boundary conditions, fluid properties, solver parameters and any initial values. It is created by CFX and used as input to CFX-Solver.

**CHT (Conjugate Heat Transfer)**

Heat transfer in a conducting solid.

**clipping plane**

A plane that is defined through the geometry of a model, in front of which no geometry is drawn. This enables you to see parts of the geometry that would normally be hidden.

**command actions**

Command actions are:

- Statements in session files
- Commands entered into the **Tools > Command Editor** dialog box
- Commands entered in Line Interface mode.

All such actions must be preceded with the > symbol. These commands force CFD-Post to undertake specific tasks, usually related to the input and output of data from the system. See also **Power Syntax** (p. 288).

**component**

A substance containing one or more materials in a fixed composition. The properties of a component are calculated from the mass fractions of the constituent materials and are based on the materials forming an ideal mixture.

**compressible flow**

Flow in which the fluid volume changes in response to pressure change. Compressible flow effects can be taken into consideration when the Mach number (M) approaches approximately 0.2.

**computational mesh**

A collection of points representing the flow field where the equations of fluid motion (and temperature, if relevant) are calculated.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>control volume</td>
<td>The volume surrounding each node, defined by segments of the faces of the elements associated with each node. The equations of fluid flow are solved over each control volume.</td>
</tr>
<tr>
<td>convergence</td>
<td>A state of a solution that occurs when the change in residual values from one iteration to the next are below defined limits.</td>
</tr>
<tr>
<td>corrected boundary node</td>
<td>Node values obtained by taking the results produced by CFX-Solver (called &quot;conservative values&quot;) and overwriting the results on the boundary nodes with the specified boundary conditions.</td>
</tr>
<tr>
<td>values</td>
<td>The values of some variables on the boundary nodes (that is, on the edges of the geometry) are not precisely equal to the specified boundary conditions when CFX-Solver finishes its calculations. For instance, the value of velocity on a node on the wall will not be precisely zero, and the value of temperature on an inlet may not be precisely the specified inlet temperature. For visualization purposes, it can be more helpful if the nodes at the boundary do contain the specified boundary conditions and so &quot;corrected boundary node values&quot; are used. Corrected boundary node values are obtained by taking the results produced by CFX-Solver (called &quot;conservative values&quot;) and overwriting the results on the boundary nodes with the specified boundary conditions. This will ensure the velocity is display as zero on no-slip walls and equal to the specified inlet velocity on the inlet, for example.</td>
</tr>
<tr>
<td>coupled solver</td>
<td>A solver in which all of the hydrodynamic equations are solved simultaneously as a single system. The advantages of a coupled solver are that it is faster than a traditional solver and fewer iterations are required to obtain a converged solution. CFX-Solver is an example of a coupled solver.</td>
</tr>
<tr>
<td>curve</td>
<td>A general vector valued function of a single parametric variable. In CFX, a line is also a curve. By default, curves are displayed in yellow in ANSYS CFX.</td>
</tr>
<tr>
<td>default boundary condition</td>
<td>The boundary condition that is applied to all surfaces that have no boundary condition explicitly set. Normally, this is set to the No Slip Adiabatic Wall boundary condition, although you can change the type of default boundary condition in CFX.</td>
</tr>
<tr>
<td>Detached Eddy Simulation</td>
<td>A model that covers the boundary layer by a RANS model and switches to a LES model in detached regions.</td>
</tr>
<tr>
<td>(DES)</td>
<td></td>
</tr>
<tr>
<td>Direct Numerical Simulation</td>
<td>A CFD simulation in which the Navier-Stokes equations are solved without any turbulence model.</td>
</tr>
<tr>
<td>(DNS)</td>
<td></td>
</tr>
<tr>
<td>discretization</td>
<td>The equations of fluid flow cannot be solved directly. Discretization is the process by which the differential equations are converted into</td>
</tr>
</tbody>
</table>
a system of algebraic equations, which relate the value of a variable in a control volume to the value in neighboring control volumes.

domain
Regions of fluid flow and/or heat transfer in CFX are called domains. Fluid domains define a region of fluid flow, while solid domains are regions occupied by conducting solids in which volumetric sources of energy can be specified. The domain requires three specifications:

- The region defining the flow or conducting solid. A domain is formed from one or more 3D primitives that constrain the region occupied by the fluid and/or conducting solids.
- The physical nature of the flow. This determines the modeling of specific features such as heat transfer or buoyancy.
- The properties of the materials in the region.

There can be many domains per model, with each domain defined by separate 3D primitives. Multidomain problems may be created from a single mesh if it contains multiple 3D primitives or is from multiple meshes.

dynamic viscosity
Dynamic viscosity, also called absolute viscosity, is a measure of the resistance of a fluid to shearing forces.

dynamical time
For advection dominated flows, this is an approximate timescale for the flow to move through the Domain. Setting the physical time step (p. 288) size to this value (or a fraction of it) can promote faster convergence.

E

eddy viscosity model
A turbulence model based on the assumption that Reynolds stresses are proportional to mean velocity gradients and that the Reynolds stress contribution can be described by the addition of a turbulent component of viscosity. An example of an eddy viscosity model is the k-ε model.

edge
The edge entity describes the topological relationships for a curve. Adjacent faces share at least one edge.

emissivity
A property of an object that describes how much radiation it emits as compared to that of a black body at the same temperature.

expansion factor
The rate of growth of volume elements away from curved surfaces and the rate of growth of surface elements away from curved boundaries. Expansion factor is also used to specify the rate of mesh coarsening from a mesh control.

expression editor
An interactive, form-driven facility within CFX for developing expressions.

external flow
A flow field that is located outside of your geometry.
F

face "Face" can have several meanings:

- A solid face is a surface that exists as part of a solid. It is also known as an implicit surface.
- An element face is one side of a mesh element.
- A boundary face is an element face that exists on the exterior boundary of the domain.
- Surfaces composed of edges that are connected to each other.

FLEXlm The program that administers ANSYS licensing.

flow boundaries The surfaces bounding the flow field.

flow region A volumetric space containing a fluid. Depending on the flow characteristics, you may have a single, uninterrupted flow region, or several flow regions, each exhibiting different characteristics.

flow symmetry Flow where the conditions of the flow entering and leaving one half of a geometry are the same as the conditions of the flow entering and leaving the other half of the geometry.

fluid A substance that tends to flow and assumes the shape of its domain, such as a gas in a duct or a liquid in a container.

free edges Element edges belonging to only one element.

G

gas or liquid surface A type of boundary that exhibits no friction and fluid cannot move through it. Also called a symmetry boundary.

general fluid A fluid whose properties may be generally prescribed in ANSYS CFX or FLUENT. Density and specific heat capacity for general fluids may depend on pressure, temperature, and any Additional Variables.

global model tolerance The minimum distance between two geometry entities below which CFX considers them to be coincident. The default setting of global model tolerance, defined in the template database, is normally .005 in whichever geometry units you are working.

geometric symmetry The state of a geometry where each half is a mirror of the other.

group A named collection of geometric and mesh entities that can be posted for display in viewports. The group's definition includes:

- Group name
- Group status (current/not current)
- Group display attributes (modified under Display menu)
• A list of the geometric and mesh entities that are members of the group.

**H**

**hexahedral element**
A mesh element with the same topology as a hexahedron, with six faces and eight vertices.

**home directory**
The directory on all Linux systems and some Windows NT systems where each user stores all of their files, and where various setup files are stored.

However, on some Windows NT systems, users do not have an equivalent to the Linux home directory. In this case, the ANSYS CFX setup file `cfx5rc` can be placed in `c:\winnt\profiles\<user>\Application Data\ANSYS CFX\<release>`, where `<user>` is the user name on the machine. Other files can be put into a directory set by the variable `HOME`.

**I**

**ideal gas**
A fluid whose properties obey the ideal gas law. The density is automatically computed using this relationship and a specified molecular weight.

**IGES (Initial Graphics Exchange Specification) file**
An ANSI standard formatted file used to exchange data among most commercial CAD systems. IGES files can be imported into CFX.

**implicit geometry**
Geometry that exists as part of some other entity. For example, the edges of a surface are implicit curves.

**import mesh**
A meshing mode that enables import of volume meshes generated in one of a number of external CFD packages. The volume mesh can contain hexahedral, tetrahedral, prismatic, and pyramidal element types.

**inactive region**
A fluid or porous region where flow and (if relevant) temperatures are not being calculated, or a solid region where temperatures are not being calculated. By default, inactive regions are hidden from view in the graphics window.

**incompressible flow**
Flow in which the density is constant throughout the domain.

**incremental adaptation**
The method of mesh adaption used by CFX where an existing mesh is modified to meet specified criteria. Incremental adaption is much faster than remeshing; however, the mesh quality is limited by that of the initial mesh.

**inertial resistance coefficients**
Mathematical terms used to define porous media resistance.
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>initial guess</td>
<td>The values of dependent variables at the start of a steady state simulation. These can set explicitly, read from an existing solution, or given default values.</td>
</tr>
<tr>
<td>initial values</td>
<td>The values of dependent variables at the initial time of a transient simulation. These can be either set explicitly, or read from an existing solution.</td>
</tr>
<tr>
<td>inlet boundary condition</td>
<td>A boundary condition (p. 278) for which the quantity of fluid flowing into the flow domain is specified, for example, by setting the fluid velocity or mass flow rate.</td>
</tr>
<tr>
<td>instancing</td>
<td>The process of copying an object and applying a positional transform to each of the copies. For example, a row of turbine blades can be visualized by applying instancing to a single blade.</td>
</tr>
<tr>
<td>interior boundary</td>
<td>A boundary that enables flow to enter and exit. These types of boundaries are useful to separate two distinct fluid regions from each other, or to separate a porous region from a fluid region, when you still want flow to occur between the two regions.</td>
</tr>
<tr>
<td>internal flow</td>
<td>Flow through the interior of your geometry, such as flow through a pipe.</td>
</tr>
<tr>
<td>interpolation</td>
<td>The process of transferring a solution from a results file containing one mesh onto a second file containing a different mesh.</td>
</tr>
<tr>
<td>isentropic</td>
<td>The description of a process where there is no heat transfer and entropy is held constant.</td>
</tr>
<tr>
<td>isosurface</td>
<td>A surface of constant value for a given variable.</td>
</tr>
<tr>
<td>Isovolume</td>
<td>A locator that consists of a collection of volume elements, all of which take a value of a variable greater than a user-specified value.</td>
</tr>
<tr>
<td>JPEG file</td>
<td>A common graphics file type that is supported by CFD-Post output options.</td>
</tr>
<tr>
<td>k-epsilon turbulence model</td>
<td>A turbulence model (p. 293) based on the concept that turbulence consists of small eddies that are continuously forming and dissipating. The k-epsilon turbulence model solves two additional transport equations: one for turbulence generation (k), and one for turbulence dissipation (epsilon).</td>
</tr>
</tbody>
</table>
kinematic diffusivity

A function of the fluid medium that describes how rapidly an Additional Variable would move through the fluid in the absence of convection.

laminar flow

Flow that is dominated by viscous forces in the fluid, and characterized by low Reynolds Number.

A flow field is laminar when the velocity distributions at various points downstream of the fluid entrance are consistent with each other and the fluid particles move in a parallel fashion to each other. The velocity distributions are effectively layers of fluid moving at different velocities relative to each other.

Large Eddy Simulation Model (LES)

The Large Eddy Simulation model decomposes flow variables into large and small scale parts. This model solves for large-scale fluctuating motions and uses “sub-grid” scale turbulence models for the small-scale motion.

legend

A color key for any colored plot.

line interface mode

A mode in which you type the commands that would otherwise be issued by the user interface. A viewer is provided that shows the geometry and the objects created on the command line. Line interface mode differs from entering commands in the Command Editor dialog box in that line interface action commands are not preceded by a > symbol. Aside from that difference, all commands that work for the Command Editor dialog box will also work in line interface mode, providing the correct syntax is used.

locator

A place or object upon which a plot can be drawn. Examples are planes and points.

M

MAIt key (Meta key)

The MAIt key (or Meta key) is used to keyboard select menu items with the use of mnemonics (the underscored letter in each menu label). By simultaneously pressing the MAIt key and a mnemonic is an alternative to using the mouse to click a menu title. The MAIt key is different for different brands of keyboards. Some examples of MAIt keys include the "" key for Sun Model Type 4 keyboards, the "Compose Character" key for Tektronix keyboards, and the Alt key on most keyboards for most Windows-based systems.

mass fraction

The ratio of the mass of a fluid component to the total mass of the fluid. Values for mass fraction range from 0 to 1.

material

A substance with specified properties, such as density and viscosity.

meridional

A term used in FLUENT documentation that is equivalent to the ANSYS CFX term constant streamwise location.
mesh  A collection of points representing the flow field where the equations of fluid motion (and temperature, if relevant) are calculated.

mesh adaption  The process by which, once or more during a run, the mesh is selectively refined at various locations, depending on criteria that you can specify. As the solution is calculated, the mesh can automatically be refined in locations where solution variables are changed rapidly, in order to resolve the features of the flow in these regions.

There are two general methods for performing mesh adaption. Incremental adaption takes an existing mesh and modifies it to meet the adaption criteria. The alternative is remeshing, in which the whole geometry is remeshed at every adaption step according to the adaption criteria. In CFX, incremental adaption is used because this is much faster; however, this imposes the limitation that the resulting mesh quality is limited by the quality of the initial mesh.

mesh control  A refinement of the surface and volume mesh in specific regions of the model. Mesh controls can take the form of a point, line, or tri-angle.

meshing mode  The method you use to create your mesh of nodes and elements required for analysis. There are two main meshing modes:

  •  Advancing Front and Inflation (AFI) (p. 277)
  •  import mesh (p. 283)

minimal results file  A file that contains only the results for selected variables, and no mesh. It can be created only for transient calculations. It is useful when you are only interested in particular variables and want to minimize the size of the results for the transient calculation.

multicomponent fluid  A fluid consisting of more than one component. The components are assumed to be mixed at the molecular level, though the proportions of each component may vary in space or time. The properties of a multicomponent fluid are dependent on the proportion of constituent components.

N  Navier-Stokes equations  The fundamental equations of fluid flow and heat transfer, solved by CFX-Solver. They are partial differential equations.

new model preferences  Preferential settings for your model that define the meshing mode (p. 286), the geometry units, and the global model tolerance (p. 282).

node allocation parameter  A parameter that is used in mesh adaption (p. 286) to determine how many nodes are added to the mesh in each adaption step (p. 277).
<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>non-clipped absolute pressure</td>
<td>The summation of solver pressure, reference pressure, and hydrostatic pressure (if a buoyant flow). This pressure, used by the solver to calculate cavitation sources, can be negative or positive.</td>
</tr>
<tr>
<td>non-Newtonian fluid</td>
<td>A fluid that does not follow a simple linear relationship between shear stress and shear strain.</td>
</tr>
<tr>
<td>normal</td>
<td>The direction perpendicular to the surface of a mesh element or geometry. The positive direction is determined by the cross-product of the local parametric directions in the surface.</td>
</tr>
<tr>
<td>open area</td>
<td>The area in a porous region that is open to flow.</td>
</tr>
<tr>
<td>OpenGL</td>
<td>A graphics display system that is used on a number of different types of computer operating systems.</td>
</tr>
<tr>
<td>outlet</td>
<td>A boundary condition where the fluid is constrained to flow only out of the domain.</td>
</tr>
<tr>
<td>outline plot</td>
<td>A plot showing the outline of the geometry. By setting the edge angle to 0, the surface mesh can be displayed over the whole geometry.</td>
</tr>
<tr>
<td>output file</td>
<td>A text file produced by CFX-Solver that details the history of a run. It is important to browse the output file when a run is finished to determine whether the run has converged, and whether a restart is necessary.</td>
</tr>
<tr>
<td>parallel runs</td>
<td>Separate solutions of sections (partitions) of your CFD model, run on more than one processor.</td>
</tr>
<tr>
<td>parametric equation</td>
<td>Any set of equations that express the coordinates of the points of a curve as functions of one parameter, or express the coordinates of the points of a surface as functions of two parameters, or express the coordinates of the points of a solid as functions of three parameters.</td>
</tr>
<tr>
<td>parametric solids</td>
<td>Six-sided solids parameterized in three normalized directions. Parametric solids are colored blue ANSYS CFX.</td>
</tr>
<tr>
<td>parametric surfaces</td>
<td>Four sided surfaces parameterized in two normalized directions. Parametric surfaces are colored green ANSYS CFX.</td>
</tr>
<tr>
<td>Particle-Particle Collision Model (LPTM-PPCM)</td>
<td>A model in ANSYS CFX that takes inter-particle collisions and their effects on the particle and gas phase into consideration.</td>
</tr>
<tr>
<td>periodic pair boundary condition</td>
<td>A boundary condition where the values on the first surface specified are mapped to the second surface. The mapping can be done either by a translation or a rotation (if a rotating frame of reference is used).</td>
</tr>
</tbody>
</table>
physical time step | The time represented in each iteration of the solution.
---|---
pick list | The list processor interprets the contents of all selected data boxes. All selected data boxes in CFX expect character strings as input. The character strings may be supplied by the graphics system when you select an entity from a viewport, or you can type or paste in the string directly. The character strings are called "pick lists."
plot | Any means of viewing the results in CFD-Post. Types of plots include vectors, streamlines, and contour plots.
point | An ordered \( n \)-tuple, where \( n \) is the number of dimensions of the space in which the point resides.
point probes | Points placed at specific locations in a computational domain where data can be analyzed.
polyline | A locator that consists of user-defined points.
power syntax | The CFX Command Language (CCL) is the internal communication and command language of CFD-Post. It is a simple language that can be used to create objects or perform actions in the post-processor. Power Syntax enables you to embed Perl commands into CCL to achieve powerful quantitative post-processing.

Power Syntax programming uses the Perl programming language to allow loops, logic, and custom macros (subroutines). Lines of Power Syntax are identified in a .ccl file by an exclamation mark (!) at the start of each line. In between Perl lines, simple syntax lines may refer to Perl variables and lists.

For details, see Power Syntax in ANSYS CFX (p. 229).
pre-processor | The component used to create the input for the solver. For ANSYS CFX, the pre-processor is CFX-Pre.
pressure | In the cavitation model, pressure is the same as solver pressure, but clipped such that the absolute pressure is non-negative. It is used for post-processing only.
prism or prismatic element | A 3D mesh element shaped like a triangular prism (with six vertices). Sometimes known as a wedge element.
PVM (Parallel Virtual Machine) | The environment that controls parallel processes.
PVMHosts file | The database file containing information about where ANSYS CFX, and consequently PVM, have been installed on each PVM node. It is consulted when the Parallel Virtual Machine is started to determine where PVM is located on each slave node.
pyramid element | A 3D mesh element that has five vertices.
reference coordinate frame  

The coordinate frame in which the principal directions of X or Y or Z are taken. X is taken in the local X of that frame, and so on. If the coordinate frame is a non-rectangular coordinate frame, then the principal axes 1, 2, and 3 will be used to define the X, Y, and Z directions, respectively. The default is CFX global system (Coord 0).

For domains, boundary conditions, and initial values, the reference coordinate frame is always treated as Cartesian, irrespective of coordinate frame type.

region  

An area comprised of a fluid, a solid material, or a porous material.

residuals  

The change in the value of certain variables from one iteration to the next.

The discretized Navier-Stokes equations (p. 286) are solved iteratively. The residual for each equation gives a measure of how far the latest solution is from the solution in the previous iteration. A solution is considered to be converged when the residuals are below a certain value.

CFX-Solver writes the residuals to the output file (p. 287) so that they can be reviewed. FLUENT allows residuals to be plotted during the solution process.

results file (CFX-Solver Results file)  

A file produced by CFX-Solver that contains the full definition of the simulation as well as the values of all variables throughout the flow domain and the history of the run including residuals (p. 289). A CFX-Solver Results file can be used as input to CFD-Post or as an input file to CFX-Solver, in order to perform a restart.

Reynolds averaged Navier-Stokes (RANS) equations  

Time-averaged equations of fluid motion that are primarily used with turbulent flows.

Reynolds stress  

The stress added to fluid flow due to the random fluctuations in fluid momentum in turbulent flows. When the Navier-Stokes equations (p. 286) are derived for time averaged turbulent flow to take into account the effect of these fluctuations in velocity, the resulting equations have six stress terms that do not appear in the laminar flow equations. These are known as Reynolds stresses.

Reynolds stress turbulence model  

A model that solves transport equations for the individual Reynolds stress components. It is particularly appropriate where strong flow curvature, swirl, and separation are present. Reynolds stress models in general tend to be less numerically robust than eddy viscosity models such as the k-epsilon turbulence model (p. 284).

RNG k-epsilon turbulence model  

An alternative to the standard k-epsilon turbulence model (p. 284). It is based on renormalization group analysis of the Navier-Stokes equations. The transport equations for turbulence generation and dissipation are the same as those for the standard k-epsilon model,
but the model constants differ, and the constant \( Cc1 \) is replaced by the function \( Cc1RNG \).

### Rotating Frame of Reference (RFR)

A coordinate system that rotates. ANSYS CFX and FLUENT can solve for fluid flow in a geometry that is rotating around an axis at a fixed angular velocity.

### run

A process that requires the specification of the CFX-Solver input file (and an initial values file, if necessary), and produces an output file and a results file (if successful).

### S

**Sampling Plane**

A locator that is planar and consists of equally-spaced points.

**scalar variable**

A variable that has only magnitude and not direction. Examples are temperature, pressure, speed (the magnitude of the velocity vector), and any component of a vector quantity.

### Scale Adaptive Simulation (SAS) model

A shear stress transport model used primarily for unsteady CFD simulations, where steady-state simulations are not of sufficient accuracy and do not properly describe the true nature of the physical phenomena. Cases that may benefit from using the SAS-SST model include:

- Unsteady flow behind a car or in the strong mixing behind blades and baffles inside stirred chemical reactors
- Unsteady cavitation inside a vortex core (fuel injection system) or a fluid-structure interaction (unsteady forces on bridges, wings, and so on).

For these problems and others, the SAS-SST model provides a more accurate solution than URANS models, where steady-state simulations are not of sufficient accuracy and do not properly describe the true nature of the physical phenomena.

**Second Moment Closure models**

Models that use seven transport equations for the independent Reynolds stresses and one length (or related) scale; other models use two equations for the two main turbulent scales.

**session file (CFX)**

A file that contains the records of all the actions in each interactive CFX session. It has the extension .ses.

**Shear Stress Transport (SST)**

A \( k - \omega \) based SST model that accounts for the transport of the turbulent shear stress and gives highly accurate predictions of the onset and the amount of flow separation under adverse pressure gradients.

**singleton (CCL object)**

A singleton object that consists of an object type at the start of a line, followed by a : (colon). Subsequent lines may define parameters and child objects associated with this object. The object definition is terminated by the string END on a line by itself. The singleton object for a session file is declared like this:
The difference between a singleton object and a named object is that after the data has been processed, a singleton can appear just once as the child of a parent object. However, there may be several instances of a named object of the same type defined with different names.

slice plane A locator that is planar, and that consists of all the points that intersect the plane and the mesh edges.

solid A material that does not flow when a force or stress is applied to it.

The general class of vector valued functions of three parametric variables.

solid sub-domain A region of the fluid domain that is occupied by a conducting solid. ANSYS CFX can model heat transfer in such a solid; this is known as CHT (Conjugate Heat Transfer) (p. 279).

solver The component that solves the CFD problem, producing the required results.

solver pressure The pressure calculated by solving conservative equations; it can be negative or positive. In the .out file it is called Pressure.

spanwise coordinate A term used in FLUENT documentation that is equivalent to the ANSYS CFX term constant span.

specific heat The ratio of the amount of heat energy supplied to a substance to its corresponding change in temperature.

specific heat capacity The amount of heat energy required to raise the temperature of a fixed mass of a fluid by 1 K at constant pressure.

speed of sound The velocity at which small amplitude pressure waves propagate through a fluid.

sphere volume A locator that consists of a collection of volume elements that are contained in or intersect a user-defined sphere.

state files Files produced by CFD-Post that contain CCL commands. They differ from session files in that only a snapshot of the current state is saved to a file. You can also write your own state files using any text editor.

STP (Standard Temperature and Pressure) Defined as 0°C (273.15 K) and 1 atm (1.013x105 Pa).

steady-state simulation A simulation that is carried out to determine the flow after it has settled to a steady state. Note that, even with time constant boundary conditions, some flows do not have a steady-state solution.

stream plot A plot that shows the streamlines of a flow. Stream plots can be shown as lines, tubes, or ribbons.
streamline | The path that a small, neutrally-buoyant particle would take through the flow domain, assuming the displayed solution to be steady state.
---|---
subdomains | Regions comprising a solid or set of solids, within the region of bounding solids for a fluid domain, that allow the prescription of momentum and energy sources. They can be used to model regions of flow resistance and heat source.
---|---
subsonic flow | The movement of a fluid at a speed less than the speed of sound.
---|---
surface plot | A plot that colors a surface according to the values of a variable. Additionally, you can choose to display contours.
---|---
symmetry-plane boundary condition | A boundary condition where all variables except velocity are mathematically symmetric and there can be no diffusion or flow across the boundary. Velocity parallel to the boundary is also symmetric and velocity normal to the boundary is zero.
---|---
template fluid | One of a list of standard fluids with predefined properties that you can use ‘as is’, or use as a template to create a fluid with your own properties.
---|---
thermal conductivity | The property of a fluid that characterizes its ability to transfer heat by conduction.
A property of a substance that indicates its ability to transfer thermal energy between adjacent portions of the substance.
---|---
thermal expansivity | The property of a fluid that describes how a fluid expands as the result of an increase in temperature. Also known as the coefficient of thermal expansion, $\beta$.
---|---
theta | The angular coordinate measured about the axis of rotation following the right-hand rule. When looking along the positive direction of the axis of rotation, theta is increasing in the clockwise direction. Note that the theta coordinate in CFD-Post does not increase over 360°, even for spiral geometries that wrap to more than 360°.
---|---
topology | The shape, node, edge, and face numbering of an element.
---|---
tracers | Particles that follow a flow pathline. Used in viewing CFD results in order to visualize the mechanics of the fluid flow.
---|---
transitions | Portions of a mesh that are the result of meshing geometry with two opposing edges that have different mesh seeds. This produces an irregular mesh.
---|---
turbulence intensity | The ratio of the root-mean-square of the velocity fluctuations to the mean flow velocity.
A turbulence intensity of 1% or less is generally considered low and turbulence intensities greater than 10% are considered
high. Ideally, you will have a good estimate of the turbulence intensity at the inlet boundary from external, measured data. For example, if you are simulating a wind-tunnel experiment, the turbulence intensity in the free stream is usually available from the tunnel characteristics. In modern low-turbulence wind tunnels, the free-stream turbulence intensity may be as low as 0.05%.

For internal flows, the turbulence intensity at the inlets is totally dependent on the upstream history of the flow. If the flow upstream is under-developed and undisturbed, you can use a low turbulence intensity. If the flow is fully developed, the turbulence intensity may be as high as a few percent.

**turbulence length scale**
A physical quantity related to the size of the large eddies that contain the energy in turbulent flows.

In fully-developed duct flows, the turbulence length scale is restricted by the size of the duct because the turbulent eddies cannot be larger than the duct. An approximate relationship can be made between the turbulence length scale and the physical size of the duct that, while not ideal, can be applied to most situations.

If the turbulence derives its characteristic length from an obstacle in the flow, such as a perforated plate, it is more appropriate to base the turbulence length scale on the characteristic length of the obstacle rather than on the duct size.

**turbulence model**
A model that predicts turbulent flow (p. 293). The available turbulence models in ANSYS CFX are:
- *k-epsilon turbulence model* (p. 284)
- *RNG k-epsilon turbulence model* (p. 289)
- *Reynolds stress turbulence model* (p. 289)
- *zero equation turbulence model* (p. 295)

Turbulence models allow a steady state representation of (inherently unsteady) turbulent flow to be obtained.

**turbulent**
A flow field that is irregular and chaotic look. In turbulent flow, a fluid particle's velocity changes dramatically at any given point in the flow field, in time, direction, and magnitude, making computational analysis of the flow more challenging.

**turbulent flow**
Flow that is randomly unsteady over time. A characteristic of turbulent flow is chaotic fluctuations in the local velocity.

**V**

**variable**
A quantity such as temperature or velocity for which results have been calculated in a CFD calculation.
vector plot  A plot that shows the direction of the flow at points in space, using arrows. Optionally, the size of the arrows may show the magnitude of the velocity of the flow at that point. The vectors may also be colored according to the value of any variable.

verification  A check of the model for validity and correctness.

viewer area  The area of ANSYS CFX that contains the 3D Viewer, Table Viewer, Chart Viewer, Comment Viewer, and Report Viewer, which you access from tabs at the bottom of the area.

viewport (CFX)  An assigned, named, graphics window definition, stored in the CFX database, that can be used to display selected portions of a model's geometry, finite elements, and analysis results. The viewport's definition includes:

- The viewport name
- The status of the viewport (posted or unposted; current or not current)
- Viewport display attributes
- A definition of the current view
- A current group
- A list of the posted groups for display
- A graphics environment accessed from Display, Preference, and Group menus that is common to all viewports.

There are the following types of CFX viewports:

**current viewport**  The viewport currently being displayed. The following actions can be performed only on the current viewport:

- Changing the view by using the View menu or mouse.
- Posting titles and annotations by using the Display menu.

**posted viewport**  A viewport that has been selected for display.

**target viewport**  A viewport selected for a viewport modify action. Any viewport (including the current viewport) can be selected as the target viewport.

viscosity  The ratio of the tangential frictional force per unit area to the velocity gradient perpendicular to the flow direction.

viscous resistance coefficients  A term to define porous media resistance.

Volume of Fluid (VOF) method  A technique for tracking a fluid-fluid interface as it changes its topology.
**W**

wall
A generic term describing a stationary boundary through which flow cannot pass.

workspace area
The area of CFX-Pre and CFD-Post that contains the **Outline**, **Variables**, **Expressions**, **Calculators**, and **Turbo** workspaces, which you access from the tabs at the top of the area. Each workspace has a tree view at the top and an editor at the bottom (which is often called the details view).

See also "CFD-Post Graphical Interface".

**Y**

**y+ (YPLUS)**
A non-dimensional parameter used to determine a specific distance from a wall through the boundary layer to the center of the element at a wall boundary.

**Z**

**zero equation turbulence model**
A simple model that accounts for turbulence by using an algebraic equation to calculate turbulence viscosity. This model is useful for obtaining quick, robust solutions for use as initial fields for simulations using more sophisticated turbulence models.
Index

Symbols
2D geometries
   and validation cases, 105
3D
   trajectories of particles and Lagrange models, 100
3D grid problems
   lines not aligned to flow, 86
3D simulations
   and coarse grid solutions in the asymptotic range, 89

A
accuracy
   of boundary layer simulations, 100
   round-off errors, 88
allowed arguments
   in an export program, 38
analytical solutions
   and software errors, 104
application uncertainties
   and numerical errors, 93
   reduction of, 101
arbitrary grid interfaces
   and grid generation, 94
area function, 161
area() power syntax subroutine, 234
areaAve function, 162
areaAve() power syntax subroutine, 234
arealnt function, 163
arealnt() power syntax subroutine, 234
aspect ratio of cells
   defined, 99
asymptotic
   range and coarse grid solution, 89
   range and error estimation, 88
automatic near-wall treatment
   hybrid methods, 100
ave function, 164
ave() power syntax subroutine, 234
axisymmetric geometries
   and validation cases, 105

B
backward Euler integration, 86
benchmark studies
   and user errors, 94
bibliography
   references from ANSYS CFX documentation, 243
   block-structured grids
      and non-scalable topologies, 94
boundary conditions
   and numerical error, 93
   in user export, 46
boundary layer flows, 98
buoyant flow variables, 191

C
CAD
   importing and checking geometry data, 94
calcTurboVariables() power syntax subroutine, 234
calculate() power syntax subroutine, 235
calculateUnits() power syntax subroutine, 235
calibration
   and validation of statistical models, 104
   of model coefficients and model capability, 92
Cartesian coordinate
   variables, 186
CCL (CFX command language)
   names definition, 137
   overview, 135
   syntax, 135
CEL (CFX expression language), 141
   available system variables, 208
   conditional statement, 145
   constants, 143, 146
   examples, 147
   expression names, 208
   expression properties, 208
   expression syntax, 143
   expressions, 141, 146
   functions and constants, 144
   fundamentals, 141
   if statement, 145
   introduction, 141
   logical expressions, 142
   logical operators, 144
   mathematical expressions, 142
   mathematical operators, 144
   multiple-line expressions, 143
   offset temperature, 146
   operators and built-in functions, 144
   relational operators, 144
   scalar expressions, 208
   statements, 142
   technical details, 149
   unavailable system variables, 208
   units, 142
   values - dimensionless, 141
   variables, 197
CEL limitations
create Design Exploration expressions in CFD-Post, 141

CFD (Computational Fluid Dynamics)
- difficulties in quantification of, 83

CFD methods
- accuracy and experimental data, 104

CFD simulation
- model selection and application, 96

CFDPOSTROOT
- installation root directory, 277

CFX command language (CCL)
- names definition, 137
- overview, 135
- syntax, 135

CFX export
- user-defined export routines, 37

CFX menu overview, 2

CFXROOT
- installation root directory, 277

course and fine grids
- interpolation of, 88

coefficient loops
- and time discretization error, 86

collectTurboInfo() power syntax subroutine, 235

comfortFactors() power syntax subroutine, 235

command line, 3

comment character in CCL syntax, 137

compresible flow variables, 191

compressorPerform() power syntax subroutine, 235

compressorPerformTurbo() power syntax subroutine, 235

count() power syntax subroutine, 235

computational cells
- representation of geometry of the flow domain, 94

conditional statement, 145

conservative variable values, 181

constants in CEL, 143, 146

continuation character
- in CCL syntax, 137

convergence
- asymptotic evaluation on unstructured meshes, 83
- plotting the value of the target variable, 88

copyFile() power syntax subroutine, 235

corrected boundary node values, 181

correlation for particles in multi-phase models, 100

count entries, 51

count function, 164

count() power syntax subroutine, 235

countTrue function, 165

countTrue() power syntax subroutine, 235

cpPolar() power syntax subroutine, 235

D

data quality
- and validation, 105

defined constants and structures, 50

demonstration experiments, 107

Detached Eddy Simulation (DES), 96

Direct Numerical Simulation (DNS), 84

double-precision round-off errors
  - See also single precision, 88

E

eddy viscosity, 98
- and heat transfer models, 100
- and one-equation models, 97

Edit menu overview, 2

element
- data structure, 52
- hexahedral, 55
- prism, 55
- pyramid, 55
- routines, 55
- tetrahedral, 55
- types, 51
- wedge, 55

element types (VMI), 9

enthalpy variables, 196

error separation
- overview, 83

errors
- from combustion, 84
- from differences between exact and discretized equations, 84
- from documentation, 84
- from flow phenomena, 84
- from inadequate use of CFD software, 84
- from insufficient simulation information, 84
- from multi-phase, 84
- from turbulence, 84
- minimizing, 94
- separation of, 83

Euler-Euler formulation
- multi-phase models, 100

evaluate(Expression) power syntax subroutine, 236

evaluatelnPreferred() power syntax subroutine, 236

examples
- calculate area, 161
- CEL, 147
- feedback to control inlet temperature, 148
- Reynolds number dependent viscosity, 147

experimental data
- and numerical errors, 93

export
linking programs, 49
export program
  allowed arguments in, 38
  example, 38
  file header, 38
  geometry file output, 42
  initialization of, 38
  opening the results file, 40
  output from, 46
  results file, 45
  specifying results file, 40
  template results file, 44
  timestep setup, 41
expression
  properties in CEL, 208
expression language, 141
  constants, 146
  expressions, 141
  statements, 142
  statements - multiple-line expressions, 143
  statements - syntax, 143
  units, 142
  using, 146
  values - dimensionless, 141
expression names
  CEL, 208
expression syntax, 143
expressions
  create in CFD-Post for Design Exploration, 141
  in CEL, 146
exprExists() power syntax subroutine, 236
extrapolation
  Richardson, 88
free shear flow, 96
  and Large Eddy Simulation models, 98
functions
  area, 161
  areaAve, 162
  arealInt, 163
  ave, 164
  count, 164
  countTrue, 165
  force, 165
  forceNorm, 167
  inside, 167
  length, 168
  lengthAve, 168
  lengthInt, 169
  mass, 169
  massAve, 169
  massFlow, 169
  massFlowAve, 171
  massFlowInt, 173
  massInt, 174
  maxVal, 174
  minVal, 174
  probe, 175
  rbstate, 175
  rmsAve, 176
  sum, 176
  torque, 177
  volume, 177
  volumeAve, 178
  volumeInt, 178
functions and constants
  CEL, 144
geometry
  and numerical error, 93
geometry file output
  from an export program, 42
geometry generation, 94
getBladeForceExpr() power syntax subroutine, 237
getBladeTorqueExpr() power syntax subroutine, 237
getCCLState() power syntax subroutine, 237
gerChildren() power syntax subroutine, 237
gerChildrenByCategory() power syntax subroutine, 237
gerExprOnLocators() power syntax subroutine, 237
gerExprString() power syntax subroutine, 237
gerExprVal() power syntax subroutine, 237
gerObjectName() power syntax subroutine, 238
gerParameterInfo() power syntax subroutine, 238
gerParameters() power syntax subroutine, 238
gerTempDirectory() power syntax subroutine, 238
getIndex() power syntax subroutine, 238
getValue() power syntax subroutine, 238
getViewArea() power syntax subroutine, 239

grid
  recommendations for angle, 94
  recommendations for aspect ratio, 94
  recommendations for density, 94
  recommendations for topology, 94
  refined for critical regions, 94

grid adaptation
  and indicator functions, 94

grid problems
  lines not aligned to flow, 86

grid refinement
  and scalable wall functions, 99
  grid refinement and time step reduction, 88

grid resolution
  assessment of mesh parameters, 94
  doubling of, 86

grid sensitivity
  SAS model and DES formulation, 98

H
heat transfer models, 100
Help menu overview, 4
hexahedral element, 55
hybrid methods
  for omega-equation based turbulence models, 99
hybrid variable values, 181

I
if statement, 145
indentation
  in CCL syntax, 137
inflow profiles
  and boundary conditions, 93
  and inlet boundary conditions, 93
inside function, 167
internal flows, 98
interpolation
  of solution between grids and integral quantities, 88
  interpolation of error, 88
isCategory() power syntax subroutine, 239
iteration
  coefficient loops and time discretization error, 86
iteration error
  numerical, 88
  quantified in terms of a residual, 88

K
k-epsilon
model selection and scalable wall functions, 100
  two equation model, 92
k-omega
  two equation model, 92

L
Lagrange models
  multi-phase models, 100
laminar channel flow, 104
laminar Couette flow, 104
Large Eddy Simulation (LES), 96
launcher, 1
  adding APPLICATION objects, 6
  adding DIVIDER objects, 8
  adding GROUP objects, 5
  customizing, 5
  interface, 1
  Show menu, 3
  using variables in APPLICATION objects, 7
law of the wall
  and standard wall functions, 99
length function, 168
length scale
  and turbulence models, 96
Length() power syntax subroutine, 239
lengthAve function, 168
lengthAve() power syntax subroutine, 239
lengthInt function, 169
lengthInt() power syntax subroutine, 239
linking
  code into CFX, 49
  export programs, 49
liquidTurbPerform() power syntax subroutine, 240
liquidTurbPerformTurbo() power syntax subroutine, 239
lists
  in CCL syntax, 138
logarithmic region
  and standard wall functions, 99
logical expressions, 142
logical operators, 144
low-Reynolds (low-Re)
  and wall boundary conditions, 99
low-Reynolds (low-Re) and DNS studies
  validation cases, 105

M
mass function, 169
mass transfer between phases
  multi-phase models, 100
massAve function, 169
massFlow function, 169
massFlow() power syntax subroutine, 240
massFlowAve function, 171
massFlowAve() power syntax subroutine, 240
massFlowAveAbs function, 171
massFlowAveAbs() power syntax subroutine, 240
massFlowInt function, 173
massFlowInt() power syntax subroutine, 240
mathematical expressions, 142
mathematical operators, 144
maximum error, 88
maxVal function, 174
maxVal() power syntax subroutine, 240
Mechanical import/export example, 79
mesh resolution
  See grid resolution, 94
meshes
  convergence on unstructured, 83
minVal function, 174
minVal() power syntax subroutine, 240
modeling
  numerical errors, 92
models
  combustion, 92
  multi-phase, 92
  radiation, 92
  turbulence, 92
multi-field runs, 207
multi-phase models
  Euler-Euler, 100
  Lagrange, 100
multicomponent calculation variables, 193
multiple-line expressions, 143

N
named objects
  in CCL syntax, 137
Navier-Stokes, 92
near-wall
  automatic treatment - hybrid methods, 100
  resolution at wall nodes - low-Re models, 99
decision ratio
  grid generation, 94
near-wall length scales
  and boundary layer flows, 98
negative volumes
  and grid generation, 94
nodes
  data structure, 52
  routines, 54
non-miscible fluids
  and multi-phase models, 100
non-orthogonal meshes, 94
numerical diffusion
  due to non-orthogonal cells, 94
numerical diffusion term
  false diffusion, 86
numerical errors
  application uncertainties, 93
  iteration, 88
  modeling, 92
  round-off, 88
  software, 93
  solution error estimation, 89
  solutions, 85
  spatial discretization, 86
  time discretization, 86
  user, 92

O
objectExists() power syntax subroutine, 240
offset temperature
  in CEL, 146
one-equation turbulence model
  and eddy viscosity, 97
operators and built-in functions
  CEL, 144
Output window overview, 4

P
parallel calculation variables, 193
parameter values
  in CCL syntax, 138
parameters
  in CCL syntax, 137
particle tracking variables, 192
particle variables
  list of all, 209
  type - boundary vertex, 217
  type - field, 212
  type - particle sources into the coupled fluid phase, 212
  type - radiation, 213
  type - RMS, 218
  type - track, 210
  type - vertex, 214
physics
  multi-phase and unsteady effects, 83
plot target variables
  as a function of the convergence level, 88
power syntax, 229
  examples, 229
  subroutines, 233
power syntax subroutines
Index

area(), 234
dec(), 235
decimate(), 235
depthAve(), 235
depthInt(), 235
depth(), 235
deg(), 235
degAAve(), 235
degAInt(), 235
degA(), 235
deg(), 235
deg2rad(), 235
deg2radAve(), 235
deg2radInt(), 235
deg2rad(), 235
degreestart(), 235
degreestartAve(), 235
degreestartInt(), 235
degreestart(), 235
degreestart2rad(), 235
degreestart2radAve(), 235
degreestart2radInt(), 235
degreestart2rad(), 235
degrad(), 235
degradAve(), 235
degradInt(), 235
degrad(), 235
degrad2rad(), 235
degrad2radAve(), 235
degrad2radInt(), 235
degrad2rad(), 235
degstart(), 235
degstartAve(), 235
degstartInt(), 235
degstart(), 235

Prandtl number

and heat transfer models, 100
precision
round-off errors, 88
prism element, 55
probe function, 175
probe() power syntax subroutine, 240
problems
due to round-off errors, 99
grid lines not aligned to flow, 86
program initialization
in an export program, 38
project management
to reduce errors, 84
to reduce user errors, 94
pseudo time stepping scheme
and iteration error, 88
pumpPerform() power syntax subroutine, 241
pumpPerformTurbo() power syntax subroutine, 241
pyramid element, 55

Q
quality

of grid - checking the mesh parameters, 94
quality assurance
definition of target variables, 83
quality of numerical results
setting the estimates for evaluation, 88
quality of solution
measurement of overall reduction in the residual, 88

R
radiation calculation variables, 195
random behavior of the numerical solution
round-off errors, 88
range() power syntax subroutine, 241
rbstate function, 175
refinement
grid and time step reduction, 88
relational operators, 144
remeshing, 65
ICEM CFD replay, 68
user defined, 66
reportError() power syntax subroutine, 241
reportWarning() power syntax subroutine, 241
residual
and iteration error, 88
results file
in an export program, 45
opening from an export program, 40
specifying in an export program, 40
Reynolds Averaged Navier-Stokes (RANS), 92
Reynolds stresses
  and Second Moment Closure, 97
Richardson extrapolation, 88–89
determination of relative solution error, 88
Richardson interpolation
  improves the solution on the fine grid, 88
rms error, 88
rmsAve function, 176
rotating frame of reference variables, 192
round-off error
  numerical, 88
round-off errors
  and wall functions, 99

S
scalable wall function
  and boundary conditions, 99
scalar expressions
  CEL, 208
scalar quantities
  defining error types, 83
Scale Adaptive Simulation model (SAS), 96
Second Moment Closure (SMC), 96
selection of model
  and modeling errors, 92
sensitivity
  SAS model and DES formulation of grid, 98
to swirl and system rotation, 97
sensitivity analysis
  to reduce application uncertainties, 101
sensitivity of the application
  and model selection, 96
shear layer
  grids that are aligned with, 94
Shear Stress Transport (SST), 96
shocks
  and fine grids, 94
Show menu overview, 3
showPkgs() power syntax subroutine, 241
showSubs() power syntax subroutine, 241
showVars() power syntax subroutine, 241
single physics
  validation cases, 105
single-phase Navier-Stokes equations, 84
single-precision round-off errors
  See also double precision, 88
singleton objects
  CCL syntax, 137
software errors
  numerical, 93
software fixes
  verification studies, 104
solid-fluid 1:1 interface
  conservative values, 182
  hybrid values, 182
solid-fluid GGI interface
  conservative values, 183
  hybrid values, 183
solid-fluid interface variables, 182
space and time
  resolution of grid and modeling errors, 96
  resolution requirements, 92
spatial discretization
  and nonlinear algebraic equations, 86
  numerical errors, 86
to swirl and system rotation, 97
spatial discretization errors
  minimizing, 102
spawnAsyncProcess() power syntax subroutine, 241
stagnation regions
  and Second Moment Closure models, 97
turbulence build-up and two-equation models, 97
statistical model
  and resolution requirements, 92
testing the quality of, 105
validation and calibration, 104
steady-state runs, 207
streamline curvature
  and two-equation models, 97
subdomain
  in user export, 46
subroutines, 233
sum function, 176
sum() power syntax subroutine, 242
swirling flows
  and residuals, 102
  and two-equation models, 97
syntax
  case sensitivity in CCL, 136
  CCL parameters, 137
  continuation character in CCL, 137
  end of line comment character in CCL, 137
  indentation in CCL, 137
  lists in CCL, 138
  name objects in CCL, 137
  parameter values in CCL, 138
  singleton objects in CCL, 137
system information, 3
system variable prefixes, 206
system variables
  available, 208
  unavailable, 208
Index

T

target variable error, 88
target variables
plotting as a function of iteration number, 102
to monitor numerical errors, 101
Taylor series
and time discretization error, 86
spatial discretization, 86
truncation error, 86
temperature
in CEL expressions, 146
temperature variables, 196
template results file
in an export program, 44
terminal rise velocity
in a calm fluid, 104
test case quality
and large-scale unsteadiness, 105
tetrahedral element, 55
time and space
resolution of grid and modeling errors, 96
resolution requirements, 92
time discretization
and inner iterations or coefficient loops, 86
numerical errors, 86
time discretization errors
minimizing, 103
time step
and target variables, 102
reducing errors, 84
unsteadiness due to a moving front, 103
time step reduction
and grid refinement, 88
timestep setup
in an export program, 41
Toolbar overview, 4
Tools menu overview, 3
torque function, 177
torque() power syntax subroutine, 242
training
to reduce errors, 84
trajectories
of particles and Lagrange models, 100
transient runs, 207
transport equation
and Second Moment Closure - two-equation model, 97
truncation error
and spatial discretization, 86
turbinePerform() power syntax subroutine, 242
turbinePerformTurbo() power syntax subroutine, 242
turbulence model
time or ensemble averaging of the equations, 92
turbulence models
gaps between real flow and statistically averaged equations, 84
turbulent flow variables, 188
two-equation models
k-omega and Shear Stress Transport model, 97

U

uncertainty
and sensitivity analysis, 101
in CFD methods due to the accuracy of simulation, 92
physical standpoint of, 83
See also errors, 84
units
in CEL, 142
unsteadiness
and quality of a test case, 105
Unsteady RANS (URANS), 96
user errors
numerical, 92
user level of variables, 183, 209
User menu overview, 4

V

validation
and calibration of statistical models, 104
of a statistical model, 105
validation experiments, 105
variables
boundary value only, 183, 209
Cartesian coordinates, 186
for a rotating frame of reference, 192
for buoyant flows, 191
for compressible flows, 191
for multicomponent calculations, 193
for multiphase calculations, 194
for parallel calculations, 193
for particle tracking, 192
for radiation calculations, 195
for total enthalpies, 196
for total pressures, 196
for total temperatures, 196
for turbulent flows, 188
hybrid and conservative values, 181
list of all, 183
long names, 183
short names, 183, 209
solid-fluid interface, 182
user level, 183, 209
variables for CEL Expressions, 197
verboseOn() power syntax subroutine, 242
verification experiments, 104
verification studies
  to detect the software errors, 104
viscous sublayer
  and aspect ratio of cells in standard wall functions, 99
  and integration of the equations - low-Re models, 99
volume
  function, 177
volume fractions
  missing information for validation cases, 105
volume mesh import (VMI)
  custom - libraries, 11
Volume of Fluid (VOF) method, 103
volume() power syntax subroutine, 242
volumeAve function, 178
volumeAve() power syntax subroutine, 242
volumeInt function, 178
volumeInt() power syntax subroutine, 242

W
wall functions
  boundary condition, 99
  using the classical - inconsistent with grid refinement, 100
wall heat transfer
  for coarser grids, 99
  one-dimensional distribution, 83
wall shear stress
  for coarser grids, 99
wedge element, 55
working directory selector, 4

Y
y+
  and accuracy of boundary layer simulations, 100
  near-wall resolution required by low-Re models, 99

Z
zone routines, 53